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Section I : Introduction





Chapitre 1 : Introduction de D-Control
Bienvenue dans la console D-Control™ pour les systèmes Avid® 
ICON. Grâce à D-Control, vous pourrez contrôler de manière 
tactile toutes les fonctions de Pro Tools® et bénéficier d'options 
performantes pour la personnalisation de l'environnement de 
mixage Pro Tools.

Caractéristiques de D-Control

D-Control dispose d'un système de monitoring audio polyvalent 
contrôlé à distance, et propose un ensemble complet de com-
mandes permettant d'effectuer des tâches d'enregistrement, de 
modification et de mixage Pro Tools.

Fonctions de contrôle

• Faders tactiles motorisés Penny et Giles

• Commandes rotatives tactiles multifonctions

• Commandes dédiées à l'affectation et à l'activation des entrées, 
sorties, inserts et départs

• Affichage modulable des commandes de préampli micro, de 
plug-in, de départ, d'insert et de panoramique

• Sections de commandes dédiées aux plug-ins Dynamics et EQ

• Commandes pour toutes les fonctions de tranche, notamment 
le mode d'enregistrement, le mode de monitoring des signaux 
d'entrée, la coupure de son, la mise en solo et la sélection de 
canal

• Commandes spécifiques pour le mode d'automation, l'activation 
et le statut safe

• Mode Flip pour transférer les paramètres des commandes 
rotatives aux faders

• Mode Custom Fader, pour un mappage souple des paramètres 
et des canaux

• Commandes complètes de transport et de navigation compre-
nant des commandes d'emplacement et des fonctions de scrub/ 
shuttle

Fonctions de monitoring

• Système de monitoring de la régie à huit canaux prenant en 
charge plusieurs formats de monitoring (du mono au sur-
round 7.1), avec possibilité d'inclure 6 sources d'entrée maximum 
et de sélectionner 3 chemins de sortie

• Système de retour à deux canaux incluant 5 sorties distinctes 
et une alimentation pour le talkback sélectionnable
• Micro de talkback intégré et entrée pour micro de talkback 
externe

• Mode autonome permettant un monitoring sans Pro Tools

Composants du système D-Control

Les composants suivants sont fournis avec les systèmes D-Control 
à 16 et 32 canaux :

Unité principale

• Unité principale de D-Control

• Cordon d'alimentation CA

• Câble Ethernet

• Câble USB

• Touches majuscules du clavier Windows

• Prise de bouclage Ethernet (à des fins de test)

Module de faders 

(1 pour le système à 16 canaux, 2 pour le système à 32 canaux)

• Unité du module de faders de D-Control

• Cordon d'alimentation CA

• Câble Ethernet

Système de monitoring XMON

• Interface XMON

• Cordon d'alimentation CA

• Câble XMON

Stand de D-Control

• Assemblages pieds gauche et droit

• Assemblage barre transversale arrière

• Rail de support de panneau arrière

• Rail de support de panneau avant

• Caches en plastique latéraux (gauche et droite)

• Cache avant des pieds

• Cache arrière des pieds

• Matériel fourni avec le stand

• Bras du moniteur et matériel
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Options d'extension du système

Module de faders

Vous pouvez ajouter 80 faders au système D-Control, dont cinq 
modules de faders à 16 canaux.

Option Surround Panner

L'option Surround Panner pour les surfaces de travail de D-Control 
fournit une commande tactile pour les fonctions de mixage et 
de panoramique afin d'améliorer le mixage multicanal du son 
surround.

Pour plus d'informations sur les options d'extension et de per-
sonnalisation de D-Control, visitez le site www.avid.com/fr.

Conditions de fonctionnement

Température et aération

Pour assurer le bon fonctionnement de D-Control, vous devez 
installer le système dans un lieu aéré, à l'abri de toute source de 
chaleur et éviter les variations de température. La température 
ambiante ne doit pas excéder 35°C.

Le panneau arrière et la moitié avant du panneau inférieur de 
chaque unité ne doivent pas être obstrués. Toute obstruction 
des panneaux arrière ou inférieur de D-Control, même partielle, 
peut provoquer des dysfonctionnements et entraîner l'annula-
tion de la garantie. 

Le stand de la console D-Control a été conçu pour garantir une 
aération adéquate des unités D-Control. Nous déconseillons 
l'utilisation d'autres stand ou meubles de studio pour l'installation 
des unités D-Control, une aération insuffisante pouvant en effet 
entraîner l'annulation de la garantie. 

Sources d'humidité

Veillez à installer les unités D-Control dans un endroit sec, à l'abri 
de l'humidité. Évitez également les déversements de liquide 
accidentels.

Nettoyage et maintenance

Pour nettoyer la partie supérieure de D-Control, utilisez un chiffon 
ou une serviette en papier et une petite quantité de solution 
nettoyante sans javel, puis nettoyez délicatement la surface. 
N'utilisez pas de substances abrasives, de produits de nettoyage 
à base de javel ni d'aérosols. 
Guide D-Control4
Configuration de la connexion

Connexion de l'alimentation

Une connexion d'alimentation distincte est requise pour chaque 
unité D-Control (unité principale et modules de faders) et pour 
l'interface de contrôle XMON. Vérifiez que la puissance de votre 
source d'alimentation est adaptée au nombre d'unités connectées. 
Nous vous recommandons de protéger votre source d'alimen-
tation en utilisant un parasurtenseur (non fourni).

Connexions Ethernet

Chaque unité D-Control communique avec Pro Tools via Ethernet. 
Un hub Ethernet 10-BaseT (non fourni) est requis pour connecter 
les unités D-Control à l'ordinateur hôte. 

Connexions USB

Pour utiliser le clavier et le trackball de l'unité principale de 
D-Control, vous devez installer un connecteur USB sur l'ordi-
nateur hôte ou sur le hub USB si votre système en est équipé. 

Connexions audio

Toutes les entrées et sorties audio analogiques externes affectées 
au monitoring de la régie et des communications en studio sont 
connectées à l'interface XMON. D-Control est relié à l'interface 
XMON par un câble à 15 broches (fourni). Toutes les entrées et 
sorties analogiques sur XMON sont des connecteurs DB-25. 

Câbles audio pour le monitoring D-Control

Avid propose plusieurs options de câblage permettant de connecter 
les interfaces et les sources externes au système de monitoring 
XMON. Pour plus d'informations, rendez-vous sur 
www.avid.com/fr.

Configuration requise et compatibilité

D-Control requiert un système qualifié exécutant Pro Tools HD 
ou Pro Tools avec Complete Production Toolkit 2.

Pour connaître la configuration requise et consulter la liste 
exhaustive des ordinateurs, systèmes d'exploitation, disques 
durs et périphériques tiers pris en charge, rendez-vous sur : 
www.avid.com/compatibility



Spécifications techniques
Dimensions du stand D-Control (sans le bras destiné au moniteur)

Hauteur maximale 100,9 cm

Largeur maximale

Unité principale comprenant un module de faders (système à 16 canaux) 165,9 cm

Unité principale comprenant deux modules de faders (système à 32 canaux) 224,8 cm

Profondeur maximale 116,1 cm
Figure 1. Dimensions du stand pour un système D-Control à 16 faders
Figure 2. Dimensions du stand pour un système D-Control à 32 faders
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Chapitre 2 : Présentation de D-Control

Unité principale de D-Control
Panneau supérieur de l'unité principale
Figure 3. Panneau supérieur de l'unité principale de D-Control
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Channel Strip 
Master Assign 
and Display

Section Channel 
Strip Master 
(également à 
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principale)
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Channel Strip 
Master Function

Commandes 
Custom Fader
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Automation Mode

Bouton Talkback

Section Miscellaneous 
Controls

Section Soft KeysSection 
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Management

Section 
Bank/Nudge

Section 
Zoom/Navigate
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VU-mètres

Vous pouvez régler l'affichage des VU-mètres de l'unité principale 
de D-Control de façon à voir les niveaux de sortie ou les niveaux 
associés à une piste ou un plug-in. Voir « Affichages des VU-mètres 
et du timecode (unité principale) » à la page 124. 

Affichages des échelles temporelles et indicateurs 
d'emplacement

Les affichages d'échelles temporelles et les indicateurs d'empla-
cement de l'unité principale de D-Control affichent des données 
identiques à celles des témoins correspondants dans Pro Tools. 
Voir « Affichages des VU-mètres et du timecode (unité principale) » 
à la page 124.

Plateforme d'affichage et logement du bras du 
moniteur

D-Control offre deux options d'affichage vidéo : vous pouvez 
placer un moniteur sur la plateforme prévue à cet effet ou installer 
un moniteur VESA TFT sur le bras livré avec l'appareil. Voir 
« Installation d'un moniteur » à la page 28.

Tranche Focus Channel Strip

L'unité principale de D-Control est équipée d'une tranche Focus 
Channel Strip, qui permet de ramener les commandes des tran-
ches de console d'une session au centre de la surface de contrôle, 
en les plaçant à la position de mixage centrale. Voir « Tranches 
de console » à la page 49.

Sections Dynamics et EQ

Les sections Dynamics et EQ de l'unité sont dédiées aux plug-ins 
qui prennent en charge l'assignation de plug-ins dynamiques 
et EQ de D-Control. Reportez-vous au Chapitre 7, « Commandes 
de plug-in ».

Section Monitor

La section Monitor de l'unité principale D-Control contient un jeu 
complet de commandes pour différentes sections de la surface 
D-Control, notamment le monitoring de la régie, le retour casque 
et le talkback/listenback. Voir « Commandes de la section 
Monitor » à la page 115.

Section Zoom/Navigate

La section Zoom/Navigate permet de contrôler la navigation, 
l'affichage et les sélections dans la fenêtre Edit de Pro Tools. Voir 
« Section Zoom/Navigate » à la page 97.
Guide D-Control8
Sections Bank/Nudge et Bank Select

Les sections Bank/Nudge et Bank Select permettent de contrôler 
l'affichage des pistes Pro Tools de la surface de contrôle D-Control, 
en mode Normal et Custom Fader. Reportez-vous aux sections 
« Section Bank/Nudge » à la page 98 et « Matrice Bank Select » à 
la page 98. 

Sections Window Management et Session 
Management

Les sections Window Management et Session Management 
permettent de contrôler l'ouverture et la fermeture des fenêtres 
de Pro Tools, et de gérer et d'enregistrer les sessions Pro Tools. 
Reportez-vous aux sections « Section Window Management » à 
la page 101 et « Section Session Management » à la page 102. 

Section Soft Keys

La section Soft Keys de l'unité principale de D-Control offre un 
accès direct à de nombreuses commandes de Pro Tools à partir 
de la surface de contrôle. Elle permet également d'accéder aux 
préférences et paramètres spécifiques à D-Control. Voir « Section 
Soft Keys » à la page 103. 

Section Miscellaneous Controls

Parmi les commandes de la section Miscellaneous Controls, on 
trouve des commandes d'édition et d'affichage de base de Pro Tools. 
Voir « Section Miscellaneous Controls » à la page 112.

Section Transport

La section Transport de l'unité principale contient deux jeux 
complets de commandes de transport, des boutons permettant 
de définir le mode de transport, des commandes Scrub/Shuttle 
ainsi que des options d'écoute et de localisation avancées. Voir 
« Section Transport » à la page 91.

Section Channel Strip Master

La section Channel Strip Master contient un groupe de commandes 
dont l'affichage à gauche et à droite de l'unité principale de 
D-Control permet d'accéder facilement à de puissantes com-
mandes d'assignation, d'affichage et de fonction de canaux à 
partir de toutes les positions de mixage. Voir « Section Channel 
Strip Master » à la page 57.

Commandes Custom Fader

Les commandes Custom Fader permettent d'invoquer un groupe 
spécial de modes D-Control, appelés modes Custom Fader, qui 
permettent d'isoler des tranches de console et de les personnaliser 
afin d'afficher et d'éditer diverses fonctions. Voir « Commandes 
Custom Fader » à la page 67.



Boutons Talkback

Les deux touches Talkback de l'unité principale reproduisent la 
fonction Talkback de D-Control. Voir « Bouton Talkback » à la 
page 69.
Commandes Automation Mode

Les commandes Automation Mode reproduisent la fonction du 
sélecteur de mode d'automation à l'écran de chaque piste. Voir 
« Commandes Automation Mode » à la page 68.
Panneau arrière de l'unité principale
Figure 4. Connecteurs du panneau arrière de l'unité principale de D-Control

Connecteur EthernetPrise pour pédale

Commutateur de mise sous tension

Alimentation CA

Connecteur USB 
clavier/trackball

Connecteur du système 
de monitoring XMON
Alimentation CA

Ce connecteur accepte un câble d'alimentation CA standard. 
L'unité principale de D-Control s'adapte automatiquement à la 
tension d'alimentation (de 100 à 240 Volts) : un cordon d'ali-
mentation standard permet de la brancher sur une prise secteur 
murale n'importe où dans le monde. 

Interrupteur

Permet d'interrompre ou de rétablir le passage du courant électrique 
dans l'unité principale de D-Control.

Prise pour pédale

Prise TRS ¼ de pouce située sur le panneau arrière et prenant en 
charge la connexion de deux pédales. Voir « Connexions de la 
pédale » à la page 34.
Connecteur USB clavier/trackball

Le connecteur USB du panneau arrière de l'unité principale 
D-Control relie le clavier et le trackball de l'ordinateur de l'unité 
au système Pro Tools. Voir « Connexions USB » à la page 34.

Connecteur Ethernet

Le connecteur Ethernet du panneau arrière de l'unité centrale 
D-Control permet d'établir la communication avec Pro Tools. 
Voir « Connexions Ethernet » à la page 33.

Connecteur du système de monitoring XMON

Le connecteur à 15 broches du panneau arrière de l'unité principale 
D-Control permet de contrôler à distance toutes les fonctions 
régulant l'audio de la section de monitoring de D-Control. Voir 
« Connexion du système de monitoring XMON » à la page 35.
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Module de faders D-Control
Panneau supérieur du module de faders
Guide D-Control10
Figure 5. Panneau supérieur du module de faders de D-Control

Commandes Channel Strip Mode

Commandes Channel Strip Function

Channel Strip 

Section Rotary Encoder

Faders des canaux

Touches de modification

Section Meter
Section Meter

Permet d'afficher le niveau des pistes, les VU-mètres des plug-ins 
ainsi que d'autres paramètres résultant des préférences définies 
pour les VU-mètres de D-Control. Voir « Affichages des VU-mètres 
(module de faders) » à la page 125.

Channel Strip

Toutes les tranches de console du module de faders de D-Control 
ont des commandes de canaux identiques, notamment six 
encodeurs rotatifs et un fader tactiles, ainsi que des commandes 
de mode et d'affichage. Voir « Tranches de console » à la page 49.

Touches de modification

Dans l'angle inférieur gauche de chaque module de faders de 
D-Control figurent quatre boutons qui reproduisent les fonctions 
des touches de modification clavier de Pro Tools. Voir « Boutons 
touches de modification » à la page 57.
Panneau arrière du module de faders

Alimentation CA

Ce connecteur accepte un câble d'alimentation CA standard. Le 
module de faders de D-Control s'adapte automatiquement à la 
tension d'alimentation (de 100 à 240 Volts) : un câble modulaire 
standard permet de le brancher sur une prise secteur murale dans 
tous les pays. 

Interrupteur

Permet d'interrompre ou de rétablir le passage du courant élec-
trique dans le module de faders.

Connecteur Ethernet

Le connecteur Ethernet du panneau arrière du module de faders 
D-Control permet d'établir la communication avec Pro Tools. 
Voir « Connexions Ethernet » à la page 33.



Interface XMON de D-Control

Le monitoring de D-Control est basé sur l'interface analogique XMON, contrôlée à distance à partir de la section de monitoring de 
D-Control.

Panneau avant de XMON
Figure 6. Panneau avant de XMON

Interrupteur

Bouton de coupure du son

Témoin de 
réception MIDI

Témoin de 
coupure du son
Interrupteur

Permet d'interrompre ou de rétablir le passage du courant élec-
trique dans l'interface XMON.

Témoin de coupure du son

Indique si le son de l'interface XMON est coupé ou non. 
Témoin de réception MIDI 

Témoin d'activité MIDI entre l'interface XMON et la surface de 
contrôle D-Control. 

Bouton de coupure du son

Coupe le son de toutes les sorties de l'interface XMON. Il est 
impossible de rétablir le son de l'interface à l'aide de ce bouton. 
Pour cela, vous devez procéder depuis la section de monitoring de 
D-Control (voir la section « Commandes de la section Monitor » à 
la page 115).
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Panneau arrière de XMON
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Le panneau arrière de l'interface XMON contient des connecteurs pour toutes les entrées et sorties audio analogiques externes de 
D-Control. Voir « Connexions audio » à la page 35.
Figure 7. Panneau arrière de XMON

Entrées Cue Entrées Main Entrées Surround Entrées Stereo

Sorties Cue Sorties Main Sorties Alt Alimentation CASurface de 
contrôle

Vis d'étalonnage des 
VU-mètres

Talkback/Listenback/
Utility
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Chapitre 3 : Installation de D-Control

Ce chapitre explique comment monter les systèmes D-Control à 16 faders (unité principale + un module de faders) et à 32 faders 
(unité principale + deux modules de faders). 

Stand de D-Control

(systèmes à 16 et 32 faders)
La procédure d'installation du stand et le nombre de pièces utilisées sont identiques pour les systèmes à 16 faders et les systèmes à 
32 faders (dans un système à 32 faders, la barre transversale et les rails de support sont plus longs). 

Figure 1. Stand de D-Control assemblé 
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Éléments du stand
Guide D-Control16
Retirez le stand de son emballage et vérifiez qu'il comporte toutes les pièces nécessaires. La Figure 2 présente les pièces métalliques 
du stand, tandis que la Figure 3 illustre les pièces en plastique. Mettez les pièces en plastique de côté pour éviter de les endommager 
lors de la procédure d'assemblage. 
Figure 2. Pièces métalliques du stand de D-Control

Rail de support de 
panneau arrière

Rail de support de 
panneau avant

Assemblage barre transversale arrièreAssemblage pied droitAssemblage pied 
gauche
Figure 3. Pièces en plastique du stand de D-Control

Caches latéraux en 
plastique (gauche et droit)

(2) Caches avant des pieds

(2) Caches arrière des 
pieds



Matériel fourni avec le stand
Le matériel suivant est fourni avec le stand de D-Control (des pièces supplémentaires peuvent être incluses). 
Figure 4. Vis d'assemblage des pièces métalliques et plastiques de D-Control

Vis à tête bombée ¼ po-20 x ½ po

Vis Phillips à tête cylindrique bombée nº10 x ¾ po

Goupille cylindrique ½ po

Vis à tête cylindrique creuse nº10-32 x ½ po

Vis Phillips à tête cylindrique bombée M6 x 8 mm
Vis à tête cylindrique creuse ¼ po-20 x ½ po

Vis à tête cylindrique creuse nº10-32 x 1 po

Vis à tête cylindrique creuse nº10-32 x ¾ po

Vis Phillips à métaux à tête cylindrique bombée 
nº6-32 x 7/16 po
Vis et goupilles d'assemblage des pièces métalliques du stand

• (14) Vis à tête bombée 1/4 po-20 x ½ po

• (10) Vis à tête cylindrique creuse ¼ po-20 x ½ po

• (22) Vis Phillips à tête cylindrique bombée M6 x 8 mm

• (8) Vis à tête cylindrique creuse ½ po-20 x 1 po pour caler 
le stand (non illustré)

• (3) Goupilles cylindriques ½ po

Vis d'assemblage des pièces plastiques du stand

• (3) Vis à tête cylindrique creuse nº10-32 x ½ po

• (4) Vis à tête cylindrique creuse nº10-32 x ¾ po

• (26) Vis à tête cylindrique creuse nº10-32 x 1 po

• (8) Vis Philips à tête cylindrique bombée nº10 x ¾ po

• (3) Vis Phillips à métaux à tête cylindrique bombée 
nº6-32 x 7/16 po

Accessoires de câblage

• (14) Fixations d'attaches pour câbles

• (8) Attaches pour câbles de monture à vis

• (14) Attaches pour câbles

• (4) Attaches velcro

• (8) Vis autotaraudeuses nº8 x ½ po (à utiliser avec les attaches 
velcro et les attaches pour câbles de monture à vis)
Outils nécessaires pour l'assemblage du stand

Les outils suivants sont fournis avec D-Control :

• Clé Allen 5/32 po (pour les vis à tête bombée)

• Clé Allen 3/16 po (pour les vis à tête cylindrique creuse)

• Clé Allen 3/8 po (pour les vis de calage du stand)

Les outils supplémentaires suivants sont requis pour assembler 
le stand de D-Control :

• Tournevis Phillips nº2 (pour les grandes vis à tête Phillips)

• Tournevis Phillips nº1 (pour les petites vis à tête Phillips)

• Un petit marteau (pour les goupilles cylindriques ½ po)

Les outils suivants sont facultatifs, mais faciliteront l'assemblage :

• Maillet en caoutchouc pour l'ajustage du stand

• Sangle à cliquet en nylon pour le serrage du stand
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Positionnement de D-Control

Pour prévoir un bon positionnement de votre système D-Control, 
prenez bien en compte les dimensions du système une fois 
assemblé et prévoyez un espace d'au moins 2,5 cm à l'arrière de 
l'unité montée, afin de garantir une ventilation optimale de 
l'unité D-Control.

Pour des informations détaillées sur les dimensions, reportez- 
vous à la section « Spécifications techniques » à la page 5.

Lors de l'assemblage de l'unité, chaque côté de l'appareil doit 
être dégagé afin de pouvoir pousser les pieds du stand vers l'in-
térieur, pour les rapprocher au cours de la phase d'assemblage 
finale. Vous devez également pouvoir accéder à l'arrière de l'unité 
pour effectuer les raccordements.

Préparation des pieds du stand

Avant d'assembler le stand de D-Control, vérifiez que la surface où 
il sera installé est à niveau et que les zones où ses pieds reposent 
sont planes. 

Chaque pied comporte à sa base trois trous destinés aux vis de 
calage qui permettent de positionner parfaitement l'unité.

Figure 5. Emplacement des vis de calage

(3) Vis à tête cylindrique creuse ½ po-20 x 1 po
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Si vous placez l'unité sur une surface en ciment ou sur un sol en 
bois dur, vous pouvez coller des coussinets en caoutchouc ad-
hésifs (fournis avec le système) sous les pieds pour protéger le 
sol et stabiliser le stand. Si vous utilisez des vis de calage, vous 
pouvez placer les coussinets en caoutchouc sous les vis, pour 
une meilleure protection du sol. 

Figure 6. Pose de coussinets en caoutchouc sous les pieds de la console 
D-Control



Assemblage du stand
Une fois la zone prête pour l'installation de D-Control, commencez par assembler les pièces métalliques du stand. 

Pour assembler le stand :

1  Placez les assemblages des pieds droit et gauche à la verticale, à une distance correspondant approximativement à la largeur de la 
barre transversale arrière. Placez les pieds afin que les supports de montage de la barre transversale se situent à l'intérieur et face 
à face, comme illustré à la Figure 7. 

Il est important de prévoir une largeur de stand initiale un peu plus large que les dimensions finales et de ne pas serrer totalement les 
vis, afin de permettre un déplacement des pieds de bord à bord le long de la barre transversale arrière et le long des rails. Une fois les 
unités D-Control installées sur le stand, vous pouvez faire glisser les pieds vers l'intérieur et serrer toutes les vis.

Figure 7. Pieds du stand de D-Control positionnés avec les supports de montage se faisant face

Pied droit du stand

Pied gauche du stand

Supports de montage de la 
barre transversale
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2  Faites glisser l'assemblage de la barre transversale arrière dans les supports de montage prévus à cet effet sur chaque pied. Les deux 
côtés de la barre transversale sont identiques, peu importe le sens dans lequel elle se trouve. Placez les pieds de façon à créer un léger 
espace entre les côtés de la barre et la surface intérieure de chaque pied. Les trous des vis situés sur les supports doivent être alignés 
sur les fentes de la barre transversale. 

Figure 8. Positionnement de l'assemblage de la barre transversale arrière sur le support de montage (à gauche) ; illustration de l'espace entre la barre 
transversale et le pied (à droite)

Supports de 
montage de la barre 

transversale

Espace entre la barre 
transversale et le pied du 

stand
3  À l'aide d'une clé Allen 5/32 po, fixez la barre transversale aux 
supports, en plaçant 6 vis à tête bombée ¼ po-20 x ½ po (voir 
Figure 9) de chaque côté (3 à l'avant, 3 à l'arrière). Ne serrez pas 
totalement les vis, afin de pouvoir déplacer les pieds de bord à 
bord le long de la barre transversale arrière.
Guide D-Control20
Figure 9. Fixation de la barre transversale



4  Repérez le rail de support de panneau arrière ; il s'agit du grand 
rail fourni avec le stand. 

5  Lorsque vous placez le rail arrière, veillez à orienter le bord avec 
l'encoche en V vers le pied gauche du stand.

Figure 10. Vue latérale des rails de support de panneau

Figure 11. Encoche en V sur le rail de support de panneau arrière

Rail de support de 
panneau arrière

Rail de support de 
panneau avant

Encoche désignant le côté gauche du rail de support 
de panneau arrière
6  Placez le rail arrière de façon à ce qu'il repose sur les taquets 
prévus à cet effet sur chaque pied du stand (voir Figure 12). Les 
trous situés aux extrémités du rail doivent s'aligner sur les fentes 
des taquets du rail arrière de chaque pied. 

7  A l'aide d'une clé Allen 3/16 po, fixez le rail arrière sur les taquets 
prévus à cet effet sur chaque pied, en plaçant deux vis à tête 
cylindrique creuse ¼ po-20 x ½ po (voir Figure 13) de chaque 
côté. Ne serrez pas totalement les vis, afin de pouvoir déplacer 
les pieds de bord à bord le long du rail arrière.

8  Repérez le rail de support de panneau avant ; il s'agit du petit 
rail fourni avec le stand.

Figure 12. Mise en place du rail de support arrière sur le pied gauche du 
stand

Figure 13. Fixation d'un rail de support
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9  Lorsque vous placez le rail avant, veillez à orienter le bord avec 
l'encoche en V vers le pied gauche du stand.

10  Placez le rail avant de façon à ce qu'il repose sur les taquets 
prévus à cet effet sur chaque pied du stand. Les trous situés aux 
extrémités du rail doivent s'aligner sur les fentes des taquets du 
rail avant de chaque pied. 

11  À l'aide d'une clé Allen 3/16 po, fixez le rail avant sur les 
taquets prévus à cet effet sur chaque pied, en plaçant deux vis à 
tête cylindrique creuse ¼ po-20 x ½ po de chaque côté. Ne serrez 
pas totalement les vis, afin de pouvoir déplacer les pieds de bord 
à bord le long du rail avant.

Une fois la barre transversale arrière et les rails de support avant et 
arrière en place (voir Figure 15), vous pouvez installer les unités 
D-Control sur le stand. 

Figure 14. Encoche en V sur le rail de support de panneau avant

Figure 15. Mise en place des rails de support avant et arrière sur le pied 
gauche du stand

Encoche désignant le côté gauche du rail de support 
de panneau avant
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Installation des unités D-Control

Une fois le stand assemblé, l'étape suivante consiste à préparer 
l'installation de l'unité principale et des modules de faders de 
D-Control. 

Fixation de l'entretoise

Une plaque de calage métallique sépare chaque unité D-Control 
sur le stand.

Une plaque de calage est installée par défaut sur le côté droit de 
chaque module de faders. Selon la taille et la configuration de 
votre système D-Control, vous pouvez être amené à retirer la 
plaque d'un module de faders pour la placer sur l'unité principale. 
Reportez-vous à la section ci-après pour plus d'informations sur 
la configuration de votre système. 

Système à 16 faders

Si votre système D-Control comporte 16 faders, vous pouvez 
placer l'unité principale à gauche ou à droite du module de 
faders. 

 Si vous placez l'unité principale à gauche du module de 
faders, vous devez retirer la plaque de calage du module de 
faders et la placer sur l'unité principale. Reportez-vous à la 
section « Déplacement de la plaque de calage » à la page 23, 
avant d'installer les unités sur le stand. 

 Si vous positionnez l'unité principale à droite du module de 
faders, vous pouvez laisser la plaque de calage telle quelle sur le 
module de faders. Passez à la section « Installation des unités 
sur le stand » à la page 24. 

Figure 16. Plaque de calage de D-Control (provenant d'un module de faders)

Figure 17. Configurations d'un système à 16 canaux

Système à 16 faders, unité principale à droite
Module 
de
faders

Module 
de 
faders

Unité 
princi-
pale

Unité 
princi-
pale

Système à 16 faders, unité principale à gauche



Système à 32 faders

Si votre système D-Control comporte 32 faders, vous pouvez 
placer l'unité principale à gauche ou à droite du module de 
faders, ainsi qu'entre deux modules de faders. 

 Si vous positionnez l'unité principale à gauche du module de 
faders ou entre deux modules de faders, vous devez retirer la plaque 
de calage du module de faders situé le plus à droite et la placer 
sur l'unité principale. Reportez-vous à la section « Déplacement 
de la plaque de calage » à la page 23, avant d'installer les unités 
sur le stand.

 Si vous positionnez l'unité principale à droite des deux modules 
de faders, vous pouvez laisser la plaque de calage telle quelle sur 
le module de faders. Passez à la section « Installation des unités 
sur le stand » à la page 24.

Déplacement de la plaque de calage

Lors de l'installation de modules de faders à droite de l'unité 
principale, vous devez retirer la plaque de calage et ses vis du 
module de faders situé le plus à droite pour la placer à droite de 
l'unité principale. 

Figure 18. Configurations d'un système à 32 canaux

N'utilisez pas de tournevis électrique ni d'appareil à couple 
élevé pour extraire les vis de la plaque de calage ou les remettre 
en place, car vous risquez d'endommager le filetage de la vis.

Système à 32 faders, unité 
principale au milieu

Système à 32 faders, unité 
principale à droite

Système à 32 faders, unité 
principale à gauche

Module 
de 

faders

Unité 
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pale

Unité 
princi-
pale

Unité 
principale

Module 
de 

faders

Module 
de 
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Module 
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faders

Module 
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Pour déplacer la plaque de calage :

1  Retirez les vis qui maintiennent la plaque de calage. Notez 
l'emplacement des vis longues (2 à l'avant et 5 à l'arrière) lors 
de leur retrait. 

2  Retirez la plaque de calage située sur le côté droit du module 
de faders. 

3  Retirez les vis correspondantes du côté droit de l'unité principale 
et gardez-les pour le module de faders.

4  Placez la plaque de calage à droite de l'unité principale et fixez-la 
à l'aide des vis qui la maintenaient à l'origine sur le module de 
faders. Notez l'emplacement des vis longues.

5  Placez les vis restantes sur le côté du module de faders. Notez 
l'emplacement des vis longues.

Figure 19. Plaque de calage de D-Control (provenant d'un module de 
faders)

Figure 20. Retrait de la plaque de calage d'un module de faders

Les trous situés sur la plaque de calage sont fraisés pour per-
mettre l'installation d'une unité sur le côté droit. Ne fixez pas 
la plaque de calage sur le côté gauche d'une unité D-Control.

Vis longues (5)

Vis longues (2)
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Ajustement des goupilles sur l'unité située le plus à 
droite

Les modules de faders et unités principales comportent sur le 
côté droit deux goupilles qui permettent d'ancrer les unités les 
unes aux autres sur le stand. Ces goupilles ne sont pas nécessaires 
pour l'unité située le plus à droite de votre configuration et peuvent 
être enlevées.

Pour ajuster les goupilles cylindriques sur l'unité la plus à droite :

1  Choisissez l'unité qui sera située le plus à droite de votre 
configuration. 

2  À l'aide d'un petit marteau, enfoncez les deux goupilles sur le 
côté droit, jusqu'à ce qu'elles soient dans l'alignement du côté 
de l'unité. Les rails à goupilles ne comportent pas de taquets d'arrêt, 
de sorte que vous pouvez installer de nouvelles goupilles si vous 
décidez d'agrandir votre système ultérieurement.

Figure 21. Pose de la goupille cylindrique dans la partie supérieure d'une 
unité D-Control

Figure 22. Pose de la goupille cylindrique à l'avant d'une unité D-Control

Emplacement de 
la goupille 
cylindrique (haut)

Emplacement de la 
goupille cylindrique 

(avant)
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Installation des unités sur le stand

Lorsque l'unité principale et les modules de faders de D-Control 
sont prêts pour l'installation, les unités sont placées dans l'ordre 
approprié pour votre configuration. Installez les unités en partant 
de la gauche du stand.

Pour installer les unités D-Control sur le stand :

1  Placez la première unité sur le stand, en veillant à ce que les 
rainures situées sous l'unité reposent sur les rails arrière et avant 
du stand. 

2  Faites glisser l'unité sur le côté gauche du stand, en laissant un 
espace d'environ 2 cm entre le côté de l'unité et le rebord intérieur 
du stand.

Figure 23. Placement d'un module de faders sur le stand

Figure 24. Espace entre l'unité et le stand



3  Placez les unités les unes après les autres sur le stand, en veillant 
à ne pas tordre les goupilles des unités déjà installées.

4  Assemblez les unités en les faisant glisser et en insérant les 
goupilles de chaque unité dans les trous correspondants sur le 
côté de l'unité suivante. 

5  Fixez les unités aux rails avant et arrière à l'aide de vis Phillips 
à tête cylindrique bombée M6 x 8 mm, en répartissant 6 vis sur 
l'unité principale (3 sur chaque rail avant et arrière) et 4 vis sur 
le module de faders (2 pour chaque rail avant et arrière). Ne serrez 
pas totalement les vis, afin de pouvoir déplacer les unités de bord 
à bord le long des rails.

Serrage du stand

Vous devez ensuite serrer le stand et fixer les unités.

Pour serrer le stand :

1  Rapprochez les pieds du stand afin de combler l'espace entre 
le stand et les unités situées à chaque extrémité. Vous pouvez 
vous aider d'un maillet en caoutchouc pour donner de petits 
coups sur la base des pieds afin de les mettre en place.

2  Utilisez une sangle à cliquet en nylon pour rapprocher les pieds 
du stand.

Figure 25. Fixation d'une unité aux rails
3  Si un espace subsiste entre la barre transversale arrière et l'un 
des pieds, positionnez la barre afin que l'écart soit à peu près 
identique de chaque côté.

4  Serrez les 6 vis à tête bombée sur chaque côté de la barre 
transversale arrière.

5  Vous pouvez si nécessaire utiliser la sangle à cliquet en nylon 
pour rapprocher les unités D-Control, en l'enroulant autour de 
la partie supérieure des pieds et des unités D-Control, comme 
illustré à la Figure 27. Assurez-vous que la sangle en nylon ne 
touche pas les commutateurs ou encodeurs de la surface. 

Figure 26. Utilisation d'une sangle en nylon sur les pieds du stand
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6  Serrez les 2 vis à tête cylindrique creuse sur chaque côté des 
rails avant et arrière.

7  Fixez les unités situées à chacune des extrémités aux rebords 
des pieds à l'aide de vis Phillips à tête cylindrique bombée 
M6 x 8 mm. Serrez ces vis. 

8  Serrez les vis Phillips à tête cylindrique bombée qui maintien-
nent les unités D-Control aux rails avant et arrière.

9  Retirez la sangle en nylon.

Figure 27. Utilisation d'une sangle en nylon sur les unités D-Control

Figure 28. Fixation d'une unité aux rebords des pieds (vue du dessous)

(2) Vis Phillips à tête cylindrique bombée 
M6 x 8 mm
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Installation de caches latéraux en plastique

Une fois les unités D-Control en place et fixées aux rails du stand, 
vous pouvez procéder à l'installation des caches latéraux en 
plastique. 

Pour installer les caches latéraux en plastique :

1  Sur chaque côté du système, repérez la paire de vis à métaux 
nº6-32, disposées l'une en dessous l'autre, à l'avant de chaque 
unité. Sur chaque côté de l'unité, retirez la vis du bas.

2  Placez les deux petits butoirs bleus en caoutchouc à l'intérieur 
des caches latéraux en plastique.

N'utilisez pas de tournevis électrique ni d'appareil à couple 
élevé pour fixer les caches latéraux en plastique, car vous 
risquez de déformer ou d'endommager les caches.

Figure 29. Retrait de la vis à métaux d'une unité

Figure 30. Installation d'un butoir dans un cache latéral en plastique

Retirez cette vis



3  Placez les caches latéraux en plastique de chaque côté de l'unité, 
en positionnant d'abord l'avant de chaque cache sur la partie 
avant du pied du stand, puis en faisant glisser le cache vers l'arrière. 
Les trous du cache doivent s'aligner sur les trous du stand. 

4  Fixez chaque cache latéral en plastique à l'aide des vis, comme 
illustré à la Figure 32. Attendez d'avoir placé toutes les vis avant 
de commencer à les serrer. 

Installation des caches en plastique sur les 
pieds
Vous pouvez installer les caches en plastique des pieds de l'unité 
D-Control à tout moment. 

Figure 31. Placement d'un cache latéral en plastique sur le stand

Figure 32. Fixation des caches latéraux en plastique

(6) Vis à tête cylindrique creuse nº10-32 x 1 po

(3) Vis Phillips à tête cylindrique bombée nº10 x ¾ po

(1) Vis Phillips à métaux à tête 
cylindrique bombée nº6-32 x 7/16 po
Pour installer les caches en plastique des pieds :

1  Placez les caches avant sur chaque pied. Fixez chaque cache 
avant à l'aide des vis, comme illustré à la Figure 34. 

2  Placez les caches arrière sur chaque pied. Fixez chaque cache 
arrière à l'aide des vis, comme illustré à la Figure 35. 

Pour éviter que les caches en plastique des pieds ne s'endom-
magent, installez-les en dernier, une fois tous les autres éléments 
de D-Control installés et placés comme il se doit. Si nécessaire, 
procédez à d'autres installations et revenez à cette étape lorsque 
vous avez terminé.

Figure 33. Placement des caches en plastique des pieds

Figure 34. Fixation des caches en plastique avant

Figure 35. Fixation des caches en plastique arrière

(1) Vis à tête cylindrique 
creuse nº10-32 x ½ po

(2) Vis à tête cylindrique 
creuse nº10-32 x 1 po

(2) Vis à tête cylindrique 
creuse nº10-32 x ¾ po

(3) Vis à tête cylindrique creuse 
nº10-32 x 1 po
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Installation d'un moniteur

D-Control permet d'utiliser deux types de moniteurs :

Moniteur sur pied : la plateforme d'affichage de l'unité D-Control 
peut recevoir un moniteur à écran plat sur pied. 

Moniteur TFT monté sur bras : grâce au bras de moniteur fourni 
avec l'unité principale, vous pouvez monter un moniteur TFT 
sur le système D-Control.

Les sections suivantes contiennent les instructions générales 
relatives à l'installation de chaque type de moniteur. Pour des 
informations supplémentaires sur un moniteur spécifique, 
reportez-vous aux instructions du fabricant.

Installation d'un moniteur sur pied

La plateforme d'affichage de l'unité principale de D-Control peut 
recevoir un moniteur à écran plat sur pied (tel qu'un moniteur 
Apple Cinema) de 20" maximum. Les moniteurs plus grands 
risquent de gêner l'affichage du pont des VU-mètres sur l'unité 
principale. 

Pour installer un moniteur sur pied :

1  Retirez la plateforme d'affichage de l'unité principale.

Figure 36. Retrait de la plateforme d'affichage de l'unité principale 
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2  Remplacez le logement du pied de montage situé sous la pla-
teforme d'affichage par la platebande fournie. 

3  Faites passer le câble du moniteur dans le port du câble de la 
plateforme d'affichage.

4  Faites passer le câble du moniteur dans l'unité principale et 
dans le port du câble situé en bas de l'unité principale. Vous 
devrez peut-être retirer la plaque recouvrant ce port.

5  Replacez la plateforme d'affichage sur l'unité principale.

6  Placez le moniteur sur la plateforme. 

Figure 37. Logement du pied de montage (arrière de la plateforme 
d'affichage)

Figure 38. Port du câble situé en bas de l'unité principale (vue du dessous)



Installation d'un moniteur TFT monté sur bras

Le bras articulé de moniteur fourni avec l'unité principale de 
D-Control peut soutenir un moniteur VESA pesant 9 kg au 
maximum. 

Pour installer un moniteur TFT monté sur bras :

1  Montez le moniteur sur le bras en suivant les instructions du 
fabricant. 

2  Ignorez le pied de montage fourni avec l'assemblage du bras 
de moniteur. Un pied de taille adéquate est fourni avec l'unité 
principale de D-Control. 

3  Installez le nouveau pied de montage dans l'unité principale. 
Remarquez l'orientation du pied (le côté avec la plus grande 
entaille fait face à l'arrière de l'unité). 

4  Faites glisser le câble dans le port de câble situé derrière le 
logement du pied de montage (vous devrez peut-être retirer la 
plateforme d'affichage pour faire passer les connecteurs dans le 
port). 

5  Faites passer le câble du moniteur dans l'unité principale et dans 
le port du câble situé en bas de l'unité principale. Vous devrez 
peut-être retirer la plaque recouvrant ce port. Voir Figure 38.

6  Placez le manchon du bras du moniteur sur le pied de montage. 
Ne serrez pas les vis du manchon.

Ce bras est emballé séparément et inclut des composants non 
nécessaires au fonctionnement de D-Control. Les éléments de 
montage du bras sont préinstallés en bas de l'unité principale.

Figure 39. Installation du pied de montage dans l'unité principale
7  Placez le bras du moniteur sur le pied de montage.

8  Réglez le manchon du bras afin que ses taquets d'arrêt empêchent 
que le bras et le moniteur ne heurtent le pont des VU-mètres de 
D-Control. En général, les vis ne doivent pas se trouver au niveau 
du trou du pied de montage mais légèrement à droite du trou et 
du port du câble tel qu'illustré dans la Figure 41. 

9  Fixez le manchon à l'aide des vis. 

Figure 40. Pose du bras sur le pied de montage

Figure 41. Détail d'un manchon de moniteur et des vis
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10  Insérez le capuchon ou la tige filetée dans le pied de montage 
et serrez-le ou serrez-la à l'aide de la clé fournie.

Figure 42. Fixation du bras à l'aide du capuchon ou de la tige filetée 

Figure 43. Bras de montage et moniteur installés
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Installation des câbles de D-Control 
(facultatif)

L'unité D-Control est fournie avec trois différents types d'attaches 
pour câbles. 

Attaches velcro : peuvent être fixées aux pieds du stand de 
D-Control. Deux trous sont prépercés à l'intérieur de chaque 
pied pour recevoir les vis autotaraudeuses nº8 x ½ po. 

Attaches pour câbles de monture : peuvent être fixées sur les pieds 
du stand de D-Control à l'aide des vis autotaraudeuses nº8 x ½ po.

Attaches adhésives : attaches autocollantes permettant de placer 
des attaches pour câbles n'importe où sur l'unité D-Control et 
pouvant être utilisées pour habiller les câbles ou pour monter 
un hub Ethernet sous l'unité. 

Reconfiguration d'un clavier de 
D-Control pour un système Windows

Le clavier de l'unité principale de D-Control est fourni avec une 
configuration de clavier Macintosh. 

Si vous utilisez D-Control avec un système Pro Tools basé sur 
Windows, vous devez reconfigurer le clavier.

Pour reconfigurer le clavier de D-Control pour Windows :

1  À l'aide d'une clé Allen 5/64 po, retirez les vis du panneau du 
clavier de l'ordinateur et extrayez le clavier de l'unité principale 
de D-Control.

2  Inversez la position du commutateur de la carte de circuits 
imprimés se trouvant sous le clavier. 

3  Retirez les deux touches Commande () situées de chaque côté 
de la barre d'espace du clavier alphabétique. 

4  Déplacez les touches Alt/Option vers l'intérieur à l'emplacement 
des touches Commande. 

Figure 44. Extraction du clavier de l'unité principale



5  Remplacez les touches Alt/Option par les touches Démarrer 
(ou Windows) fournies.

6  Retirez la touche Egal (=), également étiquetée Capture, du pavé 
numérique. 

7  Déplacez la touche Barre oblique (/), également étiquetée Enter 
Start End Length, pour remplacer la touche Egal. 

8  Déplacez la touche Astérisque (*), également étiquetée Enter 
Main Counter, pour remplacer la touche Barre oblique. 

9  Déplacez la touche Moins (–) pour remplacer la touche 
Astérisque. 

10  Retirez la touche Plus (+) et remplacez les touches Plus et 
Moins par la touche Plus fournie (deux fois plus grande).

11  Replacez le clavier sur l'unité principale de D-Control et 
fixez les vis. 

Déplacement du clavier et du trackball 
(facultatif)

Vous pouvez déplacer le trackball de l'unité principale de D-Control 
vers la gauche du clavier. 

Figure 45. Touches Windows du clavier alphabétique

Figure 46. Touches Windows du pavé numérique
Pour déplacer le clavier et le trackball :

1  À l'aide d'une clé Allen 5/64 po, retirez les vis du panneau du 
clavier et du trackball de l'unité principale de D-Control.

2  Inversez la position des panneaux de trackball et de clavier, et 
replacez avec précaution les câbles se trouvant sous les panneaux.

3  Fixez de nouveau les panneaux de trackball et de clavier sur 
l'unité principale.

Remplacement du trackball par un 
trackball externe ou une souris 
(facultatif)

Si vous préférez utiliser votre propre trackball ou souris, vous 
pouvez retirer le trackball D-Control de l'unité principale et le 
remplacer par la plaque vierge fournie, puis placez votre trackball 
ou votre souris USB sur la plaque.

Pour retirer le trackball :

1  À l'aide d'une clé Allen 5/64 po, retirez le panneau du trackball 
de l'unité principale de D-Control.

2  Débranchez la prise Molex du connecteur P1 sur la carte de 
circuits imprimés située sous la plaque du trackball.

3  Débranchez la prise Molex sous le clavier D-Control du trackball. 

4  Retirez les vis maintenant la carte de circuits imprimés à la 
plaque du trackball. Mettez la plaque du trackball D-Control de 
côté.

5  Installez la carte de circuits imprimés sous la plaque vierge.

6  Branchez votre trackball ou votre souris au connecteur USB 
de la carte de circuits imprimés.

7  Rebranchez la prise Molex (retirée à l'étape 3) au connecteur P2 
de la carte de circuits imprimés. Vérifiez que le connecteur et la 
prise sont bien ajustés et branchés pour maintenir la polarité de 
la connexion. 

8  Faites passer le câble de votre trackball ou de votre souris dans 
le trou de la plaque vierge. 

9  Fixez la plaque vierge sur l'unité principale.

Figure 47. Trackball situé à gauche du clavier sur l'unité principale
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Réinstallation du trackball

Si vous devez réinstaller le trackball par défaut sur une unité 
principale de D-Control, suivez la procédure suivante.

Pour replacer le trackball :

1  À l'aide d'une clé Allen 5/64 po, retirez la plaque vierge de l'unité 
principale.

2  Débranchez la prise Molex du connecteur P2 sur la carte de 
circuits imprimés. 

3  Débranchez la souris ou le trackball externe du connecteur 
USB sur la carte de circuits imprimés.

4  Retirez les vis maintenant la carte de circuits imprimés à la 
plaque vierge. Mettez la plaque vierge de côté.

5  Installez la carte de circuits imprimés sous la plaque vierge du 
trackball D-Control.

6  Branchez la prise Molex de l'assemblage du trackball D-Control 
au connecteur P1 sur la carte de circuits imprimés. Vérifiez que 
le connecteur et la prise sont bien ajustés et branchés pour main-
tenir la polarité de la connexion.

7  Raccordez le câble Molex sous le clavier D-Control au connecteur 
du trackball D-Control. 

8  Fixez de nouveau la plaque du trackball sur l'unité principale. 
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Chapitre 4 : Connexion de D-Control

Connexions de D-Control

Pour fonctionner avec Pro Tools, D-Control requiert une alimentation CA, ainsi que des connexions Ethernet et USB. La connexion 
d'une pédale optionnelle est également possible sur l'unité principale. La Figure 48 illustre les connecteurs situés au dos de l'unité 
principale de D-Control. 

Assurez-vous de désactiver toutes les connexions entre les unités D-Control et l'ordinateur. 

Figure 48. Connecteurs du panneau arrière de l'unité principale de D-Control

Connecteur du système de monitoring XMONPrise pour pédale

Connecteur Ethernet

Connecteur USB 
clavier/trackball
Connexions de l'alimentation

Une connexion d'alimentation distincte est requise pour chaque 
unité D-Control (unité principale et modules de faders) et pour 
l'interface de contrôle XMON. Les unités principales de D-Control, 
les modules de faders et les interfaces XMON s'adaptent auto-
matiquement à la tension d'alimentation (de 100 V à 240 V) : un 
câble d'alimentation modulaire standard permet de les brancher 
sur une prise secteur murale, et ce quel que soit le pays. Un câble 
d'alimentation est fourni avec chaque unité D-Control et avec 
l'interface XMON. 

Pour établir les connexions d'alimentation de D-Control : 

 Pour chaque unité D-Control et interface XMON, utilisez le 
câble d'alimentation CA inclus pour connecter l'unité à une 
source d'alimentation. 

Connexions Ethernet

Chaque unité D-Control communique avec Pro Tools via Ethernet. 
Toutes les unités D-Control sont livrées avec un câble Ethernet. 
Un hub Ethernet 10-BaseT (non fourni) est requis pour connecter 
les unités D-Control à l'ordinateur hôte. 

Pour établir les connexions Ethernet de D-Control :

1  Installez le hub Ethernet en suivant les instructions du fabricant, 
mettez-le sous tension et vérifiez qu'il fonctionne.

2  Connectez le hub Ethernet au port Ethernet de l'ordinateur. 
3  Pour chaque unité D-Control, connectez une extrémité du 
câble Ethernet fourni à un port du hub Ethernet, et connectez 
la seconde extrémité au port Ethernet situé au dos de l'unité. 
N'utilisez pas les ports destinés aux connexions LAN.

Utilisation de D-Control sur un réseau Ethernet

Vous pouvez acheter un hub Ethernet combiné 10/100-BaseT, 
pour une prise en charge simultanée de D-Control avec 10-BaseT 
et du reste du trafic sur le réseau avec 100-BaseT. Vous pourrez 
ainsi utiliser D-Control sur un rseau local.

La communication entre D-Control et l'ordinateur ne devrait 
pas être affectée par un flux modéré de données sur le réseau (tel 
que le courrier électronique). Si votre réseau est très chargé, vous 
pouvez créer un réseau Ethernet spécial pour D-Control.

Contrôle des systèmes Pro Tools sur un réseau

Lorsque D-Control est connecté à un réseau Ethernet, il peut être 
déclaré par tous les systèmes Pro Tools sur le réseau. Vous pou-
vez ainsi contrôler différents systèmes Pro Tools sur le réseau à 
l'aide d'une seule console D-Control. Vous ne pouvez contrôler 
qu'un seul système Pro Tools à la fois.

L'ordre de connexion au hub Ethernet est indifférent, l'utili-
sateur pouvant configurer l'ordre des unités depuis Pro Tools.
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Connexions USB

Le clavier et le trackball de l'unité principale de D-Control com-
muniquent avec l'ordinateur hôte via une connexion USB. Un 
câble USB est requis (non inclus). 

La connexion USB de D-Control prend en charge l'utilisation 
d'un hub USB, si votre système en est équipé. Aucun hub USB 
alimenté n'est requis. 

Pour établir la connexion USB de D-Control :

 Connectez une extrémité du câble USB au port USB du panneau 
arrière de l'unité principale de D-Control, puis connectez la 
seconde extrémité du câble au port USB de l'ordinateur ou du 
hub USB. 

Connexions de la pédale

Vous pouvez connecter deux pédales SPST (single-pole, single- 
throw) à l'unité principale de D-Control afin de contrôler les 
fonctions suivantes :

• démarrage et arrêt de la lecture de Pro Tools ;

• démarrage de l'enregistrement dans Pro Tools ;

• activation et désactivation du talkback.

Le connecteur de la pédale est une prise TRS ¼ de pouce située 
sur le panneau arrière de l'unité principale de D-Control. 

Pour câbler un connecteur TRS destiné à la prise de la pédale de 
D-Control :

 Respectez la convention suivante : pointe = pédale 2, anneau = 
pédale 1, manchon = terre.
Guide D-Control34



Connexions audio

Le monitoring de D-Control est basé sur l'interface analogique XMON, contrôlée à distance à partir de la section de monitoring de 
D-Control. Toutes les entrées et sorties audio analogiques externes affectées au monitoring de la régie et des communications studio 
sont connectées à l'interface XMON. 

XMON fournit une alimentation fantôme de 18 V à ses trois entrées micro externes (External Talkback Mic, Listen Mic 1 et Listen Mic 2). 

Toutes les connexions audio sont réalisées à l'aide de connecteurs DB-25 standard. La Figure 49 présente le panneau arrière de 
l'interface XMON. 

Connexion du système de monitoring XMON

D-Control est relié à l'interface XMON par un câble à 15 broches. L'unité principale de D-Control est livrée avec un câble de 15,25 m. 
Le système prend en charge des câbles d'une longueur maximum de 24,5 m. 

Pour connecter l'interface XMON à D-Control :

1  Branchez le câble d'alimentation CA sur le panneau arrière de l'interface XMON et sur une source d'alimentation. Il est recommandé 
d'utiliser une source d'alimentation protégée contre les surtensions. 

2  Connectez une extrémité du câble XMON fourni au port de la surface de contrôle de l'unité XMON, et l'autre extrémité au port à 
15 broches situé sur le panneau arrière de l'unité principale de D-Control.

Figure 49. Panneau arrière de XMON

Entrées StereoEntrées SurroundEntrées MainEntrées Cue

Sorties Cue Sorties Main Sorties Alt Surface de 
contrôle

Alimentation CATalkback/Listenback/
Utility

Vis d'étalonnage 
des VU-mètres
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Connexions pour le monitoring de la cabine d'écoute

Entrées

• Entrées Main (8 canaux), symétriques, +4 dBu (à partir de Pro Tools)

• Entrées Surround (8 canaux), symétriques, +4 dBu

• Entrées Stereo 1 (2 canaux), symétriques, +4 dBu/–10 dBV

• Entrées Stereo 2 (2 canaux), symétriques, +4 dBu/–10 dBV

• Entrées Stereo 3 (2 canaux), symétriques, +4 dBu/–10 dBV

• Entrées Stereo 4 (2 canaux), symétriques, +4 dBu/–10 dBV

• Entrées AFL/PFL (2 canaux), symétriques, +4 dBu 

• Listen Mic 1 (externe), niveau micro (XMON fournit une alimentation fantôme de 18 V)

• Listen Mic 2 (externe), niveau micro (XMON fournit une alimentation fantôme de 18 V)

Sorties

• Sorties Main Control Room (8 canaux), symétriques ou asymétriques, +4 dBu

• Sorties Alt Control Room (8 canaux), symétriques ou asymétriques, +4 dBu

• Sorties Mini Control Room (2 canaux), symétriques ou asymétriques, +4 dBu

Figure 50. Schéma du système de monitoring de la cabine d'écoute
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Connexions système Headphone/Cue (casque/retour)

Entrées

• Entrée Main Monitor (2 canaux)

• Entrée Cue 1 (2 canaux), symétrique, +4 dBu

• Entrée Cue 2 (2 canaux), symétrique, +4 dBu

• Entrée Cue 3 (2 canaux), symétrique, +4 dBu

• Internal Talkback Mic (à partir du micro interne)

• External Talkback Mic, niveau micro (XMON fournit une alimentation fantôme de 18 V)

Sorties

• Cue 1 (2 canaux), +4 dBu

• Cue 2 (2 canaux), +4 dBu

• Cue 3 (2 canaux), +4 dBu

• Headphone (2 canaux), vers prise casque interne

• Studio Loudspeaker (2 canaux)

Figure 51. Schéma du système Headphone/Cue

Entrée Main Monitor
(2 canaux) [à partir du

système cabine
d'écoute]

Entrée Cue 1
(2 canaux)

Entrée Cue 2
(2 canaux)

Entrée Cue 3
(2 canaux)

Sortie Cue 1 
(2 canaux)

Sortie Cue 2 
(2 canaux)

Sortie Cue 3 
(2 canaux)

Sortie 
Headphone 
(2 canaux)

Sortie 
Talkback/Slate 
(1 canal)

Studio LS 
(2 canaux)

Assignation 
du talkback

Bouton 
Talkback

Niveau 
talkback 
interne

Niveau 
talkback 
externe

Entrée
talkback

interne

Entrée
talkback
externe
• Sortie Talkback/Slate (1 canal)
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Exemple de schéma de câblage XMON
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Le schéma suivant indique les connexions XMON de base pour un système Pro Tools|HD avec une interface HD I/O comportant 16 sorties 
analogiques. 

Figure 52. Schéma de câblage entre une interface HD I/O et XMON
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Chapitre 5 : Configuration de D-Control
Démarrage et arrêt du système

Votre système D-Control doit être démarré et arrêté selon une 
procédure spécifique.

Démarrez votre système D-Control dans l'ordre suivant :

1  Mettez les disques durs externes sous tension. Patientez de 
10 à 15 secondes, jusqu’à ce qu'ils atteignent leur vitesse nominale. 

2  Mettez les unités D-Control sous tension. 

3  Si vous envisagez d'utiliser du matériel MIDI, mettez les interfaces 
et autres périphériques MIDI sous tension. 

4  Mettez toutes les interfaces audio Pro Tools sous tension. 

5  Allumez l'ordinateur. 

6  Mettez l'interface XMON sous tension.

7  Mettez les amplificateurs de monitoring ou les haut-parleurs 
auto-alimentés sous tension.

Arrêtez votre système basé sur D-Control dans l'ordre suivant :

1  Éteignez les amplificateurs de monitoring ou les haut-parleurs 
auto-alimentés.

2  Éteignez l'interface XMON.

3  Éteignez toutes les interfaces audio Pro Tools.

4  Éteignez l'ordinateur.

5  Si vous utilisez du matériel MIDI, éteignez les interfaces, contrô-
leurs et autres périphériques MIDI. 

6  Éteignez les unités D-Control. 

7  Mettez hors tension les disques durs externes.

Configuration logicielle

L'ensemble des logiciels D-Control est inclus lors de l'installation 
du logiciel Pro Tools. Le programme d'installation du logiciel 
Pro Tools place le dossier D-Control Personality sur le disque 
dur système.

Reportez-vous au Guide de démarrage fourni avec votre système 
pour obtenir des instructions sur l'installation ou la mise à jour 
du logiciel Pro Tools. 
Mise à jour du firmware du système

Chaque nouvelle version de Pro Tools inclut le firmware D-Control 
le plus récent. Lorsque vous déclarez une unité D-Control dans 
la boîte de dialogue Peripherals de Pro Tools, Pro Tools compare 
le firmware de toutes les unités connectées avec la version dis-
ponible dans le logiciel Pro Tools et vous invite à mettre à jour 
votre firmware, si une version plus récente est disponible.

Le cas échéant, suivez les instructions à l'écran pour charger la 
dernière version du firmware sur chaque unité D-Control. 

Déclaration des unités D-Control dans Pro Tools

La communication entre D-Control et Pro Tools est configurée 
à partir de Pro Tools.

Pour déclarer des unités D-Control dans Pro Tools :

1  Sélectionnez Setups > Peripherals et cliquez sur Ethernet 
Controllers. 

2  Sélectionnez Enable. Pro Tools parcourt la connexion Ethernet 
à la recherche d'unités D-Control connectées au système.

Affichage des contrôleurs Ethernet dans la boîte de dialogue Peripherals
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3  Sélectionnez les unités selon l'ordre dans lequel vous souhaitez 
les positionner (de gauche à droite). 

Lors de la sélection des unités, Pro Tools analyse et active chaque 
unité. Le statut actuel de chaque unité est signalé dans la boîte 
de dialogue Peripherals de la manière suivante :

• Le format Gras indique que l'unité est connectée.

• Le format Italique indique que l'unité est hors ligne ou 
déconnectée. 

• Le format Souligné indique que l'unité est utilisée par un 
autre système Pro Tools.

4  Une fois toutes les unités activées, cliquez sur OK pour fermer 
la fenêtre Peripherals.

Lorsque la communication est établie, Pro Tools identifie chaque 
banque de pistes Pro Tools à l'aide de contours de couleur. 

Les couleurs de chaque ligne d'unités permettent d'identifier le 
contrôleur sélectionné à l'écran dans Pro Tools. La couleur du 
contour utilisée pour repérer les banques, pistes, inserts, départs, 
ou tout autre élément sélectionné par D-Control correspond à 
la couleur associée à chaque unité. 

Attribution d'un nom aux unités D-Control 
dans Pro Tools

Vous pouvez attribuer un nom à chaque unité D-Control à partir 
de Pro Tools. 

Pour attribuer un nom à une unité D-Control dans Pro Tools :

1  Sélectionnez Setups > Peripherals et cliquez sur Ethernet 
Controllers. 

2  Cliquez sur le bouton Name en regard de l'unité.

3  Attribuez un nom à l'unité, puis cliquez sur OK. 

En mode Utility, vous pouvez également attribuer des noms 
aux unités principales de D-Control et aux modules de faders 
directement depuis les unités. Pour plus de détails sur l'attribution 
de nom aux unités D-Control en mode Utility, reportez-vous à 
la section « Page Name de D-Control » à la page 160.

Configuration des options de D-Control

Cette section décrit les paramètres et options de D-Control qui 
sont directement définis depuis la surface de contrôle. Pour plus 
de détails sur les options définies depuis Pro Tools, reportez- 
vous au Guide de référence Pro Tools.

Il est inutile de déclarer les unités en suivant leur ordre de 
succession physique sur le stand de D-Control. Vous pouvez 
configurer un système Pro Tools de façon à utiliser les unités 
D-Control dans l'ordre qui vous convient, pour s'adapter à 
votre workflow. 
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Options des faders, encodeurs et boutons

Les options et paramètres suivants affectent le fonctionnement 
des faders, des encodeurs et des boutons de D-Control.

Bank Justification

L'option Bank Justification détermine si les banques de canaux 
en mode Normal sont alignées à gauche, au centre gauche (à 
gauche de l'unité principale), au centre droit (à droite de l'unité 
principale) ou à droite de la surface de contrôle.

Pour définir l'option Bank Justification : 

1  Dans la section Soft Keys, appuyez sur le bouton Operation 
plusieurs fois afin d'afficher la page contenant Bank Justification 
(BnkJus).

2  Appuyez sur la touche programmable correspondant à BnkJus 
pour sélectionner le paramètre Left, CenterL, CenterR ou Right. 

3  Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur le bouton Operation pour quitter.

Faders On/Off

L'option Faders On/Off permet de désactiver temporairement 
les faders de D-Control pour empêcher tout mouvement de fader 
lors de l'écoute d'un mixage.

Pour activer et désactiver les faders de D-Control :

1  Dans la section Soft Keys, appuyez sur le bouton Operation 
plusieurs fois afin d'afficher la page contenant Faders On/Off 
(Faders). 

2  Appuyez sur la touche programmable correspondant à Faders 
pour activer ou désactiver les faders.

3  Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur le bouton Operation pour quitter.

Touch Value

L'option Touch Value détermine si les faders et les encodeurs, 
lorsque vous les touchez, affichent temporairement la valeur 
du paramètre qu'ils contrôlent.

Pour activer ou désactiver l'affichage des valeurs :

1  Dans la section Soft Keys, appuyez sur le bouton Operation 
plusieurs fois afin d'afficher la page contenant Touch Value 
(TchVal).

2  Appuyez sur la touche programmable correspondant à TchVal 
pour activer ou désactiver l'affichage.

3  Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur le bouton Operation pour quitter.



Affichage des commandes des pistes esclaves sur 
les encodeurs de pistes Master VCA

Si vous ne souhaitez pas afficher ou régler les commandes des 
pistes esclaves depuis la tranche de console Master VCA, vous 
pouvez désactiver l'affichage des commandes des pistes esclaves 
sur les encodeurs des pistes Master VCA. 

Pour activer ou désactiver l'affichage des commandes des pistes 
esclaves sur les pistes Master VCA :

1  Dans la section Soft Keys, appuyez sur le bouton Operation 
plusieurs fois afin d'afficher la page contenant la préférence 
d'affichage Encoder VCA (EncVCA).

2  Appuyez sur la touche programmable correspondant à EncVCA 
pour sélectionner le paramètre Yes (affichage des commandes 
des pistes esclaves sur les encodeurs) ou No (pas d'affichage des 
commandes des pistes esclaves). 

3  Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur le bouton Operation pour quitter.

Affichage des positions de départs et d'inserts sur 
les encodeurs

L'option Show Send/Insert Letters vous permet d'afficher les 
lettres des départs et inserts sur les positions de départs et d'inserts 
sans affectation.

Les affichages des encodeurs et des tranches de console donnent 
des informations sur les inserts et les départs comme suit :

 Si l'option Show/Send Insert Letters est activée, les inserts sans 
affectation affichent uniquement des majuscules (A à J) dans les 
positions correspondantes.

 Si l'option Show/Send Insert Letters est activée, les départs sans 
affectation affichent uniquement des minuscules (a à j) dans les 
positions correspondantes.

 Les inserts et les départs avec affectation affichent uniquement 
le nom de l'insert ou du départ, sans lettre.

Pour activer l'affichage des lettres d'inserts et de départs :

1  Dans la section Console Prefs Soft Keys, appuyez sur le bouton 
Operation plusieurs fois afin d'afficher la page contenant Show 
Send/Insert Letters (Lettrs).

2  Appuyez sur la touche programmable correspondant à Lettrs 
pour activer ou désactiver le paramètre.

3  Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur le bouton Operation pour quitter.
Mode Rotary Encoder Velocity

Le mode Rotary Encoder Velocity affecte la sensibilité des po-
tentiomètres des encodeurs rotatifs. Le mode Fixed correspond 
à une résolution normale. En mode Velocity Sensitive, l'accéléra-
tion peut être configurée sur lente, moyenne ou rapide. En mode 
Fine, la réponse est réglée sur une résolution précise.

Pour sélectionner le mode Rotary Encoder Velocity :

1  Dans la section Soft Keys, appuyez sur le bouton Operation 
plusieurs fois afin d'afficher la page contenant le mode Rotary 
Encoder Velocity (Rotary). 

2  Appuyez sur la touche programmable correspondant à Rotary 
pour choisir entre les paramètres Fixed, Vel-Sl (sensible à la vé-
locité lent), Vel-Md (sensible à la vélocité moyen), Vel-Fa (sensi-
ble à la vélocité rapide) et Fine.

3  Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur le bouton Operation pour quitter.

Pan on Lower Encoder

L'option Pan on Lower Encoder détermine si les commandes de 
panoramique sont affichées sur l'encodeur du bas de chaque 
canal, même lorsqu'une commande d'un autre type est affichée 
sur les encodeurs du haut. 

Pour sélectionner l'option Pan on Lower Encoder :

1  Dans la section Soft Keys, appuyez sur le bouton Operation 
plusieurs fois afin d'afficher la page contenant Pan on Lower 
Encoder (PanBot). 

2  Appuyez sur la touche programmable correspondant à PanBot 
pour sélectionner le paramètre Yes ou No.

3  Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur le bouton Operation pour quitter.

Encoder Order

L'option Encoder Order détermine si les commandes des inserts, 
départs et panoramiques sont affichées de haut en bas ou de bas 
en haut sur les encodeurs rotatifs de D-Control.

Pour sélectionner l'option Encoder Order :

1  Dans la section Soft Keys, appuyez sur le bouton Operation 
plusieurs fois afin d'afficher la page contenant Encoder Order 
(Encod). 

2  Appuyez sur la touche programmable correspondant à Encod 
pour sélectionner le paramètre BotTp (de bas en haut) ou TpBot 
(de haut en bas). 

3  Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur le bouton Operation pour quitter.
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Mode Select Switch Latch

Le mode Select Switch Latch détermine si les boutons Select des 
canaux basculent entre les modes verrouillé (latching) et OU 
exclusif (non-latching) en mode Select. 

Pour sélectionner le mode Select Switch Latch :

1  Dans la section Soft Keys, appuyez sur le bouton Operation 
plusieurs fois afin d'afficher la page contenant le mode Select 
Switch Latch (Select). 

2  Appuyez sur la touche programmable correspondant à Select 
pour sélectionner le paramètre Latch ou ExclOr (déverrouillé).

3  Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur le bouton Operation pour quitter.

Options des Custom Faders

Les options et paramètres suivants affectent l'affichage des Custom 
Faders dans D-Control. Pour en savoir plus sur l'utilisation des 
Custom Faders, reportez-vous à la section Chapitre 13, « Modes 
Custom Fader »

Maximum Custom Fader Bank Size

L'option Maximum Custom Fader Bank Size détermine le nombre 
de canaux utilisés lors de l'affichage des pistes dans la banque 
de Custom Faders de droite ou de gauche. 

L'option Custom Fader Bank Size est configurée indépendamment 
pour chaque catégorie de modes Custom Fader (plug-ins, groupes 
et types de pistes). 

Les options de la taille de la banque incluent 4, 8, 16 ou 32 canaux, 
la valeur maximale correspondant au nombre total de canaux 
sur le système D-Control. Vous pouvez choisir des paramètres 
pour chacune de ces tailles (indiquées par le préfixe Min) utilisant 
le nombre minimum de canaux nécessaires, afin que la section 
Custom Faders opère un redimensionnement dynamique pour 
correspondre au nombre de canaux du groupe. 

LCFPI (Left CF Bank Size for Plug-Ins) : détermine le nombre de 
canaux alloués au mode Custom Fader Plug-In dans la section 
Custom Faders de gauche.

RCFPI (Right CF Bank Size for Plug-Ins) : détermine le nombre de 
canaux alloués au mode Custom Fader Plug-In dans la section 
Custom Faders de droite.

LCFGrp (Left CF Bank Size for Custom Groups and Mix/Edit 
Groups) : détermine le nombre de canaux alloués au mode Custom 
Groups dans la section Custom Faders de gauche.

RCFGrp (Right CF Bank Size for Custom Groups and Mix/Edit 
Groups) : détermine le nombre de canaux alloués au mode Custom 
Groups dans la section Custom Faders de droite.

LCFTyp (Left CF Bank Size for Track Type) : détermine le nombre 
de canaux alloués au mode Custom Fader Tracks dans la section 
Custom Faders de gauche.
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RCFTyp (Right CF Bank Size for Track Type) : détermine le nombre 
de canaux alloués au mode Custom Fader Tracks dans la section 
Custom Faders de droite.

Pour configurer la taille maximum de la banque Custom Faders :

1  Dans la section Soft Keys, appuyez sur le bouton Operation 
plusieurs fois afin d'afficher la page contenant Custom Fader 
Bank Size. 

2  Effectuez l'une des opérations suivantes :

• Pour accroître le nombre de tranches de console, appuyez 
sur la touche programmable correspondant au paramètre 
à modifier.

– ou –

• Pour diminuer le nombre de tranches de console, maintenez 
la touche Maj enfoncée et appuyez sur la touche program-
mable correspondant au paramètre à modifier.

3  Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur le bouton Operation pour quitter.

Alignement des banques Custom Faders

L'option Custom Fader Bank Justification détermine la distribution 
des deux banques Custom Faders disponibles sur la surface de 
contrôle.

LCFJst (Left Custom Fader Justification) : détermine si les Custom 
Faders contrôlés par la section Custom Faders de gauche sont 
placés à gauche, au centre gauche, au centre droit ou à droite de 
l'unité principale.

RCFJst (Right Custom Fader Justification) : détermine si les Custom 
Faders contrôlés par la section Custom Faders de droite sont 
placés à gauche, au centre gauche, au centr e droit ou à droite de 
l'unité principale.

Pour sélectionner l'option Custom Fader Bank Justification :

1  Dans la section Soft Keys, appuyez sur le bouton Operation 
plusieurs fois afin d'afficher la page contenant Custom Fader 
Bank Justification (LCFJst ou RCFJst).

2  Appuyez plusieurs fois sur la touche programmable corres-
pondant à LCFJst ou RCFJst pour choisir entre les paramètres 
Left, CenterL, CenterR et Right pour la banque correspondante 
de Custom Faders.

3  Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur le bouton Operation pour quitter.



Affichage de pistes masquées sur les Custom Faders

Vous pouvez configurer D-Control de sorte à afficher les pistes 
masquées sur les affichages des Custom Faders. Bien que vous 
puissiez les mélanger, vous ne pouvez pas les sélectionner ou les 
activer pour l'enregistrement. Les noms de pistes masquées 
s'affichent en jaune sur les Custom Faders.

Pour afficher les pistes masquées sur les affichages des Custom 
Faders :

1  Dans la section Soft Keys, appuyez sur le bouton Operation 
plusieurs fois afin d'afficher la page contenant Custom Fader 
Tracks (CFTrks). 

2  Appuyez sur la touche programmable correspondant à CFTrks 
pour sélectionner le paramètre Show Hidden Tracks (ShwHdn) 
ou Hide Hidden Tracks (HidHdn). 

3  Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur le bouton Operation pour quitter.

Définitions d'affichage en mode Custom Fader Plug-In

Trois options d'affichage sont disponibles pour les paramètres 
de plug-ins dans les affichages des canaux des Custom Faders. 
Ces options, ou définitions d'affichage, sont accessibles dans les 
préférences de fonctionnement de D-Control. 

Name View : affiche le nom de la piste, le nom du plug-in et le 
format de canal du plug-in sur lequel est mis le focus dans les 
affichages des canaux des Custom Faders. 

Expanded View : affiche des commandes de plug-ins supplémen-
taires dans les affichages des canaux des Custom Faders. Cet af-
fichage est également disponible à tout moment en mainte-
nant le bouton Plug-In de la section Custom Faders jusqu'à ce 
qu'il se mette à clignoter. Voir « Affichage Expanded Plug-In » à la 
page 154.

Fader View : conserve les noms des pistes sur les affichages des 
canaux et le contrôle des faders du volume de piste pendant 
que les paramètres des plug-ins des Custom faders s'affichent 
sur les encodeurs des canaux. L'activation de Expanded View 
ou du mode Plug-In Map ferme automatiquement Fader View. 

Pour définir l'affichage en mode Custom Fader Plug-In :

1  Dans la section Soft Keys, appuyez sur le bouton Operation 
plusieurs fois afin d'afficher la page contenant Plug-In View 
Definitions (LPIDef et RPIDef). 

2  Appuyez plusieurs fois sur la touche programmable corres-
pondant à LPIDef ou RPIDef pour choisir entre les paramètres 
correspondants pour l'affichage du mode Plug-In.

3  Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur le bouton Operation pour quitter.
Mettre le focus sur des plug-ins en mode Custom 
Faders

Vous pouvez configurer D-Control pour mettre le focus sur des 
plug-ins directement dans le mode Custom Faders Plug-In au 
lieu de le faire dans les tranches de console.

Pour activer le focus sur des plug-ins dans les Custom Faders de 
D-Control :

1  Dans la section Soft Keys, appuyez sur le bouton Operation 
plusieurs fois afin d'afficher la page contenant Channel Editing 
for Plug-Ins (ChanPI).

2  Appuyez sur la touche programmable correspondant à ChanPI 
pour sélectionner le paramètre On (pour mettre le focus sur des 
plug-ins des Custom Faders) ou Off (pour mettre le focus sur des 
plug-ins des tranches de console). 

3  Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur le bouton Operation pour quitter.

Pour mettre le focus sur un plug-in directement dans les Custom 
Faders :

1  Appuyez sur le bouton Inserts du canal pour afficher les noms 
des plug-ins sur les encodeurs du canal. Appuyez sur les boutons 
Page Up et Page Down du canal pour afficher des plug-ins sup-
plémentaires.

2  Appuyez sur le bouton Select de l'encodeur du plug-in sur lequel 
vous souhaitez mettre le focus.

Les commandes du plug-in sur lequel est mis le focus apparaissent 
dans le mode Custom Fader Plug-In.

Pour mettre le focus sur un plug-in en utilisant le mode inverse du 
paramètre ChanPI actif :

 Maintenez les touches Ctrl+Alt (Windows) ou Commande+ 
Option (Mac) enfoncées tout en appuyant sur le bouton Select 
de l'encodeur d'un plug-in. 

Options du mode Transport

D-Control peut fonctionner en mode Dual Transport ou Single 
Transport. Le mode Dual Transport active le deuxième ensemble 
de commandes de transport dans la section intitulée Machine 
Transport. En mode Single Transport, seules les commandes de 
transport indiquées Pro Tools Transport sont actives.

Pour sélectionner le mode Transport :

1  Dans la section Soft Keys, appuyez sur le bouton Operation 
plusieurs fois afin d'afficher la page contenant Transport Mode 
(Trnspt). 

2  Appuyez sur la touche programmable correspondant à Trnspt 
pour sélectionner le paramètre Dual ou Single.

3  Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur le bouton Operation pour quitter.
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Préférences d'affichage

Les options suivantes affectent l'interaction entre D-Control et 
l'affichage à l'écran des éléments de Pro Tools.

Target Track from Application

L'option Target Track from Application détermine si la sélection 
d'un insert ou d'un départ à l'écran sélectionne également la 
piste sur l'unité principale de D-Control. Pour plus de détails 
sur la mise en focus d'une piste dans D-Control, consultez la 
section « Mettre le focus sur une piste » à la page 131.

Pour sélectionner l'option Target Track from Application :

1  Dans la section Soft Keys, appuyez sur le bouton Operation 
plusieurs fois afin d'afficher la page contenant Application Target 
(APTrgt). 

2  Appuyez sur la touche programmable correspondant à APTrgt 
pour sélectionner le paramètre Yes ou No.

3  Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur le bouton Operation pour quitter.

Channel Window Display

L'option Channel Window Display détermine si l'affichage de 
paramètres de plug-in ou de panoramique de départ (en appuyant 
sur le bouton Select d'un encodeur) sur D-Control ouvre la fenêtre 
de plug-in ou de départ correspondante dans Pro Tools. Cette 
option détermine également si les boutons Select des canaux 
(des sections Dynamics ou EQ) modifient l'affichage des canaux 
des plug-ins multi-mono.

 Lorsque cette option est configurée sur Yes, les fenêtres de plug-in 
et de départ changent d'apparence pour refléter le statut de la 
surface de contrôle. 

 Lorsque cette option est configurée sur No, les fenêtres de 
plug-in et de départ restent inchangées. 

Pour sélectionner l'option Channel Window Display :

1  Dans la section Soft Keys, appuyez sur le bouton Operation 
plusieurs fois afin d'afficher la page contenant Channel Window 
Display (ChanWn). 

2  Appuyez sur la touche programmable correspondant à ChanWn 
pour sélectionner le paramètre Yes ou No.

3  Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur le bouton Operation pour quitter.
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Options des VU-mètres

Les options suivantes affectent le fonctionnement des VU-mètres 
de D-Control.

Send Meters On/Off

L'option Send Meters On/Off permet d'activer et de désactiver 
les VU-mètres des départs. Elle s'applique lorsque les départs sont 
affichés sur les encodeurs rotatifs de D-Control. Cet affichage 
des niveaux suit les paramètres d'affichage des niveaux Send 
Pre/Post de Pro Tools.

Pour activer et désactiver les VU-mètres des départs :

1  Dans la section Soft Keys, appuyez sur le bouton Meter plusieurs 
fois afin d'afficher la page contenant Send Meters On/Off (SndMtr).

2  Appuyez sur la touche programmable correspondant à SndMtr 
pour activer et désactiver les VU-mètres. 

3  Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur le bouton Meter pour quitter.

Insert Meter On/Off

L'option Insert Meter On/Off permet d'activer et de désactiver 
les VU-mètres des inserts. Elle s'applique lorsque les inserts sont 
affichés sur les encodeurs rotatifs de D-Control.

Pour activer et désactiver les vumètres des inserts :

1  Dans la section Soft Keys, appuyez sur le bouton Meter plusieurs 
fois afin d'afficher la page contenant Insert Meters On/Off (InsMtr).

2  Appuyez sur la touche programmable correspondant à InsMtr 
pour activer et désactiver les VU-mètres. 

3  Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur le bouton Meter pour quitter.

Meters Pre/Post Fader

L'option Meters Pre/Post Fader permet de basculer entre les modes 
pré et post-fader des VU-mètres de canal. 

Pour basculer entre les VU-mètres pré et post-fader :

1  Dans la section Soft Keys, appuyez sur le bouton Meter plusieurs 
fois afin d'afficher la page contenant Meters Pre/Post Fader (Meters).

2  Appuyez sur la touche programmable correspondant à Meters 
pour basculer entre l'option PreFad (VU-mètre pré-fader) et PostFd 
(VU-mètre post-fader). 

3  Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur le bouton Meter pour quitter.



Center Meters Track/Output

L'option Center Meters Track/Output permet de modifier l'affi-
chage des 8 VU-mètres des canaux sur le pont des VU-mètres de 
l'unité principale en affichant les niveaux de sortie principale 
ou de la piste focus. Lorsque vous choisissez d'afficher le niveau 
de la piste focus, vous pouvez afficher des niveaux pour des pistes 
multicanal jusqu'à 8 canaux (7.1 surround).

Pour afficher le niveau de sortie ou de la piste sur les VU-mètres 
centraux :

1  Dans la section Soft Keys, appuyez sur le bouton Meter plusieurs 
fois afin d'afficher la page contenant Center Meters Track/Output 
(CtrMtr).

2  Appuyez sur la touche programmable correspondant à CtrMtr 
pour sélectionner le paramètre Output ou Track.

3  Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur le bouton Meter pour quitter.

Gain Reduction Priority

Si les anneaux de diodes LED des encodeurs et les VU-mètres des 
canaux sont configurés pour afficher la réduction de gain des 
plug-ins dynamiques, vous pouvez déterminer quelle fonction 
est prioritaire lorsque des plug-ins Compressor/Gate multifonc-
tions sont utilisés.

Pour définir la priorité d'affichage de réduction de gain sur les 
VU-mètres :

1  Dans la section Soft Keys, appuyez sur le bouton Meter plusieurs 
fois afin d'afficher la page contenant Gain Reduction Priority 
(GRPrio).

2  Appuyez sur la touche programmable correspondant à GRPrio 
pour sélectionner le paramètre Compressor/Limiter (CompLm) 
ou Expander/Gate (ExpGat) 

3  Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur le bouton Meter pour quitter.

VCA Meters On/Off

L'option VCA Meters On/Off permet de d'activer et de désactiver 
les VU-mètres des niveaux des pistes esclaves VCA sur les enco-
deurs rotatifs du canal VCA. 

Pour activer et désactiver les VU-mètres des pistes esclaves VCA :

1  Dans la section Soft Keys, appuyez sur le bouton Meter plusieurs 
fois afin d'afficher la page contenant VCA Meters On/Off (VCAMtr).

2  Appuyez sur la touche programmable correspondant à VCAMtr 
pour activer et désactiver les VU-mètres. 

3  Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur le bouton Meter pour quitter.
Étalonnage du système

Réétalonnage des faders de D-Control

Si un fader de l'unité D-Control présente des problèmes de sen-
sibilité, vous pouvez le réétalonner à l'aide de la commande 
Recal en mode Utility. Pour plus d'informations, reportez-vous 
à la section « Recal » à la page 163.

Étalonnage des VU-mètres de sortie

Vous pouvez étalonner les VU-mètres de sortie du pont des 
VU-mètres de l'unité principale depuis XMON, afin que les 
niveaux des VU-mètres de Pro Tools correspondent aux niveaux 
des VU-mètres des sources externes. Dans l'exemple ci-dessous, 
une interface HD I/O ou 192 I/O est utilisée en tant que source 
de référence.

Pour étalonner les VU-mètres de sortie de D-Control :

1  Définissez le niveau de référence de votre interface HD I/O ou 
192 I/O en suivant les instructions du guide de cette interface.

2  Lorsque la sortie analogique de l'interface HD I/O ou 192 I/O 
est connectée à l'entrée principale de XMON, envoyez un signal 
d'étalonnage sur les sorties principales de D-Control et notez le 
niveau de sortie sur les VU-mètres de D-Control. 

3  Débranchez la sortie analogique de l'interface HD I/O ou 
192 I/O de l'entrée principale de XMON et connectez-la à 
l'entrée Alt de XMON.

4  Activez la sortie Alt. 

5  Réglez les potentiomètres du panneau arrière de XMON afin 
que le niveau de sortie de chaque canal sur D-Control corres-
ponde au niveau affiché pour la sortie principale.

6  Une fois les réglages terminés, rebranchez la sortie analogique 
de l'interface HD I/O ou 192 I/O à l'entrée principale de XMON.

Étalonnage de l'indication SPL de la section Monitor

La section Monitor de l'unité D-Control permet d'afficher le niveau 
de sortie en dB ou dB SPL. Vous pouvez étalonner l'affichage 
SPL pour qu'il reflète le niveau de pression acoustique à la position 
de mixage. Voir « Bouton Cal (Calibration Mode) » à la page 118.
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Chapitre 6 : Commandes des tranches
Tranches de console

L'unité principale de D-Control comporte une tranche centrale 
appelée Tranche Focus, et chaque module de faders de D-Control 
est doté de 16 tranches. Chaque tranche (Figure 1) comporte 
des commandes identiques, notamment six encodeurs rotatifs 
et un fader tactiles, ainsi que des commandes d'affichage et de 
sélection de mode. 
Figure 1. Tranche de D-Control
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Section des encodeurs rotatifs

Chaque tranche comporte six encodeurs rotatifs tactiles, chacun 
muni d'un anneau de diodes LED, d'un affichage, de boutons 
de mode et de témoins de statut. Les encodeurs rotatifs permettent 
de contrôler les paramètres d'entrée, d'insert, de départ, de pa-
noramique et du préamplificateur micro.

Bouton encodeur

Les boutons encodeurs des tranches de D-Control sont sensibles 
au toucher. Lorsque vous bougez l'encodeur, l'affichage de l'en-
codeur passe du nom du paramètre à sa valeur. L'affichage des 
valeurs de paramètre peut être désactivé.

Lorsque vous automatisez un paramètre contrôlé par un encodeur, 
l'écriture de l'automation se déclenche dès que vous touchez le 
bouton encodeur. 

Entrées, sorties, inserts et départs

Lors de l'affectation de l'entrée ou de la sortie d'un canal, d'un 
insert ou d'un départ, le bouton encodeur permet d'afficher les 
entrées, sorties, inserts ou départs disponibles. Lorsque l'ali-
mentation fantôme d'un préamplificateur micro est contrôlée 
à distance, le bouton encodeur peut être utilisé pour l'activer ou 
la désactiver.

Pistes d'instrument

Sur les pistes d'instrument, le bouton encodeur inférieur est utilisé 
pour contrôler le volume MIDI. 

Pistes Master VCA

Sur les pistes Master VCA, les boutons encodeurs sont utilisés 
pour contrôler le volume des pistes esclaves. 

Anneau de diodes LED de l'encodeur

Chaque encodeur est muni d'un anneau de 15 LED tricolores. 
Les informations représentant des valeurs discrètes ou de palliers 
sont affichées au moyen d'une seule LED, les informations repré-
sentant des valeurs variant de façon continue sont indiquées 
via une série de LED.

Encodeur rotatif d'une tranche

Anneau de diodes
LED de l'encodeur

Témoin Automation
Mode de l'encodeur

Bouton Select

Témoins de
plug-in Dyn/EQ

Bouton encodeur

Affichage de l'encodeur

Témoins Mute/Pre

Bouton
Bypass/Mute/Pre
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En mode Normal, les anneaux de diodes LED des encodeurs 
peuvent afficher le niveau des départs, la position du panoramique, 
des valeurs de paramètres de plug-ins, ainsi que des réglages du 
préamplificateur micro. En mode Flip, ils indiquent le niveau 
de la piste.

Pistes d'instrument

Sur les pistes d'instrument, l'anneau de diodes LED de l'encodeur 
inférieur affiche la vélocité MIDI. 

Pistes Master VCA

Sur les pistes Master VCA, l'anneau de diodes LED des encodeurs 
affiche les niveaux des pistes esclaves. 

Témoin du mode automation de l'encodeur

En dessous de chaque bouton encodeur, une diode LED libellée 
auto s'allume lorsque le paramètre correspondant est activé 
pour l'automation. Le témoin s'allume en vert pour le mode 
Read, en jaune continu lorsqu'il est prêt pour l'automation 
dans tous les modes Write, et il clignote en rouge pour indiquer 
l'écriture de données d'automation dans tous les modes Write. 

Affichage de l'encodeur

Chaque encodeur comporte un affichage à six caractères, où 
apparaissent les noms des paramètres. Les valeurs du paramètre 
s'affichent lorsque l'on touche ou bouge le bouton de l'encodeur 
associé.

Ces affichages utilisent des couleurs et un rétro-éclairage pour 
indiquer les paramètres suivants :

• Vert : couleur par défaut des noms et valeurs des paramètres 
relatifs aux entrées, inserts, départs, au panoramique et au 
préamplificateur micro.

• Vert inversé : noms des entrées, sorties, plug-ins ou départs 
inactifs.

• Jaune : options d'affectation en mode Assign, tout paramètre 
en mode Flip.

• Rouge : plug-in, départ ou canal écrêté.



Témoins des plug-ins Dynamics et EQ

Lors de l'affichage des inserts sur un encodeur, ces LED s'allument 
pour indiquer la présence d'un plug-in Dynamics (témoin jaune) 
ou EQ (témoin vert).

Témoins Mute et Pre

Lors de l'affichage des départs sur un encodeur, ces LED s'allument 
pour indiquer que le son du départ est mis en mute (témoin rouge) 
ou réglé pour une opération pré-fader (témoin vert).

Bouton Select des encodeurs

Chaque encodeur possède un bouton Select, qui permet de lui 
affecter un insert ou un départ, ou d'afficher les paramètres des 
inserts ou des départs afin de les modifier.

Inserts

Lors de l'assignation d'un insert, le bouton Select permet de 
confirmer la sélection des éléments suivants à chaque niveau :

• Type d'insert (plug-in TDM ou TDM multi-mono, RTAS ou 
RTAS multi-mono, ou insert matériel)

• Sous-dossier Plug-in (par exemple EQ, Dynamics, Pitch Shift, 
Reverb ou Delay)

• Insert ou plug-in individuel

Lors de l'affichage d'un plug-in, le bouton Select permet d'afficher 
et de modifier les paramètres du plug-in sur les encodeurs rotatifs 
de ce canal.

Départs

Lors de l'assignation d'un départ, le bouton Select permet de 
confirmer la sélection des paramètres suivants :

• Type de départ (interface ou bus)

• Assignation du départ

Lors de l'affichage d'un départ, le bouton Select permet d'afficher 
et de modifier les informations de panoramique du départ sur 
les encodeurs rotatifs de ce canal.

Pistes Master VCA

Sur les pistes Master VCA, le bouton Select permet de passer les 
pistes esclaves correspondantes sur la tranche Focus.
Bouton Bypass/Mute/Pre

Chaque encodeur est muni d'un bouton Bypass/Mute/Pre (B/M/P), 
dont les fonctions dépendent des données affichées par l'encodeur. 
Pour les départs, la fonction du bouton B/M/P dépend également 
du paramètre Switch Mode actif. 

Reportez-vous à la section « Bouton Switch Mode (SW MODE) » 
à la page 61 pour plus d'informations sur la modification du 
paramètre Switch Mode et l'affichage de la fonction active du 
bouton B/M/P. 

Inserts

 Lorsque le nom d'un plug-in est affiché sur un encodeur (dans 
l'affichage Inserts supérieur), le bouton B/M/P permet de le 
mettre en bypass. Le bouton B/M/P s'allume lorsque le plug-in 
est en bypass.

 Lorsqu'un paramètre de plug-in est affiché sur un encodeur 
(en appuyant sur le bouton Select), le bouton B/M/P affecte uni-
quement certains paramètres (tels que la polarité ou la liaison 
de canaux), que vous pouvez activer ou désactiver.

Départs

Lorsque le nom d'un départ est affiché sur un encodeur, le bouton 
B/M/P produit les effets suivants :

• Si le mode Mute est activé, le bouton B/M/P coupe le son 
du départ correspondant. Le témoin Mute rouge s'allume 
pour indiquer que le son est coupé. 

• Si le mode Pre est activé, le bouton B/M/P permet de sélec-
tionner une opération pré-fader ou post-fader. Le témoin 
Pre vert s'allume pour indiquer que le départ est prêt pour 
une opération pré-fader. 

Mic Pre

Lorsque les paramètres Mic Pre sont affichés sur les encodeurs 
d'une tranche (dans l'affichage Mic Pre supérieur), les boutons 
B/M/P ont la fonction suivante :

• B/M/P de l'encodeur supérieur : active ou désactive l'alimen-
tation fantôme

• B/M/P de l'encodeur Gain : active ou désactive le paramètre 
HPF du préampli micro

• B/M/P de l'encodeur Source : active ou désactive le paramètre 
Insert du préampli micro

• B/M/P de l'encodeur Pad : active ou désactive le paramètre Pad 
du préampli micro

• B/M/P de l'encodeur Polarity : inverse la polarité du préampli 
micro

Pistes d'instrument

Sur les pistes d'instrument, le bouton B/M/P inférieur est utilisé 
pour contrôler l'état de mute MIDI. 
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Pistes Master VCA

Sur les pistes Master VCA, les boutons B/M/P sont utilisés pour 
contrôler l'état de mute des pistes esclaves. 

Commandes MIDI sur les pistes d'instrument

La vue Instruments de Pro Tools contient des commandes MIDI 
qui peuvent s'afficher dans l'encodeur inférieur des tranches de 
D-Control. 

Pour afficher les commandes de volume et de mute MIDI sur une 
piste d'instrument :

 Appuyez sur le bouton Input dans la section de commandes 
Channel Strip Mode de la tranche d'instrument.

Les commandes MIDI s'affichent dans l'encodeur du bas (enco-
deur 6), comme suit :

• Bouton encodeur : volume MIDI

• Bouton B/M/P : mute MIDI

• Anneau de diodes LED de l'encodeur : VU-mètre de vélocité 
MIDI

Pour afficher les commandes de panoramique MIDI :

 Maintenez le bouton Input enfoncé et appuyez sur le bouton 
Pan dans la section de commandes Channel Strip Mode de la 
tranche.

Le bouton encodeur inférieur (encodeur 6) contrôle le panora-
mique MIDI.

Pour quitter l'affichage des commandes MIDI :

 Appuyez sur un autre bouton de la section Channel Strip Mode. 

Affichage des pistes esclaves sur les pistes 
Master VCA

En mode Normal, les pistes Master VCA affichent les pistes 
esclaves sur les encodeurs rotatifs, comme suit :

• Bouton encodeur : contrôle du volume des pistes esclaves

• Anneau de diodes LED de l'encodeur : VU-mètre des pistes 
esclaves

• Bouton B/M/P de l'encodeur : mute des pistes esclaves

• Bouton Select de l'encodeur : assigne la piste esclave à la 
tranche Focus

S'il y a plus de six pistes esclaves pour un Master VCA, vous pouvez 
appuyer sur les boutons Page Up/Page Down du canal pour afficher 
les pistes esclaves supplémentaires sur les encodeurs rotatifs.
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Commandes Channel Strip Mode

Chaque tranche comporte un groupe de commandes Channel 
Strip Mode. Ces commandes permettent l'affichage et la modi-
fication des paramètres de panoramique, de plug-in, du préam-
plificateur micro, d'insert ou de départ dans la section des enco-
deurs des tranches de D-Control 

Boutons Page Up et Page Down

Les paramètres de contrôle sont organisés sur les encodeurs rotatifs 
des tranches par pages ou par groupes de six paramètres simultanés 
au maximum.

Les boutons Page Up et Page Down s'allument pour indiquer 
l'existence de pages supplémentaires de paramètres de départs, 
de panoramique, de plug-in, de préampli micro ou de pistes escla-
ves (pour les pistes Master VCA), dans la direction correspondante 
sur chaque tranche. S'il n'existe aucune autre page, aucun des 
deux boutons n'est allumé.

Pour faire défiler l'affichage des pages de paramètres vers le haut 
ou vers le bas :

 Appuyez sur un bouton Page Up ou Page Down allumé.

Boutons Dynamics et EQ

Les boutons Dynamics et EQ s'allument pour indiquer la présence 
du type de plug-in correspondant sur une tranche.

Pour afficher et modifier le premier plug-in Dynamics ou EQ d'une 
tranche sur les encodeurs rotatifs :

 Appuyez sur un bouton Dynamics ou EQ allumé. 

Pour parcourir tous les plug-in Dynamics ou EQ d'un canal :

 Appuyez plusieurs fois sur le bouton correspondant.

Commandes Channel Strip Mode

Bouton Pg Up

Bouton EQ

Bouton Pg Dn

Bouton Dyn

Bouton Input

Bouton Inserts

Bouton
Bypass/Spill

Bouton Microphone 
Preamplifier

Bouton Pan

Bouton Sends



Bouton Input

Avec les pistes audio et les pistes d'entrées auxiliaires, le bouton 
Input est utilisé pour mettre les canaux en mode Inline. Voir 
« Mode Inline Console » à la page 135.

Avec les pistes d'instrument, le bouton Input est utilisé pour 
afficher les commandes MIDI de la piste sur les encodeurs rotatifs. 
Reportez-vous à la section « Commandes MIDI sur les pistes 
d'instrument » à la page 52. 

Bouton Mic Pre

Lorsque vous appuyez sur le bouton Mic Pre, les commandes affec-
tées à un préamplificateur micro contrôlé à distance s'affichent 
sur les encodeurs rotatifs de la tranche pour modification. Les 
préamplificateurs de micro sont déclarés dans la boîte de dialogue 
Peripherals de Pro Tools et assignés à des canaux dans la boîte 
de dialogue I/O Setup de Pro Tools.

Bouton Inserts

Lorsque vous appuyez sur le bouton Inserts sur une tranche, les 
noms des plug-ins s'affichent en deux ensembles de cinq (Inserts 
A à E ou Inserts F à J) dans les affichages de l'encodeur. 

Vous pouvez utiliser le mode Flip pour transférer les commandes 
des inserts (A à J) des encodeurs du canal vers les faders. Voir 
« Mode Flip » à la page 134.

Pour basculer entre l'affichage des inserts A à E et F à J sur une 
tranche :

1  Appuyez sur le bouton Inserts dans la section de commandes 
Channel Strip Mode de la tranche pour afficher les inserts de 
niveau supérieur.

2  Appuyez sur les boutons Page Up et Page Down pour alterner 
cet affichage entre les deux ensembles de cinq départs (A à E et 
F à J). 

Pour afficher les paramètres d'un plug-in individuel :

 Appuyez sur le bouton Select de l'encodeur correspondant. 

Pour revenir au premier niveau d'affichage des plug-ins sur la 
tranche :

 Appuyez de nouveau sur le bouton Inserts.

Le bouton Inserts clignote lorsqu'un plug-in situé sur ce canal 
est écrêté. Pour effacer un écrêtage, appuyez sur le bouton Clear 
Clip de la section Session Management. Pour plus 
d'informations, reportez-vous à la section « Bouton Clear Clip 
et témoin Plug-In Clip » à la page 102.
Bouton Pan

Lorsque vous appuyez sur le bouton Pan, les commandes de 
panoramique de la tranche s'affichent dans les affichages de 
l'encodeur.

Si la piste est une piste multicanal, le bouton Page Up s'allume 
pour indiquer qu'il y a plusieurs pages de commandes de panora-
mique. Les commandes panoramiques multicanal sont organisées 
comme suit :

Pour ouvrir/fermer la fenêtre Output à l'écran pour une piste :

1  Appuyez sur le bouton Pan du canal. 

2  Maintenez la touche Démarrer (Windows) ou Ctrl (Mac) 
enfoncée et appuyez sur le bouton de l'encodeur du canal.

Panoramique surround 2-Knob

Lorsque vous travaillez en surround, vous pouvez coupler les 
commandes de panoramique avant et arrière sur D-Control 
pour faciliter le mouvement sur l'axe X dans le champ audio. 

Pour coupler les panoramiques surround avant et arrière :

1  Appuyez sur le bouton Operation dans la section Console Prefs 
jusqu'à ce que 2 KbPan s'affiche dans la section Soft Keys.

2  Appuyez sur le bouton 2 KbPan pour activer et désactiver l'option. 

Affichage Surround Pan, page 1

Affichage Commande de panoramique 

SCnt% Pourcentage central latéral (le cas échéant)

Cntr% Pourcentage haut-parleur central

F Div Divergence frontale

Rear Panoramique arrière

F/R Panoramique avant/arrière

Front Panoramique avant

Affichage Surround Pan, page 2

Affichage Commande de panoramique 

LFE Niveau d'effet sur les basses fréquences

R Div Divergence arrière

Rear Panoramique arrière

F/R Div Divergence avant/arrière

F/R Balance avant/arrière

F Div Divergence frontale
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Bouton Bypass/Spill

La fonction du bouton Bypass/Spill dépend des informations 
affichées sur la tranche. 

Inserts

 Dans l'affichage de premier niveau Inserts (lorsque le nom des 
plug-in s'affiche sur les encodeurs d'une tranche), le bouton 
Bypass/Spill permet de mettre en bypass tous les plug-ins situés 
sur ce canal.

 Lorsque les paramètres d'un seul plug-in s'affichent sur les 
encodeurs des tranches, le bouton Bypass/Spill permet de mettre 
en bypass uniquement ce plug-in.

Départs

 Dans l'affichage de premier niveau Sends (lorsque le nom des 
départs s'affiche sur les encodeurs d'une tranche), le bouton 
Bypass/Spill permet de mettre en mute tous les départs de ce 
canal.

 Lorsque les paramètres d'un seul départ s'affichent sur les 
encodeurs d'une tranche, le bouton Bypass/Spill ne produit 
aucun effet.

Pistes Master VCA

 Sur les pistes Master VCA, le bouton Bypass/Spill affiche (ou 
bascule) les pistes esclaves pour le VCA sur les Custom Faders.

Bouton Sends

Lorsque vous appuyez sur le bouton Sends sur une tranche, les 
départs s'affichent en deux ensembles de cinq (Sends A à E ou 
Sends F à J) dans les affichages de l'encodeur. Les encodeurs 
rotatifs contrôlent le niveau de départ. 

Vous pouvez utiliser le mode Flip pour transférer les commandes 
de n'importe quel départ (A à J) vers les faders. Voir « Mode Flip » 
à la page 134.

Pour basculer entre l'affichage des départs A à E et F à J sur une 
tranche :

1  Appuyez sur le bouton Sends dans la section de commandes 
Channel Strip Mode de la tranche pour afficher le premier 
niveau des départs.

2  Appuyez sur les boutons Page Up et Page Down pour alterner 
cet affichage entre les deux ensembles de cinq départs (A à E et 
F à J). 

Pour ouvrir/fermer une fenêtre Send à l'écran :

1  Appuyez sur le bouton Sends du canal de la fenêtre Send que 
vous souhaitez ouvrir ou fermer. 

2  Maintenez la touche Démarrer (Windows) ou Ctrl (Mac) 
enfoncée et appuyez sur le bouton Select de l'encodeur de la 
fenêtre Send à ouvrir ou fermer.
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Mode Send/Pan

Le mode Send/Pan permet de régler simultanément le panora-
mique et le niveau d'un départ sur un canal. En mode Send/Pan, 
le niveau du départ est contrôlé par le fader de canal et le pano-
ramique du départ par les encodeurs. 

Le mode Send/Pan permet d'afficher plusieurs départs sur des 
différents canaux ou, en utilisant les boutons Do To All ou Do 
To Selected, le même départ sur plusieurs canaux. 

En mode Send/Pan, vous pouvez coupler des commandes de 
panoramique de départs individuels aux commandes de pano-
ramique principales des pistes correspondantes (Follow Main 
Pan ou FMP). 

Pour passer en mode Send/Pan :

1  Appuyez sur le bouton Sends pour afficher les départs sur les 
encodeurs du canal.

2  Appuyez sur le bouton Select de l'encodeur correspondant au 
départ que vous voulez afficher. Les boutons Send et Pan du canal 
s’allument pour indiquer que le mode Send/Pan est activé. 

Pour revenir à l'affichage de premier niveau des départs sur la 
tranche :

 Appuyez de nouveau sur le bouton Sends. 

Pour coupler les commandes de panoramique d'un départ aux 
commandes de panoramique principales d'une piste :

1  Mettez la piste en mode Send/Pan pour le départ que vous 
souhaitez coupler. 

2  Appuyez sur le bouton B/M/P de l'un des encodeurs actifs sur 
la piste pour activer ou désactiver le statut FMP du départ.

Indication d'écrêtage d'un départ

Le bouton Sends clignote lorsqu'un départ situé sur ce canal est 
écrêté. Pour effacer un écrêtage, appuyez sur le bouton Clear 
Clip de la section Session Management. Pour plus d'informations, 
reportez-vous à la section « Bouton Clear Clip et témoin Plug-In 
Clip » à la page 102.



Commandes Channel Strip Function

Chaque tranche est équipée de commandes Channel Strip Function 
permettant de contrôler la sélection du canal et la tranche Focus, 
les modes Input Monitor et Automation, sans oublier les mises 
en mute et en solo et l'activation pour l'enregistrement, le mode 
input monitoring et le mode d'automation.

Bouton Input Monitor Mode

Le bouton Input Monitor Mode permet de sélectionner le mode 
Auto Input ou Input Only pour le monitoring de ce canal. Le 
bouton s'allume lorsque le mode Input Only est actif. 

Bouton Record Enable

Le bouton Record Enable permet d'activer et de désactiver le 
mode d'enregistrement d'un canal. Lorsque le canal est activé 
pour l'enregistrement et que la barre de transport Pro Tools est 
arrêtée, le bouton clignote. Pendant l'enregistrement, le bouton 
est allumé en continu.

Mode Record Safe : pour protéger une piste contre l'enregistrement 
à partir de D-Control, maintenez la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée et appuyez sur le bouton Record 
Enable de la piste.

Bouton Channel Select

La fonction du bouton Channel Select dépend du paramètre 
Select/Focus Mode sélectionné. Pour plus d'informations sur le 
bouton Select/Focus Mode, consultez la section « Boutons et 
témoins Sel/Focus Mode » à la page 66.

Mode Select : si le mode Select est activé (bouton Select/Focus 
Mode), le bouton Channel Select sélectionne le canal dans 
Pro Tools. Une fois le canal sélectionné, le bouton s'allume. 
Dans ce mode, vous pouvez utiliser le bouton Channel Select 
pour basculer entre les comportements verrouillage (latching) 
et OU exclusif (non-latching).

Commandes Channel Strip Function

Bouton Solo

Affichage de 
canal

Bouton
Automation Trim

Bouton Record 
Enable

Bouton Mute

Bouton Automation
Mode

Bouton Select du
canal

Bouton Input
Monitor Mode
Mode Focus : si le mode Focus est sélectionné (touche Select/ 
Focus Mode), le bouton Channel Select passe les commandes 
de ce canal sur la tranche Focus de l'unité principale. Lorsque le 
focus est mis sur ce canal, le bouton s'allume. Étant donné que 
l'on ne peut mettre le focus que sur une seule piste dans ce mode, 
le bouton Select ne peut adopter qu'un comportement OU 
exclusif (non-latching). 

Bouton Solo

Le bouton Solo permet d'activer ou de désactiver la mise en solo 
du canal. Lorsqu'un canal est mis en solo, le bouton Solo s'allume 
et les boutons Mute des autres canaux de la session clignotent 
pour indiquer une coupure du son implicite. La fonction du 
bouton Solo suit les préférences de fonctionnement de Pro Tools 
pour les opérations verrouillées.

Mode Solo Safe : pour protéger une piste contre la mise en solo 
à partir de D-Control, maintenez la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée et appuyez sur le bouton Solo de la 
piste. 

Lorsqu'une piste est protégée contre la mise en solo, le bouton 
Solo clignote une fois. 

Bouton Mute

Le bouton Mute permet d'activer ou de désactiver la coupure du 
son du canal. 

 Lorsqu'une piste est mise en mute, son bouton Mute s'allume. 

 Lorsque le son d'une piste est coupé (et qu'une autre piste est 
mise en solo), le bouton Mute clignote. 

Affichage de canal

Chaque affichage de canal présente les informations relatives 
au canal dans les modes d'affichage suivants. Dans chaque mode, 
le volume du canal en dB est indiqué lorsque l'on bouge le fader 
du canal. 

Mode Track Name : affiche uniquement le nom de la piste.

Mode Group/Name : indique le groupe auquel appartient la piste 
(par lettre de groupe) ainsi que le nom de la piste sous forme 
abrégée.

Mode Track Position Number/Name : affiche le numéro de la piste 
et son nom sous forme abrégée.

Mode Headroom : affiche l'abréviation HR, suivie de la marge de 
sécurité restante en dB.

Mode Level : affiche le volume de la piste en dB uniquement. 

Les couleurs et le rétro-éclairage utilisés par les affichages des 
canaux indiquent les paramètres suivants :

• Vert : noms et valeurs du canal

• Vert inversé : canal inactif

• Rouge : canal écrêté
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Bouton Automation Mode

Le bouton Automation Mode permet d'appliquer les différents 
modes d'automation de Pro Tools, à savoir Write, Latch, Touch, 
Read et Off. Le mode actif est signalé par les témoins du mode 
Automation, à gauche du fader de chaque canal. Lorsque le mode 
Off est activé, aucun des témoins n'est allumé.

Le bouton Automation Mode permet de sélectionner les modes 
Touch, Latch et Read pendant la lecture, mais interdit l'activation 
des modes Write et Off en cours de lecture. Pour entrer directement 
en mode Write ou Off pendant la lecture, utilisez les commandes 
Automation Mode situées en bas à droite et à gauche de l'unité 
principale. Voir « Commandes Automation Mode » à la page 68. 

Vous pouvez utiliser les boutons Do To All et Do To Selected pour 
sélectionner des modes d'automation agissant sur plusieurs 
canaux.

Pour sélectionner un mode d'automation pour un canal, effectuez 
l'une des opérations suivantes :

• Pour faire défiler les modes d'automation en avant, appuyez 
sur le bouton Automation Mode du canal.

– ou –

• Pour faire défiler les modes d'automation en arrière, main-
tenez la touche Maj enfoncée et appuyez sur le bouton 
Automation Mode du canal.

Bouton Automation Trim

Le bouton Automation Trim permet d'appliquer au canal le mode 
Trim correspondant au mode Write, Latch, Touch ou Read activé. 
Le mode Trim actif est signalé par le témoin jaune du mode Trim, 
à gauche du fader de chaque canal. Le bouton Automation Trim 
n'a aucun effet lorsque le canal est en mode Off.

Section Fader

Section Fader d'une tranche

Fader de 
canal

Témoins
AutoMatch

Témoin de mode 
Custom Fader

Témoin Group 
Status

Témoins 
Automation Mode
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Les faders tactiles des tranches de D-Control contrôlent le volume 
du canal en mode Normal, ainsi qu'un large éventail de para-
mètres en mode Flip ou Custom Fader. Lorsque l'on bouge un 
fader, l'affichage de la tranche correspondante n'indique plus 
le nom de la piste mais le niveau du volume (en mode Normal). 
En mode Flip ou Custom Fader, le nom du paramètre est remplacé 
par sa valeur. Lorsque le paramètre d'un fader est automatisé, le 
simple fait de bouger le fader lance l'écriture de l'automation. 

Témoins Automation Mode

Les témoins Automation Mode, situés à gauche du fader de chaque 
canal, indiquent le mode d'automation actif. Les modes WR 
(Write), TC (Touch) et LT (Latch) sont représentés par des témoins 
rouges, le jaune correspond au mode TM (Trim) et le vert au 
mode RD (Read). 

 En mode Write, le témoin Write clignote en permanence. 

 En mode Touch ou Latch, le témoin correspondant s'allume 
jusqu'au démarrage de l'écriture de l'automation. 

 Lorsqu'une piste en mode Latch est prête pour l'écriture de 
données d'automation, le témoin du mode Latch clignote. 

 Lorsque l'écriture de données d'automation commence, le 
témoin correspondant clignote. 

 Si l'automation du canal est désactivée (Off), aucun témoin 
n'est allumé. 

Témoin Group Status

Situé à gauche du fader de chaque canal, le témoin Group Status 
(témoin vert marqué GRP) indique, lorsqu'il est allumé, que le 
canal appartient à un groupe Mix ou Edit actif dans Pro Tools. 
Si le canal appartient à un groupe inactif, ou si les groupes sont 
suspendus, le témoin est éteint. 

Témoin de mode Custom Fader

Le témoin de mode Custom Fader (témoin bleu marqué CF) est 
situé à gauche du fader de chaque canal et indique, lorsqu'il est 
allumé, que le mode Custom Fader actif pour le canal. 

Témoins AutoMatch

Lorsqu'ils sont allumés, les témoins AutoMatch (témoins en 
forme de flèches vertes), situés à gauche du fader de chaque canal, 
indiquent, lorsqu'ils sont allumés, la direction dans laquelle 
vous devez bouger le fader afin de rétablir le dernier niveau 
d'automation appliqué à la piste. Cette fonction est très utile, 
notamment lors de la modification de l'automation du fader. 



Boutons touches de modification

Dans l'angle inférieur gauche de chaque module de faders de 
D-Control figurent quatre boutons qui reproduisent les fonctions 
des touches de modification du clavier d'ordinateur Pro Tools. 

Bouton Shift (Windows et Mac)

Le bouton Shift du module de faders a la même fonction que la 
touche Maj du clavier de D-Control.

Bouton Control (Windows et Mac)

Le bouton Control du module de faders a la même fonction que 
la touche Ctrl du clavier de D-Control. 

Bouton Win (Windows) ou Option (Mac)

Le bouton Win/Option du module de faders a la même fonction 
que la touche Démarrer (Windows) ou Option (Mac) du clavier 
de D-Control. 

Bouton Alt (Windows) ou Command (Mac)

Le bouton Alt/Command du module de faders a la même fonction 
que la touche Alt (Windows) ou Commande (Mac) du clavier 
de D-Control.

Section Channel Strip Master

La section Channel Strip Master (Figure 2) regroupe des com-
mandes affectées aux canaux. Ces commandes figurent à gauche 
et à droite de l'unité principale de D-Control, l'utilisateur peut 
donc y accéder facilement à partir de toutes les positions de 
mixage. Lorsque vous utilisez les commandes de cette section, 
chaque opération est systématiquement répercutée sur les deux 
groupes de commandes.

Touches de modification (Module Fader)

L'ordre des boutons de modification du module de 
faders est identique à celui des touches 
correspondantes sur un clavier Windows ou Mac, de 
gauche à droite.

Shift (Maj) Ctrl Démarrer 
(Windows) 

Option (Mac)

Alt (Windows) 
 Commande 

(Mac)
Boutons Flip

Les six boutons Flip jaunes de la section Channel Strip Master 
correspondent aux six rangées horizontales d'encodeurs rotatifs 
des tranches de D-Control.

Mode Flip

Les boutons Flip appellent le mode Flip, qui transfère les comman-
des de l'encodeur rotatif correspondant vers le fader de chaque 
tranche, ce qui permet de modifier et d'automatiser facilement 
les paramètres des départs, plug-ins, préamplis micro et pano-
ramiques, à partir des faders de canaux. 

En mode Flip, la commande de l'encodeur rotatif est transférée 
vers le fader du canal ; le bouton Select de l'encodeur permute 
avec le bouton Select du canal ; le bouton Bypass/Mute/Pre de 
l'encodeur et le bouton Mute du canal permutent, tout comme 
l'affichage de l'encodeur et l'affichage du canal. 

En mode Flip, le bouton Flip de la rangée d'encodeurs concernée 
s'allume, et les affichages des encodeurs permutés s'affichent 
en jaune.

Pistes d'instrument et mode Flip

En mode Flip, les commandes des pistes d'instrument sont 
transférées comme suit :

• Le fader de chaque canal contrôle le paramètre (volume ou 
panoramique MIDI) affecté à l'encodeur inférieur, qui contrôle 
à son tour le volume des pistes.

• Le bouton Mute du canal contrôle la fonction MIDI Mute, et 
le bouton B/M/P de l'encodeur inférieur contrôle la mise en 
mute du canal.

Pour transférer des commandes d'une rangée d'encodeurs rotatifs 
vers les faders de canal :

 Appuyez sur le bouton Flip correspondant à la rangée 
d'encodeurs.

Pour quitter le mode Flip :

 Appuyez sur un bouton Flip allumé.

Lorsque D-Control est en mode Flip et que vous passez au mode 
Make Inactive ou Assign, le mode Flip est temporairement 
désactivé, mais le bouton Flip reste allumé. Lorsque vous 
quittez le mode Make Inactive ou Assign, les commandes 
reviennent à leur position en mode Flip. 
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Figure 2. Section Channel Strip Master
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Variante du mode Flip, le mode Flop transfère les commandes 
des cinq premières rangées d'encodeurs rotatifs vers la rangée 
d'encodeurs du bas, permettant ainsi d'accéder plus facilement 
à ces commandes depuis toutes les positions de mixage. 

En mode Flop, la rangée d'encodeurs transférée occupe la rangée 
du bas, les boutons Flip des deux rangées s'allument et les affi-
chages de leurs encodeurs respectifs s'affichent en jaune. 

Pour transférer des commandes depuis l'une des cinq rangées 
supérieures d'encodeurs vers la rangée d'encodeurs inférieure :

 Maintenez la touche Démarrer (Windows) ou Ctrl (Mac) en-
foncée et appuyez sur le bouton Flip correspondant à la rangée 
d'encodeurs.

Pour quitter le mode Flop :

 Appuyez sur l'un des boutons Flip allumés.

Commandes Make Inactive

Les commandes Make Inactive permettent de désactiver les pistes, 
entrées, sorties, départs ou inserts. Chaque bouton place D-Control 
dans un mode Make Inactive temporaire, dans lequel les éléments 
sont désactivés ou réactivés. Le bouton clignote lorsque le mode 
Make Inactive est actif. 

Désactivation d'une piste

En mode Make Inactive, les boutons Select de canal s'allument 
sur toutes les pistes.

Pour activer ou désactiver une piste :

1  Appuyez sur l'un des boutons Make Inactive.

2  Appuyez sur le bouton Select de la tranche pour chaque piste 
à désactiver ou activer. 

3  Appuyez sur le bouton Make Inactive qui clignote pour quitter 
le mode Inactive.

Lorsque D-Control est en mode Make Inactive ou Assign, le 
mode Flop est temporairement désactivé, mais le bouton Flip 
reste allumé. Lorsque vous quittez le mode Make Inactive ou 
Assign, les commandes reviennent à leur position en mode 
Flop. 

Commandes Make Inactive

Bouton de désactivation 
Inserts

Bouton de désactivation 
Outputs

Bouton de 
désactivation 
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Bouton de 
désactivation 
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Bouton de désactivation Inputs

Le bouton Inputs appelle le mode Inputs Inactive et affiche les 
entrées du canal sur la rangée d'encodeurs du bas. Le bouton 
Bypass/Mute/Pre de l'encodeur du bas permet d'activer et de 
désactiver l'entrée.

Bouton de désactivation Outputs

Le bouton Outputs appelle le mode Outputs Inactive et affiche 
les sorties principales du canal sur la rangée des encodeurs du 
bas. Le bouton Bypass/Mute/Pre de l'encodeur du bas permet 
d'activer et de désactiver la sortie.

Bouton de désactivation Sends

Le bouton Sends appelle le mode Sends Inactive et affiche les 
départs du canal sur ses encodeurs. Le bouton Bypass/Mute/Pre 
de chaque encodeur permet d'activer et de désactiver le départ 
correspondant.

Bouton de désactivation Inserts

Le bouton Inserts appelle le mode Inserts Inactive et affiche les 
inserts d'un canal sur ses encodeurs. Le bouton Bypass/Mute/Pre 
de chaque encodeur permet d'activer et de désactiver l'insert 
correspondant.

Pour activer ou désactiver une entrée, une sortie, un départ ou un 
insert :

1  Vérifiez que le canal indique l'affichage de premier niveau 
pour l'élément que vous souhaitez activer ou désactiver.

2  Appuyez sur le bouton Make Inactive pour activer le mode Make 
Inactive approprié. 

3  Appuyez sur le bouton Bypass/Mute/Pre des encodeurs pour 
désactiver ou réactiver les éléments correspondants sur la piste.

4  Appuyez sur le bouton Make Inactive clignotant pour quitter 
le mode Inactive.

Commandes Plug-In Automation

Les commandes Plug-In Automation permettent d'activer l'auto-
mation des paramètres et de les protéger contre tout risque 
d'écrasement.

Bouton Enable

Le bouton Enable permet d'activer l'automation des paramètres, 
par simple contact ou pression sur les commandes correspondantes. 

Commandes Plug-in Automation

Bouton 
Automation Safe

Bouton Enable Parameter
En mode Enable Parameters, le bouton Enable est allumé. Dans 
ce mode, le témoin Auto rouge des encodeurs rotatifs activés 
pour l'automation s'allume, et le bouton des paramètres dont 
l'automation est activée est allumé. 

Pour activer et désactiver l'automation des paramètres de 
plug-ins :

1  Appuyez sur le bouton Enable.

2  Utilisez les encodeurs rotatifs ou appuyez sur les boutons des 
commandes dont vous souhaitez activer ou désactiver l'automation. 

3  Pour quitter le mode Enable Parameters, appuyez de nouveau 
sur le bouton Enable.

Bouton Safe

Le bouton Safe appelle un mode dans lequel le bouton Bypass/ 
Mute/Pre de chaque plug-in ou départ, ainsi que le bouton de 
sélection de canal de chaque piste sont convertis en boutons 
Safe.

Plug-ins et départs

Lorsque le mode Automation Safe est activé, vous pouvez protéger 
l'automation d'un plug-in ou d'un départ contre tout risque 
d'écrasement en appuyant sur le bouton Bypass/Mute/Pre de ce 
plug-in ou départ. Le bouton Bypass/Mute/Pre de tout plug-in 
ou départ protégé s'allume, indiquant le statut du bouton Safe 
dans la fenêtre de sortie du plug-in ou du départ affichée à l'écran. 

Pistes

En mode Automation Safe, vous pouvez empêcher que les para-
mètres de volume, de panoramique et de mute ne soient écrasés, 
en appuyant sur le bouton de sélection de canal. Le bouton Select 
de canal de toutes les pistes protégées s'allume, et le statut du 
bouton Safe est indiqué dans la fenêtre de sortie de la piste.

Pour activer et désactiver le mode Automation Safe :

1  Appuyez sur le bouton Safe.

2  Appuyez sur le bouton Select de canal des pistes dont vous 
souhaitez activer ou désactiver le statut Automation Safe. Le 
statut Automation Safe de la piste est indiqué par le bouton Safe 
dans la fenêtre de sortie de la piste. 

3  Appuyez sur le bouton Bypass/Mute/Pre des plug-ins ou départs 
dont vous souhaitez activer ou désactiver le statut Automation 
Safe. 

4  Pour quitter ce mode, appuyez de nouveau sur le bouton Safe.

Vous pouvez également activer ou désactiver l'automation 
d'un paramètre de plug-in en maintenant les touches Ctrl+ 
Alt+Démarrer (Windows) ou Commande+Option +Ctrl 
(Mac) enfoncées et en sélectionnant l'encodeur rotatif du 
paramètre.
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Commandes Assign

Les commandes Assign permettent d'assigner aux canaux des 
entrées, sorties, inserts et départs. Chaque bouton active un 
mode Assign temporaire, dans lequel des éléments sont affectés 
aux canaux ou supprimés de ces derniers. Le bouton clignote 
lorsque le mode Assign est actif.

Vous pouvez activer le mode Assign pendant la lecture dans 
Pro Tools. Pour confirmer l'affectation des entrées, sorties et 
départs, la barre de transport doit être arrêtée. Vous pouvez 
néanmoins confirmer les affectations d'inserts pendant la lecture.

Bouton Assign Inputs

Le bouton Inputs appelle le mode Assign Inputs dans lequel les 
entrées du canal s'affichent dans la rangée des encodeurs du bas. 

Lors de l'assignation d'une entrée, le bouton Select de l'encodeur 
du bas permet de naviguer vers le bas dans l'arborescence du 
menu Input, et le bouton encodeur sert à parcourir les choix 
disponibles à chaque niveau :

• Type d'entrée (Interface ou Bus), affiché en jaune

• Entrées individuelles, affichées en vert

Le bouton Bypass/Mute/Pre de l'encodeur du bas permet de 
remonter dans l'arborescence du menu Input.

Bouton Assign Outputs

Le bouton Outputs appelle le mode Assign Outputs dans lequel 
les sorties du canal s'affichent dans la rangée des encodeurs du 
bas.

Lors de l'assignation d'une sortie, le bouton Select de l'encodeur 
du bas permet de naviguer vers le bas dans l'arborescence du 
menu Output, et le bouton encodeur sert à parcourir les choix 
disponibles à chaque niveau :

• Type de sortie (Interface ou Bus), affiché en jaune

• Sorties individuelles, affichées en vert

Le bouton Bypass/Mute/Pre de l'encodeur du bas permet de 
remonter dans l'arborescence du menu Output.

Commandes Assign

Bouton 
d'assignation 

Inputs

Bouton 
d'assignation 

Sends

Bouton d'assignation 
Outputs

Bouton d'assignation 
Inserts
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Bouton Assign Sends

Le bouton Sends appelle le mode Assign Sends dans lequel les 
départs d'un canal s'affichent sur les encodeurs du canal. 

Lors de l'assignation d'un départ, le bouton Select de l'encodeur 
permet de naviguer vers le bas dans l'arborescence du menu Send, 
et le bouton encodeur sert à parcourir les choix disponibles à 
chaque niveau :

• Type de départ (Interface ou Bus), affiché en jaune

• Départs individuels, affichés en vert

Le bouton Bypass/Mute/Pre de chaque encodeur permet de 
remonter dans l'arborescence du menu Send.

Bouton Assign Inserts

Le bouton Inserts appelle le mode Assign Inserts dans lequel les 
inserts d'un canal s'affichent sur les encodeurs du canal. Lors de 
l'affectation d'un insert, le bouton Select de l'encodeur permet 
de naviguer vers le bas dans l'arborescence du menu Insert, et le 
bouton encodeur sert à parcourir les choix disponibles à chaque 
niveau. Le bouton Bypass/Mute/Pre de l'encodeur du bas permet 
de remonter dans l'arborescence du menu Insert.

L'ordre dans lequel les plug-in s'affichent dans le menu Insert 
est déterminé par la préférence d'affichage de Pro Tools pour 
l'organisation des plug-ins. 

Si l'option Organize Plug-In Menus by Category est sélectionnée, 
les options et niveaux de menus proposés sont les suivants :

• Type d'insert (plug-in TDM ou TDM multi-mono, RTAS ou 
RTAS multi-mono, ou insert matériel), affiché en jaune

• Sous-dossier Plug-In (par exemple EQ, Dynamics, Pitch Shift, 
Reverb ou Delay), affiché en jaune

• Insert ou plug-in individuel, affiché en vert

Si l'option Organize Plug-In Menus by Category n'est pas sélec-
tionnée, le niveau du sous-dossier Plug-In n'est pas disponible.

Pour assigner une entrée, une sortie, un départ ou un insert :

1  Appuyez sur le bouton Assign pour activer le mode Assign 
souhaité. 

2  Sur le canal sur lequel vous souhaitez effectuer une affectation, 
utilisez un bouton encodeur pour sélectionner le premier niveau 
du menu.

3  Appuyez sur le bouton Select de l'encodeur pour accéder aux 
niveaux du menu inférieurs et sur le bouton Bypass/Mute/Pre 
pour passer aux niveaux du menu supérieurs. 

4  Effectuez l'une des opérations suivantes :

• Appuyez sur le bouton clignotant Select de l'encodeur ou 
sur le bouton Assign clignotant pour confirmer l'affectation. 

– ou –

• Pour annuler l'affectation, appuyez sur le bouton Esc 
clignotant.



Pour affecter plusieurs entrées, sorties, départs ou inserts :

1  Appuyez sur le bouton Assign pour activer le mode Assign 
souhaité. 

2  Utilisez les boutons encodeurs et appuyez sur les boutons 
Select et Bypass/Mute/Pre pour définir chaque affectation.

3  Effectuez l'une des opérations suivantes :

• Appuyez sur le bouton Assign clignotant pour confirmer 
simultanément toutes les affectations. 

– ou –

• Pour annuler les affectations, appuyez sur le bouton Esc 
clignotant.

Pour supprimer une entrée, une sortie, un départ ou un insert :

1  Appuyez sur le bouton Assign pour activer le mode Assign 
souhaité. 

2  Pour supprimer l'affectation, appuyez plusieurs fois sur le 
bouton Bypass/Mute/Pre de l'encodeur pour atteindre le 
premier niveau du menu d'assignation. 

3  Tournez le bouton encodeur dans le sens contraire des 
aiguilles d'une montre jusqu'à ce qu'aucune assignation ne soit 
plus visible. 

4  Effectuez l'une des opérations suivantes :

• Appuyez sur le bouton clignotant Select de l'encodeur ou 
sur le bouton Assign clignotant pour confirmer la 
suppression. 

– ou –

• Pour annuler la suppression et restaurer l'affectation, 
appuyez sur le bouton Esc clignotant.

Annulation des assignations de plug-ins

Vous pouvez utiliser le bouton Set to Default pour supprimer 
rapidement les assignations de plug-ins aux pistes, sans passer 
par le mode Assign.

Pour supprimer rapidement des assignations de plug-ins :

1  Appuyez sur le bouton Set to Default.

2  Appuyez sur le bouton Select de l'encodeur de chaque 
affectation de plug-in à supprimer. 

3  Appuyez sur le bouton Set to Default clignotant.

Assignation d'entrées et de sorties MIDI sur des 
pistes d'instrument

Les boutons Inputs et Outputs de la section Assign permettent 
d'affecter les entrées et sorties MIDI sur des pistes d'instrument.

Cette méthode supprime les affectations immédiatement 
et ne peut être annulée. 
Pour affecter une entrée ou sortie MIDI sur une piste 
d'instrument :

1  Appuyez sur le bouton Inputs ou Outputs de la section Assign 
pour passer au mode Assign correspondant. La rangée d'enco-
deurs 5 affiche les entrées/sorties MIDI.

2  Utilisez le potentiomètre de la rangée d'encodeurs 5 sur chaque 
canal sur lequel vous souhaitez effectuer une affectation pour 
sélectionner le premier niveau de choix du menu MIDI.

3  Appuyez sur le bouton Select de l'encodeur pour accéder aux 
niveaux inférieurs et sur le bouton Bypass/Mute/Pre pour accéder 
aux niveaux supérieurs du menu MIDI.

4  Effectuez l'une des opérations suivantes :

• Appuyez sur le bouton clignotant Select de l'encodeur ou sur 
le bouton Assign clignotant pour confirmer les affectations.

– ou –

• Pour annuler les affectations, appuyez sur le bouton Esc 
clignotant. 

Commandes Switch Information

Les commandes Switch Information permettent de changer le 
mode et l'affichage des boutons Bypass/Mute/Pre de l'encodeur 
et, de manière plus générale, d'afficher la valeur des paramètres 
de l'encodeur.

Bouton Switch Mode (SW MODE)

Le bouton Switch Mode permet de basculer les fonctions du 
bouton Bypass/Mute/Pre de l'encodeur entre Mute et Pre-Fader 
lorsque les départs s'affichent sur les encodeurs.

• Si le mode Bypass est activé, le bouton B/M/P de l'encodeur 
met en mute le départ correspondant.

• Si le mode Pre est activé, le bouton B/M/P du encodeur définit 
un mode d'opération pré-fader ou post-fader pour le départ 
correspondant.

Pour définir le Switch Mode :

 Appuyez plusieurs fois sur le bouton Switch Mode jusqu'à ce 
que le témoin souhaité s'allume (Mute ou Pre). 

Commandes Switch Information

Témoin de mode 
Pre-fader 

Bouton Show ValBouton Sw 
Info

Témoin de 
mode Mute

Bouton Switch Mode
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Bouton Switch Info (Sw Info)

Le bouton Switch Info permet de parcourir les valeurs ou de les 
afficher de façon momentanée. Si vous appuyez rapidement 
dessus, l'affichage de l'encodeur indique la fonction affectée au 
bouton Bypass/Mute/Pre de chaque encodeur rotatif. Si vous le 
maintenez enfoncé, la fonction s'affiche jusqu'à ce que vous 
relâchiez le bouton. 

Bouton Show Values (Show Val)

Le bouton Show Values permet de parcourir les valeurs ou de les 
afficher de façon momentanée. Si vous appuyez rapidement 
dessus, l'affichage de l'encodeur indique successivement le nom 
et la valeur du paramètre. Si vous le maintenez enfoncé, la valeur 
du paramètre s'affiche jusqu'à ce que vous relâchiez le bouton. 

Commandes Automation Enable

Les commandes Automation Enable permettent d'activer ou de 
suspendre l'écriture de chaque type d'automation sur tous les 
canaux. Ces commandes ont les mêmes fonctions que les bou-
tons correspondants dans la fenêtre Automation Enable. 

 Lorsque l'écriture est activée pour un type d'automation mais 
n'effectue aucun enregistrement sur une piste dans la session, 
le bouton correspondant s'allume. 

 Lorsque l'écriture est activée pour un type d'automation et 
qu'elle effectue un enregistrement sur une piste dans la session, 
le bouton correspondant clignote. 

Bouton Inserts

Le bouton Inserts active et suspend l'écriture de l'automation 
de tous les paramètres de plug-ins activés pour l'automation, 
sur toutes les pistes de la session.

Bouton Vol

Le bouton Vol active et suspend l'écriture de l'automation de 
volume d'un canal, sur toutes les pistes d'une session. 

Bouton Pan

Le bouton Pan active et suspend l'écriture de l'automation de 
panoramique d'un canal, sur toutes les pistes d'une session. 

Commandes Automation Enable

Bouton Enable 
Inserts 
Automation

Bouton Enable 
Send Volume 
Automation

Bouton Enable 
Send Pan 
Automation

Bouton Enable 
Send Mute 
Automation

Bouton Enable
Volume

Automation

Bouton Enable
Pan

Automation

Bouton Enable
Mute

Automation
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Bouton Mute

Le bouton Mute active et suspend l'écriture de l'automation de 
mise en mute d'un canal, sur toutes les pistes d'une session. 

Bouton Snd Vol

Le bouton Snd Vol active et suspend l'écriture de l'automation 
de volume d'un départ, sur toutes les pistes d'une session. 

Bouton Snd Pan

Le bouton Snd Pan active et suspend l'écriture de l'automation 
de panoramique d'un départ, sur toutes les pistes d'une session. 

Bouton Snd Mute

Le bouton Snd Mute active et désactive l'écriture de l'automation 
de mise en mute d'un départ, sur tous les canaux. 

Commandes Auto Write To

Les commandes Auto Write To appellent les commandes manuelles 
Write to Start/End/All/Punch/Next et les commandes d'auto-
mation automatiques Write to Start/End/All/Punch/Next on 
Stop dans Pro Tools.

Vous pouvez également appeler les commandes Write to Start/ 
End/All/Punch/Next dans la section Soft Keys de D-Control. 

Bouton All

Lors d'une passe d'automation, le bouton All applique la valeur 
d'automation actuelle à une sélection ou à une piste entière, 
pour tous les paramètres activés pour l'écriture.

Pour écrire manuellement des données d'automation à l'ensemble 
d'une sélection ou d'une piste :

 Appuyez sur le bouton All pendant la lecture.

Pour écrire des données d'automation à l'ensemble d'une 
sélection ou d'une piste à l'arrêt :

 Maintenez la touche Démarrer (Windows) ou Ctrl (Mac) en-
foncée et appuyez sur le bouton All.

Boutons Auto Write To

Bouton 
d'automation 
Write to All

Bouton 
d'automation 
Write to End

Bouton 
d'automation 
Write to Next

Bouton
d'automation
Write to Start

Bouton
d'automation

Write to Punch



Pour configurer la commande Write to All on Stop de façon à ce 
qu'elle reste activée après une passe d'automation :

 Maintenez les touches Alt+Démarrer (Windows) ou Option+ 
Ctrl (Mac) enfoncées et appuyez sur le bouton All. 

Pour désactiver la fonction automatique Write to All on Stop :

 Appuyez sur le bouton All clignotant.

Bouton Start

Lors d'une passe d'automation, le bouton Start applique la valeur 
d'automation actuelle au début d'une sélection ou d'une piste, 
pour tous les paramètres activés pour l'écriture. 

Pour écrire manuellement des données d'automation au début 
d'une sélection ou d'une piste :

 Appuyez sur le bouton Start pendant la lecture.

Pour écrire des données d'automation au début d'une sélection ou 
d'une piste à l'arrêt :

 Maintenez la touche Démarrer (Windows) ou Ctrl (Mac) en-
foncée et appuyez sur le bouton Start.

Pour configurer la commande Write to Start on Stop de façon à ce 
qu'elle reste activée après une passe d'automation :

 Maintenez les touches Alt+Démarrer (Windows) ou Option+ 
Ctrl (Mac) enfoncées et appuyez sur le bouton Start. 

Pour désactiver Write to Start on Stop : 

 Appuyez sur le bouton Start clignotant.

Bouton End

Lors d'une passe d'automation, le bouton End applique la valeur 
d'automation actuelle à la fin d'une sélection ou d'une piste, 
pour tous les paramètres activés pour l'écriture.

Pour écrire manuellement des données d'automation à la fin d'une 
sélection ou d'une piste :

 Appuyez sur le bouton End pendant la lecture.

Pour écrire des données d'automation à la fin d'une sélection ou 
d'une piste à l'arrêt :

 Maintenez la touche Démarrer (Windows) ou Ctrl (Mac) en-
foncée et appuyez sur le bouton End. 

Pour configurer la commande Write to End on Stop de façon à ce 
qu'elle reste activée après une passe d'automation :

 Maintenez les touches Alt+Démarrer (Windows) ou Option+ 
Ctrl (Mac) enfoncées et appuyez sur le bouton End. 

Pour désactiver la fonction automatique Write to End on Stop :

 Appuyez sur le bouton End clignotant.
Bouton Punch

Le bouton Punch applique la valeur d'automation actuelle à 
partir du point d'entrée précédent (point de la piste à partir 
duquel la passe d'automation actuelle a débuté), pour tous les 
paramètres activés pour l'écriture. 

Pour écrire manuellement des données d'automation à partir du 
point d'entrée précédent :

 Appuyez sur le bouton Punch pendant la lecture.

Pour écrire des données d'automation à partir du point d'entrée 
précédent à l'arrêt :

 Maintenez la touche Démarrer (Windows) ou Ctrl (Mac) en-
foncée et appuyez sur le bouton Punch. 

Pour configurer la commande Write to Punch on Stop de façon à ce 
qu'elle reste activée après une passe d'automation :

 Maintenez les touches Alt+Démarrer (Windows) ou Option+ 
Ctrl (Mac) enfoncées et appuyez sur le bouton Punch. 

Pour désactiver la fonction automatique Write to Punch on Stop :

 Appuyez sur le bouton Punch clignotant.

Bouton Next

Le bouton Next applique la valeur d'automation actuelle jusqu'au 
point d'inflexion d'automation suivant, pour tous les paramètres 
activés pour l'écriture. 

Contrairement aux autres commandes Write To, la commande 
Write to Next on Stop reste toujours activée après une passe 
d'automation jusqu'à ce que vous la désactiviez. 

Pour écrire manuellement des données d'automation jusqu'au 
point d'inflexion suivant :

 Appuyez sur le bouton Next pendant la lecture.

Pour configurer la commande Write to Next on Stop de façon à ce 
qu'elle reste activée après une passe d'automation :

 Maintenez la touche Démarrer (Windows) ou Ctrl (Mac) 
enfoncée et appuyez sur le bouton Next. 

Pour désactiver la fonction automatique Write to Next on Stop :

 Appuyez sur le bouton Next clignotant.
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Commandes Global

Les commandes Global permettent d'appliquer des comman-
des affectant plusieurs canaux de différentes façons. 

Boutons Do To All et Do To Selected

Les boutons Do To All et Do To Selected de D-Control peuvent 
s'utiliser de deux façons : pour appliquer des actions à plusieurs 
pistes dans une session Pro Tools, et pour changer le mode d'af-
fichage de plusieurs tranches sur D-Control.

Les boutons Do To All et Do To Selected suivent un comportement 
continu ou momentané. 

 Lorsque vous appuyez dessus, leur effet s'applique uniquement 
à l'opération suivante. 

 Si vous les maintenez enfoncés, leur effet s'applique à toutes 
les opérations effectuées jusqu'à leur relâchement. 

 Si vous appuyez deux fois dessus, leur action est continue et 
ils clignotent jusqu'à ce que vous appuyiez de nouveau dessus.

Application d'actions à plusieurs pistes de Pro Tools

Les boutons Do To All et Do To Selected sont très pratiques lorsqu'il 
s'agit d'exécuter des tâches telles que la mise en mute, en solo, 
l'affectation de départs ou d'un même plug-in à plusieurs pistes 
d'une session. 

Pour appliquer des actions à plusieurs pistes dans une session 
Pro Tools :

1  Effectuez l'une des opérations suivantes :

• Appuyez sur le bouton Do To All ou Do To Selected pour 
appliquer l'action à un seul paramètre. 

– ou –

• Appuyez deux fois sur le bouton Do To All ou Do To Selected 
pour appliquer l'action correspondante à plusieurs para-
mètres. 

2  Appuyez sur l'un des boutons suivants pour appliquer l'action 
correspondante à l'ensemble des pistes de la session en cours ou 
uniquement aux pistes sélectionnées :

• Bouton Mute de canal

• Bouton Solo de canal

• Mode Solo Safe de canal : touche Ctrl (Windows) ou 
Commande (Mac) + bouton Solo

• Bouton Automation Mode

• Bouton Automation Trim

• Bouton Select de canal (en mode Select)

• Bouton Record Enable

Commandes Global

Bouton Do to
Selected

Bouton Set to
Default

Bouton Suspend 
Groups

Bouton Do to All
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• Mode Record Safe : touche Ctrl (Windows) ou Commande 
(Mac) + bouton Record Enable

• Bouton Input Monitor Mode

3  En fonction du mode d'affichage actuel des tranches, vous 
pouvez appliquer les paramètres suivants à toutes les pistes de la 
session ou uniquement aux pistes sélectionnées :

• Commandes Mic Pre : Polarity, Pad, Impedance, Source, Gain

• Send Pre/Post : bouton B/M/P en mode Send Pre/Post

• Send Mute : bouton B/M/P en mode Send Mute

• Plug-in Bypass : bouton B/M/P en mode Inserts

4  Vous pouvez également appliquer les opérations suivantes à 
toutes les pistes de la session ou uniquement aux pistes sélec-
tionnées :

• Affectation d'entrées, de sorties, d'inserts et de départs

• Désactivation d'entrées, de sorties, d'inserts, de départs et 
de pistes

• Réinitialisation des commandes à l'aide du bouton Set to 
Default

• Modification du couplage de panoramiques

• Modification du choix de l'éditeur de panoramique

5  Lorsque vous avez terminé, si les boutons Do To all ou Do To 
Selected sont verrouillés, appuyez sur le bouton Do To All ou Do 
To Selected clignotant pour quitter le mode correspondant.

Modification de l'affichage des paramètres des tranches de 
D-Control

Les boutons Do To All et Do To Selected permettent également 
d'afficher et de modifier les paramètres de panoramique, du 
préampli micro, d'insert ou de départ à toutes les pistes de la 
session ou uniquement aux pistes sélectionnées. 

Les boutons Do To All et Do To Selected s'appliquent indépen-
damment aux tranches en mode Normal et en mode Custom Fa-
der. Le mode d'affichage de la tranche Focus n'est pas affecté 
par les opérations Do To All ou Do To Selected.

Ce fonctionnement indépendant permet d'appliquer plusieurs 
modes d'affichage à différentes banques de canaux en une seule 
opération, par exemple le mode Pan pour les canaux en mode 
Normal, le mode Plug-In pour les canaux en mode Custom Fader 
et le mode Sends sur la tranche Focus.

Pour changer le mode d'affichage des tranches de D-Control :

1  Appuyez sur le bouton Do To All ou Do To Selected.

2  Sur chaque canal, appuyez sur l'une des boutons Channel Strip 
Mode suivants afin d'appliquer l'action correspondante à tous 
les canaux de D-Control ou tous les canaux sélectionnés :

• Bouton Dynamics

• Bouton EQ

• Bouton Input

• Bouton Microphone Preamplifier

• Bouton Inserts

• Bouton Pan

• Bouton Bypass/Spill

• Bouton Sends



3  Lorsque vous avez terminé, si les boutons Do To all ou Do To 
Selected sont verrouillés, appuyez sur le bouton Do To All ou Do 
To Selected clignotant pour quitter le mode correspondant.

Bouton Set to Default

Le bouton Set to Default permet de rétablir les valeurs par défaut 
des paramètres dans la surface D-Control. Cette touche fonc-
tionne à la fois en mode Normal et Custom Fader. 

L'action du bouton Set to Default peut être momentanée ou 
verrouillée. Lorsque vous appuyez dessus, son effet s'applique 
uniquement à l'opération suivante. Si vous appuyez deux fois 
dessus, elle s'active en continu et clignote jusqu'à ce que vous 
appuyiez de nouveau dessus. 

Lorsque vous appuyez sur le bouton Set to Default ou qu'il est 
activé en continu, vous pouvez réinitialiser les paramètres 
suivants :

Pour remettre à 0 dB le volume du canal d'une piste :

 Appuyez sur le bouton Set to Default + le bouton Select du 
canal.

– ou –

 Maintenez la touche Alt (Windows) ou Option (Mac) enfoncée 
et touchez le fader du canal. 

Pour remettre à 0 (centre) la commande de panoramique d'un 
canal :

 Appuyez sur le bouton Set to Default + le bouton Select de 
l'encodeur de panoramique. 

Pour remettre à 0 dB le niveau d'un départ : 

 Appuyez sur le bouton Set to Default + le bouton Select de 
l'encodeur de départ. Cela permet de régler le niveau du départ 
sur 0 dB, quel que soit le paramètre Send défini par défaut dans 
les préférences de fonctionnement de Pro Tools.

Commandes Channel Strip Mode

Au lieu d'utiliser le bouton Set To Default, vous pouvez 
également maintenir la touche Alt (Windows) ou Option 
(Mac) enfoncée et appuyer sur le bouton correspondant 
pour rétablir les valeurs par défaut des paramètres.

Vous pouvez également utiliser le bouton Set to Default pour 
supprimer les affectations de plug-ins des canaux. Voir 
« Annulation des assignations de plug-ins » à la page 61.

Bouton Microphone
Preamplifier

Bouton Pan

Bouton Sends

Bouton EQBouton Dyn

Bouton Input

Bouton Inserts

Bouton
Bypass/Spill
Pour remettre à 0 dB la valeur de gain du préampli micro d'un 
canal : 

 Appuyez sur le bouton Set to Default + le bouton Select de 
l'encodeur de gain du préampli micro.

Pour remettre à 0 dB la valeur de gain d'un canal LFE :

 Appuyez sur le bouton Set to Default + le bouton Select de 
l'encodeur du canal LFE.

Pour définir les valeurs par défaut des paramètres d'un plug-in 

 Appuyez sur le bouton Set to Default + le bouton Compare du 
plug-in (le bouton Compare est disponible dans les sections 
Dynamics et EQ de D-Control, ainsi que dans le mode Custom 
Fader Expanded Plug-in).

Bouton Suspend Groups

Le bouton Suspend Groups suspend tous les groupes de la session. 

Son action est continue, et elle clignote pour indiquer les groupes 
suspendus. Pour quitter le mode Suspend Groups, appuyez de 
nouveau sur le bouton Suspend Groups. 

Commandes Global Channel Strip Mode

Les commandes Global Channel Strip Mode permettent d'afficher 
et de modifier les paramètres de panoramique, de préampli micro, 
d'insert ou de départ de toutes les pistes d'une session. Ces com-
mandes n'affectent les tranches dans aucun mode Custom Fader. 

Boutons Pg Up et Pg Dn

Les boutons Pg Up et Pg Dn de la section Global Channel Strip 
Mode permettent de modifier l'affichage des pages sur toutes 
les tranches. 

 Pour déplacer vers le haut ou vers le bas l'affichage des pages 
de paramètres de tous les encodeurs rotatifs, appuyez sur les 
boutons Pg Up ou Pg Dn.

Commandes Global Channel Strip Mode

Bouton Dyn global

Bouton Input global

Bouton Inserts global

Bouton EQ 
global

Bouton Mic Pre 
global

Bouton Pan 
global

Bouton Sends 
global

Boutons Pg Up 
et Pg Dn globaux
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Boutons Dyn et EQ

Les boutons Dyn et EQ de la section Global Channel Strip Mode 
affichent le premier plug-in du type correspondant sur les enco-
deurs rotatifs de tous les canaux. Pour parcourir tous les plug-in 
Dynamics ou EQ de tous les canaux, appuyez plusieurs fois sur 
le bouton correspondant.

Bouton Input

Le bouton Input de la section Global Channel Strip Mode permet 
d'appliquer à tous les canaux le mode Inline (pistes audio ou 
d'entrée auxiliaire) ou d'afficher les commandes MIDI sur les 
encodeurs rotatifs (pistes d'instrument). 

Reportez-vous aux sections « Mode Inline Console » à la page 135 
et « Commandes MIDI sur les pistes d'instrument » à la page 52. 

Bouton Mic Pre

Le bouton Mic Pre de la section Global Channel Strip Mode 
affiche les commandes des préamplificateurs micro contrôlés à 
distance sur les encodeurs rotatifs de tous les canaux.

Bouton Inserts

Le bouton Inserts de la section Global Channel Strip Mode affiche 
les inserts sur les encodeurs rotatifs de tous les canaux.

Bouton Pan

Le bouton Pan de la section Global Channel Strip Mode affiche 
les commandes de panoramique des canaux sur les encodeurs 
rotatifs de tous les canaux.

Bouton Sends

Le bouton Sends de la section Global Channel Strip Mode affiche 
les commandes de départ sur les encodeurs rotatifs de tous les 
canaux. 
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Commandes Channel Strip Master Function

Les commandes Channel Strip Master Function permettent de 
changer les modes des boutons Select des canaux et de leurs 
affichages, d'effacer les statuts Solo et Mute et, de façon plus 
générale, de suspendre l'automation. 

Bouton Esc

Le bouton Esc permet de sortir d'un mode, d'annuler des opéra-
tions ou de fermer des boîtes de dialogue à l'écran. Lorsque le 
bouton Esc permet d'annuler ou de quitter une action donnée, 
le bouton clignote. 

Boutons et témoins Sel/Focus Mode

Le bouton Sel/Focus Mode bascule la fonction des boutons de 
sélection de canal entre les modes Select et Focus. 

 En mode Select, les boutons de sélection de canal permettent 
de sélectionner des canaux dans Pro Tools. 

 En mode Focus, les boutons de sélection de canal permettent 
de passer les commandes d'un canal sur la tranche Focus de 
l'unité principale. 

Les témoins situés de chaque côté de cette touche indiquent le 
mode actuel. 

Commandes Channel Strip Master Function

Bouton et témoins
Sel/Focus Mode

Bouton Esc

Bouton Solo Clear

Bouton Mute Clear

Bouton Disp Mode

Bouton Auto Suspend



Bouton Solo Clear

Le bouton Solo Clear permet de désactiver toutes les boutons 
Solo verrouillés dans la session. Cette touche clignote lorsqu'un 
canal est mis en solo. 

Bouton Mute Clear

Le bouton Mute Clear annule toutes les mises en mute de toutes 
les pistes de la session et clignote lorsque le son d'un canal est 
coupé. 

L'action Mute Clear peut être annulée en appuyant sur le bouton 
Undo. 

Bouton Disp Mode

Le bouton Disp Mode permet d'afficher successivement les cinq 
modes d'affichage suivants sur les affichages de canaux : Track 
Name, Group/ Name, Channel Number/Name, Headroom Value 
et Level. Pour plus d'informations, reportez-vous à la section 
« Affichage de canal » à la page 55. 

Bouton Auto Suspend

Le bouton Auto Suspend suspend la lecture et l'écriture de toute 
automation sur toutes les pistes de la session. Tous les canaux 
conservent leur mode d'automation actuel, mais l'automation 
est momentanément interrompue. 

Le bouton Auto Suspend clignote lorsque l'automation est 
suspendue. 
Commandes Custom Fader

Les commandes Custom Fader permettent d'appeler un groupe 
spécial de modes D-Control, appelés modes Custom Fader, qui 
permettent d'isoler des tranches et de les personnaliser afin 
d'afficher et de modifier diverses fonctions. Il s'agit des modes 
Custom Groups, Mix/Edit Groups, Tracks et Plug-In. Pour plus 
d'informations sur les modes Custom Fader, consultez la section 
Chapitre 13, « Modes Custom Fader ».

Affichage Custom Faders

 Lorsqu'un mode Custom Fader est activé, l'affichage Custom 
Faders indique le nom du groupe Custom, Mix/Edit ou du plug-in 
affiché dans les canaux Custom Faders.

 Lorsqu'aucun mode Custom Fader n'est actif, l'affichage Custom 
Faders indique le nom des plug-in situés sur le canal sur lequel 
se trouve le focus. Lorsque vous passez au mode Custom Fader 
Plug-In, ce plug-in s'affiche sur les canaux Custom Faders.

Bouton Custom

Le bouton Custom appelle le mode Custom Groups, qui permet 
de créer un ensemble personnalisé de canaux et de les organiser 
librement sur les canaux Custom Faders. Le mode Custom Groups 
est spécifique à D-Control et ne s'affiche pas à l'écran dans 
Pro Tools. 

Bouton Groups

Le bouton Groups appelle le mode Mix/Edit Groups, qui permet 
de créer, modifier et rappeler les groupes Pro Tools Mix et Edit 
sur les canaux Custom Faders. 

Commandes Custom Fader

Bouton Plug-In

Bouton Tracks

Bouton Mix/Edit Groups

Bouton Custom Groups

Affichage Custom
Faders

Bouton Bank/Cycle

Bouton Window

Bouton Lock

Bouton Flip

Bouton Map
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Bouton Tracks

Le bouton Tracks appelle le mode Track Type, qui permet d'ap-
peler les types de pistes suivants vers les canaux Custom Faders : 
Master Faders, pistes audio, entrées auxiliaires, pistes MIDI, pistes 
d'instrument et pistes masquées. 

En mode Track Type, les boutons Bank Select dans la matrice 
Bank Select permettent de sélectionner le type de piste à afficher. 

Bouton Plug-In

Le bouton Plug-In appelle le mode Plug-In, qui permet d'appeler 
les commandes de plug-in du canal sur lequel se trouve le focus 
vers les canaux Custom Faders. 

Bouton Map

Le bouton Map fonctionne avec les modes Custom Groups, Mix/ 
Edit Groups et Plug-In. Dans ces modes, il permet de personna-
liser davantage l'organisation des commandes, en mappant des 
commandes d'encodeurs rotatifs individuels sur les faders des 
canaux Custom Faders. 

Le bouton Map n'a aucun effet sur les autres canaux D-Control 
en mode Normal. 

Bouton Flip

Le bouton Flip des Custom Faders fonctionne dans les modes 
Custom Groups, Mix/Edit Groups et Plug-In. Dans ces modes, 
les commandes de la rangée d'encodeurs du haut sont transférées 
vers les faders des canaux Custom Faders lorsque vous appuyez 
sur le bouton Flip. Si vous appuyez de façon répétée sur ce bouton, 
les rangées d'encodeurs suivantes sont elles aussi transférées vers 
les faders. Le bouton Flip des Custom Faders n'a aucune incidence 
sur les autres canaux D-Control en mode Normal. 

Bouton Lock

Le bouton Lock s'applique au mode Custom Fader Plug-In uni-
quement. Il verrouille le plug-in actuellement visible dans l'af-
fichage Custom Faders, afin qu'il ne soit pas modifié lorsqu'un 
autre canal passe sur la tranche Focus. Ce bouton s'allume lors-
que le plug-in est verrouillé.

 Lorsque le mode Custom Fader Plug-In est actif, le plug-in 
verrouillé apparaît sur les canaux Custom Faders, afin que vous 
puissiez passer un autre canal sur la tranche Focus et maintenir 
le plug-in verrouillé sur les canaux Custom Faders.

 Lorsque le mode Custom Fader Plug-in est inactif, le plug-in 
verrouillé apparaît dans l'affichage Custom Faders, afin que vous 
puissiez passer un autre canal sur la tranche Focus tout en main-
tenant le plug-in verrouillé dans l'affichage Custom Faders. Lorsque 
vous passez au mode Custom Fader Plug-In, ce plug-in s'affiche 
sur les canaux Custom Faders.
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Bouton Window

Le bouton Window permet d'ouvrir et de fermer la fenêtre de 
plug-in à l'écran, pour tous les plug-ins répertoriés dans l'affichage 
Custom Faders. 

Bouton Bank/Cycle

 En mode Custom Groups ou Mix/Edit Groups, le bouton Bank/ 
Cycle permet de créer des banques de faders au sein des canaux 
Custom Faders, lorsque le nombre de canaux ne permet pas de 
les afficher tous à la fois.

 En mode Custom Fader Plug-In, le bouton Bank/Cycle permet 
de parcourir les plug-ins de la tranche Focus, en affichant leurs 
commandes sur les canaux Custom Faders.

 Lorsqu'aucun mode Custom Fader n'est actif, le bouton Bank/ 
Cycle parcourt les plug-in de la tranche Focus, en indiquant leur 
nom dans l'affichage Custom Faders. 

Commandes Automation Mode
Les commandes Automation Mode permettent d'afficher et de 
définir les modes d'automation. Ces boutons s'allument pour 
indiquer qu'au moins un canal est configuré dans ce mode 
d'automation. Si plusieurs modes d'automation sont affectés à 
différents canaux, les boutons de tous les modes 
correspondants sont allumées.

Les commandes Automation Mode reproduisent la fonction du 
sélecteur de mode d'automation à l'écran de chaque piste, et 
permettent de modifier les modes d'automation pendant la 
lecture. 

Pour configurer le mode d'automation sur un ou plusieurs canaux :

1  Maintenez enfoncé un bouton Automation Mode (Write, Touch, 
Latch, Trim, Read ou Off). 

2  Appuyez sur les boutons Select des canaux dont vous souhaitez 
définir le mode d'automation.

Pour configurer le mode d'automation sur un ou plusieurs canaux 
sélectionnés :

1  Appuyez sur le bouton Do To Selected.

2  Appuyez sur les boutons Select des canaux dont vous souhaitez 
définir le mode d'automation.

3  Appuyez sur un bouton Automation Mode (Write, Touch, 
Latch, Trim, Read ou Off). 

Pour configurer le mode d'automation sur tous les canaux :

1  Appuyez sur le bouton Do To All.

2  Appuyez sur un bouton Automation Mode (Write, Touch, Latch, 
Trim, Read ou Off). 

Commandes Automation Mode

Bouton d'automation 
Off

Bouton d'automation 
en mode Read

Bouton d'automation en 
mode Trim

Bouton d'automation
en mode Write

Bouton d'automation
en mode Touch

Bouton d'automation
en mode Latch



Bouton Write

Le bouton Write indique ou définit le mode d'automation pour 
les pistes sélectionnées sur le mode Write.

Bouton Touch

Le bouton Touch indique ou définit le mode d'automation pour 
les pistes sélectionnées sur le mode Touch. 

Bouton Latch

Le bouton Latch indique ou définit le mode d'automation pour 
les pistes sélectionnées sur le mode Latch. 

Bouton Trim

Le bouton Trim indique ou définit le mode d'automation pour 
les pistes sélectionnées sur le mode Trim. 

Bouton Read

Le bouton Read indique ou définit le mode d'automation pour 
les pistes sélectionnées sur le mode Read. 

Bouton Off

Le bouton Off indique ou définit le mode d'automation pour 
les pistes sélectionnées sur Off. 

Bouton Talkback
Les deux boutons Talkback qui figurent en bas de chaque section 
Channel Strip Master sur l'unité principale ont la même fonction 
que le bouton Talkback de D-Control.

Les boutons Talkback peuvent adopter un comportement mo-
mentané ou verrouillé. Ils s'activent uniquement lorsqu'ils 
sont maintenus enfoncés. 

Si vous appuyez rapidement deux fois sur le bouton, il s'active 
en continu et clignote pour indiquer que le talkback est actif. 
Appuyez de nouveau dessus pour désactiver le talkback.

Le talkback peut être activé automatiquement. Pour plus d'infor-
mations, reportez-vous à la section « Bouton Auto Talkback » à la 
page 123.

Le niveau de talkback est défini à l'aide des commandes Talkback 
de la section Monitor. Pour plus d'informations, reportez-vous 
à la section « Système Talkback/Listen » à la page 122. 

Bouton Talkback

Bouton Talkback
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Chapitre 7 : Commandes de plug-in
D-Control permet d'assigner, d'afficher et de contrôler des plug-ins 
directement depuis la surface de contrôle de différentes façons. 

Les sections Dynamics et EQ de l'unité D-Control sont dédiées aux 
plug-ins qui prennent en charge le mappage de plug-ins Dynamics 
et EQ. Ces sections comprennent des encodeurs et des boutons 
qui permettent de mapper les commandes standard pour chaque 
type de plug-in. 

En mode Custom Fader Plug-Ins, il est possible de mettre le focus 
sur tous les types de plug-ins sur plusieurs canaux de D-Control. 
Voir « Mode Plug-In de Custom Faders » à la page 154. 

Formats de canal de plug-ins

D-Control prend en charge les formats de canal de plug-ins mono, 
stéréo, multicanal et multi-mono. Les plug-ins multi-mono 
peuvent comprendre jusqu'à huit canaux mono individuels 
qui peuvent être liés de nombreuses manières. 

D-Control permet d'afficher, de modifier et de coupler des 
canaux spécifiques de plug-ins multi-mono Dynamics et EQ 
directement à l'aide des boutons Select des canaux dans la 
section correspondante.

Assignation et suppression de plug-ins

Vous pouvez effectuer des assignations de plug-ins directement 
depuis D-Control de différentes façons. En mode Inserts, les 
plug-ins peuvent être ajoutés insert par insert. En mode Assign 
Inserts, vous pouvez assigner des plug-ins à des positions d'insert 
sur plusieurs pistes.

Pour assigner un plug-in en mode Inserts :

1  Appuyez sur le bouton Inserts pour afficher les inserts sur le 
canal auquel vous voulez assigner le plug-in.

2  Effectuez l'une des opérations suivantes :

• Si la position d'insert que vous voulez utiliser est vide, appuyez 
sur le bouton Select de l'encodeur correspondant.

– ou –

• Si un plug-in est déjà présent dans la position d'insert que 
vous voulez utiliser, maintenez enfoncé le bouton Select de 
l'encodeur correspondant.
3  Sur la position d'insert sur laquelle vous souhaitez effectuer 
une affectation, utilisez le bouton encodeur pour sélectionner 
le premier niveau de choix du menu.

4  Appuyez sur le bouton Select de l'encodeur pour accéder aux 
niveaux inférieurs du menu et sur le bouton Bypass/Mute/Pre 
pour passer aux niveaux supérieurs du menu. 

5  Quand le plug-in que vous souhaitez assigner s'affiche, appuyez 
sur le bouton Select de l'encodeur pour confirmer votre sélection.

Pour assigner des plug-ins à plusieurs pistes :

1  Appuyez sur le bouton Assign Inserts pour passer en mode 
Inserts Assign. Les deux premières positions de départ ou d’insert 
apparaîtront sur les affichages de l'encodeur par défaut.

2  Sur la position d'insert sur laquelle vous souhaitez effectuer 
une affectation, utilisez le potentiomètre pour sélectionner le 
premier niveau de choix du menu.

3  Appuyez sur le bouton Select de l'encodeur pour accéder aux 
niveaux inférieurs du menu et sur le bouton Bypass/Mute/Pre 
pour passer aux niveaux supérieurs du menu. 

4  Quand le plug-in que vous souhaitez assigner s'affiche, appuyez 
sur le bouton Select de l'encodeur pour confirmer votre sélection.

5  Répétez les étapes 2 à 4 pour effectuer des affectations d'insert 
supplémentaires.

6  Appuyez sur le bouton Assign clignotant pour confirmer les 
affectations et quitter le mode Inserts Assign.

Pour supprimer un plug-in :

1  Appuyez sur le bouton Set to Default. 

2  Appuyez sur le bouton Select de l'encodeur pour chaque plug-in 
que vous souhaitez supprimer.

3  Appuyez sur le bouton Set to Default clignotant pour quitter 
le mode Set to Default.
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Préférences de plug-ins par défaut

Vous pouvez définir un plug-in EQ et un plug-in Dynamics par 
défaut dans Pro Tools afin de pouvoir effectuer rapidement des 
affectations depuis D-Control.

Pour définir un plug-in EQ ou Dynamics par défaut :

1  Dans Pro Tools, sélectionnez Setup > Preferences, puis cliquez 
sur Mixing. 

2  Sous Setup, sélectionnez un plug-in à partir du menu déroulant 
Default EQ ou Default Dynamics.

3  Cliquez sur OK pour refermer la fenêtre Preferences.

Pour assigner un plug-in EQ ou Dynamics par défaut sur un canal 
de D-Control :

 Maintenez enfoncé le bouton EQ ou Dyn du canal et appuyez 
sur le bouton Select où vous souhaitez effectuer l'affectation. 

– ou –

 Procédez comme suit :

• Appuyez sur le bouton Inserts du canal pour passer en mode 
Local Assign.

• Appuyez sur le bouton Select de l'encodeur auquel vous voulez 
assigner le plug-in.

• Appuyez sur le bouton EQ ou Dyn du canal.

Mettre le focus sur des plug-ins dans 
D-Control

Le focus est mis sur un plug-in lorsque ses commandes sont map-
pées sur les boutons encodeurs, boutons ou faders de D-Control. 
Il est possible de modifier et d'automatiser ses paramètres depuis 
la surface de contrôle. D-Control permet de mettre le focus sur 
un plug-in en affichant ou non sa fenêtre à l'écran.

Vous pouvez mettre le focus sur un plug-in de différentes façons : 
sur les encodeurs de ses canaux, sur les encodeurs de la tranche 
Focus et dans la section Custom Faders. 

Avec les plug-ins Dynamics et EQ, vous pouvez également 
accéder directement aux paramètres des plug-ins dans les 
sections Dynamics et EQ dédiées de D-Control.

Pour mettre le focus sur un plug-in sur une tranche :

1  Appuyez sur le bouton Inserts du canal pour afficher les noms 
des plug-ins sur les encodeurs du canal.

2  Appuyez sur le bouton Select de l'encodeur pour le plug-in sur 
lequel vous souhaitez mettre le focus. 

Les commandes du plug-in apparaissent sur les encodeurs du canal. 
Vous pouvez parcourir les différentes pages de commandes du 
plug-in en appuyant sur les boutons Page Up et Page Down du 
canal.
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Pour passer un plug-in sur la tranche Focus :

1  Passez la piste du plug-in sur la tranche Focus.

2  Appuyez sur le bouton Inserts du canal. Le nom des plug-ins 
s'affiche sur les encodeurs du canal.

3  Appuyez sur le bouton Select situé sous le nom du plug-in sur 
lequel vous souhaitez mettre le focus. Les paramètres du plug-in 
s'affichent dans les encodeurs de la tranche Focus. 

4  S'il existe plusieurs pages de paramètres pour le plug-in, les 
boutons Page Up ou Page Down s'allument. Pour faire défiler les 
pages de paramètres, appuyez sur le bouton approprié.

Pour mettre le focus sur un plug-in dans la section Dynamics ou EQ :

1  Pour passer la piste du plug-in sur la tranche Focus, appuyez 
sur le bouton Select de la piste correspondante. Le focus est 
automatiquement mis sur les premiers plug-ins Dynamics et 
EQ de cette piste, dans la section correspondante de l'unité 
D-Control. 

2  Appuyez sur le bouton Cycle de la section Dynamics ou EQ pour 
mettre le focus sur d'autres plug-ins Dynamics ou EQ. L'option 
No Insert est toujours disponible.

Pour mettre le focus sur un plug-in dans la section Custom Faders :

1  Pour passer la piste du plug-in sur la tranche Focus, appuyez sur 
le bouton Select de la piste correspondante. Le focus est automa-
tiquement mis sur le premier plug-in qui ne soit pas un plug-in 
Dynamics ni EQ, et son nom s'affiche dans l'affichage Custom 
Faders. 

2  Dans la section Custom Faders, appuyez sur le bouton Bank/Cycle 
pour afficher successivement les plug-ins disponibles sur le canal 
rendu prioritaire. L'option No Insert est toujours disponible.

Le plug-in dont le nom s'affiche dans la zone Custom Faders 
devient alors disponible en mode Custom Fader Plug-In. Voir 
« Mode Plug-In de Custom Faders » à la page 154.

Ouverture des fenêtres de plug-ins

Vous pouvez ouvrir les fenêtres des plug-ins depuis D-Control 
de différentes façons.

Pour ouvrir une fenêtre de plug-in depuis un canal de D-Control :

 Maintenez la touche Démarrer (Windows) ou Ctrl (Mac) 
enfoncée et appuyez sur le bouton Select de l'encodeur pour 
le plug-in. 



Pour ouvrir une fenêtre de plug-in sur une piste mise en focus :

1  Passez une piste sur la tranche Focus en appuyant sur son 
bouton Select. 

2  Dans la section Custom Faders, appuyez sur le bouton Bank/Cycle 
pour afficher successivement les plug-ins de la piste mise en focus. 
Les noms des plug-ins apparaissent dans la zone Custom Faders. 

3  Dans la section Custom Faders, appuyez sur le bouton Win pour 
ouvrir le plug-in dont le nom s'affiche.

Pour ouvrir une fenêtre de plug-in Dynamics ou EQ mis en focus :

 Appuyez sur le bouton Window dans la section Dynamics ou 
EQ de D-Control.

Pour ouvrir ou fermer toutes les fenêtres de plug-ins mis en focus :

 Appuyez sur le bouton Plug-In dans la section Window 
Management. 

Pour fermer toutes les fenêtres de plug-ins ouvertes :

 Maintenez la touche Alt (Windows) ou Option (Mac) 
enfoncée et appuyez sur le bouton Plug-In dans la section 
Window Management. Cette opération ferme toutes les 
fenêtres de plug-ins en temps réel et AudioSuite. 

Pour configurer l'unité D-Control afin qu'elle ouvre 
automatiquement les fenêtres de plug-ins :

1  Appuyez plusieurs fois sur le bouton Operation dans la section 
Soft Keys de D-Control pour afficher la page contenant Channel 
Window Display (ChanWn). 

2  Appuyez sur le bouton ChanWn pour afficher le paramètre Yes.

Si le paramètre Yes est défini, lorsque vous affectez un nouveau 
plug-in ou que vous appuyez sur le bouton Select d'un encodeur 
pour modifier un plug-in ou afficher successivement les plug-ins 
de la piste mise en focus, la fenêtre de plug-in s'ouvre automa-
tiquement.
Gestion de plusieurs fenêtres de 
plug-ins

D-Control permet d'ouvrir plusieurs fenêtres de plug-ins et 
de passer de l'une à l'autre. Cela permet de conserver plusieurs 
fenêtres de plug-ins ouvertes simultanément tout en travaillant 
sur plusieurs pistes (dans une session où plusieurs pistes possèdent 
des plug-in Dynamics et EQ par exemple).

Ciblage des plug-ins

Un plug-in est ciblé à l'écran lorsque son icône cible dans l'en-tête 
de la fenêtre de plug-in apparaît en rouge. La première fenêtre 
de plug-in qui s'ouvre est automatiquement ciblée. 

 Lorsqu'une fenêtre de plug-in est ciblée, elle est remplacée 
lorsque vous ouvrez une nouvelle fenêtre de plug-in. 

 Lorsqu'une fenêtre de plug-in n'est pas ciblée (lorsque son 
icône cible est grise), la fenêtre de plug-in reste à l'écran.

Pour ouvrir plusieurs fenêtres de plug-ins : 

 Maintenez la touche Maj enfoncée pendant que vous ouvrez 
les fenêtres les unes après les autres. Les nouvelles fenêtres de 
plug-ins ne sont pas ciblées.

Pour basculer entre les fenêtres de plug-ins en passant le focus 
d'une piste à une autre :

1  Mettez le focus sur une piste comprenant plusieurs plug-ins 
(des plug-ins Dynamics, EQ et Pitch Shift, par exemple) en 
appuyant sur le bouton Select de la piste.

2  Ouvrez plusieurs fenêtres de plug-ins sur la piste en focus tout 
en maintenant la touche Maj enfoncée. 

3  Maintenez la touche Alt (Windows) ou Option (Mac) enfoncée 
pendant que vous passez le focus sur une autre piste contenant 
plusieurs plug-ins en appuyant sur le bouton Select correspondant. 

Les plug-ins mis en focus dont les fenêtres sont ouvertes basculent 
dans les nouvelles fenêtres de plug-ins affichées, si ces plug-ins 
sont présents sur la nouvelle piste. 
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Activation et désactivation des plug-ins

Vous pouvez activer et désactiver un plug-in directement sur une 
tranche sans avoir à activer le mode Make Inactive de D-Control.

Pour activer/désactiver un plug-in directement sur une tranche :

1  Appuyez sur le bouton Inserts d'une tranche pour afficher le 
nom des plug-ins sur les encodeurs du canal.

2  Maintenez les touches Ctrl+Démarrer (Windows) ou Ctrl+
Commande (Mac) enfoncées et appuyez sur le bouton Select 
de l'encodeur pour le plug-in.

Changement des présélections de 
plug-ins à partir des tranches

Vous pouvez activer les paramètres suivants ou précédents du 
menu Plug-In Librarian directement à partir d'une tranche sur 
D-Control. Ces commandes sont identiques aux boutons Next 
et Previous Setting des en-têtes de plug-ins.

Pour activer le paramètre suivant ou précédent d'un plug-in dans 
une tranche :

1  Mettez le focus sur le plug-in dans une tranche de sorte à afficher 
ses commandes sur les encodeurs de celle-ci.

2  Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur les boutons Page Up (Suivant) ou Page 
Down (Précédent) dans les commandes Channel Strip Mode de 
la tranche.

Copier-coller des paramètres de 
plug-ins

Vous pouvez copier les paramètres d'un plug-in, puis les coller 
dans une instance différente de celui-ci directement sur une 
tranche de D-Control, à partir de l'affichage de premier niveau, 
ou de l'affichage mis en focus du plug-in.

Pour copier-coller les paramètres d'un plug-in à partir de 
l'affichage de premier niveau :

1  Appuyez sur les boutons Inserts des tranches où copier-coller 
les paramètres de plug-in afin d'afficher les noms des plug-ins 
sur les encodeurs de canal. 

2  Pour copier les paramètres d'un plug-in, maintenez les touches 
Maj+Ctrl (Windows) ou Maj+Commande (Mac) enfoncées et 
appuyez sur le bouton Select de l'encodeur sous le nom du plug-in 
en question. 
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3  Pour coller les paramètres dans une autre instance du plug-in, 
maintenez les touches Maj+Ctrl (Windows) ou Maj+Commande 
(Mac) enfoncées et appuyez sur le bouton B/M/P sous le nom de 
ce plug-in.

Pour copier-coller les paramètres à partir de l'affichage des 
plug-ins en focus :

1  Mettez le focus sur les plug-ins des tranches où copier-coller les 
paramètres de sorte à afficher leurs commandes sur les encodeurs 
des tranches. 

2  Pour copier les paramètres d'un plug-in, maintenez les touches 
Maj+Ctrl (Windows) ou Maj+Commande (Mac) enfoncées et 
appuyez sur le bouton Select de l'encodeur sous la rangée inférieure 
des encodeurs du plug-in en question. 

3  Pour coller les paramètres dans une autre instance du plug-in, 
maintenez les touches Maj+Ctrl (Windows) ou Maj+Commande 
(Mac) enfoncées et appuyez sur le bouton B/M/P sous la rangée 
inférieure des encodeurs de ce plug-in.

Activation de l'automation des plug-ins

Lorsque les noms des plug-ins apparaissent dans l'affichage de 
premier niveau d'une tranche de D-Control, vous pouvez rapide-
ment activer tous les paramètres d'un plug-in pour l'automation. 

Vous pouvez également utiliser les boutons Do To All ou Do To 
Selected de D-Control pour automatiser plusieurs plug-ins sur 
la même position d'insert au cours d'une session. 

Pour activer et désactiver l'automation d'un paramètre de plug-in :

1  Appuyez sur le bouton Inserts des commandes Channel Strip 
Mode d'une piste pour afficher les inserts de premier niveau. Les 
noms des plug-ins apparaissent dans les fenêtres de l'encodeur 
de cette piste. 

2  Appuyez sur le bouton Select d'un encodeur pour afficher les 
paramètres d'un plug-in sur les encodeurs rotatifs. 

3  Maintenez les touches Ctrl+Alt+Démarrer (Windows) ou 
Commande+Option+Ctrl (Mac) enfoncées et sélectionnez 
l'encodeur rotatif pour le plug-in pour lequel vous souhaitez 
activer l'automation des paramètres.

Utilisez les boutons Do To All et Do To Selected pour copier-coller 
les paramètres de tous les plug-ins à la même position d'insert 
sur toutes les pistes ou l'ensemble des pistes sélectionnées.



Pour activer et désactiver l'automation de tous les paramètres 
d'un plug-in :

1  Appuyez sur le bouton Inserts des commandes Channel Strip 
Mode d'une piste pour afficher les inserts de premier niveau. Les 
noms des plug-ins apparaissent dans les fenêtres de l'encodeur 
de cette piste. 

2  Maintenez les touches Ctrl+Alt+Démarrer (Windows) ou 
Commande+Option+Ctrl (Mac) enfoncées et sélectionnez 
l'encodeur rotatif pour le plug-in pour lequel vous souhaitez 
activer l'automation des paramètres.

Pour activer et désactiver l'automation de tous les plug-ins sur une 
position d'insert spécifique :

1  Appuyez sur le bouton Inserts des commandes Channel Strip 
Mode d'une piste pour afficher les inserts de premier niveau. Les 
noms des plug-ins apparaissent dans les fenêtres de l'encodeur 
de cette piste.

2  Appuyez sur le bouton Do To All dans la section de commandes 
globales.

3  Maintenez les touches Ctrl+Alt+Démarrer (Windows) ou 
Commande+Option+Ctrl (Mac) enfoncées et sélectionnez 
l'encodeur rotatif pour le plug-in sur la position d'insert 
(insert 1 à 5) à laquelle vous souhaitez activer l'automation 
des paramètres.

Pour activer et désactiver l'automation des plug-ins sur une 
position d'insert spécifique sur toutes les pistes sélectionnées :

1  Sélectionnez les pistes contenant les plug-ins pour lesquels vous 
souhaitez activer l'automation.

2  Appuyez sur le bouton Inserts des commandes Channel Strip 
Mode d'une piste pour afficher les inserts de premier niveau. Les 
noms des plug-ins apparaissent dans les fenêtres de l'encodeur 
de cette piste.

3  Appuyez sur le bouton Do To Selected dans la section de 
commandes globales. 

4  Maintenez les touches Ctrl+Alt+Démarrer (Windows) ou 
Commande+Option+Ctrl (Mac) enfoncées et sélectionnez 
l'encodeur rotatif pour le plug-in sur la position d'insert 
(insert 1 à 5) à laquelle vous souhaitez activer l'automation 
des paramètres.
Assignation de plug-ins

Vous pouvez placer un plug-in en mode Learn, sélectionner des 
paramètres d'affectation et assigner indépendamment deux 
ensembles de paramètres de plug-in à chaque encodeur ou à 
son bouton B/M/P associé, et ceci directement depuis la surface 
de contrôle.

Vous pouvez assigner des paramètres à des encodeurs et des 
boutons B/M/P à la fois dans les Custom Faders et dans les 
tranches. 

Lorsque vous placez un plug-in en mode Learn, sa piste passe sur 
la tranche Focus et le mode Custom Fader Plug-In est automati-
quement activé. En mode Learn, les affichages des encodeurs 
d'un plug-in en focus sont vierges, indiquant qu'il est prêt pour 
l'assignation des paramètres vers les encodeurs et les boutons 
B/M/P. 

Option LrnTch (Learn Touch) 

L'option Learn Touch (dans la section Soft Keys de Operation) 
détermine si les commandes sont activées lorsqu'un plug-in est 
en mode Learn. Lorsque cette option est activée, les encodeurs 
et les boutons n'envoient pas de commandes vers Pro Tools en 
mode Learn, mais autorisent uniquement des opérations du 
mode Learn. Vous pouvez ainsi sélectionner des paramètres à 
assigner depuis la surface de contrôle.

Assignation de plug-ins et tranches

Les paramètres d'assignation de plug-ins de D-Control sont or-
ganisés dans les pages des tranches des 6 encodeurs et boutons 
pouvant être assignés. Ces pages s'affichent une à une sur les 
6 encodeurs dans les tranches de D-Control. 

Assignation de plug-ins et taille de la banque Custom Faders

Les paramètres d'assignation de plug-ins de D-Control sont 
organisés dans les pages Custom Faders des 8 encodeurs et 
boutons pouvant être assignés. 

Lorsque l'assignation de plug-ins s'affiche dans des banques Plug-In 
Custom Fader, l'organisation des pages de cartes d'assignation 
de plug-ins suit le paramètre Maximum Custom Fader Bank Size 
for Plug-Ins (dans la section Soft Keys de Operation).

Pour obtenir des informations complètes sur la création et la 
gestion des cartes d'assignation de plug-ins, reportez-vous au 
Guide de référence Pro Tools.

Vous ne pouvez pas assigner des commandes aux sections EQ 
et Dynamics de D-Control.
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Par défaut, la banque de Custom Faders de gauche est utilisée 
sauf si l'option Custom Fader Bank Size (LCF) est définie sur 0 
ou que les Custom Faders de gauche sont verrouillés. Dans ces 
cas, la banque de Custom Faders de droite est utilisée. 

Passer un plug-in en mode Learn

Vous pouvez passer un plug-in en mode Learn directement 
depuis D-Control.

Pour passer un plug-in en mode Learn depuis la surface de 
contrôle :

1  Mettez le focus sur le plug-in en mode Custom Fader.

2  Maintenez la touche Démarrer (Windows) ou Ctrl (Mac) 
enfoncée et appuyez sur le bouton Map de la section Custom 
Faders.

Pour sortir un plug-in du mode Learn depuis la surface de contrôle :

 Maintenez la touche Démarrer (Windows) ou Ctrl (Mac) 
enfoncée et appuyez sur le bouton Map clignotant de la section 
Custom Faders.

– ou –

 Appuyez sur le bouton Win de la section Custom Faders pour 
fermer la fenêtre du plug-in.

Création et modification de cartes d'assignation de 
plug-ins

Pour créer une carte d'assignation de plug-in personnalisée :

1  Vérifiez que l'option LrnTch (Learn Touch) (dans la section 
Soft Keys de Operation) est activée (On). 

2  Ouvrez le plug-in dont vous voulez personnaliser les assignations. 

3  Passez le plug-in en mode Learn. Le focus est mis sur le 
plug-in, ses encodeurs et boutons sont vierges, prêts pour 
l'assignation.

4  Sur la surface de contrôle, effectuez l'une des opérations 
suivantes : 

• Pour un plug-in EQ ou Dynamics, vérifiez qu'un plug-in 
du même type s'affiche dans la section EQ ou Dynamics de 
la surface de contrôle.

– ou –

• Pour tous les autres types de plug-ins, affichez une instance 
différente du même type de plug-in dans un second em-
placement (sur une tranche en mode Normal ou dans une 
autre banque de Custom Faders, par exemple).

Lorsque vous créez et rappelez des cartes d'assignation de 
plug-ins, il est important d'utiliser le même paramètre 
Custom Fader Bank Size, afin que les cartes d'assignation 
de plug-ins s'affichent de manière cohérente. Les exemples 
de cette section concernent une taille de banque Custom 
Faders de 8 canaux.
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5  Utilisez l'encodeur ou appuyez sur le bouton du paramètre 
que vous souhaitez assigner. Le témoin Auto de l'encodeur ou le 
témoin Mute du bouton s'allume. 

6  Sur l'encodeur auquel vous souhaitez assigner le paramètre, 
appuyez sur le bouton Select pour passer d'un affichage à l'autre 
de la commande.

7  Assignez le paramètre en effectuant l'une des opérations 
suivantes :

• Sélectionnez l'encodeur pour assigner un paramètre continu 
ou commuté, ou appuyez sur le bouton B/M/P pour assigner 
un paramètre commuté. 

– ou –

• Si D-Control est en mode Flip, sélectionnez le fader pour 
assigner un paramètre continu ou commuté, ou appuyez sur 
le bouton de sélection de canal pour assigner un paramètre 
commuté. 

8  Sortez le plug-in du mode Learn.

Pour modifier l'assignation des paramètres d'une carte 
d'assignation de plug-in :

1  Vérifiez que l'option LrnTch (Learn Touch) (dans la section 
Soft Keys de Operation) est activée (On). 

2  Ouvrez le plug-in dont vous voulez modifier les assignations. 

3  Sélectionnez la carte d'assignation à modifier dans le menu 
déroulant Map Preset. 

4  Passez le plug-in en mode Learn. Le focus est mis sur la carte 
d'assignation du plug-in sur la surface de contrôle.

5  Sur la surface de contrôle, effectuez l'une des opérations 
suivantes : 

• Pour un plug-in EQ ou Dynamics, vérifiez qu'un plug-in 
du même type s'affiche dans la section EQ ou Dynamics de 
la surface de contrôle.

– ou –

• Pour tous les autres types de plug-ins, affichez une instance 
différente du même type de plug-in dans un second em-
placement (sur une tranche en mode Normal ou dans une 
autre banque de Custom Faders, par exemple).

6  Utilisez l'encodeur ou appuyez sur le bouton du paramètre 
que vous souhaitez assigner. Le témoin Auto de l'encodeur ou le 
témoin Mute du bouton s'allume. 

7  Sélectionnez l'encodeur pour lequel vous souhaitez modifier 
l'assignation et, si nécessaire, appuyez sur le bouton Select de 
l'encodeur pour passer d'un affichage à l'autre de la commande.

8  Sélectionnez l'encodeur ou appuyez sur le bouton B/M/P pour 
assigner le paramètre.

9  Sortez le plug-in du mode Learn.



Pour supprimer l'assignation d'un paramètre d'une carte 
d'assignation de plug-in :

1  Vérifiez que l'option LrnTch (Learn Touch) (dans la section 
Soft Keys de Operation) est activée (On). 

2  Ouvrez le plug-in dont vous voulez modifier les assignations. 

3  Sélectionnez la carte d'assignation à modifier dans le menu 
déroulant Map Preset. 

4  Passez le plug-in en mode Learn. Le focus est mis sur la carte 
d'assignation du plug-in sur la surface de contrôle.

5  Sélectionnez l'encodeur pour lequel vous souhaitez modifier 
l'assignation et, si nécessaire, appuyez sur le bouton Select de 
l'encodeur pour passer d'un affichage à l'autre de la commande.

6  Effectuez l'une des opérations suivantes pour chaque assignation 
de paramètre à supprimer :

• Si le menu Parameter affiche No Control, sélectionnez l'en-
codeur ou appuyez sur le bouton B/M/P pour supprimer 
l'assignation de paramètre.

– ou –

• Si le menu Parameter affiche le nom d'une présélection, 
maintenez la touche Ctrl (Windows) ou Commande 
(Mac) enfoncée et appuyez sur le bouton B/M/P pour 
supprimer l'assignation de paramètre.

7  Sortez le plug-in du mode Learn.

Modification des réglages prédéfinis de cartes 
d'assignation de plug-in

Vous pouvez sélectionner la carte d'assignation de plug-in 
précédente ou suivante directement depuis D-Control. 

Pour activer la carte d'assignation de plug-in précédente ou 
suivante dans une tranche :

1  Mettez le focus sur le plug-in dans la tranche de sorte à afficher 
ses commandes sur les encodeurs de celle-ci.

2  Maintenez la touche Démarrer (Windows) ou Ctrl (Mac) 
enfoncée et appuyez sur les boutons Page Up (Suivant) ou 
Page Down (Précédent) dans les commandes Channel Strip 
Mode de la tranche. Le nom du réglage prédéfini de la carte 
d'assignation de plug-in s'affiche momentanément dans 
l'affichage inférieur de l'encodeur. 

Pour activer la carte d'assignation de plug-in précédente ou 
suivante dans les Custom Faders :

1  Mettez le focus sur un plug-in dans la section Custom Faders. 

2  Maintenez la touche Démarrer (Windows) ou Ctrl (Mac) en-
foncée et appuyez sur les boutons Page Up (Suivant) ou Page Down 
(Précédent) dans un canal Custom Fader. Le nom du réglage prédé-
fini de la carte d'assignation de plug-in s'affiche momentanément 
dans les affichages des canaux Custom Faders. 

Pour sélectionner la carte d'assignation de plug-in précédente 
ou suivante sur plusieurs canaux, utilisez les boutons Do To 
All et Do To Selected de D-Control.
Affichage de la réduction de gain des 
plug-ins Dynamics sur les VU-mètres 
des canaux

Vous pouvez afficher les mesures de réduction de gain pour les 
plug-ins Dynamics directement sur les VU-mètres des canaux en 
mode Normal. Lorsque le mode VU-mètre est activé, les VU-mètres 
des canaux de D-Control affichent le niveau de piste et la réduction 
de gain du compresseur lorsque vous affichez les paramètres de 
plug-in sur les encodeurs du canal. 

Pistes mono : lorsqu’une piste mono est affichée sur une tranche 
D-Control, le VU-mètre du canal de gauche affiche le niveau de 
piste, tandis que celui de droite affiche la réduction de gain du 
plug-in. 

Pistes multicanal : lorsqu’une piste multicanal est affichée sur 
une tranche D-Control, le VU-mètre de gauche affiche le niveau 
du premier canal, tandis que celui de droite affiche la réduction 
de gain. 

Affichage des VU-mètres centraux : lorsque les VU-mètres centraux 
des 8 canaux de l’unité principale de D-Control sont réglés de 
façon à indiquer les niveaux pour la piste focus, ils affichent les 
niveaux pour un ou deux canaux de sortie, ainsi que l’entrée, la 
sortie, la réduction de gain et l’expansion pour un plug-in 
Dynamics sur la piste focus. 

Pour afficher la réduction de gain d’un plug-in Dynamics sur les 
VU-mètres des canaux :

1  Dans la section Soft Keys, appuyez sur le bouton Meter.

2  Pour afficher la réduction de gain, appuyez sur le bouton GRChan. 

3  Pour quitter, appuyez sur le bouton Meter.

4  Sur un canal utilisant un plug-in Dynamics, appuyez sur le 
bouton Dynamics des commandes d'affichage des tranches pour 
faire apparaître les paramètres du plug-in sur les encodeurs des 
tranches de canal.

La réduction de gain du plug-in Dynamics s’affiche sur le 
VU-mètre droit du canal, de haut en bas. 

Pour afficher la réduction de gain d’un plug-in Dynamics sur les 
VU-mètres centraux :

1  Dans la section Soft Keys, appuyez sur le bouton Meter Prefs 1.

2  Pour basculer l’affichage sur Track, appuyez sur le bouton CtrMtr.

3  Pour afficher la réduction de gain, appuyez sur le bouton GRChan. 

4  Pour quitter, appuyez sur le bouton Meter Prefs 1.

5  Passez un canal avec un plug-in Dynamics sur la tranche Focus.

6  Appuyez sur le bouton Dynamics des commandes d’affichage 
de la tranche Focus pour voir les paramètres du plug-in sur les 
encodeurs de la tranche Focus.

Les niveaux d’entrée et de sortie, la réduction de gain et l’expansion 
du plug-in Dynamics s’affichent sur les VU-mètres centraux les 
plus à droite, de haut en bas. 
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Section Dynamics

La section Dynamics inclut des commandes standard pour les plug-ins de compression, gate et limiteur, et un ensemble de commandes 
pour la gestion des paramètres d'affichage et de modification des plug-ins, ainsi que pour la sélection et la liaison de canaux dans les 
plug-ins multi-mono.
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Section Dynamics de l'unité D-Control

Commandes 
Knee/Hysteresis

Commandes 
Attack

Commandes 
Gain/Hold

Boutons de 
sélection de canal

Commandes 
Low Filter

Commandes 
High Filter

Commandes 
de niveau

Commandes 
Ratio/Range

Commande 
Release

Commande 
Threshold

VU-mètres de 
réduction de gain

VU-mètres Input et 
Output

Commandes de modification et 
d'affichage de la section Dynamics
Prise en charge des plug-ins Dynamics

Les plug-ins de traitement dynamique peuvent posséder des com-
mandes très diverses, selon leurs applications. La section Dynamics 
de D-Control fournit des boutons et des potentiomètres rotatifs 
dédiés adaptés à la plupart des plug-ins. Certains plug-ins n'uti-
lisent pas toutes les commandes Dynamics, et d'autres possèdent 
des paramètres supplémentaires qui peuvent être affichés dans 
la section Dynamics. Pour afficher toutes les commandes d'un 
plug-in, vous pouvez utiliser le mode Custom Fader Plug-Ins.
Affichage de plug-ins Dynamics

La section Dynamics met automatiquement le focus sur le premier 
plug-in Dynamics du canal affiché sur la tranche Focus de l'unité 
principale. 

Pour afficher successivement les plug-ins Dynamics du canal 
sur lequel se trouve le focus, appuyez sur le bouton Cycle de la 
section Dynamics.



Commandes Knee/Hysteresis et Ratio/Range

Commande Knee/Hysteresis

L'encodeur situé en haut de la section contrôle le paramètre 
knee ou la valeur d'hystérésis de la page du plug-in actuel, en 
fonction du témoin qui est allumé. Le témoin Auto situé sous le 
potentiomètre s'allume lorsque l'automation du paramètre est 
activée. 

Commande Ratio/Range

L'encodeur situé en bas de la section contrôle le taux de com-
pression ou la valeur de plage de la page du plug-in actuel, en 
fonction du témoin qui est allumé. Le témoin Auto situé sous le 
potentiomètre s'allume lorsque l'automation du paramètre est 
activée.

Commandes Knee/Hysteresis et Ratio/Range de la section Dynamics

Témoin 
Range

Témoin 
Hysteresis

Encodeur 
Knee/Hysteresis

Témoin
Knee

Encodeur
Ratio/Range

Témoin
Ratio
Commandes Attack et Release

Commande Attack

L'encodeur situé en haut de la section contrôle la valeur d’attaque 
du plug-in actuel. Le témoin Auto situé sous le potentiomètre 
s'allume lorsque l'automation du paramètre est activée. 

Commande Release

L'encodeur situé en bas de la section contrôle la valeur de relâ-
chement du plug-in actuel. Le témoin Auto situé sous le poten-
tiomètre s'allume lorsque l'automation du paramètre est activée. 

Commandes Attack et Release de la section Dynamics

Encodeur 
Attack

Encodeur 
Release
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Commandes Gain/Hold et Threshold

Commande Gain/Hold

L'encodeur situé en haut de la section contrôle la valeur du gain 
(gain Make-Up) ou de maintien de la page de plug-in actuel, en 
fonction du témoin qui est allumé. Le témoin Auto situé sous le 
potentiomètre s'allume lorsque l'automation du paramètre est 
activée. 

Commande Threshold

L'encodeur situé en bas de la section contrôle la valeur de seuil de la 
page de plug-in actuel. Le témoin Auto situé sous le potentiomètre 
s'allume lorsque l'automation du paramètre est activée. 

Commandes Gain/Hold et Threshold de la section Dynamics

Témoin 
Hold

Encouder 
Gain/Hold

Témoin Gain

Encodeur
Threshold
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Commandes Low Filter et High Filter

La section Dynamics inclut les commandes de filtres 
d'égalisation passe-haut et passe-bas de certains plug-ins 
Dynamics. 

Encodeurs Filter Frequency

Les encodeurs situés en haut de ces sections contrôlent la fré-
quence de filtrage pour chaque filtre. Lorsqu'il s'agit d'un filtre 
coupe-bande, ces encodeurs contrôlent sa fréquence centrale. 
Lorsqu'il s'agit d'un filtre passe-haut ou passe-bas, ils contrôlent 
la fréquence de coupure. 

Encodeurs Q/Slope

Les encodeurs situés en bas de ces sections contrôlent la valeur 
Q (pour les filtres coupe-bande) ou la pente d'atténuation à la 
fréquence de coupure (pour les filtres passe-haut et passe-bas). 

Boutons et témoins Notch/Shelf

Les boutons Notch/Shelf de ces sections permettent de passer 
d'un filtre à l'autre lorsque ces derniers sont disponibles. Les 
témoins situés au-dessus du bouton s'allument pour afficher le 
type de filtre actif. 

Boutons Filter In

Les boutons Filter In de ces sections permettent d'activer ou de 
désactiver chaque filtre indépendamment. 

Commandes Low Filter et High Filter de la section Dynamics

Encodeurs Filter 
Frequency

Encodeurs 
Q/Slope

Boutons et 
témoins 

Notch/Shelf

Boutons 
Filter In



Commandes de sélection de canal de la section Dynamics
Commandes de sélection de canal de la section Dynamics

Boutons de sélection de canal

Bouton de mode Select/Link/Bypass

Affichages Dynamics

Bouton Link

Témoin Bypass
Affichages Dynamics

Les témoins de la section Dynamics affichent par défaut le nom du 
plug-in sur lequel est mis le focus. Lorsqu'un encodeur rotatif 
est bougé, ces témoins signalent le nom et la valeur du paramètre 
correspondant. 

Boutons de sélection de canal

Plug-ins multicanal

Lorsque vous utilisez un plug-in multicanal, tous les canaux 
sont contrôlés par paire et les boutons de sélection de canal 
n'ont aucun effet. 

Plug-ins multi-mono

Lorsque vous utilisez un plug-in multi-mono, les commandes des 
canaux sont généralement couplées et modifiées simultanément.

Vous pouvez cependant modifier plusieurs paramètres de plug-in 
pour les canaux individuels d'un plug-in multi-mono. Pour ce faire, 
utilisez les boutons de sélection de canal pour désactiver le couplage 
de tous les canaux ou à l'inverse coupler des canaux spécifiques.

Les boutons de sélection de canal permettent de choisir les 
canaux suivants : 

• L (Gauche)

• Lc (Centre gauche)

• C (Centre)

• Rc (Centre droit)

• R (Droit)

• Ls (Gauche surround)

• Cs (Centre surround)

• Rs (Droit surround)

• LFE

Ces choix prennent en charge toutes les configurations de 
canaux possibles dans Pro Tools. Vous pouvez utiliser un 
maximum de huit canaux simultanément (7.1 surround).
Bouton Link (Master Link)

Plug-ins multicanal

Lorsque vous utilisez un plug-in multicanal, tous les canaux 
sont contrôlés par paire et le bouton Link n'a aucun effet.

Plug-ins multi-mono

Lorsque vous utilisez un plug-in multi-mono, le bouton Link 
active le bouton correspondant dans la fenêtre de plug-in, ce 
qui couple ou découple tous les canaux du plug-in. Lorsque le 
couplage des canaux est activé, le bouton Link est allumé.

Bouton de mode Select/Link/Bypass

Le bouton de mode Select/Link/Bypass détermine la fonction des 
boutons de sélection de canal avec des plug-ins multi-mono. 

Mode Select : dans ce mode, les boutons de sélection de canal 
déterminent le canal d'un plug-in multi-mono pour lequel les 
commandes de plug-in seront actives. Lorsqu'un canal est sé-
lectionné, le témoin correspondant s'allume. Tous les témoins 
des canaux couplés se comportent de manière identique.

En mode Select, si l'option Channel Window Display de D-Control 
est définie sur Yes, les boutons de sélection de canal modifient 
également l'affichage du canal dans la fenêtre de plug-in.

Mode Bypass : dans ce mode, les boutons de sélection de canal 
déterminent les canaux de plug-in multi-mono qui sont mis en 
bypass. Lorsqu'un canal est mis en bypass, le témoin correspondant 
s'allume. Tous les témoins des canaux couplés se comportent de 
manière identique.

Mode Link : dans ce mode, les boutons de sélection de canal déter-
minent les canaux individuels de plug-in multi-mono qui sont 
couplés. Lorsque des canaux sont couplés, les témoins corres-
pondant sont allumés.
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Commandes de modification et d'affichage de la section Dynamics
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Commandes de modification et d'affichage de la section Dynamics

Bouton Bypass

Bouton Key 
Listen

Bouton 
Save As

Bouton 
Lock

Bouton Auto

Bouton d'automation Safe

Bouton Window

Bouton Page

Bouton Ext Key

Bouton Compare

Bouton Cycle
Bouton Page

Si un plug-in contient plusieurs pages de commandes, le bouton 
Page s'allume. Ce bouton permet d'afficher les pages supplémen-
taires du plug-in affiché.

Les commandes de la page active apparaissent dans la fenêtre 
du plug-in avec un contour de couleur.

Bouton Ext Key

Le bouton Ext Key active ou désactive le déclencheur pour les 
plug-ins qui prennent en charge le traitement side-chain avec 
une source externe. Ce témoin s'allume lorsque le déclencheur 
est activé.

Bouton Key Listen

Le bouton Key Listen active ou désactive la fonction Key Listen 
pour les plug-ins prenant en charge l'écoute du déclencheur. 
Ce témoin s'allume lorsque la fonction Key Listen est activée.
Bouton Save As

Le bouton Save As agit comme la commande Save As du menu 
Plug-In Settings.

Pour enregistrer un paramètre de plug-in Dynamics depuis 
D-Control :

1  Appuyez sur le bouton Save As des commandes de modification 
et d'affichage de la section Dynamics. Le bouton Save As clignote 
tant que la boîte de dialogue Save Settings est ouverte.

2  Tapez un nom pour le paramètre de plug-in.

3  Effectuez l'une des opérations suivantes :

• Cliquez sur OK pour enregistrer les paramètres et fermer la 
boîte de dialogue. 

• Appuyez sur le bouton Save As clignotant pour enregistrer 
les paramètres et fermer la boîte de dialogue.

• Appuyez sur le bouton Escape pour quitter la boîte de 
dialogue sans enregistrer les paramètres.



Bouton Lock

Le bouton Lock permet de verrouiller le focus sur le plug-in actif de 
la section Dynamics. Lorsque le focus est verrouillé sur un plug-in, 
il reste dans la section Dynamics, même si le focus passe sur une 
autre piste dans D-Control. Ce bouton s'allume lorsque le focus 
est verrouillé sur un plug-in. 

Bouton Compare

Le bouton Compare active le bouton correspondant de la fenêtre 
de plug-in, ce qui permet de basculer entre le paramètre de plug-in 
enregistré et les modifications effectuées.

Bouton Auto

Le bouton Auto permet d'activer l'automation des paramètres 
Dynamics en sélectionnant ou en appuyant sur les commandes 
correspondantes dans la section Dynamics uniquement. 

En mode Automation, le bouton Auto est allumé. Dans ce mode, 
le témoin Auto rouge des encodeurs rotatifs activés pour l'auto-
mation s'allume, et le bouton des paramètres dont l'automation 
est activée est allumé. 

Pour activer et désactiver l'automation des paramètres Dynamics 
individuels :

1  Appuyez sur le bouton Auto.

2  Sélectionnez les encodeurs rotatifs ou appuyez sur les boutons 
de la section Dynamics pour lesquels vous souhaitez activer 
l'automation. 

3  Appuyez de nouveau sur le bouton Auto pour quitter le mode 
Automation. 

Pour activer et désactiver l'automation de tous les paramètres 
d'un plug-in Dynamics :

1  Appuyez sur le bouton Auto.

2  Effectuez l'une des opérations suivantes :

• Maintenez la touche Alt (Windows) ou Option (Mac) 
enfoncée.

– ou –

• Maintenez le bouton Do to All enfoncé.

3  Bougez n'importe quel encodeur rotatif ou appuyez sur un 
bouton de la section Dynamics. 

4  Appuyez de nouveau sur le bouton Auto pour quitter le mode 
Automation. 
Bouton Safe

Le bouton Safe active le bouton correspondant de la fenêtre de 
plug-in, ce qui évite l'écrasement de l'automation existante pour 
ce plug-in. 

Bouton Cycle

Le bouton Cycle répertorie tous les plug-ins Dynamics disponibles 
du canal sur lequel le focus est mis. 

Bouton Bypass

Le bouton Bypass permet de contourner le plug-in. 

Bouton Window

Le bouton Window permet d'ouvrir et de fermer la fenêtre du 
plug-in sur lequel est mis le focus. 
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VU-mètres et commandes de gain de la section Dynamics
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Encodeurs Input Gain et Output Gain

Les encodeurs Input et Output Gain contrôlent le gain d'entrée et le gain de sortie pour le plug-in actif. Le témoin Auto sous chaque 
potentiomètre de l'encodeur s'allume lorsque l'automation du paramètre est activée. 

VU-mètres Input et Output et témoin Clip

Les VU-mètres Input et Output affichent les niveaux d'entrée et de sortie du plug-in actif. Le témoin Clip s'allume lorsqu'un écrêtage 
est détecté par le plug-in, et peut être désactivé en appuyant sur le bouton Clear Clip de la section Session Management. 

VU-mètres Gain Reduction

Les VU-mètres Gain Reduction affichent la quantité de réduction du gain pour les fonctions Compressor/Limiter (à gauche) et les 
fonctions Expander/Gate (à droite). 

Vous pouvez également afficher les mesures de réduction de gain pour les plug-ins Dynamics directement sur les VU-mètres de canal 
en mode Normal. Voir « Affichage de la réduction de gain des plug-ins Dynamics sur les VU-mètres des canaux » à la page 77.

Commandes de niveau (à gauche) et VU-mètres (à droite) de la section Dynamics

Encodeur Input Gain

Encodeur Output Gain

VU-mètre Output
VU-mètre de 
réduction de gain 
Expander/Gate

VU-mètre de
réduction de gain

Compressor/Limiter

Témoin d'écrêtage

VU-mètre Input



Section EQ

La section EQ inclut des commandes standard pour une variété de plug-ins multi-bande, et un ensemble de commandes pour la 
gestion des paramètres d'affichage et de modification des plug-ins, ainsi que pour la sélection et le couplage de canaux dans les 
plug-ins multi-mono.
Section EQ de l'unité D-Control

Commandes de 
niveau

Commandes 
High-Pass Filter

Commandes 
Low-Mid Filter

Commandes 
Low Filter

Commandes 
Mid Filter

Commandes 
High Filter

Commandes 
High-Mid Filter

Commandes 
Low-Pass 

Filter
Boutons de 

sélection de canal

VU-mètres Input et OutputCommandes de modification et d'affichage de la section EQ
Prise en charge des plug-ins EQ

Les plug-ins de traitement EQ peuvent posséder des commandes 
très diverses, selon leurs applications. La section EQ de D-Control 
fournit des boutons et des potentiomètres rotatifs dédiés, adaptés 
à la plupart des plug-ins. Certains plug-ins n'utilisent pas toutes 
les commandes EQ, et d'autres possèdent des paramètres supplé-
mentaires qui peuvent être affichés dans la section EQ. 

Pour afficher simultanément toutes les commandes d'un plug-in, 
vous pouvez utiliser le mode Custom Fader Plug-Ins.
Affichage de plug-ins EQ

La section EQ affiche automatiquement le premier plug-in EQ 
du canal présent sur la tranche Focus de l'unité principale. 

Pour afficher plusieurs plug-ins EQ qui se trouvent sur le canal sur 
lequel est mis le focus, appuyez sur le bouton Cycle de la section EQ.
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Commandes High-Pass Filter et Low-Pass 
Filter

Les filtres passe-haut et passe-bas comportent les mêmes 
commandes sur les côtés gauche et droit de la section EQ.

Encodeurs Q

Les encodeurs situés en haut des bandes d'égaliseur contrôlent 
la valeur Q de chaque filtre. Le témoin Auto sous chaque bouton 
encodeur s'allume lorsque l'automation du paramètre est activée.

Boutons et témoins Notch/Shelf

Les boutons Notch/Shelf des bandes d'égaliseur permettent de 
passer d'un filtre à l'autre lorsque ces derniers sont disponibles. 
Les témoins situés de chaque côté du bouton s'allument pour 
afficher le type de filtre actif.

Encodeurs Frequency

Les encodeurs situés en bas des bandes d'égaliseur contrôlent la 
fréquence de chaque filtre. Lorsqu'il s'agit d'un filtre coupe-bande, 
ces encodeurs contrôlent sa fréquence centrale. Lorsqu'il s'agit 
d'un filtre passe-haut ou passe-bas, ils contrôlent la fréquence de 
coupure. Le témoin Auto sous chaque bouton encodeur s'allume 
lorsque l'automation du paramètre est activée.

Boutons Band In

Les boutons Band In des bandes d'égaliseur permettent d'activer ou 
de désactiver la bande d'égaliseur correspondante dans le plug-in. 

Commandes High-Pass Filter et Low-Pass Filter de la section EQ

Encodeurs Q

Boutons et témoins 
Notch/Shelf

Encodeurs Frequency

Boutons Filter In
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Commandes d'égaliseur Low Shelf/Peak et 
High Shelf/Peak

Les commandes des bandes d'égaliseur Low Shelf/Peak et High 
Shelf/Peak des côtés droit et gauche de la section EQ sont iden-
tiques, à l'intérieur des commandes de filtre passe-haut et passe-bas.

Encodeurs Q

Les encodeurs situés en haut des bandes d'égaliseur contrôlent la 
valeur Q de chaque bande. Le témoin Auto sous chaque bouton 
encodeur s'allume lorsque l'automation du paramètre est activée.

Boutons et témoins Notch/Shape

Les boutons Notch/Shape des bandes d'égaliseur permettent de 
passer d'un égaliseur à l'autre lorsque ces derniers sont disponibles. 
Les témoins situés de chaque côté du bouton s'allument pour 
afficher le type d'égaliseur actif.

Encodeurs Frequency

Les encodeurs situés au centre des bandes d'égaliseur contrôlent 
la fréquence de chaque bande. Lorsqu'il s'agit d'un égaliseur 
coupe-bande, ces encodeurs contrôlent sa fréquence centrale. 
Lorsqu'il s'agit d'un égaliseur passe-haut ou passe-bas, ils con-
trôlent la fréquence de coupure. Le témoin Auto sous chaque 
bouton encodeur s'allume lorsque l'automation du paramètre 
est activée.

Encodeurs Gain

Les encodeurs situés en bas des bandes d'égaliseur contrôlent le gain 
de chaque bande. Le témoin Auto sous chaque bouton encodeur 
s'allume lorsque l'automation du paramètre est activée.

Boutons Band In

Les boutons Band In des bandes d'égaliseur permettent d'activer ou 
de désactiver la bande d'égaliseur correspondante dans le plug-in. 

Commandes Low Filter et High Filter de la section EQ

Encodeurs Q

Boutons et témoins 
Notch/Shape

Encodeurs Frequency

Encodeurs Gain

Boutons Band In



Commandes Low-Mid, Mid et High-Mid des bandes d'égaliseur

Les commandes des bandes d'égaliseur Low-Mid, Mid et High-Mid, situées au centre de la section EQ, sont identiques.
Encodeurs Q

Les encodeurs situés en haut des bandes d'égaliseur contrôlent la valeur Q de chaque bande. Le témoin Auto sous chaque bouton 
encodeur s'allume lorsque l'automation du paramètre est activée.

Encodeurs Frequency

Les encodeurs situés au centre des bandes d'égaliseur contrôlent la fréquence centrale de chaque bande. Le témoin Auto sous chaque 
bouton encodeur s'allume lorsque l'automation du paramètre est activée.

Encodeurs Gain

Les encodeurs situés en bas des bandes d'égaliseur contrôlent le gain de chaque bande. Le témoin Auto sous chaque bouton encodeur 
s'allume lorsque l'automation du paramètre est activée.

Boutons Band In

Les boutons Band In des bandes d'égaliseur permettent d'activer ou de désactiver la bande d'égaliseur correspondante dans le plug-in. 

Commandes des bandes d'égaliseur Low-Mid, Mid et High-Mid de la section EQ

Encodeurs Frequency

Boutons Band In

Encodeurs Q

Encodeurs Gain
C
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Commandes de sélection de canal de la section EQ
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Commandes de sélection de canal de la section EQ

Affichages EQ

Bouton Link

Boutons de sélection de canal

Bouton de mode Select/Link/Bypass

Témoin Bypass
Affichages EQ

Les témoins de la section EQ affichent par défaut le nom du plug-in 
sur lequel est mis le focus. Lorsqu'un encodeur rotatif est bougé, ces 
témoins signalent le nom et la valeur du paramètre correspondant. 

Boutons de sélection de canal

Plug-ins multicanal

Lorsque vous utilisez un plug-in multicanal, tous les canaux sont 
contrôlés par paire et les boutons de sélection de canal n'ont pas 
d'effet, sauf pour les plug-ins multicanal (tels que Focusrite d2) 
qui prennent directement en charge la sélection de canal.

Plug-ins multi-mono

Lorsque vous utilisez un plug-in multi-mono, les commandes des 
canaux sont généralement couplées et modifiées simultanément.

Vous pouvez cependant modifier plusieurs paramètres de plug-in 
pour les canaux individuels d'un plug-in multi-mono en désacti-
vant le couplage entre tous les canaux ou en couplant des canaux 
spécifiques à l'aide des boutons de sélection de canal.

Les boutons de sélection de canal permettent de choisir les canaux 
suivants : 

• L (Gauche)

• Lc (Centre gauche)

• C (Centre)

• Rc (Centre droit)

• R (Droit)

• Ls (Gauche surround)

• Cs (Centre surround)

• Rs (Droit surround)

• LFE

Ces choix prennent en charge toutes les configurations de 
canaux possibles dans Pro Tools. Vous pouvez utiliser un 
maximum de huit canaux simultanément (7.1 surround).
Bouton Link (Master Link)

Plug-ins multicanal

Lorsque vous utilisez un plug-in multicanal, tous les canaux sont 
contrôlés par paire et le bouton Link n'a pas d'effet, sauf pour les 
plug-ins multicanal (tels que Focusrite d2) qui prennent direc-
tement en charge le couplage des canaux.

Plug-ins multi-mono

Lorsque vous utilisez un plug-in multi-mono, le bouton Link 
active le bouton correspondant dans la fenêtre de plug-in, ce 
qui couple ou découple tous les canaux du plug-in. Lorsque le 
couplage des canaux est activé, le bouton Link est allumé.

Bouton de mode Select/Link/Bypass

Le bouton de mode Select/Link/Bypass détermine la fonction 
des boutons de sélection de canal avec des plug-ins multi-mono. 

Mode Select : dans ce mode, les boutons de sélection de canal 
déterminent le canal d'un plug-in multi-mono pour lequel les 
commandes de plug-in seront actives. Lorsqu'un canal est sélec-
tionné, le témoin correspondant s'allume. Tous les témoins des 
canaux associés se comportent de manière identique.

En mode Select, si l'option Channel Window Display de D-Control 
est définie sur Yes, les boutons de sélection de canal modifient 
également l'affichage du canal dans la fenêtre de plug-in.

Mode Bypass : dans ce mode, les boutons de sélection de canal 
déterminent les canaux de plug-in multi-mono qui sont mis en 
bypass. Lorsqu'un canal est désactivé, le témoin correspondant 
s'allume. Tous les témoins des canaux couplés se comportent 
de manière identique.

Mode Link : dans ce mode, les boutons de sélection de canal déter-
minent les canaux individuels de plug-in multi-mono qui sont 
couplés. Lorsque des canaux sont couplés, les témoins corres-
pondants sont allumés.



Commandes de modification et d'affichage de la section EQ
Commandes de modification et d'affichage de la section EQ

Bouton Master Bypass

Bouton 
Save As

Bouton 
Lock

Bouton Window

Bouton d'automation Safe

Bouton Auto

Bouton Cycle

Bouton Compare
Bouton Save As

Le bouton Save As agit comme la commande Save As du menu 
Plug-In Settings et permet ainsi d'enregistrer un nouveau fichier 
de paramètres pour le plug-in.

Pour enregistrer un paramètre de plug-in EQ dans D-Control :

1  Appuyez sur le bouton Save As des commandes de modification 
et d'affichage de la section Dynamics. Le bouton Save As clignote 
tant que la boîte de dialogue Save Settings est ouverte.

2  Tapez un nom pour le paramètre de plug-in.

3  Effectuez l'une des opérations suivantes :

• Cliquez sur OK pour enregistrer les paramètres et fermer la 
boîte de dialogue. 

• Appuyez sur le bouton Save As clignotant pour enregistrer 
les paramètres et fermer la boîte de dialogue.

• Appuyez sur le bouton Escape pour quitter la boîte de dialogue 
sans enregistrer les paramètres.

Bouton Lock

Le bouton Lock permet de verrouiller le focus sur le plug-in actif 
de la section EQ. Lorsque le focus est verrouillé sur un plug-in, 
le plug-in actif reste dans la section EQ, même si le focus passe 
sur une autre piste dans D-Control. Ce bouton s'allume lorsque 
le focus est verrouillé sur un plug-in. 

Bouton Compare

Le bouton Compare active le bouton correspondant de la fenêtre 
de plug-in, ce qui permet de basculer entre le paramètre de plug-in 
enregistré et les modifications effectuées.
Bouton Auto

Le bouton Auto permet d'activer les paramètres EQ pour l'auto-
mation en sélectionnant ou en appuyant sur les commandes de 
la section EQ uniquement. 

En mode Automation, le bouton Auto est allumé. Dans ce mode, 
le témoin Auto rouge des encodeurs rotatifs activés pour l'auto-
mation s'allume, et le bouton des paramètres dont l'automation 
est activée est allumé. 

Pour activer et désactiver l'automation des paramètres EQ 
individuels :

1  Appuyez sur le bouton Auto.

2  Sélectionnez les encodeurs rotatifs ou appuyez sur les boutons de 
la section EQ pour lesquels vous souhaitez activer l'automation. 

3  Appuyez de nouveau sur le bouton Auto pour quitter le mode 
Automation. 

Pour activer et désactiver l'automation de tous les paramètres 
d'un plug-in EQ :

1  Appuyez sur le bouton Auto.

2  Effectuez l'une des opérations suivantes :

• Maintenez la touche Alt (Windows) ou Option (Mac) 
enfoncée.

– ou –

• Maintenez le bouton Do to All enfoncé.

3  Bougez n'importe quel encodeur rotatif ou appuyez sur un 
bouton de la section EQ. 

4  Appuyez de nouveau sur le bouton Auto pour quitter le mode 
Automation. 
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Bouton Safe

Le bouton Safe active le bouton correspondant de la fenêtre de 
plug-in, ce qui évite l'écrasement de l'automation existante pour 
ce plug-in. 

Bouton Cycle

Le bouton Cycle répertorie tous les plug-ins EQ disponibles du 
canal sur lequel est mis le focus. 

Bouton Bypass

Le bouton Bypass permet de contourner le plug-in. 

Bouton Window

Le bouton Window permet d'ouvrir et de fermer la fenêtre du 
plug-in sur lequel est mis le focus. 
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Commandes de niveau et VU-mètres de la 
section EQ

Encodeurs Input Gain et Output Gain

Les encodeurs Input et Output Gain contrôlent le gain d'entrée et 
le gain de sortie pour le plug-in actif. Le témoin Auto sous chaque 
bouton encodeur s'allume lorsque l'automation du paramètre 
est activée. 

VU-mètres Input et Output et témoin Clip

Les VU-mètres Input et Output affichent les niveaux d'entrée et de 
sortie du plug-in actif. Le témoin Clip s'allume lorsqu'un écrêtage 
est détecté par le plug-in, et peut être désactivé en appuyant sur 
le bouton Clear Clip de la section Session Management. 

Commandes de niveau et VU-mètres de la section EQ

Encodeur Input Gain

Encodeur Output Gain

VU-mètre Output

Témoin
d'écrêtage

VU-mètre
Input



Chapitre 8 : Commandes de transport et de 
navigation

Section Transport

La section Transport de D-Control inclut deux jeux complets de boutons de transport, des boutons permettant de définir le mode 
de transport, des boutons et des commandes de scrub/shuttle ainsi que des boutons d'écoute et de repérage avancés. 
Section Transport de D-Control

Boutons Audition

Boutons Master
Record Mode

Boutons Locate

Boutons Machine
Transport

Boutons Pro Tools
Transport

Boutons Online

Boutons External 
Machines

Commandes et boutons 
Scrub/Shuttle

Boutons Transport Mode
Boutons Transport

D-Control contient deux jeux de boutons de transport, un pour 
Pro Tools et l'autre dédié aux machines externes contrôlées à 
l'aide de l'option MachineControl. 

Pro Tools Transport

Les boutons Pro Tools Transport de D-Control correspondent 
aux commandes de la barre de transport de Pro Tools.

Boutons Pro Tools Transport

Témoin MIDI 
Merge

RecordPlayStopRewind Fast 
Forward
Bouton Rewind : déplace le curseur à un emplacement antérieur 
à sa position actuelle dans la session Pro Tools. 

Bouton Fast Forward : déplace le curseur à un emplacement 
postérieur à sa position actuelle dans la session Pro Tools. 

Bouton Stop : interrompt la lecture de la session Pro Tools.

Bouton Play : commence la lecture de la session Pro Tools à 
partir de la position actuelle du curseur. 

Bouton Record : active Pro Tools pour l'enregistrement. La fonction 
exacte est déterminée par le mode d'enregistrement actuel de 
Pro Tools (QuickPunch, TrackPunch, Wait for Note, Pause). 

Témoin MIDI Merge : indique si l'option MIDI Merge est activée 
ou non.
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Machine Transport

L'option MachineControl permet d'activer le mode Dual Transport 
pour D-Control, ce qui active automatiquement les commandes 
Machine Transport. Ces commandes peuvent ensuite être affectées 
pour contrôler un périphérique 9 broches ou MMC externe.

Commandes Scrub/Shuttle

Les commandes Scrub/Shuttle permettent d'effectuer les actions 
suivantes :

• opérations du curseur d'édition, y compris scrubbing, scrubbing 
et trimming simultanés, navigation et sélections ;

• applications de zooms, navigation dans les fenêtres Pro Tools 
et création de banques de faders sur D-Control. 

Molette Scrub/Shuttle

La molette Scrub/Shuttle permet d'effectuer les actions suivantes : 
contrôle de la position du curseur dans Pro Tools, application 
de zooms, navigation dans les fenêtres et création de banques 
de faders. 

Défilement et localisation dans les fenêtres Pro Tools

Pour faire défiler horizontalement le contenu de la fenêtre Edit 
ou Mix :

1  Activez la fenêtre dont vous voulez faire défiler le contenu en 
cliquant dessus ou à l'aide du bouton de la fenêtre correspondante 
dans la section Window Management.

2  Maintenez la touche Alt (Windows) ou Option (Mac) 
enfoncée tout en actionnant la molette Scrub/Shuttle. 

Pour faire défiler verticalement le contenu de la fenêtre Edit 
ou Mix :

1  Activez la fenêtre dont vous voulez faire défiler le contenu en 
cliquant dessus ou à l'aide du bouton de la fenêtre correspondante 
dans la section Window Management.

2  Maintenez la touche Maj enfoncée tout en actionnant la 
molette Scrub/Shuttle. 

Commandes Scrub/Shuttle

Bouton 
Shuttle

Bouton 
Trim

Bouton 
Scrub

Molette 
Scrub/Shuttle
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Pour localiser le curseur dans la fenêtre Edit en mode Continuous 
Scroll :

 Tout en maintenant les touches Ctrl+Alt+Démarrer (Windows) 
ou les touches Commande+Option+Ctrl (Mac) enfoncées, appuyez 
sur le bouton Mark In ou Mark Out dans la section Audition. 

Sélection à l'aide de la molette Scrub/Shuttle

Pour effectuer des sélections à l'aide de la molette Scrub/Shuttle :

1  Localisez le curseur dans une piste. 

2  Appuyez sur le bouton Scrub ou Shuttle.

3  Effectuez l'une des opérations suivantes :

• Tout en maintenant le bouton Mark In enfoncé, tournez la 
molette Scrub/Shuttle dans le sens contraire des aiguilles 
d'une montre pour effectuer une sélection ou étendre la 
sélection vers la gauche. 

– ou –

• Tout en maintenant le bouton Mark Out enfoncé, tournez la 
molette Scrub/Shuttle dans le sens des aiguilles d'une montre 
pour effectuer une sélection ou étendre la sélection vers la 
droite. 

Pour effectuer un scrubbing lors de l'ajout au début d'une 
sélection :

 Tout en maintenant les touches Démarrer+Maj (Windows) 
ou Ctrl+Maj (Mac) enfoncées, appliquez un scrubbing au début 
de la sélection.

Pour effectuer un scrubbing lors de l'ajout à la fin d'une sélection :

 Tout en maintenant les touches Démarrer+Maj+Alt (Windows) 
ou Ctrl+Maj+Option (Mac) enfoncées, appliquez un scrubbing 
à la fin de la sélection.

Pour effectuer un scrubbing avec une résolution précise lors de 
l'ajout au début d'une sélection :

 Tout en maintenant les touches Démarrer+Maj+Ctrl (Windows) 
ou Ctrl+Maj+Commande (Mac) enfoncées, appliquez un scrubbing 
au début de la sélection.

Pour effectuer un scrubbing avec une résolution précise lors de 
l'ajout à la fin d'une sélection :

 Tout en maintenant les touches Démarrer+Maj+Alt+Ctrl 
(Windows) ou Ctrl+Maj+Option+Commande (Mac) enfoncées, 
appliquez un scrubbing à la fin de la sélection.

Zoom continu à l'intérieur de la fenêtre Edit

Pour appliquer un zoom horizontal continu dans la fenêtre Edit :

 Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée tout en actionnant la molette Scrub/Shuttle.



Pour appliquer un zoom vertical continu dans la fenêtre Edit :

 Maintenez les touches Ctrl+Alt (Windows) ou Commande+
Option (Mac) enfoncées tout en actionnant la molette Scrub/
Shuttle.

Déplacement des fenêtres à l'écran à l'aide de la molette 
Scrub/Shuttle

Pour déplacer une fenêtre Pro Tools horizontalement à l'écran :

 Dans la section Window Management, maintenez le bouton de 
la fenêtre correspondante enfoncé tout en actionnant la molette 
Scrub/Shuttle. 

Pour déplacer une fenêtre Pro Tools verticalement à l'écran :

 Dans la section Window Management, maintenez le bouton 
de la fenêtre correspondante et la touche Maj enfoncés tout en 
actionnant la molette Scrub/Shuttle. 

Déplacement par incrément de la position ou de la sélection de 
piste sur D-Control à l'aide de la molette Scrub/Shuttle

Pour déplacer par incrément la position des pistes sur D-Control en 
mode Normal :

 Tout en maintenant enfoncé l'un des boutons Nudge/Bank, 
actionnez la molette Scrub/Shuttle.

Pour déplacer par incrément la position des pistes sur D-Control 
dans la section Custom Faders :

 Tout en maintenant enfoncé le bouton Bank/Cycle dans la 
section Custom Faders, actionnez la molette Scrub/Shuttle.

Pour déplacer par incrément la piste sélectionnée dans la tranche 
Focus Channel Strip :

1  Tout en maintenant la touche Ctrl (Windows) ou Commande 
(Mac) enfoncée, appuyez sur le bouton Nudge 1 de droite ou 
gauche. 

2  Tout en maintenant le bouton Nudge 1 enfoncé, actionnez la 
molette Scrub/Shuttle.

Bouton Scrub

Le bouton Scrub active le mode de transport Scrub, ce qui permet 
d'effectuer un scrubbing depuis la position du curseur ou sur 
l'ensemble d'une sélection. 

Pour effectuer un scrubbing audio en mode Scrub :

1  Lorsque Pro Tools est arrêté, appuyez sur le bouton Scrub.

2  Tournez la molette Scrub/Shuttle dans le sens des aiguilles 
d'une montre pour effectuer un scrubbing avant de l'audio, 
ou dans le sens inverse des aiguilles d'une montre pour un 
scrubbing arrière.

3  Pour quitter ce mode, appuyez de nouveau sur le bouton Scrub.
Scrubbing sans mode Scrub

Vous pouvez utiliser la molette Scrub/Shuttle pour effectuer un 
scrubbing lorsque le transport est arrêté ou lors de la lecture, 
sans activer le mode Scrub. 

Pour effectuer un scrubbing pendant la lecture :

1  Cliquez sur la piste à laquelle appliquer un scrubbing.

2  Maintenez la touche Démarrer (Windows) ou Ctrl (Mac) 
enfoncée tout en actionnant la molette Scrub/Shuttle.

Pour verrouiller la molette Scrub/Shuttle en mode Scrub :

 Maintenez la touche Démarrer (Windows) ou Ctrl (Mac) 
enfoncée un court instant (moins d'une demi-seconde) tout 
en actionnant la molette Scrub/Shuttle.

Pour appliquer un scrubbing avec une résolution précise :

 Maintenez les touches Démarrer+Ctrl (Windows) ou 
Ctrl+Commande (Mac) enfoncées tout en actionnant la 
molette Scrub/Shuttle.

Bouton Trim

Le bouton Trim active le mode de transport Trim/Scrub, 
ce qui permet d'effectuer un scrubbing pour rechercher un 
point d'édition, puis d'effectuer un trim jusqu'à ce point.

Pour effectuer un scrubbing lors du trimming :

1  Accédez à la région ou la sélection à trimmer.

2  Appuyez sur le bouton Trim.

3  Appuyez sur le bouton Scrub.

4  Tournez la molette Scrub/Shuttle pour placer le curseur sur 
l'emplacement de trimming.

5  Pour faire un trim à l'emplacement du curseur ou au début de 
la sélection, appuyez à nouveau sur le bouton Trim. 

Bouton Shuttle

Le bouton Shuttle active le mode de transport Shuttle, ce qui 
permet de localiser le curseur dans la fenêtre Edit. 

Pour utiliser le mode Shuttle :

1  Lorsque Pro Tools est arrêté, appuyez sur le bouton Shuttle.

2  Tournez la molette Scrub/Shuttle dans le sens des aiguilles 
d'une montre pour effectuer un shuttle avant, ou dans le sens 
inverse des aiguilles d'une montre pour un shuttle arrière. 

3  Pour quitter ce mode, appuyez de nouveau sur le bouton Shuttle.

Les modes Scrub, Trim/Scrub et Shuttle permettent de créer des 
sélections et de définir des régions dans la fenêtre Edit de Pro Tools. 

Pour faire un trim à la fin d'une sélection, maintenez la 
touche Alt (Windows) ou Option (Mac) enfoncée tout en 
appuyant sur le bouton Trim.
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Boutons Master Record Mode

Les boutons Master Record Mode permettent de basculer vers le 
mode de préparation pour l'enregistrement ou vers le mode de 
monitoring des signaux d'entrée de tous les canaux d'une session. 

Bouton Master Record Enable

Le bouton Master Record Enable bascule le statut de préparation 
pour l'enregistrement pour toutes les pistes audio concernées d'une 
session. Ce bouton clignote lorsque des canaux sont prêts pour 
l'enregistrement et que la barre de transport Pro Tools est arrêtée ; 
les témoins continuent de clignoter au cours de l'enregistrement.

Si des pistes de la session sont préparées pour l'enregistrement, une 
pression sur le bouton Master Record Enable annule ce statut. Si 
aucun canal n'est préparé pour l'enregistrement, cette même action 
prépare toutes les pistes audio concernées pour l'enregistrement.

Bouton Master Input Monitor Mode

Le bouton Master Input Monitor Mode active le mode de monito-
ring des signaux d'entrée pour toutes les pistes audio préparées pour 
l'enregistrement d'une session. Cette action peut être effectuée 
en sélectionnant Change Record Enabled Tracks to Auto Input 
ou Input Only dans Pro Tools. Ce bouton s'allume uniquement 
lorsque des pistes préparées pour l'enregistrement sont en mode 
Input Only.

Pour activer le mode de monitoring des signaux d'entrée de toutes 
les pistes audio d'une session, maintenez la touche Alt (Windows) 
ou Option (Macintosh) enfoncée tout en appuyant sur le bouton 
Master Input Monitor Mode.

Boutons Master Record Mode

Bouton Master Record Enable

Bouton Master Input Monitor Mode
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Boutons Transport Mode

Les boutons Transport Mode permettent d'activer divers modes 
de lecture et d'enregistrement pour la barre de transport Pro Tools. 

Bouton Pro Tools Online

Le bouton Pro Tools Online active ou désactive le statut online 
de Pro Tools. Dans la barre de transport de Pro Tools, le bouton 
Online s'allume pour indiquer que le statut actuel est online.

Lorsque Pro Tools est online et en attente de timecode, ce 
bouton clignote. Lorsqu'un timecode est reçu, il s'allume 
de façon continue. 

Bouton 9-Pin Remote

Le bouton 9-Pin Remote active le mode 9-Pin Remote Deck 
Emulation avec l'option MachineControl. 

Bouton Machine Online

Avec l'option MachineControl, le bouton Machine Online active 
ou désactive le statut online de la machine externe. Vous pouvez 
naviguer dans Pro Tools Transport Master en maintenant la touche 
Démarrer (Windows) ou Ctrl (Mac) enfoncée tout en appuyant 
sur le bouton Machine Online .

Bouton Loop Playback

Le bouton Loop Playback bascule Pro Tools en mode Loop 
Playback. Il s'allume lorsque le mode Loop Playback est actif. 
Dans la barre de transport de Pro Tools, le bouton Play s'allume 
pour indiquer que le statut actuel est Loop Playback.

Bouton QuickPunch

Le bouton QuickPunch bascule Pro Tools en mode d'enregistre-
ment QuickPunch. Il s'allume lorsque le mode QuickPunch est 
actif. Dans la barre de transport de Pro Tools, le bouton Record 
s'allume pour indiquer que le statut actuel est QuickPunch.

Boutons Transport Mode

Bouton 
QuickPunch

Bouton 
TrackPunch

Bouton Loop 
Playback

Bouton 9-Pin 
Remote

Bouton Machine 
Online

Bouton Pro Tools 
Online



Bouton TrackPunch

Le bouton TrackPunch bascule Pro Tools en mode d'enregistre-
ment TrackPunch. Il s'allume lorsque le mode TrackPunch est 
actif. Dans la barre de transport de Pro Tools, le bouton Record 
s'allume pour indiquer que le statut actuel est TrackPunch.

Boutons Audition

Les boutons Audition permettent d'activer le pré-roll ou le post-roll 
en lecture, de définir une sélection de points d'entrée et de sortie, 
et de déclencher la lecture automatique de plages. 

Bouton Audition

Le bouton Audition active ou désactive le mode Audition. 
Il s'allume lorsque le mode Audition est activé. 

Lorsque le mode Audition est activé, vous pouvez écouter 
rapidement le début et la fin d'une sélection, avec ou sans 
pré-roll ou post-roll, en appuyant sur les touches suivantes :

Bouton Pre-Roll : lit le signal audio du point de pré-roll jusqu'au 
début de la sélection. 

Bouton Mark In : lit le signal audio sur la longueur de post-roll 
définie, en commençant au début de la sélection.

Bouton Mark Out : lit le signal audio sur la longueur de pré-roll 
définie précédant le point de sortie de la sélection.

Bouton Post-roll lit le signal audio sur la longueur de post-roll 
définie, à partir de la fin de la sélection. 

Boutons Pre-Roll et Post-Roll

Lorsque le mode Audition est désactivé, les boutons Pre-Roll et 
Post-Roll activent ou désactivent la lecture de pré-roll et post-roll 
dans Pro Tools. Lorsqu'un pré-roll ou post-roll est actif, les boutons 
correspondants s'allument.

Lorsque le mode Audition est activé, les boutons Pre-Roll et 
Post-Roll lisent une plage de signaux audio située autour de 
la section d'édition actuelle.

Boutons Audition

Bouton 
Post-Roll

Bouton 
Mark In

Bouton 
Audition

Bouton 
Pre-Roll

Bouton 
Mark Out
Boutons Mark In et Mark Out

Lorsque le mode Audition est désactivé, les boutons Mark In et 
Mark Out sont utilisés pour définir le début et la fin de la sélection 
au cours de la lecture ou lors de l'utilisation de la molette Scrub/
Shuttle. 

Lorsque le mode Audition est activé, les boutons Mark In 
et Mark Out lisent une plage de signaux audio autour de la 
section d'édition actuelle. 

Pour déplacer le début de la sélection : 

Après avoir arrêté le transport, maintenez le bouton Mark In 
enfoncé tout en actionnant la molette Scrub/Shuttle. 

Pour déplacer la fin de la sélection :

Après avoir arrêté le transport, maintenez le bouton Mark In 
enfoncé tout en actionnant la molette Scrub/Shuttle. 

Pour déplacer la sélection en intégralité :

Après avoir arrêté le transport, maintenez les boutons Mark In 
et Mark Out enfoncés tout en actionnant la molette Scrub/Shuttle. 

Boutons Locate

Les boutons Locate placent la barre de transport Pro Tools à 
l'endroit spécifié. 

Bouton Go To Start

Le bouton Go To Start renvoie le curseur de lecture au début de 
la session. 

Bouton Go To End

Le bouton Go To End renvoie le curseur de lecture à la fin de la 
session.

Bouton Back

Le bouton Back déplace la position de lecture vers l'arrière en 
fonction de la valeur de l'option Back/Forward Amount.

Pour déplacer le point de lecture vers l'avant :

 Tout en maintenant la touche Alt (Windows) ou Option (Mac) 
enfoncée, appuyez sur le bouton Back dans la section Transport.

Boutons Locate

Bouton Go 
To Start

Bouton Go 
To End

Bouton 
Back

Bouton Back 
& Play

Bouton Instant 
Playback
Chapitre 8
 : Comm
andes de tr
ansport et de navigation 95



Bouton Back & Play

Le bouton Back and Play recule la position de lecture actuelle 
en fonction de la valeur de l'option Back/Forward Amount et 
lance automatiquement la lecture.

Mode Forward & Play

Activez le mode Forward & Play en utilisant l'une des méthodes 
suivantes :

Pour déplacer le point de lecture vers l'avant et reprendre la 
lecture :

 Tout en maintenant la touche Alt (Windows) ou Option 
(Macintosh) enfoncée, appuyez sur le bouton Back and Play 
dans la section Transport.

Bouton Instant Playback

Le bouton Instant Playback prépare Pro Tools à la lecture afin 
que la lecture démarre instantanément dès que vous appuyez 
sur Play. Ce bouton peut également être utilisé au cours de l'en-
registrement pour activer le mode Record Pause de Pro Tools.

Bouton External Machines

Les boutons External Machines permettent d'accéder directement 
aux fonctions d'armement à distance des pistes des machines de 
l'option MachineControl. Ces fonctions sont disponibles lorsque 
MachineControl est activée et qu'un profil d'armement des pistes 
est déclaré. Pour plus de détails sur les fonctions d'armement à 
distance des pistes et les modes d'enregistrement, reportez vous 
au Guide MachineControl. 

Bouton Track Arm from Channel Strips

Le bouton Track Arm from Channel Strips affiche les commandes 
d'armement des pistes pour la machine externe actuellement 
activée sur les canaux Custom Fader. Le nom des pistes apparaît 
dans les affichages du canal Custom Fader, et les pistes peuvent 
être préparées pour l'enregistrement via le bouton Record Enable 
correspondant. 

Si le nombre de pistes de machines disponibles à l'armement est 
supérieur au nombre de pistes pouvant être affichées, le bouton 
Bank/Cycle permet de rechercher parmi les différentes banques 
des canaux. 

Boutons External Machines

Bouton 
Insert/Assemble

Bouton Auto 
Insert/Punch

Bouton Track 
Arm from 

Channel Strips

Bouton 
Machine 

Insert
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Bouton Machine Insert

Le bouton Machine Insert active/désactive l'option Machine 
Follows Edit Insertion/Scrub de Machine Control dans les pré-
férences de fonctionnement de Pro Tools.

Bouton Auto Insert/Punch

La touche Auto Insert/Punch bascule le protocole d'enregistrement 
de MachineControl entre les modes Auto Edit et Punch In/Out, 
comme indiqué dans la fenêtre Track Arming de Pro Tools.

Bouton Insert/Assemble

Le bouton Insert/Assemble bascule l'enregistrement 
MachineControl entre les modes Insert et Assemble, 
comme indiqué dans la fenêtre Track Arming de Pro Tools. 

Boutons External Machine Online

Boutons Machine Online

Les boutons Machine Online (Mach 1, Mach 2, Mach 3, et Mach 4) 
sont utilisés dans le mode Multi de D-Control pour passer le 
contrôle de la console d'un système Pro Tools connecté à un 
autre. 

Lorsqu'un système Pro Tools est disponible, vous pouvez le con-
trôler en appuyant sur le bouton Machine Online correspondant. 

Voir « Mode Multi de D-Control » à la page 100.

Boutons External Machine Online

Bouton 
Machine 4 

Online

Bouton 
Machine 2 

Online

Bouton 
Machine 3 

Online

Bouton 
Machine 1 

Online



Section Zoom/Navigate

La section Zoom/Navigate permet de contrôler la navigation, 
l'affichage, et les sélections dans la fenêtre Edit de Pro Tools. 

Bouton Zoom Mode 

Le bouton Zoom Mode met les boutons fléchés en mode Zoom.

Bouton Navigate Mode

Le bouton Navigate Mode active le mode Navigate des boutons 
fléchés.

Boutons fléchés (Haut, Bas, Précédent, Suivant)

La fonction des boutons fléchés dépend du mode actif.

Mode Zoom : lorsque le mode Zoom est sélectionné, les boutons 
Haut et Bas agissent sur le zoom vertical et les boutons Précédent 
(Gauche) et Suivant (Droite) agissent sur le zoom horizontal.

Mode Navigate : en mode Navigate, les boutons fléchés Haut et 
Bas déplacent le curseur d'édition vers le haut ou vers le bas dans 
les pistes, et les boutons fléchés Précédent (Gauche) et Suivant 
(Droite) déplacent le curseur d'édition vers la gauche ou vers la 
droite dans les limites des régions ou transitoires (en fonction 
du paramètre Tab to Transients). 

Entrée de texte dans les fenêtres Pro Tools : dans les modes Zoom 
et Navigate, les boutons fléchés permettent de passer d'un champ 
de texte à un autre. Les boutons fléchés Précédent (Gauche) et 
Suivant (Droite) déplacent le curseur un caractère à la fois, et les 
boutons fléchés Haut et Bas placent le curseur au début et à la 
fin du champ de texte.

Section Zoom/Navigate de D-Control

Boutons Zoom Preset

Boutons
fléchés

Bouton Mode
Zoom

Bouton Mode 
Navigate 
Les boutons fléchés permettent d'entrer des valeurs numériques 
dans les compteurs principaux et secondaires, les champs Start/
End/Length, et les champs Pre/Post Roll des fenêtres Edit et 
Transport. Les boutons fléchés Précédent (Gauche) et Suivant 
(Droite) permettent de passer d'un champ à l'autre et les boutons 
Haut et Bas de modifier la valeur du champ.

Navigation dans les boîtes de dialogue : dans Pro Tools, les boutons 
fléchés permettent de parcourir les dossiers des boîtes de dialogue 
telles qu'Open Session. 

Dans la boîte de dialogue New Track, les boutons fléchés effectuent 
les actions suivantes :

• Les flèches Haut et Bas permettent d'augmenter et de réduire 
le nombre de pistes.

• Ctrl (Windows) ou Commande (Mac)+boutons fléchés Haut 
et Bas : défilement des types de pistes

• Ctrl (Windows) ou Commande (Mac)+boutons fléchés 
Précédent (Gauche) et Suivant (Droite) : défilement des 
formats de pistes

• Ctrl+Alt (Windows) ou Commande+Option (Mac)+boutons 
fléchés Précédent (Gauche) et Suivant (Droite) : activation/
désactivation de l'affichage du menu de base de temps

Dans la boîte de dialogue Name Tracks, les boutons fléchés 
effectuent les actions suivantes :

• Ctrl (Windows) ou Commande (Mac)+boutons fléchés 
Précédent (Gauche) et Suivant (Droite) : passer au nom 
de piste précédent ou suivant

Navigation dans la fenêtre Edit : dans la fenêtre Edit, les boutons 
fléchés effectuent les actions suivantes :

 Ctrl (Windows) ou Commande (Mac)+boutons fléchés 
Précédent (Gauche) et Suivant (Droite) : défilement dans 
la fenêtre Edit

Boutons Zoom Preset

Les boutons Zoom Preset chargent les cinq présélections de 
zoom horizontal de Pro Tools. 

Pour sauvegarder une présélection de zoom :

1  À l'aide des boutons Horizontal Zoom ou de l'outil Zoomer, 
définissez le niveau de zoom que vous souhaitez enregistrer.

2  Tout en maintenant la touche Ctrl (Windows) ou Commande 
(Macintosh) enfoncée, appuyez sur un bouton Zoom Preset. 

Pour charger une présélection de zoom :

 Appuyez sur le bouton de présélection de zoom correspondant.
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Section Bank/Nudge

La section Bank/Nudge contrôle l'affichage des canaux en mode 
Normal de la surface D-Control. Ils permettent également de 
déplacer l'affichage de la tranche Focus Channel Strip vers l'avant 
ou vers l'arrière par incréments de un ou huit canaux.

Si des canaux se trouvent dans un des modes Custom Fader, ils 
ne sont pas affectés par les commandes Bank ou Nudge, et les 
autres canaux se déplacent autour.

Boutons Nudge 1

Les boutons Nudge 1 déplacent l'affichage des pistes vers la gauche 
ou vers la droite sur la surface de contrôle, par incrément d'un canal. 

Pour déplacer le focus de la piste vers l'avant ou vers l'arrière par 
incréments d'un canal :

 Donnez la priorité à une piste dans la tranche Focus Channel 
Strip puis, tout en maintenant la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée, appuyez sur le bouton Nudge 1 de 
déplacement vers la gauche ou vers la droite dans la section 
Bank/Nudge.

Boutons Nudge 8

Les boutons Nudge 8 déplacent l'affichage des pistes vers la gauche 
ou vers la droite sur la surface de contrôle, par incrément de huit 
canaux. 

Pour déplacer le focus de la piste vers l'avant ou vers l'arrière par 
incrément de huit canaux :

 Donnez la priorité à une piste dans Focus Channel Strip puis, 
tout en maintenant la touche Ctrl (Windows) ou Commande 
(Mac) enfoncée, appuyez sur le bouton Nudge 8 de déplacement 
vers la gauche ou vers la droite dans la section Bank/Nudge.

Boutons Bank

Les boutons Bank déplacent l'affichage des pistes vers la gauche 
ou vers la droite sur la surface de contrôle, la valeur d'incrément 
correspondant au nombre de canaux disponibles sur la surface. 

Bouton Home

Le bouton Home déplace l'affichage des pistes pour que la pre-
mière piste de la session s'affiche sur le canal le plus à gauche de 
la surface de contrôle. 

Section Bank/Nudge de D-Control

Bouton Home

Boutons Bank (Droite et Gauche)

Boutons Nudge by 1 Track 
(Droite et Gauche)

Boutons Nudge by 8 Tracks 
(Droite et Gauche)
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Matrice Bank Select

Dans les modes Custom Fader, la matrice Bank Select permet de 
créer et de sélectionner des groupes personnalisés et des groupes 
de mixage/édition, de sélectionner des types de pistes à afficher 
dans les faders personnalisés Custom Faders et de sélectionner 
des pages de paramètres de plug-in de fader personnalisé.

Pour plus d'informations sur l'utilisation de la matrice dans les 
modes Custom Fader, reportez-vous au Chapitre 13, « Modes 
Custom Fader ». 

Bouton Bank Select Edit

Le bouton Bank Select Edit s'utilise lors de la création des groupes 
de mixage ou d'édition ou de groupes personnalisés depuis 
D-Control. Une fois que vous avez appuyé sur le bouton, vous 
pouvez sélectionner les pistes que vous souhaitez ajouter au 
groupe. 

Vous pouvez également créer des groupes de mixage ou d'édition 
en sélectionnant les pistes que vous souhaitez ajouter dans le 
groupe et en appuyant deux fois sur le bouton Bank Select Edit. 

Boutons Bank Select

Les boutons Bank Select s'utilisent lors de l'affectation ou du 
rappel de groupes personnalisés ou de groupes de mixage ou 
d'édition, ou lors de la sélection de types de pistes ou de pages 
de paramètres de plug-in depuis D-Control.

Section D-Control Bank Select

Bouton Bank Select Edit

Boutons Bank Select 1 à 12



Mode Dual Transport
(option MachineControl avec un périphérique à 9 broches 
ou MMC)

Le mode Dual Transport affecte le jeu supérieur de commandes 
de transport à un périphérique à 9 broches ou MMC à l'aide de 
MachineControl. 

 En mode Dual Transport, vous pouvez basculer le Transport 
Master (transport maître) entre Transport = Pro Tools et Transport = 
Machine, Transport = MMC, ou Transport = Remote, directement 
à l'aide des boutons de transport de D-Control. 

 En mode Single Transport, vous pouvez basculer Transport 
Master entre Transport = Pro Tools et Transport = Machine, 
Transport = MMC, ou Transport = Remote, directement à l'aide 
du bouton Machine Online des commandes Transport Mode. 

Pour basculer entre les modes Dual Transport et Single Transport :

1  Dans la section Soft Keys, appuyez sur le bouton Operation 
plusieurs fois afin d'afficher la page contenant Transpt.

2  Appuyez sur la Soft Key correspondant à Transpt pour basculer 
le mode Transport entre Dual et Single.

3  Tout en maintenant la touche Ctrl (Windows) ou Commande 
(Mac) enfoncée, appuyez sur le bouton Operation pour quitter.

Sélection du Transport Master en mode Dual 
Transport

En mode Dual Transport, n'importe lequel des jeux de commandes 
de transport peut être actif. Les boutons de transport s'allument 
pour indiquer le Transport Master actif.

• Si les boutons Pro Tools Transport sont allumés, 
Transport = Pro Tools. 

• Si les boutons Machine Transport sont allumés, 
le Transport Master est l'un des suivants :

• Transport = Machine

• Transport = MMC

• Transport = Remote
Pour sélectionner le Transport Master en mode Dual Transport :

 Dans les commandes Transport Mode, appuyez sur le bouton 
Machine Online. 

– ou –

 Effectuez l'une des opérations suivantes :

• Lorsque Transport = Pro Tools, appuyez sur un bouton éteint 
quelconque (Rewind, Fast Forward, Stop, Play, ou Record) 
dans la section Machine Transport. 

• Lorsque Transport = Machine, MMC, ou Remote, appuyez 
sur un bouton éteint quelconque (Rewind, Fast Forward, 
Stop, Play, ou Record) dans la section Pro Tools Transport. 

La première pression réalisée sur un bouton de transport éteint 
modifie le Transport Master et n'envoie pas de commande de 
transport. La deuxième pression envoie la commande de transport. 

Sélection du Transport Master en mode 
Single Transport

En mode Single Transport, seules les commandes Pro Tools 
Transport sont actives et contrôlent le Transport Master 
actuellement sélectionné.

Pour sélectionner le Transport Master en mode Single Transport :

 Dans les commandes Transport Mode, appuyez sur le bouton 
Machine Online. 

Parcours des Transport Masters disponibles

Dans les modes Single et Dual Transport, le bouton 
Machine Online permet de parcourir les Transport 
Master disponibles (Pro Tools, Machine, MMC, et 
Remote) à partir de D-Control. 

Pour parcourir les Transport Masters disponibles :

 Tout en maintenant la touche Démarrer (Windows) ou Ctrl 
(Mac) enfoncée, appuyez plusieurs fois sur le bouton Machine 
Online des commandes Transport Mode.
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Mode Multi de D-Control

Le mode Multi de D-Control permet d'utiliser une seule 
console D-Control pour accéder au maximum à quatre 
systèmes Pro Tools|HD sur un réseau. Le mode Multi vous 
permet d'affecter rapidement un autre système Pro Tools à 
la console en appuyant sur un seul bouton de cette dernière.

Activation du mode Multi

Pour permettre la déclaration d'une console D-Control sur 
plusieurs systèmes Pro Tools|HD, vous devez préalablement 
placer l'unité principale et les modules de faders en mode 
Multi. 

Pour activer ou désactiver le mode Multi pour une unité D-Control :

1  Si l'unité est déclarée sur un système, effectuez l'une des 
actions suivantes :

• Quittez Pro Tools. 

– ou –

• Annulez la déclaration de l'unité dans la boîte de dialogue 
Pro Tools Peripherals.

2  Appuyez sur le bouton Solo dans la tranche Focus Channel 
Strip (sur l'unité principale) ou sur la tranche de console la plus 
à gauche (sur un module de faders) et maintenez-le enfoncé 
pendant environ trois secondes.

Lorsque l'unité est en mode Multi, elle affiche D-Control 
Multi-Mode dans les Soft Keys (sur une unité principale) 
ou dans les affichages de canal (sur un module de faders). 

Déclaration des unités D-Control en mode Multi

Lorsqu'une unité D-Control est en mode Multi, elle apparaît 
plusieurs fois dans la boîte de dialogue Peripherals, où les noms 
des différentes instances contiennent les numéros 1 à 4. Ces 
unités peuvent ensuite être déclarées sur différents systèmes 
Pro Tools du réseau. 

Pour déclarer des unités D-Control en mode Multi :

1  Sur le premier système Pro Tools, choisissez Setups > Peripherals 
et cliquez sur Ethernet Controllers.

2  Dans la page Ethernet Controllers, sélectionnez Enable. Pro Tools 
analyse la connexion Ethernet à la recherche d'unités D-Control 
en mode Multi.

3  Déclarez l'unité principale et les modules de faders contenant le 
suffixe 1 dans l'ordre dans lequel vous souhaitez faire apparaître 
les unités, de la gauche vers la droite.

4  Cliquez sur OK pour fermer la fenêtre Peripherals.

5  Sur le deuxième système Pro Tools, répétez les étapes précéden-
tes : déclarez l'unité principale et les modules de faders contenant 
le suffixe 2 en respectant l'ordre, de gauche à droite, utilisé lors 
de leur déclaration sur le premier système Pro Tools.
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6  Si vous disposez de systèmes Pro Tools supplémentaires, 
déclarez les unités D-Control 3 et 4 sur les systèmes suivants, 
en respectant l'ordre utilisé ci-dessus, de gauche à droite.

À mesure que vous déclarez les unités D-Control sur chaque 
système Pro Tools, les boutons Machine Online (de Mach 1 à 
Mach 4) dans la section Online des commandes Transport 
clignotent pour indiquer qu'un système est disponible.

Utilisation du mode Multi de D-Control

Lorsque plusieurs systèmes Pro Tools sont disponibles, vous 
pouvez afficher leur statut de synchronisation de transport et 
passer instantanément de l'un à l'autre à l'aide des boutons 
Machine Online (de Mach 1 à Mach 4) dans la section Online 
des commandes Transport.

Indication du statut des systèmes Pro Tools HD

Lorsque Pro Tools Transport Master est défini sur Transport = 
Machine ou Transport = MMC, les boutons Machine Online 
(de Mach 1 à Mach 4) affichent le statut des systèmes Pro Tools 
disponibles comme suit :

Lorsque Pro Tools Transport Master est défini sur Transport = 
Remote, les boutons Machine Online (de Mach 1 à Mach 4) 
affichent uniquement les états suivants :

Changement du contrôle entre les systèmes Pro Tools

Lorsqu'un système Pro Tools est disponible, vous pouvez en 
prendre le contrôle en appuyant sur le bouton Machine Online 
correspondant (de Mach 1 à Mach 4).

Indications du statut des systèmes Pro Tools (Transport = Machine ou 
MMC)

État du bouton Mach Signification

Off Aucun système Pro Tools disponible

Clignotement (lent) Système Pro Tools actif sur D-Control

Clignotement (rapide) Système Pro Tools disponible, arrêté ou 
non synchronisé sur le timecode

On 
(allumé en permanence)

Système Pro Tools disponible, 
synchronisé sur le timecode

Indication du statut des systèmes Pro Tools (Transport = Remote)

État du bouton Mach Signification

Off Aucun système Pro Tools disponible

Clignotement (lent) Système Pro Tools actif sur D-Control

On 
(allumé en permanence)

Système Pro Tools disponible, online

Lorsque Transport = Remote, le bouton Pro Tools Online et 
les commandes Transport clignotent (Rewind, Fast Forward, 
Stop, Play, ou Record) et n'indiquent pas avec précision le 
statut de transport Pro Tools.



Chapitre 9 : Sections Management et Soft Key

Section Window Management

La section Window Management comporte des commandes permettant d'ouvrir et de fermer les fenêtres Pro Tools à l'écran. 
Lorsqu'une fenêtre est ouverte, le bouton correspondant s'allume. Le cas échéant, vous pouvez appuyer sur un bouton en 
maintenant enfoncée la touche Alt (Windows) ou Option (Mac) pour agrandir une fenêtre, ou la touche Ctrl (Windows) ou 
Commande (Mac) pour réduire une fenêtre.
Section Window Management de D-Control

Fenêtre Beat Detective

Fenêtre Big Counter

Fenêtre Mic Pre

Fenêtre Pan

Fenêtre Edit

Fenêtre Plug-in

Fenêtre MIDI Operations

Fenêtre MIDI Event

Fenêtre Workspace Browser

Fenêtre Transport

Fenêtre Memory Locations

Fenêtre Mix
Bouton de la fenêtre MIDI Event

Ouvre ou ferme la fenêtre MIDI Event ou la place au premier plan. 

Bouton de la fenêtre MIDI Operations

Ouvre ou ferme la fenêtre MIDI Operations.

Bouton de la fenêtre Beat Detective

Ouvre ou ferme la fenêtre Beat Detective.

Bouton Workspace Browser

Ouvre ou ferme le navigateur du workspace Digibase. Maintenez 
la touche Alt (Windows) ou Option (Mac) enfoncée et appuyez 
sur ce bouton pour fermer toutes les fenêtres Digibase.

Bouton Big Counter

Ouvre ou ferme la fenêtre Big Counter. 

Bouton de la fenêtre Mic Pre

Ouvre ou ferme la fenêtre Mic Pre pour la piste sélectionnée.
Bouton de la fenêtre Memory Locations

Ouvre ou ferme la fenêtre Memory Locations.

Bouton de la fenêtre Transport

Ouvre ou ferme la fenêtre Transport. Maintenez enfoncées les 
touches suivantes et appuyez sur ce bouton pour afficher/masquer 
les commandes de transport : 

• Alt (Windows) ou Option (Mac) : commandes MIDI et 
compteurs

• Ctrl (Windows) ou Commande (Mac) : commandes MIDI 
uniquement

• Démarrer (Windows) ou Ctrl (Mac) : compteurs uniquement

Bouton de la fenêtre Pan

Ouvre ou ferme la fenêtre Pan pour la piste sélectionnée. Maintenez 
la touche Alt (Windows) ou Option (Mac) enfoncée pour fermer 
toutes les fenêtres Pan.

Bouton de la fenêtre Mix

Ouvre ou ferme la fenêtre Mix ou la place au premier plan. 
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Bouton de la fenêtre Edit

Ouvre ou ferme la fenêtre Edit ou la place au premier plan.

Bouton de la fenêtre Plug-In

Ouvre ou ferme des fenêtres de l'un des plug-ins actuellement 
ciblés dans la session. Maintenez la touche Alt (Windows) ou 
Option (Mac) enfoncée pour fermer toutes les fenêtres de plug-in.

Section Session Management

La section Session Management inclut des commandes permettant 
la gestion des sessions et la réalisation d'opérations d'enregistre-
ment. 

Bouton Clear Clip et témoin Plug-In Clip

D-Control signale les occurrences d'écrêtage du signal sur les 
pistes audio, les départs et les plug-ins. L'état de l'indicateur 
d'écrêtage dépend des paramètres de clip définis dans les préfé-
rences d'affichage de Pro Tools.

• Si une piste audio est écrêtée, l'affichage du fader correspon-
dant devient rouge. 

• Si un départ est écrêté, le bouton Send clignote dans la section 
Display Controls du canal. De plus, si la tranche de console 
affiche des départs, l'affichage de l'encodeur correspondant 
devient rouge. 

• Si un plug-in est écrêté, le bouton Insert clignote dans la section 
Display Controls du canal. De plus, si la tranche de console se 
trouve au niveau supérieur de la vue Inserts, l'affichage de 
l'encodeur correspondant devient rouge. 

Le bouton Clear Clip s'allume si un clip se produit sur une piste 
audio ou un départ, n'importe où dans la session. Le témoin 
Plug-In Clip s'allume si un clip se produit sur un plug-in, n'im-
porte où dans la session. 

Lorsque vous appuyez sur le bouton Clear Clip, tous les clips et 
les crêtes sont supprimés de la session.

Section Session Management de D-Control

Bouton All 
Notes Off

Bouton Utility 
Mode

Bouton
Redo

Bouton
Undo

Bouton
Save

Bouton
Publish

Bouton
Clear Clip

Bouton
QWERTY

Keyboard

Témoin
Plug-In Clip
Guide D-Control02
Bouton All Notes Off

Le bouton All Notes Off permet de couper le son des notes coin-
cées avec les périphériques MIDI. Un message All Notes Off est 
envoyé à chaque canal pour tous les périphériques MIDI connectés. 

Bouton QWERTY Disable

Le bouton QWERTY Disable désactive temporairement le clavier 
d'ordinateur sur D-Control, afin d'empêcher les mauvaises mani-
pulations du clavier. Il s'allume lorsque le clavier est désactivé. 

Le bouton QWERTY Disable n'affecte pas le fonctionnement du 
trackball de D-Control. 

Bouton Utility

Le bouton Utility active le mode Utility de D-Control. Lorsque 
D-Control est en mode Utility, ce bouton s'allume.

Le mode Utility permet d'afficher des informations sur le système 
D-Control, de nommer les unités D-Control, d'exécuter des 
tests de diagnostic de D-Control et de définir certaines préféren-
ces matérielles pour D-Control. Pour plus d'informations sur le 
mode Utility, reportez-vous à l'Annexe A, « Mode Utility ».

Bouton Publish

Le bouton Publish exécute la commande Send Session Via 
DigiDelivery dans Pro Tools, ouvrant la boîte de dialogue Send 
To DigiDelivery à l'écran.

Bouton Save

Ce bouton exécute la commande Save Session (Enregistrer une 
session) de Pro Tools. À chaque nouvelle modification dans une 
session et lorsque la commande Save est disponible, ce bouton 
s'allume. 

Pour enregistrer la session actuelle :

1  Appuyez sur le bouton Save. Le bouton clignote, vous invitant 
à confirmer l'enregistrement. 

2  Effectuez l'une des opérations suivantes :

• Pour confirmer l'enregistrement, appuyez une seconde fois 
sur le bouton Save. 

• Pour annuler l'enregistrement, appuyez sur Echap. 

Bouton Redo

Ce bouton exécute la commande Redo de Pro Tools. 

Bouton Undo

Ce bouton exécute la commande Undo de Pro Tools. 



Section Soft Keys

La section Soft Keys donne accès à de nombreuses commandes de Pro Tools, directement depuis la surface de contrôle. Elle permet 
également d'accéder aux préférences et paramètres spécifiques à D-Control. Cette section comporte six touches programmables et 
les affichages correspondants, ainsi qu'une matrice de sélecteurs de mode permettant de modifier les fonctions affichées. Lorsqu'une 
fonction apparaît dans un affichage de Soft Key, appuyez sur le bouton Soft Key correspondant pour activer cette fonction. 
Section Soft Keys de D-Control

Bouton 
Show/Hide

Bouton 
Audio Files

Bouton Edit 
Tools

Bouton Edit 
Modes

Bouton 
Window

Bouton 
Playlist

Bouton 
Track

Bouton 
Group

Bouton 
Snap

Bouton Edit 
Function

Bouton 
AutoMatch

Bouton 
Auto Join 

Bouton 
Modes

Bouton 
Prefs

Bouton 
Operation

Bouton 
Actions

Bouton 
Join

Boutons et 
affichages Soft 

Key
Bouton 
Meter

Bouton 
User

Bouton 
Bank Sel

Bouton 
Mem Loc

Bouton 
MIDI
Affichage de Soft Key par défaut

Lorsqu'une session est ouverte pour la première fois, la section 
Soft Key affiche des informations de base relatives à la session :

• Nom de la session

• Bit : résolution de la session

• Samp. : fréquence d'échantillonnage de la session

• File : type de fichier de la session

• Tcode : fréquence de timecode de la session

• État activé/désactivé de la compensation de la latence

La compensation de la latence peut être activée ou désactivée 
depuis cet affichage. Les autres paramètres indiqués ci-dessus 
ne peuvent pas être modifiés depuis la section Soft Keys. 

Affichage des Soft Keys avec les boîtes de dialogue 
Pro Tools

Lorsqu'une boîte de dialogue s'affiche à l'écran dans Pro Tools, 
les deux Soft Keys inférieures affichent brièvement Escape et 
Enter, ce qui vous permet d'annuler ou de confirmer la boîte de 
dialogue à partir de la surface de contrôle.
Désactivation des modes Soft Key

Vous pouvez quitter un mode Soft Key et revenir à l'affichage 
Soft Key par défaut en maintenant la touche Ctrl (Windows) ou 
Commande (Mac) enfoncée tout en appuyant sur le bouton 
Soft Key correspondant actuellement allumé.

Commandes Management

Bouton Snap

Le bouton Snap affiche les commandes suivantes :

Page 1

• Captre : Capture

• Punch Captre : Punch Capture

• Snap 1–4 : Snapshots 1–4

Pages 2–12 

• Snap 5–48 : Snapshots 5–48 (par groupes de 4)
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Bouton Group

Page 1

Le bouton Group affiche les commandes suivantes :

• Create Edit : création de groupes d'édition

• Suspnd : interruption de groupes

• Create Mix : création de groupes de mixage

• Modify : modification de groupes

• Create Both : création de groupes de mixage et d'édition

Page 2

• Preset 1–6 : boutons de presets (1-6) de la boîte de dialogue 
Groups

Bouton Track

Le bouton Track affiche les commandes suivantes :

• New Track : Track > New

• Dup Track : Track > Duplicate

• Delete Selectd : Track > Delete

• Make Act/In : Track > Make Active/Inactive

• Bounce : File > Bounce To > Disk

• Split Mono : Track > Split Into Mono

Bouton Playlist

Le bouton Playlist affiche les commandes de playlist suivantes :

• New : nouvelle playlist

• Duplicate : duplication d'une playlist

• Delete Audio : suppression des playlists audio non utilisées

• Delete MIDI : suppression des playlists MIDI non utilisées

• Prev Plylst : affichage de la playlist précédente

• Next Plylst : affichage de la playlist suivante

Bouton Window

Aucune session : si aucune session n'est ouverte, le bouton Window 
affiche les commandes suivantes :

Page 1

• Task Managr : Window > Task Manager

• Disk Space : Window > Disk Space

• System Usage : Window > System Usage

Page 2

• I/O Setup : Setup > I/O

• HW Setup : Setup > Hardware

• PB Engine : Setup > Playback Engine

• Preferences : Setup > Preferences

• Peripherals : Setup > Peripherals
Guide D-Control04
Ouvrir session : si une session est ouverte, le bouton Window 
affiche les commandes suivantes :

Page 1

• Auto Enabls : Window > Automation

• Track Arm : Window > Machine Track Arming

• Strip Silnce : Edit > Strip Silence

• Sessn Setup : Setup > Session

• Task Managr : Window > Task Manager

• Projct Browsr : Window > Project Browser

Page 2

• Color Pallet : Window > Color Palette

• Big Countr : Window > Big Counter

• Undo Histry : Window > Undo History

• Disk Space : Window > Disk Space

• Video Window : Window > Video

• System Usage : Window > System Usage

Page 3

• I/O Setup : Setup > I/O

• HW Setup : Setup > Hardware

• PB Engine : Setup > Playback Engine

• Disk Alloc : Setup > Disk Allocation

• Preferences : Setup > Preferences

• Peripherals : Setup > Peripherals

Page 4

• Window Confgs : Window > Configurations > Window 
Configuration List

• MIDI Editor : Window > MIDI Editor

• Score Editor : Window > Score Editor

Page 5

• Tile Windws : Window > Arrange > Tile

• Tile Hrzntl : Window > Arrange > Tile Horizontal

• Tile Vertcl : Window > Arrange > Tile Vertical

• Cascde Windws : Window > Arrange > Cascade



Commandes d'édition

Bouton Edit Function 1 (commandes d'édition principales)

Le bouton Edit Function 1 affiche les commandes suivantes :

Page 1

• Cut : Edit > Cut

• Copy : Edit > Copy

• Paste : Edit > Paste

• Clear : Edit > Clear

• TCE To TLSel : Edit > TCE Edit to Timeline Selection

Page 2

• CutSP AllAut : Edit > Cut Special > All Automation 

• CopySP AllAut : Edit > Copy Special > All Automation 

• CutSP PanAut : Edit > Cut Special > Pan Automation 

• CopySP PanAut : Edit > Copy Special > Pan Automation

• CutSP PI Aut : Edit > Cut Special > Plug-In Automation 

• CopySP PI Aut : Edit > Copy Special > Plug-In Automation 

Page 3

• PsteSP Merge : Edit > Paste Special > Merge

• ClrSP AllAut : Edit > Clear Special > All Automation 

• PsteSP RepFil : Edit > Paste Special > Repeat to Fill Selection

• ClrSP PanAut : Edit > Clear Special > Pan Automation

• PsteSP ToCurr : Edit > Paste Special > To Current 
Automation Type

• ClrSP PI Aut : Edit > Clear Special > Plug-In Automation 

Bouton Edit Function 2

Le bouton Edit Function 2 affiche les commandes suivantes :

Page 1

• Trim To Sel : Edit > Trim > To Selection

• Cpture Region : Edit > Capture Region

• Seprte : Edit > Separate Region

• Heal Seprtn : Edit > Heal Separation

• Consolidate : Edit > Consolidate Selection

• Time Stamp : Audio Regions List > Time Stamp Selected

Page 2

• SendTo Back : Region > Send to Back

• SendTo Front : Region > Bring to Front

• Group Region : Region > Group

• Ungrp Region : Region > Ungroup

• Ungrp All : Region > Ungroup All

• Regrp Region : Region > Regroup
Bouton Edit Function 3

Le bouton Edit Function 3 affiche les commandes suivantes :

Page 1

• Duplicate : Edit > Duplicate

• Repeat : Edit > Repeat

• Shift : Edit > Shift

• Insert Silnce : Edit > Insert Silence

• Lock Region : Region > Lock/Unlock

• Mute Region : Region > Mute/Unmute

Page 2

• Loop Region : Region > Loop Region

• Unloop Region : Region > Unloop Region

• ID/Rem SyncPT : Region > Identify/Remove Sync Point

• Rename Rgns : Region > Rename Regions

• Quantz ToGrid : Region > Quantize to Grid

• RgnDrp : Region List > Timeline Drop Order > L to R/Top 
to Bottom

Bouton Edit Modes

Le bouton Edit Modes affiche les modes d'édition de Pro Tools :

Page 1

• Shuffl : Shuffle Mode

• Spot : Spot Mode

• Slip : Slip Mode

• Grid Rel : Relative Grid Mode

• Grid Abs : Absolute Grid Mode

Page 2

• Tab Trnsnt : Tab to Transients

• Dynamc Trnspt : Options > Dynamic Transport

• Loop Plybck : Options > Loop Playback

• Loop Record : Options > Loop Record

• LLM : Options > Low Latency Monitoring

Bouton Edit Tools

Le bouton Edit Tools affiche les outils d'édition de Pro Tools. 
Pour parcourir plusieurs versions du même outil, appuyez plu-
sieurs fois sur la Soft Key correspondante.

• Zoom : outils Normal/Single Zoomer

• Trim : outils Standard/Scrub/TCE Trimmer

• Select : outil Selector

• Grabbr : outils Time/Separation/Object Grabber

• Scrub : outil Scrubber

• Pencil : Square, Random, Free, Line, Triangle, Arc, S-Curve

Pour sélectionner le Smart Tool, appuyez simultanément sur deux 
des boutons suivants : Trimmer, Selector ou Grabber. 
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Commandes Select/MIDI

Bouton Bank Select

Le bouton Bank Select (Bank Sel) configure les Soft Keys de façon 
à refléter la sélection en cours dans la matrice Bank Select. Lorsque 
Bank Select est activé, les Soft Keys affichent le nom des groupes 
Mix/Edit, des groupes Custom, les types de pistes ou les numéros 
de page de plug-in contrôlés par la matrice Bank Select.

Étant donné que la matrice Bank Select comporte 12 boutons, 
chaque banque de douze est affichée sur deux pages de six Soft 
Keys. Pour parcourir les pages de l'affichage Soft Key, appuyez 
plusieurs fois sur le bouton Bank Select dans la section Soft Keys.

Pour parcourir les pages de la banque actuellement affichée dans 
la section Soft Keys :

 Appuyez plusieurs fois sur le bouton Bank Select (Bank Sel) 
pour parcourir les pages de la banque en cours.

Bouton Memory Location

Le bouton Memory Location (Mem Loc) affiche les noms des 
emplacements mémoire par page de six. 

Pour plus d’informations sur l'affichage et la création d'empla-
cements de mémoire à partir de D-Control, reportez-vous à la 
section « Emplacements mémoire » à la page 113. 

Bouton MIDI

Le bouton MIDI affiche les commandes suivantes : 

Page 1

• Wait Note : fenêtre Transport > bouton Wait for Note

• Count Off : fenêtre Transport > bouton Countoff

• Merge Record : fenêtre Transport > bouton MIDI Merge

• Transpose : Event > Event Operations > Transpose

• Veloc : Event > Event Operations > Change Velocity

• Click On/Off : Options > Click

Page 2

• Change Tempo : fenêtre Change Tempo

• Change Meter : fenêtre Change Meter

• Split Notes : Event > Event Operations > Select/Split Notes

• Quantz : Event > Event Operations > Quantize

• Input Quantz : Event > Event Operations > Input Quantize

Page 3

• Write PTProp : Track > Write MIDI Real Time Properties

• Remove DpNote : Event > Remove Duplicate Notes
Guide D-Control06
Bouton User

Le bouton User permet de rassembler, dans une configuration 
personnalisée, 24 fonctions (6 sur chacune des quatre pages) et 
d'accéder rapidement aux commandes ou modes les plus souvent 
utilisés. Vous pouvez ajouter des fonctions à chacune des quatre 
pages disponibles.

Pour ajouter une fonction au jeu de touches User :

1  Dans la section Soft Keys, appuyez plusieurs fois sur le bouton 
User pour afficher la page (Page 1, 2, 3, ou 4) sur laquelle vous 
souhaitez ajouter une fonction.

2  Appuyez sur les Soft Keys pour afficher la page contenant la 
fonction que vous souhaitez ajouter. 

3  Tout en maintenant la touche Ctrl (Windows) ou Commande 
(Mac) enfoncée, appuyez sur la Soft Key correspondant à la fonction.

La fonction vient s'ajouter à la liste des fonctions des touches 
User des Soft Keys, sur la page User sélectionnée.

Pour supprimer une fonction du jeu de touches User :

1  Dans la section Soft Keys, appuyez plusieurs fois sur le bouton 
User pour afficher la fonction que vous souhaitez supprimer.

2  Tout en maintenant la touche Ctrl (Windows) ou Commande 
(Mac) enfoncée, appuyez sur la Soft Key correspondant à la 
fonction User. 



Préférences de la console

Bouton Meter

Bouton Meter (page 1)

Le bouton Meter montre les préférences d'affichage des VU-mètres 
pour D-Control, par pages de six. Pour parcourir les pages de 
l'affichage Soft Key, appuyez plusieurs fois sur le bouton Meter 
Prefs dans la section Soft Keys.

Le bouton Meter contrôle les VU-mètres de D-Control uniquement 
et n'affecte pas l'affichage à l'écran de Pro Tools.

SndMtr (Send Meters) : active ou désactive l'affichage des VU-mètres 
de départ sur les encodeurs rotatifs du canal. 

InsMtr (Insert Meters) : active ou désactive l'affichage des VU-mètres 
de plug-in sur les encodeurs rotatifs du canal. 

VCAMtr (VCA Meters) : active ou désactive l'affichage des VU-mètres 
des esclaves VCA sur les encodeurs rotatifs du canal.

Meters : bascule l'affichage des VU-mètres de canal entre le mode 
préfader et postfader.

CtrMtr (Center Meters) : bascule l'affichage du VU-mètre à 8 canaux 
sur le Meter Bridge de l'unité principale entre les niveaux de sortie 
principale et la piste sélectionnée.

GrChan (Gain Reduction Channel Display) : permet aux VU-mètres 
de canal d'afficher la réduction de gain du plug-in de traitement 
dynamique quand le plug-in est en focus sur la tranche.

Bouton Meter (page 2)

RefLvl (Reference Level) : permet de modifier l'affichage du 
VU-mètre de D-Control pour écouter le programme selon 
différents niveaux de référence.

GRPrio (Gain Reduction Priority) : lorsqu'un plug-in multifonction 
Compressor/Limiter ou Expander/Gate est utilisé, cette préférence 
indique quelle fonction (CompLm ou ExpGat) dispose de la 
priorité d'affichage des VU-mètres lorsque les anneaux de dio-
des LED de l'encodeur et les VU-mètres de canal sont configurés 
pour afficher la réduction de gain du plug-in Dynamics.

Bouton Operation

Le bouton Operation contrôle les comportements spécifiques à 
D-Control et n'affecte pas l'affichage à l'écran de Pro Tools. Les 
préférences de fonctionnement de D-Control sont enregistrées 
avec les préférences d'application de Pro Tools. Pour plus de 
détails sur les préférences de fonctionnement, reportez-vous à 
la section « Configuration des options de D-Control » à la page 40.
Bouton Operation (page 1)

BnkJus (Bank Justification) : détermine si les banques de canaux 
en mode Normal sont alignées à gauche, au centre (à gauche de 
l'unité principale), à droite (à droite de l'unité principale) ou à 
droite de la surface de contrôle. 

Rotary (Rotary Encoder Velocity Mode) : indique la réactivité des 
boutons encodeurs rotatifs. Le mode Fixed correspond à une 
résolution normale. Les modes de vélocité définissent différents 
taux d'accélération de l'encodeur. En mode Fine, la réponse est 
fixe et la résolution précise. 

LCFJst (Left Custom Fader Justification) : détermine si les faders 
personnalisés contrôlés par la section Left Custom Faders sont 
placés à gauche, au centre gauche, au centre droit ou à droite de 
l'unité principale.

RCFJst (Right Custom Fader Justification) : détermine si les faders 
personnalisés contrôlés par la section Right Custom Faders sont 
placés à gauche, au centre gauche, au centre droit ou à droite de 
l'unité principale.

LPIDef (Left Plug-In View Definition) : détermine l'affichage des 
paramètres de plug-in sur les faders personnalisés dans la section 
Left Custom Fader (affichage Name, Expanded ou Fader).

RPIDef (Right Plug-In View Definition) : détermine l'affichage des 
paramètres de plug-in sur les faders personnalisés dans la section 
Right Custom Fader affichage Name, Expanded ou Fader).

Bouton Operation (page 2)

LCFPI (Left CF Bank Size for Plug-Ins) : détermine le nombre de 
canaux alloués au mode Custom Fader Plug-In dans la section 
Left Custom Fader.

RCFPI (Right CF Bank Size for Plug-Ins) : détermine le nombre de 
canaux alloués au mode Custom Fader Plug-In dans la section 
Right Custom Fader.

LCFGrp (Left CF Bank Size for Custom Groups and Mix/Edit Groups) : 
détermine le nombre de canaux alloués au mode Custom Groups 
dans la section Left Custom Fader.

RCFGrp (Right CF Bank Size for Custom Groups and Mix/Edit Groups) : 
détermine le nombre de canaux alloués aux Custom Groups 
dans la section Right Custom Fader.

LCFTyp (Left CF Bank Size for Track Type) : détermine le nombre 
de canaux alloués au mode Custom Fader Tracks dans la section 
Left Custom Fader.

RCFTyp (Right CF Bank Size for Track Type) : détermine le nombre 
de canaux alloués au mode Custom Fader Tracks dans la section 
Right Custom Fader.
Chapitre 9 : Sections Management et Soft Key 107



1

Bouton Operation (page 3)

PanBot (Pan on Lower Encoder) : détermine si les commandes de 
panoramique sont affichées sur l'encodeur inférieur de chaque 
canal, même lorsqu'une commande d'un autre type est affichée 
sur les encodeurs supérieurs. 

Encod (Encoder Order) : détermine si les commandes d'inserts, 
de départ et de panoramique doivent être affichées dans l'ordre 
de haut en bas ou de bas en haut sur les encodeurs rotatifs de 
D-Control.

ApTrgt (Target Track from Application) : détermine si la sélection 
à l'écran d'une commande d'insertion ou de départ sélectionne 
sa piste sur l'unité principale D-Control. 

Faders (Faders On/Off) : désactive temporairement les faders de 
D-Control pour empêcher tout mouvement lors de l'écoute 
d'un mixage. 

ChanWn (Channel Window Display) : détermine si l'affichage des 
paramètres de plug-in ou de départ (en appuyant sur le bouton 
de sélection d'un encodeur) sur D-Control doit ouvrir la fenêtre 
correspondante de plug-in ou de départ dans Pro Tools. Cette 
option détermine également si les boutons de sélection de canaux 
(des sections Dynamics ou EQ) doivent modifier l'affichage des 
canaux de plug-in multi-mono. 

 Lorsque cette préférence est définie sur Yes, les fenêtres de 
plug-in et de départ changent d'aspect pour refléter le statut de 
la surface de contrôle. 

 Lorsque cette préférence est définie sur No, les fenêtres de 
plug-in et de départ restent inchangées. 

Select (Select Switch Latch Mode) : détermine si les boutons de 
sélection des canaux adoptent un comportement continu ou 
exclusif (non continu) en mode Select. 

Bouton Operation (page 4)

SoloFc (Focused Track Follows Solo) : détermine si une piste mise 
en solo est automatiquement sélectionnée ou non dans Focus 
Channel Strip (fonctionne en mode Select ou Focus)

2KbPan (Two-Knob Panning) : active ou désactive la liaison des 
contrôles de panoramiques avant et arrière dans les fenêtres pano-
ramiques surround pour faciliter le mouvement gauche-droite 
dans le champ surround.

TchVal (Touch Display of Parameter Values) : détermine l'affichage 
des valeurs de paramètres lorsque des faders ou des encodeurs 
sont touchés. Cette option peut être définie sur On, Off, ou NoVol, 
ce qui désactive l'affichage des valeurs de volume dans le fader 
principal uniquement.

Pour les pistes stéréo, l'encodeur affiche L par défaut (canal 
de gauche). Pour passer au canal de droite, appuyez sur Select.
Guide D-Control08
CFTrks (Custom Faders Display Hidden Tracks) : détermine si les 
pistes masquées dans Pro Tools doivent être affichées ou masquées 
dans les modes Custom Fader. Les pistes masquées dans Pro Tools 
mais affichées dans les faders personnalisés ne peuvent pas être 
sélectionnées ni préparées pour l'enregistrement. 

Brdcst (Broadcast) : indique si le système de monitoring XMON 
est en mode Broadcast, ce qui empêche les modes Solo AFL et PFL 
de changer la source XMON Control Room Input.

Trk/Ed (Link Track and Edit Selection) : active ou désactive les 
options Link Track et Edit Selection de manière à sélectionner 
automatiquement une piste ou plage de pistes lorsqu'une sélec-
tion est effectuée dans la timeline de la piste.

Bouton Operation (page 5)

Import PIMaps (Import Plug-In Maps) : ouvre une boîte de dialogue 
Choose a mapping file dans Pro Tools.

Export PIMaps (Export Plug-In Maps) : ouvre une boîte de dialogue 
Save Plug-In Mapping As dans Pro Tools. 

SplFcs (Focus VCA Master When Spilled) : entraîne la sélection 
d'une piste Master VCA dans Focus Channel Strip lorsque ses 
pistes esclaves sont basculées, ou son affichage dans Custom 
Faders en appuyant sur le bouton Byp/Mute dans le Master VCA.

FilBnk (Always Fill Channel Strips When Banking) :  active ou 
désactive le paramètre de préférence qui maximise le nombre 
de canaux affichés en mode Normal lors de recherches parmi 
les différentes banques. Lorsque cette option est sélectionnée, 
la recherche parmi les différentes banques s'arrête lorsque toutes 
les tranches de console sont pleines. 

FillCF (Always Fill Custom Faders When Banking) :  active ou dé-
sactive le paramètre de préférence qui maximise le nombre de 
canaux affichés en mode Custom Faders lors de recherches parmi 
les différentes banques. Lorsque cette option est sélectionnée, 
la recherche parmi les différentes banques s'arrête lorsque tous 
les faders personnalisés sont pleins. 

Trnspt (Transport Mode) :  bascule entre les modes Dual et Single 
Transport. Le mode Dual Transport active le deuxième jeu de 
commandes de transport dans la section Machine Transport. 
En mode Single Transport, seules les commandes de transport 
appelées Pro Tools Transport sont actives.

Bouton Operation (page 6)

AsnMtx (Assign Matrix Enable) : détermine si la méthode utilisée 
pour assigner des entrées, des sorties, des inserts et des départs 
est la matrice d'assignation ou le mode Assign standard. 

MtxJst (Matrix Select Area Justification) : détermine si des éléments 
de la zone de sélection de la matrice d'assignation doivent appa-
raître dans l'ordre de haut en bas ou de bas en haut sur les enco-
deurs rotatifs de D-Control.



PIClmn (Plug-In Menu Column Width) : détermine le nombre de 
noms de plug-in affichés par ligne d'encodeurs dans la matrice 
d'assignation.

IOClmn (I/O Menu Column Width) : détermine le nombre de noms 
de chemins d'E/S affichés par ligne d'encodeurs dans la matrice 
d'assignation.

MtxRws (Assign Matrix Rows) : détermine le nombre de lignes 
d'encodeurs utilisées pour afficher des éléments dans la matrice 
d'assignation.

MtxLck (Assign Matrix Lock) : détermine si la matrice d'assignation 
doit être verrouillée par défaut ou manuellement.

Bouton Operation (page 7)

ChanPI (Channel Strip Editing for Plug-Ins) : bascule le paramètre 
de préférence qui active l'affichage des paramètres de plug-in 
directement sur les encodeurs de canaux de D-Control. 

EncVCA (VCA Encoder Display) : indique si les commandes d'une 
piste esclave VCA sont affichées dans les encodeurs des canaux 
Master VCA.

LrnTch (Learn Touch) :  détermine si les encodeurs et boutons de 
D-Control doivent être actifs lorsqu'un plug-in est en mode Learn. 

Lettrs (Show Send/Insert Letters) : détermine si D-Control doit 
afficher les lettres Send et Insert sur des points de départ et 
d'insert sans assignation.

Commandes d'automation

Bouton AutoMatch

Le bouton AutoMatch active la commande AutoMatch dans les 
modes d'automation Latch ou Write. 

Bouton Join

Le bouton Join est utilisé en mode Latch pour reprendre manuel-
lement l'écriture de données d'automation sur tous les canaux 
qui étaient en cours d'écriture lors de la passe d'automation 
précédente.

Lorsque vous interrompez le transport pendant une passe d'auto-
mation, le buffer Join est chargé avec les valeurs actuelles de toutes 
les commandes en cours d'écriture de données d'automation. 

Lorsque vous appuyez sur le bouton Join pendant la lecture, 
l'écriture de données d'automation commence aux valeurs en-
registrées dans le buffer Join.

Pour vider le buffer Join :

 Tout en maintenant les touches Ctrl+Démarrer (Windows) ou 
Commande+Ctrl (Mac) enfoncées, appuyez sur le bouton Join. 
Bouton Auto Join

En mode Latch, le bouton AutoJoin permet de reprendre automa-
tiquement l'écriture de données d'automation après l'arrêt, puis 
le redémarrage du transport au cours d'une passe d'automation.

Bouton Actions

Le bouton Action affiche les commandes suivantes :

Bouton Actions (page 1)

Prview (Preview) : active le mode Preview de Pro Tools.

Punch Prview (Punch Preview) : exécute la commande Punch 
Preview.

Prview Suspnd (Preview Suspend) : interrompt le mode Preview.

Captre (Capture) : exécute la commande Capture.

Punch Captre (Punch Capture) : exécute la commande Punch 
Capture.

Voir « Aperçu de l'automation » à la page 136 et « Capture et 
rappel des données d'automation » à la page 137 pour plus 
d'informations sur ces commandes.

Bouton Actions (page 2)

Wrt To All (Write to All) :  permet d'écrire les valeurs actuelles 
d'automation sur l'ensemble d'une sélection ou d'une piste, 
au cours d'une passe d'automation. 

Snap Back : entraîne la sortie de toutes les pistes préparées pour 
Latch ou Write de leur passe d'automation actuelle et revient 
immédiatement aux niveaux d'écriture précédents. En cours de 
lecture, cette commande arrête l'écriture de données d'automa-
tion sans appliquer la progression AutoMatch.

Wrt To Start (Write To Start) : permet d'écrire, lors d'une passe 
d'automation, les valeurs d'automation actuelles à partir du 
point d'insertion en reculant vers le début d'une sélection ou 
d'une piste. 

Wrt To End (Write to End) : permet d'écrire, lors d'une passe d'auto-
mation, les valeurs d'automation actuelles du point d'insertion 
en avançant vers la fin d'une sélection ou d'une piste. 

Wrt To Punch (Write To Punch Point) : permet d'écrire les valeurs 
actuelles d'automation jusqu'au point où l'écriture des données 
d'automation a commencé. 

Wrt To Next (Write to Next Breakpoint) : permet d'écrire, lors d'une 
passe d'automation, les valeurs d'automation actuelles du point 
d'insertion en avançant vers le prochain point d'inflexion 
d'automation.
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Bouton Actions (page 3)

Wrt To Currnt (Write To Current Parameter) : écrit la valeur actuelle 
de commande vers le paramètre d'automation actuellement 
affiché (Edit > Automation > Write To Current).

Wrt To All Ena (Write To All Enabled Parameters) : écrit les valeurs 
actuelles de commande vers tous les paramètres d'automation 
activés (Edit > Automation > Write To All Enabled). 

Trm To Currnt (Trim To Current Parameter) : applique la valeur 
actuelle de trim au paramètre d'automation actuellement affiché 
(Edit > Automation > Trim To Current).

Trm To AllEna (Trim To All Enabled Parameters) : applique les va-
leurs actuelles de trim à tous les paramètres d'automation activés 
(Edit > Automation > Trim To All Enabled).

Gld To Currnt (Glide To Current Parameter) : applique une transi-
tion entre des valeurs d'automation au paramètre d'automation 
actuellement affiché (Edit > Automation > Glide To Current). 

Gld To AllEna (Glide To All Enabled Parameters) : applique une 
transition entre des valeurs d'automation à tous les paramètres 
d'automation activés (Edit > Automation > Glide To All Enabled).

Bouton Actions (page 4)

Copy to Send : ouvre la boîte de dialogue Copy To Send pour 
copier les valeurs des commandes des pistes à chaque départ 
des pistes sélectionnées (Edit > Automation > Copy To Send). 

Thin Auto (Thin Automation) : exécute la commande Thin 
Automation. (Edit > Automation > Thin).

Colesc VCAAtm (Coalesce VCA Automation) : exécute la commande 
Track > Coalesce VCA Master Automation.

Colesc TrmAtm (Coalesce Trim Automation) : exécute la commande 
Track > Coalesce Trim Automation.

Clear TrmAtm (Clear Trim Automation) : exécute la commande 
Track > Clear Trim Automation.

Suspend TrmAtm (Suspend Trim Automation) : interrompt provi-
soirement l'automation de trimming pour permettre l'écoute 
des mouvements de trim.

Bouton Modes

Le bouton Modes affiche les commandes suivantes :

AWrtTo All (Auto Write to All on Stop) : écrit les valeurs actuelles 
d'automation sur l'ensemble d'une sélection ou d'une piste lorsque 
le transport est interrompu après une passe d'automation. 

Par défaut, le mode Automatic Write to All on Stop est activé 
pour une seule passe d'automation. Pour configurer le mode de 
sorte qu'il reste activé après une passe d'automation, maintenez 
les touches Démarrer+Alt (Windows) ou Ctrl+Option (Mac) en-
foncées tout en appuyant sur le bouton AWrtTo All.
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AWrtTo Start (Auto Write to Start on Stop) : écrit automatiquement 
les valeurs d'automation actuelles à partir du point d'insertion 
en reculant vers le début d'une sélection ou d'une piste lorsque 
le transport est interrompu après une passe d'automation. 

Par défaut, le mode Automatic Write to Start on Stop est activé 
pour une seule passe d'automation. Pour configurer le mode de 
sorte qu'il reste activé après une passe d'automation, maintenez 
les touches Démarrer+Alt (Windows) ou Ctrl+Option (Mac) en-
foncées tout en appuyant sur le bouton AWrtTo Strt.

AWrtTo End (Auto Write to End on Stop) : écrit les valeurs d'automa-
tion actuelles à partir du point d'insertion en avançant vers la 
fin d'une sélection ou d'une piste lorsque le transport est inter-
rompu après une passe d'automation. 

Par défaut, le mode Automatic Write to End on Stop est activé 
pour une seule passe d'automation. Pour configurer le mode de 
sorte qu'il reste activé après une passe d'automation, maintenez 
les touches Démarrer+Alt (Windows) ou Ctrl+Option (Mac) en-
foncées tout en appuyant sur le bouton AWrtTo End. 

AWrtTo Punch (Auto Write to Punch Point on Stop) : écrit les valeurs 
actuelles d'automation jusqu'au point où la passe d'automation 
actuelle a commencé. 

Par défaut, le mode Automatic Write to Punch Point on Stop est 
activé pour une seule passe d'automation. Pour configurer le 
mode de sorte qu'il reste activé après une passe d'automation, 
maintenez la touche Alt (Windows) ou Option (Mac) enfoncée 
tout en appuyant sur le bouton AWrtTo Punch.

AWrtTo Next (Auto Write to Next Breakpoint on Stop) : écrit les 
valeurs d'automation actuelles à partir du point d'insertion en 
avançant vers le prochain point d'inflexion d'automation lorsque 
le transport est interrompu après une passe d'automation. 

Automatic Write to Next Breakpoint on Stop reste activé après 
chaque passe d'automation jusqu'à ce que vous le désactiviez en 
appuyant sur le bouton AWrtTo Next (allumé).

Bouton Prefs

Le bouton Prefs affiche les commandes suivantes :

Bouton Prefs (page 1)

Match Time : détermine la durée AutoMatch, ou le temps néces-
saire aux valeurs d'automation pour revenir aux valeurs précé-
demment écrites après l'arrêt d'une passe d'automation.

Glide Time : détermine la durée AutoGlide, ou le temps nécessaire 
aux valeurs de panoramique surround pour se déplacer entre deux 
points dans une passe d'automation exécutée à l'aide du surround 
panner optionnel de D-Control. 



LchStp (Allow Latch Prime in Stop) : active ou désactive la préférence 
Allow Latch Prime in Stop, ce qui permet de préparer les pistes 
en mode Latch pour l'écriture de données d'automation pendant 
que le transport est interrompu. Lorsqu'une piste en mode Latch 
est préparée pour l'écriture de données d'automation, le témoin 
correspondant au mode Latch clignote. 

PlgAut (Plug-In Controls Default to Auto-Enabled) :  sélectionne ou 
désélectionne la préférence qui active automatiquement les 
commandes de plug-in lorsqu'elles sont ajoutées à une piste.

AutCls (Coalesce when Removing Slaves from VCA Group) : active 
ou désactive la préférence qui fusionne automatiquement les 
données d'automation à la piste esclave lorsqu'elles sont sup-
primées d'un groupe contrôlé par VCA.

TrmCols (Coalesce Trim Automation) : définit la préférence qui 
détermine le moment où les données d'automation de trimming 
sont fusionnées (After Every Pass, On Exiting Trim Mode, ou 
Manually).

Bouton Prefs (page 2)

MmtTch (Latching Behavior for Switched Controls in Touch) : active 
ou désactive la préférence qui détermine le comportement des 
commandes commutées en mode Touch. 

StdVCA (Standard VCA Logic for Group Attributes) : active ou dé-
sactive la préférence qui désactive le comportement normal de 
liaison aux groupes en cas d'assignation de VCA à un groupe.

WrtWrn (Suppress Automation “Write To” Warnings) : active ou 
désactive la préférence qui supprime les boîtes de dialogue suite 
à l'appel des commandes Write To Start/End/All.

PanLnk (Use Absolute Pan Linking) : active ou désactive la préférence 
qui détermine le comportement des commandes de panoramique 
dans des pistes groupées.

SndTrm (Include Sends in Trim Mode) : active ou désactive la pré-
férence qui détermine si les faders de départ doivent passer en 
mode Trim en même temps que le volume principal.

CtlUnd (Include Control Changes in Undo Queue) : active ou dés-
active la préférence qui détermine si des déplacements de com-
mandes de mixage (tels que des faders ou des commandes de 
panoramiques) doivent être inclus dans la liste d'annulations 
de Pro Tools. 

Bouton Audio Files

Commandes Open Recent Session

No Session Open : lorsqu'aucune session n'est ouverte, le bouton 
Audio Files affiche le nom des dix dernières sessions Pro Tools 
sur ses pages d'affichage 1 et 2. 

Open Session : si une session est ouverte, le bouton Audio Files 
affiche les commandes suivantes : 
Page 1

• New Sessn : File > New Session

• Open Sessn : File > Open Session

• Close Sessn : File > Close Session

• Revert Sessn : File > Revert to Saved

• Save As : File > Save As

• Save Copy In : File > Save Copy In

Page 2

• Import Audio : File > Import > Audio

• Import MIDI : File > Import > MIDI

• Import SesDat : File > Import > Session Data

• Import RgnGrp : File > Import > Region Groups

• Import Video : File > Import > Video

Page 3

• Export Region : Region List Menu > Export Regions as Files

• Export MIDI : File > Export > MIDI

• Export OMFAAF : File > Export > Selected Tracks as New 
AAF/OMF

• Export Text : File > Export > Session Info As Text

Pages 4 et 5

• Recent Sessns : Open recent sessions (listed by name)

Bouton Show/Hide

Le bouton Show/Hide affiche les commandes suivantes du 
menu Show/Hide Tracks List : 

Bouton Show/Hide (page 1)

• Show All : Show All Tracks

• Hide All : Hide All Tracks

• Show Selctd : Show Only Selected Tracks

• Hide Selctd : Hide Only Selected Tracks

• Show Inactv : Show Only Inactive Tracks

• Hide Inactv : Hide Only Inactive Tracks

Bouton Show/Hide (page 2)

• Show Audio : Show Only Audio Tracks

• Hide Audio : Hide Only Audio Tracks

• Show Aux : Show Only Auxiliary Inputs

• Hide Aux : Hide Only Auxiliary Inputs

• Show MIDI : Show Only MIDI Tracks

• Hide MIDI : Hide Only MIDI Tracks

Bouton Show/Hide (page 3)

• Show Instmt : Show Only Instrument Tracks

• Hide Instmt : Hide Only Instrument Tracks

• Show VCA : Show Only VCA Master Tracks

• Hide VCA : Hide Only VCA Master Tracks

• Hide MkInac : Hide and Make Inactive

Vous pouvez sélectionner plusieurs catégories Show/Hide en 
maintenant la touche Maj enfoncée tout en appuyant sur la 
Soft Key correspondante.
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Section Miscellaneous Controls

La section Miscellaneous Controls inclut des commandes pour les fonctions de base d'affichage et d'édition de Pro Tools.
Guide D-Control12
Commandes Miscellaneous de D-Control (affichage étendu)

Link
Edit/Timeline
bouton

Bouton
Selection

Start

Bouton
Shuffle

Mode

Bouton
Cut

Bouton
Track Size

Bouton
Explode

View

Bouton
Paste

Bouton
Slip

Mode

Bouton
Selection

Length

Bouton
Sub

Counter

Bouton 
Main 
Counter

Bouton 
Selection 
End

Bouton 
Spot 
Mode

Bouton 
Grid 
Mode

Bouton 
Copy

Bouton 
Track Size 
Down

Bouton 
Repeat

Bouton 
Go To

Bouton et 
témoins 
Edit/Timeline 
Selection
Boutons Main Counter et Sub Counter

Les boutons Main Counter et Sub Counter affichent successivement 
les modes d'affichage de timecode (Bars:Beats, Min.Secs, Time 
Code, Feet+Frames et Samples) sur le compteur correspondant. 

Bouton Link Edit/Timeline

Le bouton Link Edit/Timeline active ou désactive la commande 
Link Edit and Timeline Selection. Il est allumé lorsque les sélec-
tions sont liées. 

Boutons Location Start/End/Length

Les boutons Start/End/Length permettent de sélectionner les 
valeurs correspondantes dans les indicateurs de sélection. Vous 
pouvez saisir de nouvelles valeurs et les confirmer en appuyant 
sur la touche Entrée. 

Bouton et témoins Edit/Timeline

Le bouton Edit/Timeline bascule les valeurs de l'indicateur de 
sélection et la fonction de transport de D-Control entre la sélec-
tion d'édition et la sélection de timeline. Les témoins situés 
au-dessus du bouton s'allument pour indiquer quelle valeur est 
affichée. Si les sélections d'édition et de timeline sont liées, ces 
valeurs seront identiques. 
Edit Modes

Les boutons Edit Modes activent directement le mode d'édition 
correspondant de Pro Tools. Le bouton qui s'allume correspond 
au mode actuel. 

Bouton Shuffle : active le mode Shuffle de Pro Tools.

Bouton Spot : active le mode Spot de Pro Tools. 

Bouton Slip : active le mode Slip de Pro Tools. 

Bouton Grid : bascule Pro Tools entre les modes Absolute Grid et 
Relative Grid. 

Mode Shuttle Lock

Le mode Shuffle Lock vous empêche d'activer le mode Shuffle 
par inadvertance.

Pour verrouiller le mode Shuffle :

 En mode d'édition quelconque, excepté le mode Shuffle, ap-
puyez sur le bouton Shuffle tout en maintenant la touche Ctrl 
(Windows) ou Commande (Mac) enfoncée.

Pour déverrouiller le mode Shuffle :

 Appuyez sur le bouton Shuffle à l'écran tout en maintenant la 
touche Ctrl (Windows) ou Commande (Mac) enfoncée.



Edit Function

Les boutons Edit Function exécutent directement la commande 
correspondante dans Pro Tools. Les boutons qui s'allument in-
diquent les fonctions disponibles. 

Bouton Cut : coupe la sélection d'édition actuelle. 

Bouton Copy : copie la sélection d'édition actuelle dans le 
Presse-papiers. 

Bouton Paste : colle le contenu actuel du Presse-papiers. 

Bouton Repeat : colle le contenu actuel du Presse-papiers de bout 
en bout le nombre de fois spécifié. 

Boutons Track Size

Les boutons Track Size Up et Track Size Down augmentent et 
réduisent la hauteur de toutes les pistes contenant un curseur 
de sélection ou d'édition. 

Bouton Explode

Le bouton Explode invoque la commande Zoom Toggle de 
Pro Tools, qui permet d'effectuer un zoom sur la sélection d'édition 
actuelle et définit la hauteur de piste telle que spécifiée dans les 
préférences d'affichage de Pro Tools. 

Bouton Go To

Le bouton Go To permet de sélectionner une piste spécifique 
sur Focus Channel Strip de l'unité principale. 

Pour accéder à une piste spécifique :

1  Appuyez sur le bouton Go To.

2  Saisissez le numéro de position de la piste recherchée et 
appuyez sur la touche Entrée.
Emplacements mémoire

Vous pouvez afficher et créer des emplacements mémoire de 
Pro Tools à partir des Soft Keys de D-Control.

Pour faire apparaître les emplacements mémoire dans les Soft Keys, 
procédez comme suit :

 Appuyez à plusieurs reprises sur le bouton Mem Loc dans la 
section Soft Keys pour faire défiler l'affichage des emplacements 
mémoire.

– ou –

 Maintenez la touche Maj enfoncée et appuyez plusieurs fois 
sur le bouton Mem Loc dans la section Soft Keys pour faire défiler 
en arrière. 

Pour créer un nouvel emplacement mémoire à partir des Soft 
Keys :

1  Dans la section Soft Keys, appuyez sur le bouton Mem Loc. Le 
bouton Mem Loc s'allume pour indiquer l'affichage des empla-
cements mémoire. 

2  Appuyez sur une Soft Key correspondant à un affichage vierge.

3  Définissez les propriétés du nouvel emplacement mémoire dans 
la boîte de dialogue New Memory Location. 

4  Appuyez sur la Soft Key correspondant à la touche Entrée pour 
enregistrer l'emplacement mémoire.

Pour éditer un emplacement mémoire à partir des Soft Keys :

1  Dans la section Soft Keys, appuyez sur le bouton Mem Loc. Le 
bouton Mem Loc s'allume pour indiquer l'affichage des empla-
cements mémoire. 

2  S'il existe plus de six emplacements mémoire, appuyez sur la 
Soft Key correspondant à Pg. Préc et Pg. suiv pour afficher des 
emplacements supplémentaires.

3  Tout en maintenant la touche Démarrer (Windows) 
ou Commande (Mac) enfoncée, appuyez sur la Soft Key 
correspondant à l'emplacement mémoire à éditer.

4  Modifiez les propriétés du nouvel emplacement mémoire dans 
la boîte de dialogue Edit Memory Location. 

5  Appuyez sur la Soft Key correspondant à la touche Entrée pour 
enregistrer l'emplacement mémoire.

Pour supprimer un emplacement mémoire à partir des Soft Keys :

1  Dans la section Select/MIDI Soft Keys, appuyez sur le bouton 
Mem Loc.

2  Tout en maintenant la touche Alt (Windows) ou Option (Mac) 
enfoncée, appuyez sur la Soft Key correspondant à l'emplacement 
mémoire à supprimer.
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Configurations de fenêtres

Vous pouvez afficher, créer et éditer des configurations de fenê-
tres à partir des Soft Keys de D-Control.

Pour afficher des configurations de fenêtres dans les Soft Keys :

1  Tout en maintenant la touche Démarrer (Windows) ou Ctrl 
(Mac) enfoncée, appuyez sur le bouton Mem Loc dans la section 
Select/MIDI Soft Keys. Le bouton Mem Loc clignote pour indiquer 
l'affichage de la configuration de fenêtre. 

2  S'il existe plus de six configurations de fenêtres, appuyez sur 
les Soft Keys correspondant à Pg. Préc et Pg. suiv pour afficher 
les configurations supplémentaires.

Pour rappeler une configuration de fenêtre à partir des Soft Keys :

1  Tout en maintenant la touche Démarrer (Windows) ou Ctrl 
(Mac) enfoncée, appuyez sur le bouton Mem Loc dans la section 
Select/MIDI Soft Keys. 

2  Appuyez sur la Soft Key correspondant à la configuration de 
fenêtre à rappeler.

Pour créer une configuration de fenêtre à partir des Soft Keys :

1  Tout en maintenant la touche Démarrer (Windows) ou Ctrl 
(Mac) enfoncée, appuyez sur le bouton Mem Loc dans la section 
Select/MIDI Soft Keys. 

2  Appuyez sur une Soft Key correspondant à un affichage vierge.

3  Définissez les propriétés de la nouvelle configuration de fenêtre 
dans la boîte de dialogue New Window Configuration. 

4  Appuyez sur la Soft Key correspondant à la touche Entrée pour 
enregistrer la configuration de fenêtre.
Guide D-Control14
Pour éditer une configuration de fenêtre à partir des Soft Keys :

1  Tout en maintenant la touche Démarrer (Windows) ou Ctrl 
(Mac) enfoncée, appuyez sur le bouton Mem Loc dans la section 
Select/MIDI Soft Keys.

2  Tout en maintenant la touche Démarrer (Windows) 
ou Commande (Mac) enfoncée, appuyez sur la Soft Key 
correspondant à la configuration de fenêtre à éditer.

3  Modifiez les propriétés de configuration de fenêtre dans la boîte 
de dialogue Edit Window Configuration. 

4  Appuyez sur la Soft Key correspondant à la touche Entrée pour 
enregistrer la configuration de fenêtre.

Pour supprimer une configuration de fenêtre à partir des Soft 
Keys :

1  Tout en maintenant la touche Démarrer (Windows) ou Ctrl 
(Mac) enfoncée, appuyez sur le bouton Mem Loc dans la section 
Select/MIDI Soft Keys.

2  Tout en maintenant la touche Alt (Windows) ou Option 
(Mac) enfoncée, appuyez sur la Soft Key correspondant à la 
configuration de fenêtre à supprimer.



Chapitre 10 : Sections Monitor et Meter

Commandes de la section Monitor

La section Monitor inclut un jeu de commandes pour plusieurs sections de l'unité D-Control, notamment le monitoring de la régie, 
le casque/retour et le talkback/listenback. Toutes les connexions d'entrée et de sortie du système d'écoute de l'unité D-Control 
s'effectuent sur l'interface XMON (qui est connectée à la console de D-Control via le câble XMON) et sont contrôlées à distance 
depuis cette section. 
Section Monitor de l'unité D-Control

Commandes de 
la régie

Commandes de 
Casque/Retour

Commandes 
Talkback/Listenback

Sélecteurs de 
source 

d'entrée pour 
la régie

Sélecteurs 
de source 

d'entrée Cue
Commandes 

Talkback
Commandes 

Listen Mic
Commandes 
Mini Monitor

Commande 
niveau Dim

Commandes 
AFL/PFL

Commandes 
casque

Commandes 
mode de 

monitoring

Commandes 
monitoring 
secondaire

Commandes 
monitoring 
principal

Commandes 
Studio 

Loudspeaker

Boutons de 
sélection de 

canal de sortie et 
de mode

Commandes 
Cue 1

Commandes 
Cue 2

Commandes 
Cue 3
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Système de monitoring de la régie

Le système de monitoring de la régie est constitué de huit canaux 
dotés de six sources d'entrée (deux surround à 8 canaux, quatre 
stéréo) et de trois sorties disponibles (deux surround à 8 canaux, 
une stéréo).

Les sources d'entrée sont sélectionnées à l'aide des boutons dédiés 
et peuvent être combinées dans un mode spécial de sommation 
permettant d'écouter simultanément plusieurs entrées. 

Les sorties vers la régie sont activées via des boutons dédiés et 
des commandes de niveau, notamment la fonction Dim, pour 
une réduction de niveau momentanée. 

Sélecteurs Control Room Input Source

Boutons Input Source

Le système de monitoring de la régie comporte six sources 
d'entrée : 

• Entrées Main (8 canaux)

• Entrées Surround (8 canaux)

• Entrées Stereo 1 (2 canaux)

• Entrées Stereo 2 (2 canaux)

• Entrées Stereo 3 (2 canaux)

• Entrées Stereo 4 (2 canaux)

Pour sélectionner une source, appuyez sur le bouton Input cor-
respondant, qui s'allume lorsque la source est activée.

Sélecteurs Control Room Input Source

Bouton Sum

Bouton Main

Bouton Surround

Boutons
d'entrées
stéréo
Guide D-Control16
Mode Input Level Trim

Le trim de chaque source d'entrée peut être contrôlé séparément 
pour permettre de définir plusieurs niveaux de référence ou de 
compenser les écarts entre les différents gains. Les valeurs de trim 
disponibles varient de –20 dB à +10 dB, par incréments de 0,5 dB. 

Pour régler le trim des niveaux d'entrée :

1  Maintenez enfoncé le bouton Input Source Selector pour le trim 
de l'entrée que vous souhaitez ajuster, jusqu'à ce que le bouton 
clignote. 

2  Utilisez le bouton encodeur Main Output Level pour définir la 
valeur de trim. L'indication Trim ainsi que sa valeur (exprimée 
en dB) apparaissent dans l'affichage de la section Monitor.

3  Appuyez sur le bouton Input Source Selector clignotant pour 
quitter le mode Trim. 

Bouton Sum

En mode de fonctionnement normal, les boutons Control 
Room Input Source adoptent un comportement OU exclusif 
(non-latching), de sorte qu'une seule source peut être écoutée 
à la fois.

D-Control comporte cependant un mode Sum qui permet 
d'écouter simultanément plusieurs sources d'entrée. Lorsque 
le mode Sum est activé, plusieurs boutons de source d'entrée 
peuvent être actifs.

En mode Sum, les valeurs de trim des entrées sont ignorées. 

Pour ajouter ou supprimer des entrées en mode Sum :

1  Appuyez sur le bouton Sum. Le bouton s'allume pour indiquer 
que le mode Sum est actif. 

2  Appuyez sur un bouton Input Source pour activer ou désactiver 
les entrées correspondantes. Vous pouvez désactiver toutes les 
entrées.

Pour quitter le mode Sum :

 Appuyez de nouveau sur le bouton Sum. Le monitoring 
s'effectue de nouveau sur l'entrée qui était sélectionnée lors 
de l'activation du mode Sum.



Commandes Control Room Output

Boutons Output On/Off

Le système de monitoring de la régie comporte trois types de 
sorties :

• Sorties régie Main (8 canaux)

• Autres sorties régie (8 canaux)

• Mini sorties régie (2 canaux)

Vous ne pouvez activer qu'une seule sortie à la fois. Les boutons 
Output On/Off suivent un comportement OU exclusif (non-
latching). Lorsque vous activez une sortie, son nom et sa valeur 
de gain (exprimée en dB) apparaissent dans l'affichage de la 
section Monitor. 

Commandes Output Level

Chacune des trois sorties Control Room comporte un encodeur 
rotatif tactile pour le contrôle du niveau de sortie. Lorsque l'un de 
ces encodeurs est bougé, l'affichage de la section Monitor indique 
le nom de la sortie et le niveau actuel (exprimé en dB). Les plages 
de gains varient de –INF à +10 dB, par incréments de 1 dB. 

Mode Output Level Trim

Le trim de chaque niveau de sortie peut être contrôlé séparément 
pour permettre de définir plusieurs niveaux de référence ou de 
compenser les écarts entre les différents gains. Les valeurs de trim 
disponibles varient de –20 dB à +10 dB, par incréments de 0,5 dB. 

Pour régler le trim des niveaux de sortie :

1  Maintenez enfoncé le bouton On/Off correspondant à la sortie 
pour laquelle vous souhaitez ajuster le trim, jusqu'à ce que le 
bouton clignote. 

2  Utilisez le bouton encodeur correspondant pour définir la 
valeur de trim. L'indication Trim ainsi que sa valeur (exprimée 
en dB) apparaissent dans l'affichage de la section Monitor.

Commandes Control Room Output

Commande de 
niveau de sortie 
Mini

Bouton On/Off 
sorties Mini

Commande de 
niveau de sortie 
Main

Bouton On/Off 
sorties Main

Commande de
niveau de
sortie Alt

Bouton On/Off
sorties Alt

Commande
Dim Level
3  Appuyez sur le bouton On/Off clignotant pour quitter le mode 
Trim. 

Commande Dim Level

La commande Dim Level permet de régler la quantité de réduc-
tion de niveau appliquée via le bouton Dim, situé dans la partie 
inférieure de la section Monitor. Les valeurs de réduction de niveau 
varient de –30 dB à 0 dB, par incréments de 1 dB. 

Lorsque le bouton encodeur Dim est bougé, l'indication Dim ainsi 
que la valeur du gain de réduction (exprimée en dB) s'affichent 
dans la section Monitor.

Couplage de niveaux de sortie de monitoring

Vous pouvez coupler les commandes Output Level afin de per-
mettre un réglage par paire des niveaux Main, Alt et Mini. Vous 
pouvez ainsi uniformiser les niveaux relatifs lorsque vous réglez le 
gain de sortie et passez d'un système de haut-parleurs à un autre.

Lorsque vous couplez les commandes Output Level, tous les pa-
ramètres de trim des sorties sont conservés, ainsi que les écarts 
entres les paramètres des commandes Output Level Main, Alt et 
Mini actuels. 

Pour coupler les commandes Output Level de D-Control :

1  Effectuez l'une des opérations suivantes :

• Définissez indépendamment les niveaux Main, Alt et Mini. 
Tous les écarts entre ces commandes seront conservés une 
fois liées. 

– ou –

• Réglez les niveaux Main, Alt et Mini au minimum (jusqu'à 
-INF). Ceci garantit qu'il n'y aura aucun écart entre ces 
commandes une fois liées.

2  Maintenez enfoncé le bouton Setup des commandes Monitor 
Output Mode et appuyez sur le bouton Main Output On/Off. La 
section Monitor affiche Output Lk On pour indiquer que le 
couplage est actif. 

Pour supprimer le couplage entre les commandes Output Level 
de D-Control :

 Maintenez enfoncé le bouton Setup des commandes Monitor 
Output Mode et appuyez sur le bouton Main Output On/Off. La 
section Monitor affiche Output Lk Off.
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Commandes Monitor Output Mode

Bouton Setup

Cette fonction n'est pas encore implémentée pour D-Control.

Bouton Cal (Calibration Mode)

Le bouton Cal appelle un mode qui modifie la valeur de sortie 
affichée dans la section Monitor, en transformant la valeur de 
gain (exprimée en dB) en valeur de niveau de pression acoustique 
(exprimée en dB SPL) pour chaque sortie de la régie. Ce bouton 
s'allume lorsqu'une valeur SPL est affichée pour la sortie active.

Pour afficher les niveaux de sortie en dB SPL, vous devez d'abord 
étalonner chaque sortie. L'étalonnage SPL requiert l'utilisation 
d'une source de bruit rose (ou tout autre signal de référence) et 
d'un VU-mètre de niveau de pression acoustique pour mesurer 
individuellement la sortie des haut-parleurs de la régie.

Pour étalonner les sorties de la régie afin d'afficher les valeurs SPL :

1  Envoyez le signal de référence vers les sorties Main de la régie 
et réglez le niveau de sortie dans Pro Tools sur votre niveau de 
référence de studio (–18 dBFS, par exemple). 

2  Réglez le panoramique du signal au centre (de sorte qu'un 
niveau équivalent soit envoyé vers tous les haut-parleurs Main 
Control Room Output).

3  Définissez la balance entre les haut-parleurs pour tous les haut-
parleurs du système utilisant le mode Output Trim pour chaque 
canal, en vous servant du VU-mètre de niveau de pression acous-
tique pour mesurer la valeur SPL à la position de mixage. Voir 
« Mode Individual Output Trim » à la page 119.

4  Passez en mode Solo sur le haut-parleur central et réglez l'enco-
deur de niveau Main Control Room Output pour que le VU-mètre 
de niveau de pression acoustique mesure le niveau de référence 
cible (85 dB, par exemple) à la position de mixage. Vous pouvez 
activer le mode Output Level Trim pour affiner le réglage du ni-
veau de sortie. Voir « Mode Output Level Trim » à la page 117.

5  Maintenez enfoncé le bouton Cal jusqu'à ce qu'il clignote. 

6  Réglez l'encodeur de niveau Main Control Room Output 
jusqu'à ce que le niveau de référence cible apparaisse dans l'af-
fichage de la section Monitor. 

7  Appuyez sur le bouton Cal clignotant.

8  Répétez les étapes 4 à 7 pour toutes les sorties Alt et Mini. 

Commandes Monitor Output Mode

Bouton Mono

Bouton MuteBouton Dim

Bouton Setup

Bouton
d'étalonnage Cal
Guide D-Control18
Pour alterner l'affichage de sortie entre dB et dB SPL :

1  Sélectionnez la sortie pour laquelle vous souhaitez alterner 
l'affichage (Main, Alt ou Mini). 

2  Effectuez l'une des opérations suivantes :

• Pour afficher la sortie en dB SPL, appuyez sur le bouton 
Cal pour l'allumer.

– ou –

• Pour afficher la sortie en dB, appuyez sur le bouton Cal 
pour l'éteindre.

Bouton Mono

Le bouton Mono mixe les signaux gauche et droit de tous les 
modes de sortie (tous les canaux surround ne sont pas affectés) 
pour fournir une sortie mono, utile pour le contrôle des relations 
de phase et de balance. Le bouton Mono s'allume pour indiquer 
que le mode est actif.

Mode Mono Trim

Le trim de la sortie Mono peut être défini pour s'ajuster au niveau 
de référence des autres sorties. Les valeurs de trim disponibles 
varient de -12 dB à 0 dB, par incréments de 0,5 dB. 

Pour régler le trim d'une sortie mono :

1  Maintenez enfoncé le bouton Mono jusqu'à ce qu'il clignote. 

2  Utilisez le bouton encodeur Alt Output pour définir la valeur 
de trim Mono. L'indication Trim ainsi que sa valeur (exprimée 
en dB) apparaissent dans l'affichage de la section Monitor.

3  Appuyez sur le bouton Mono clignotant pour quitter le mode 
Trim.

Bouton Dim

La fonction Dim applique une réduction de gain ajustable aux 
sorties de la régie. Cette fonction affecte les trois destinations 
de sortie. Le bouton Dim active et désactive la fonction Dim et 
s'allume pour indiquer que la fonction est active. 

La quantité de réduction du gain est définie via la commande 
Dim Level, qui se trouve en haut à droite dans la section Control 
Room Output. 

Bouton Mute

Le bouton Mute active et désactive l'état Mute pour toutes les 
sorties de la régie. Le mode Mute s'applique globalement aux 
trois destinations de sortie. Le bouton Mute s'allume pour indi-
quer que le mode est actif. 

Si le bouton Mute du panneau avant de l'interface XMON est 
activé, le bouton Mute de l'unité D-Control doit être utilisé pour 
désactiver le mode Mute sur le système de monitoring. Le mode 
Mute ne peut pas être désactivé depuis le panneau avant de XMON 
pour les sorties.



Affichages de la section Monitor

Lorsqu'un bouton encodeur rotatif de la section Monitor est bou-
gé, les affichages des témoins indiquent le nom de la commande 
et sa valeur.

Commandes Ouput Channel Select

Boutons de sélection de canal

Les boutons de sélection de canal permettent de mettre en mode 
Solo ou Mute des canaux individuels des sorties de la régie. La 
fonction des boutons de sélection de canal dépend du mode du 
bouton Solo/Mute. 

• Lorsque ce mode est réglé sur Solo, chaque bouton de sélection 
de canal applique le mode Solo au canal de sortie correspondant.

• Lorsque ce mode est réglé sur Mute, chaque bouton de sélection 
de canal applique le mode Mute au canal de sortie correspondant.

Avec les deux modes, les boutons de sélection de canal adoptent 
un comportement verrouillé, permettant ainsi que des sorties 
multiples soient mises en mode Solo ou Mute. Les boutons de 
sélection de canal s'allument pour indiquer qu'ils sont actifs. 

Les boutons de sélection de canal permettent de choisir les 
canaux suivants : 

• L (Gauche)

• Lc (Centre gauche)

• C (Centre)

• Rc (Centre droit)

• R (Droit)

• Ls (Gauche surround)

• Cs (Centre surround)

• Rs (Droit surround)

• LFE

Affichages de la section Monitor

Commandes Ouput Channel Select

Affichages de la section 
Monitor

Boutons de sélection de 
canal

Bouton et témoins 
Solo/Mute
Ces choix prennent en charge toutes les configurations de 
canaux possibles dans Pro Tools. Vous pouvez utiliser un 
maximum de huit canaux simultanément (7.1 surround).

Mode Individual Output Trim

Le trim de chaque canal de sortie peut être réglé individuellement 
pour chacune des trois sorties de la régie (Main, Alt et Mini), ce 
qui permet d'ajuster la balance entre les canaux pour chaque 
ensemble de haut-parleurs de la régie. Les valeurs de trim sont 
stockées pour les trois sorties. Les valeurs de trim disponibles 
varient de -30 dB à +10 dB, par incréments de 0,5 dB.

Pour régler le trim du niveau de sortie d'un canal de sortie individuel :

1  Activez la sortie de régie (Main, Alt ou Mini) pour laquelle vous 
souhaitez ajuster le trim pour les niveaux des canaux. 

2  Maintenez enfoncé le bouton de sélection de canal correspon-
dant au canal pour lequel vous souhaitez régler le trim, jusqu'à 
ce que le bouton clignote.

3  Utilisez le bouton encodeur Main Output pour définir la valeur 
de trim du canal. L'indication Trim ainsi que sa valeur (exprimée 
en dB) apparaissent dans l'affichage de la section Monitor.

4  Appuyez sur le bouton de sélection de canal clignotant pour 
quitter le mode Trim. 

5  Répétez les étapes précédentes pour chaque canal de sortie et 
chaque ensemble de sorties (Main, Alt ou Mini) pour lesquels 
vous souhaitez ajuster le trim.

Bouton Solo/Mute et témoins

Le bouton Solo/Mute permet d'alterner la fonction des boutons 
de sélection de canal entre les modes Solo et Mute. Le témoin 
correspondant s'allume pour indiquer que le mode est actif. 
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Commandes du mode Solo

La fonction Solo dispose de trois modes : Solo in Place (SIP), 
After-Fader Listen (AFL) et Pre-Fader Listen (PFL). 

 Le mode SIP coupe le son de toutes les pistes qui ne sont pas en 
solo, ce qui isole toutes les pistes en solo dans le mixage principal. 
La source XMON Control Room Input reste inchangée, si bien 
que vous pouvez écouter les canaux en solo dans les systèmes de 
monitoring principaux de la régie. 

 Les modes AFL et PFL envoient le signal vers un chemin de 
sortie distinct, avec des niveaux réglables individuellement pour 
chaque mode. La source XMON Control Room Input change 
automatiquement afin de permettre l'écoute de l'entrée AFL/PFL, 
sauf si D-Control est en mode Broadcast (Reportez-vous à la sec-
tion « Mode Broadcast pour l'écoute AFL et PFL » à la page 120). 
Vous pouvez alors écouter les canaux mis en solo sur les systèmes 
de monitoring principaux de la régie (mode Broadcast désactivé) 
ou sur un système dédié au monitoring en solo (mode Broadcast 
activé).

Pour sélectionner le mode Solo :

 Appuyez sur le bouton SIP, AFL ou PFL de la section Monitor 
de D-Control pour sélectionner le mode Solo correspondant.

Définition des niveaux AFL et PFL

La section Monitor de D-Control permet de définir des niveaux 
individuels pour les modes AFL et PFL.

Pour définir le niveau AFL ou PFL :

1  Dans la section Monitor de D-Control, appuyez sur le bouton 
AFL ou PFL. 

2  Faites tourner l'encodeur rotatif AFL/PFL. Le niveau AFL/PFL 
apparaît dans l'affichage de la section Monitor.

Commandes du mode Solo de la section Monitor de D-Control

Les modes Solo AFL et PFL requièrent le plug-in 
Surround Mixer. 

Les niveaux AFL ou PFL peuvent être réglés même si aucun 
canal n'est en solo.

Bouton Latch

Bouton Moment

Bouton X-OR

Bouton AFL

Bouton PFL

Bouton SIP

Commande
de niveau

AFL/PFL
Guide D-Control20
Pour revenir à la valeur par défaut du niveau AFL ou PFL :

1  Dans la section Monitor de D-Control, appuyez sur le bouton 
AFL ou PFL. 

2  Maintenez la touche Alt (Windows) ou Option (Mac) enfoncée 
et bougez l'encodeur rotatif AFL/PFL. 

Mode Broadcast pour l'écoute AFL et PFL

Vous pouvez passer le système d'écoute de D-Control en mode 
Broadcast, ce qui empêche les modes solo AFL et PFL de changer la 
source XMON Control Room Input. Vous pouvez ainsi mettre 
des canaux en solo tout en conservant le mixage de monitoring 
principal.

Vous pouvez ensuite utiliser le sélecteur de chemin AFL/PFL dans 
la boîte de dialogue I/O Setup pour envoyer le signal solo AFL/PFL 
vers des haut-parleurs ou casques distincts. 

Pour passer le système d'écoute XMON en mode Broadcast :

1  Dans la section Soft Key, appuyez sur le bouton Operation.

2  Appuyez sur la touche programmable correspondant à 
Broadcast pour définir l'option sur On.

En mode Broadcast, tous les canaux mis en solo dans les modes 
AFL ou PFL sont envoyés vers le chemin AFL/PFL, mais XMON 
ne change pas la sortie Control Room Input pour le monitoring 
de ce chemin.

En mode Broadcast mode, tout canal mis en solo dans le mode 
SIP provoquera la coupure de toutes les autres pistes.

Options Solo Latch

Trois options Solo Latch peuvent être sélectionnées directement 
depuis la section Monitor de D-Control. Ces options s'appliquent 
aux trois modes Solo (SIP, AFL et PFL). 

Latch : lorsque cette option est sélectionnée, chaque nouvelle 
pression sur un bouton Solo de canal l'ajoute à la sortie Solo.

X–OR : lorsque cette option est sélectionnée, chaque nouvelle 
pression sur un bouton Solo de canal annule les solos précédents.

Momentary : lorsque cette option est sélectionnée, vous pouvez 
activer la mise en solo temporaire de plusieurs canaux, en mainte-
nant le bouton Solo d'un seul canal enfoncé et en appuyant sur les 
boutons Solo des canaux de votre choix. Lorsque vous relâchez 
le bouton Solo, tous les solos sont annulés.

Pour annuler le mode X-OR et mettre en solo plusieurs pistes 
à la fois, maintenez enfoncé le bouton Solo sur la première 
piste. Les boutons Solo sur lesquels vous appuyez ensuite seront 
activés en continu.



Système Casque/Retour

Le système Casque/Retour est un système à 2 canaux avec quatre sources d'entrée stéréo et cinq sorties stéréo disponibles. 

Commandes de sortie du système Casque/Retour
Commandes de sortie du système Casque/Retour

Commandes de niveau 
de sortie Cue

Bouton On/Off Studio 
Loudspeaker

Commande de niveau 
Studio Loudspeaker

Commande de
niveau

Headphone

Bouton On/Off
Headphone

Boutons On/Off
sorties Cue
Boutons Headphone/Cue Output On/Off

Le système Casque/Retour comporte cinq sorties disponibles :

• Cue 1 (2 canaux)

• Cue 2 (2 canaux)

• Cue 3 (2 canaux)

• Headphone (2 canaux)

• Studio Loudspeaker (2 canaux)

Les trois sorties Cue et les sorties Headphone et Studio Louds-
peaker peuvent être activées ou désactivées indépendamment ou 
simultanément. Les boutons On/Off s'allument pour indiquer 
qu'une sortie est active. 

Vous pouvez ajouter le signal de talkback sur toutes les sorties 
de façon indépendante. 

Commandes Headphone/Cue Level

Chacune des cinq sorties du système Casque/Retour comporte 
un encodeur rotatif tactile pour le contrôle du niveau de sortie. 
Lorsque l'un de ces encodeurs est bougé, l'affichage de la section 
Monitor indique le nom de la sortie et son niveau actuel (exprimé 
en dB). Les plages de gains varient de –INF à +10 dB, par incré-
ments de 1 dB.

Par ailleurs, lorsque l'un des ces boutons encodeurs est bougé, les 
sélecteurs Cue Input Source affichent la source d'entrée actuelle 
et l'affectation de talkback pour la sortie correspondante. Vous 
pouvez ensuite modifier la source d'entrée et l'affectation de 
talkback pour la sortie affichée. Il n'est pas utile que la sortie 
soit active pour afficher ou modifier les affectations.
Fonction Talkback Dim du système Casque/Retour

Lors le talkback est enclenché, une fonction Dim indépendante 
est automatiquement appliquée aux sorties Headphone/Cue. La 
quantité de réduction de gain est réglée à partir de cette section. 

Pour définir la valeur de réduction du gain pour la fonction Dim du 
système Casque/Retour :

1  Maintenez enfoncé le bouton Talkback Assign jusqu'à ce qu'il 
clignote.

2  Utilisez le bouton encodeur Main Output pour définir la valeur 
Dim du canal. L'indication TB Dim ainsi que la valeur de réduc-
tion de gain (exprimée en dB) apparaissent dans l'affichage de 
la section Monitor.

3  Appuyez sur le bouton Talkback Assign clignotant.

4  Répétez les étapes précédentes pour chaque canal de sortie et 
chaque ensemble de sorties (Main, Alt ou Mini) pour lesquelles 
vous souhaitez régler le trim.
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Sélecteurs Cue Input Source

Boutons Cue Input Source

Le système de monitoring Casque/Retour comporte quatre 
sources d'entrée : 

• Entrée Cue 1 (2 canaux)

• Entrée Cue 2 (2 canaux)

• Entrée Cue 3 (2 canaux)

• Entrée Main Monitor (2 canaux)

Ces sources d'entrée sont acheminées vers les sorties applicables 
avec les boutons Cue Input Source, qui s'allument lorsque la 
source d'entrée correspondante est activée pour une sortie donnée. 

Le tableau ci-dessous présente les sorties possibles pour chaque 
source d'entrée. La fonction Talkback peut être ajoutée à chacune 
des sorties.

Bouton Assign Talkback

Le bouton Assign Talkback permet d'ajouter le signal de talkback 
à toutes les sorties du système Casque/Retour. Il s'allume pour 
indiquer que le talkback est actif sur une sortie spécifique.

Sorties casque

Une sortie Headphone se trouve sous l'unité principale de 
D-Control, près du côté avant droit. Les quatre autres paires 
de sorties casque sont disponibles sur l'interface XMON.

Sélecteurs Cue Input Source

Entrée Sorties possibles

Cue 1 Cue 1, HP, Studio LS

Cue 2 Cue 2, HP, Studio LS

Cue 3 Cue 3, HP, Studio LS

Main Monitor Cue 1, Cue 2, Cue 3, HP, Studio LS

Boutons de source 
d'entrée Cue

Bouton Assign Talkback
Guide D-Control22
Système Talkback/Listen

Le système Talkback/Listen comporte deux entrées micro de 
talkback avec des commandes de niveau indépendantes et deux 
entrées micro Listen avec une commande de niveau partagée.

Commandes Talkback

Le système Talkback comporte deux entrées micro de talkback 
(une externe et une intégrée), chacune dotée d'un encodeur ro-
tatif tactile pour contrôler le volume de sortie. Lorsque l'un de 
ces encodeurs est sélectionné, l'affichage de la section Monitor 
indique le nom de l'entrée et le niveau de volume actuel (exprimé 
en dB). Les valeurs de niveau varient de –INF à +30 dB sur chaque 
encodeur.

Commande External Talkback Level

La commande External Talkback Level permet de régler le volume 
du micro de talkback externe. Lorsque ce bouton encodeur est 
bougé, l'indication Ext TB ainsi que le niveau (exprimé en dB) 
apparaissent dans l'affichage de la section Monitor.

Commande Talkback Level

La commande Talkback Level permet de régler le volume du 
micro intégré (interne), qui se trouve sur le pont des VU-mètres 
de l'unité principale de D-Control. Lorsque ce bouton encodeur 
est bougé, l'indication Int TB ainsi que le niveau (exprimé en dB) 
apparaissent dans l'affichage de la section Monitor.

Commandes Talkback et Listen

Commande
de niveau
Listen Mic

Boutons de
sélection Listen

Mic

Commande de 
niveau External 
Talkback

Commande de 
niveau Talkback 
intégré

Bouton Auto 
Talkback



Fonction Talkback Dim

Lorsque le talkback est enclenché, la fonction Dim (telle que dé-
finie par la commande Dim Level dans la section Control Room 
Output) est automatiquement appliquée aux sorties principales. 
Tout réglage de la commande Dim Level affecte les fonctions 
Talkback Dim et Control Room Output Dim. Lorsque le talkback 
est enclenché, le bouton Dim des commandes Monitor Output 
Mode s'allume. 

Bouton Auto Talkback

Le bouton Auto Talkback active un mode dans lequel les micros de 
talkback et de listenback sont automatiquement activés chaque 
fois que la barre de transport Pro Tools est arrêtée. Lorsque le mode 
Auto Talkback est actif, le bouton Auto Talkback ainsi que les 
boutons Talkback s'allument. 

En mode Auto Talkback, vous pouvez désactiver temporairement, 
puis réactiver le talkback, tout en restant en mode Auto Talkback. 

Pour désactiver temporairement le talkback en mode Auto 
Talkback :

 Appuyez sur l'un des boutons Talkback qui clignotent.

Pour réactiver le talkback en mode Auto Talkback :

 Appuyez deux fois sur le bouton Talkback afin qu'il clignote 
de nouveau.

Bouton Talkback

Les deux boutons Talkback qui figurent en bas de chaque section 
Channel Strip Master sur l'unité principale ont la même fonction 
que le bouton Talkback de D-Control.

Les boutons Talkback peuvent adopter un comportement mo-
mentané ou verrouillé. Ils s'activent uniquement lorsqu'ils sont 
maintenus enfoncés. 

Si vous appuyez rapidement deux fois sur le bouton, il s'active 
en continu et clignote pour indiquer que le talkback est actif. 
Appuyez de nouveau dessus pour désactiver le talkback.

Bouton Talkback

Bouton de talkback
Commandes Listen

Le système Listen comporte deux entrées micro sélectionnables, 
dotées d'un encodeur rotatif tactile pour le contrôle de niveau.

Commande Listen Mic Level

La commande Listen Mic Level permet de régler le volume de 
l'entrée micro Listen sélectionnée, Mic 1 ou Mic 2. Lorsque ce 
bouton encodeur est bougé, le nom de l'entrée Lstn 1 ou Lstn 2 
ainsi que le niveau (exprimé en dB) apparaissent dans l'affichage 
de la section Monitor. Lorsque les deux entrées sont actives, la 
section Monitor affiche les deux noms des entrées et les niveaux 
correspondants. 

Lorsqu'une entrée est active, l'encodeur contrôle le niveau de 
cette entrée, de façon indépendante. Lorsque les deux entrées 
sont actives, l'encodeur contrôle les deux niveaux simultanément, 
maintenant ainsi un écart relatif entre les deux. 

Les valeurs de contrôle de niveau varient de –INF à +30 dB.

Boutons Listen Mic Select

Il existe deux boutons Listen Mic Select pour les entrées micro 
Listen externes :

• Mic 1

• Mic 2

Les deux entrées peuvent être activées simultanément. Si aucune 
de ces entrées n'est active, la commande Listen Mic Level peut 
quand même être réglée, en préparation de l'activation future 
d'une entrée.
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Affichages des VU-mètres et du timecode (unité principale)

Échelle temporelle 
principale

Échelle temporelle 
secondaire

Indicateur Start

Indicateur End

Indicateur Length

Affichages des
VU-mètres

Micro de talkback

Témoins de format d'affichage du timecode
VU-mètres
Le pont des VU-mètres de l'unité principale inclut huit graphiques à barres, constitués de 32 segments à LED pour l'affichage des 
niveaux de sortie ou du niveau de la piste active sur la tranche Focus, selon le paramètre Meter Preferences de D-Control. Le témoin 
supérieur est rouge et indique l'écrêtage sur le canal correspondant. 

Pour plus de détails sur la configuration des VU-mètres, consultez la section « Options des VU-mètres » à la page 44. 

Échelle temporelle et indicateurs d'emplacement

Les cinq affichages sur l'unité principale reflètent les échelles temporelles principale et secondaire, ainsi que les valeurs Selection 
Start, End et Length de Pro Tools. 

Témoins du format d'affichage du timecode

Les témoins situés à gauche des affichages de timecode indiquent le format de timecode actuellement utilisé pour les échelles 
temporelles principale et secondaire. Les formats disponibles sont les suivants :

• H:M:S:MS (Heures:Minutes:Secondes:Millisecondes)

• H:M:S:F (Heures:Minutes:Secondes:Image)

• Feet:Frms (Feet+Frames)

• Bars:Beats

Micro de talkback

Le micro de talkback intégré de D-Control se trouve entre les affichages des VU-mètres et du timecode. 



Affichages des VU-mètres (module de faders)
Les affichages des VU-mètres sur chaque module de faders présentent des graphiques à barres de 32 segments à LED pour chaque 
canal et peuvent afficher des niveaux pré ou post-fader, selon le paramètre Meter Preferences de D-Control. En mode Custom Fader, 
ces affichages de VU-mètres peuvent indiquer les niveaux d'entrée et de sortie de plug-ins, la réduction de gain pour les plug-ins 
Dynamics, etc. Le témoin supérieur est rouge et indique un écrêtage sur le canal ou sur le paramètre correspondant.

Paramétrage des VU-mètres de D-Control pour différents niveaux de référence

L'option de VU-mètre Reference Level de Pro Tools permet de modifier l’affichage des VU-mètres de D-Control pour faciliter le 
contrôle des signaux issus de Pro Tools en fonction de niveaux de référence.

Pour chaque paramétrage, sauf 0 dB, une LED unique s’allume en continu sur un point fixe du pont des VU-mètres pour indiquer 
ce niveau de référence. Vous pouvez alors comparer les crêtes des signaux avec ce niveau indiqué. 

Les paramétrages de niveau de référence suivants sont disponibles :

0 dB : paramétrage normal, utilisé pour définir un niveau de référence de 0 dB (pleine échelle).

–14 dB : avec ce paramétrage, une LED orange s’allume à -14 dB sur tout le pont des VU-mètres. 

–18 dB : avec ce paramétrage, une LED orange s’allume à -18 dB sur tout le pont des VU-mètres. 

–20 dB : avec ce paramétrage, une LED orange s’allume à -20 dB sur tout le pont des VU-mètres.

B–20 dB : ce niveau de référence est conçu pour les applications de diffusion, avec un seuil inférieur de passage au segment orange. 
Pour ce paramétrage, une LED orange s’allume à -20 dB sur tout le pont des VU-mètres. Dans ce mode, les couleurs des LED des 
VU-mètres sont modifiées : les LED de –20 dB à –13 dB sont vertes et les LED de –12 dB à 0 dB sont oranges, 0 dB reste rouge.

Pour paramétrer un niveau de référence des VU-mètres de D-Control :

1  Dans la section Soft Keys, appuyez sur le bouton Meter. 

2  Appuyez sur la touche programmable correspondant à RefLvl pour naviguer entre les paramètres de niveau de référence des 
VU-mètres.

3  Pour quitter, appuyez sur le bouton Meter Prefs 1. 

Affichages des VU-mètres (module de faders)
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Chapitre 11 : Fonctionnement et commandes du 
mode Normal
La puissance et la flexibilité du système D-Control résident dans 
les différents modes de fonctionnement disponibles, lesquels 
permettent de personnaliser le comportement de ses commandes 
de tranches et de les adapter à votre workflow. 

Les principaux modes de fonctionnement de D-Control sont le 
mode Normal et les quatre modes Custom Fader.

En mode Normal, les pistes Pro Tools s'affichent sur D-Control 
dans un format de console standard. Dans ce mode, chaque 
tranche correspond à une piste de la session et la plupart des 
commandes de tranches correspondent exactement aux com-
mandes ou aux affichages de Pro Tools :

 Le fader de canal contrôle le volume du canal.

 L'affichage de canal indique le nom et le volume de la piste 
lorsque le fader correspondant est manipulé.

 Le bouton Pan affiche les valeurs de panoramique sur les enco-
deurs (il s'agit de l'affichage par défaut lorsqu'une piste est créée). 

 Le bouton Inserts affiche le nom de tous les inserts sur les 
encodeurs.

 Le bouton Sends affiche le nom des départs ainsi que leurs 
niveaux sur les encodeurs.

 Le bouton Pre affiche les commandes de pré-fader du canal 
sur les encodeurs.

 Le bouton Dyn affiche successivement les plug-ins Dynamics 
de la piste.

 Le bouton EQ affiche successivement les plug-ins EQ de la piste.

Assignation d'éléments à des pistes

Vous pouvez affecter des entrées, des sorties, des inserts et des 
départs à des pistes directement depuis D-Control en activant 
un mode Assign temporaire. 

Pour affecter une entrée, une sortie, un départ ou un insert :

1  Appuyez sur un bouton Assign (Input, Output, Insert ou Send) 
pour activer le mode Assign correspondant. 

2  Sur le canal sur lequel vous souhaitez effectuer une affectation, 
utilisez le bouton encodeur pour sélectionner le premier niveau 
de choix du menu.

Pour plus d'informations sur le mode Custom Fader, 
reportez-vous au Chapitre 13, « Modes Custom Fader ».
3  Appuyez sur le bouton Select de l'encodeur pour accéder aux 
niveaux inférieurs du menu et sur le bouton Bypass/Mute/Pre 
pour remonter aux niveaux supérieurs. 

4  Appuyez sur le bouton clignotant Select de l'encodeur ou sur 
le bouton Assign clignotant pour confirmer l'affectation. 

Pour affecter plusieurs entrées, sorties, départs ou inserts :

1  Appuyez sur un bouton Assign (Input, Output, Insert ou Send) 
pour activer le mode Assign correspondant. 

2  Utilisez les boutons encodeurs et appuyez sur les boutons Select 
et Bypass/Mute/Pre pour définir chaque affectation.

3  Appuyez sur le bouton Assign clignotant pour confirmer si-
multanément toutes les affectations.

Pour supprimer une entrée, une sortie, un départ ou un insert :

1  Appuyez sur un bouton Assign (Input, Output, Insert ou Send) 
pour activer le mode Assign correspondant. 

2  Pour supprimer l'assignation, appuyez plusieurs fois sur le 
bouton Bypass/Mute/Pre de l'encodeur pour atteindre le premier 
niveau du menu d'affectation. 

3  Tournez le bouton encodeur dans le sens contraire des aiguilles 
d'une montre jusqu'à ce que l'insert ou le départ disparaisse. 

4  Effectuez l'une des opérations suivantes :

• Appuyez sur le bouton clignotant Select de l'encodeur ou sur 
le bouton Assign clignotant pour confirmer la suppression. 

– ou –

• Pour annuler la suppression et restaurer l'affectation, 
appuyez sur le bouton Esc clignotant.

Pour supprimer rapidement une affectation de sortie ou de départ :

1  Appuyez sur le bouton Output Assign ou Send Assign. 

2  Maintenez la touche Démarrer (Windows) ou Ctrl (Mac) en-
foncée et appuyez sur le bouton Select pour chaque affectation 
de sortie ou de départ que vous souhaitez supprimer.

3  Appuyez sur le bouton Assign clignotant pour quitter le mode 
Assign.
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Affectation d’entrées pour sessions avec 
sorties de plug-ins multiples

Pour les sessions utilisant des plug-ins dotés de sorties multiples, 
les sorties auxiliaires de ces plug-ins sont disponibles en tant 
qu’entrées pour d’autres pistes audio et pistes d’entrées auxi-
liaires. Celles-ci constituent une troisième catégorie d’entrées 
appelées plug-ins, dans le menu des entrées de piste. 

Lors de l’affectation d’entrées via D-Control, cette troisième 
catégorie d’entrées apparaît dans le premier niveau de menu. 

Pour affecter une sortie de plug-in à une entrée :

1  Appuyez sur le bouton Assign Inputs.

2  Sur le canal sur lequel vous souhaitez réaliser l'assignation, 
utilisez un bouton encodeur pour sélectionner Plug-In dans le 
premier niveau de choix du menu.

3  Appuyez sur le bouton Select de l'encodeur pour descendre au 
niveau du menu correspondant aux plug-ins.

4  Tournez le bouton encodeur pour choisir le plug-in dont vous 
voulez sélectionner la sortie auxiliaire.

5  Appuyez sur le bouton Select de l'encodeur pour descendre au 
niveau du menu correspondant aux sorties auxiliaires du plug-in.

6  Effectuez l'une des opérations suivantes :

• Pour confirmer l'affectation, appuyez sur le bouton cligno-
tant Select de l'encodeur ou sur le bouton clignotant Assign 
Inputs.

– ou –

• Pour annuler l'affectation, appuyez sur le bouton Esc 
clignotant.

Affectation d’inserts et de départs à partir 
d’un canal

Vous pouvez affecter des inserts et des départs à des canaux 
spécifiques sans activer le mode Assign global.

Pour affecter un insert ou un départ :

1  Sur le canal sur lequel vous souhaitez réaliser l'assignation, 
appuyez sur le bouton Inserts ou Sends pour afficher les éléments 
correspondants sur les encodeurs du canal.

2  Appuyez sur le bouton Select de l'encodeur sur lequel vous 
voulez effectuer l'affectation. Une flèche droite (> – –) apparaît 
sur l’afficheur alphanumérique de l'encodeur pour indiquer que 
l'encodeur est en mode Assign. 

3  Utilisez le bouton encodeur correspondant pour sélectionner 
le premier niveau de choix du menu.

4  Appuyez sur le bouton Select de l'encodeur pour accéder aux 
niveaux inférieurs du menu et sur le bouton Bypass/Mute/Pre 
pour remonter aux niveaux supérieurs. 
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5  Effectuez l'une des opérations suivantes :

• Pour confirmer l’affectation, appuyez sur le bouton cligno-
tant Select de l'encodeur. 

– ou –

• Pour annuler l'affectation, appuyez sur le bouton Esc 
clignotant.

Pour modifier un insert ou un départ déjà affecté :

1  Sur le canal sur lequel vous souhaitez modifier l'assignation, 
appuyez sur le bouton Inserts ou Sends pour afficher les éléments 
correspondants sur les encodeurs du canal. 

2  Maintenez enfoncé le bouton Select de l'encodeur pour l’insert 
ou le départ que vous voulez modifier, jusqu’à ce qu’une flèche 
droite (>) s'affiche près de celui-ci sur l'afficheur alphanumérique 
de l'encodeur, indiquant que l'encodeur est en mode Assign. 

3  Effectuez l'une des opérations suivantes pour sélectionner un 
nouvel insert ou un nouveau départ :

• Utilisez le bouton encodeur correspondant pour faire une 
sélection à partir du niveau actif de choix du menu.

– ou –

• Appuyez sur le bouton Select de l'encodeur pour accéder aux 
niveaux inférieurs du menu et sur le bouton Bypass/Mute/
Pre pour remonter aux niveaux supérieurs.

4  Lorsque le nouvel insert ou le nouveau départ apparaît sur 
l'afficheur alphanumérique de l'encodeur, effectuez l'une des 
opérations suivantes :

• Pour confirmer l’affectation, appuyez sur le bouton cligno-
tant Select de l'encodeur. 

– ou –

• Pour annuler l'affectation, appuyez sur le bouton Esc 
clignotant.

Pour supprimer un insert ou un départ :

1  Sur le canal sur lequel vous souhaitez supprimer l'assignation, 
appuyez sur le bouton Inserts ou Sends pour afficher les éléments 
correspondants sur les encodeurs du canal. 

2  Maintenez enfoncé le bouton Select de l'encodeur pour l’insert 
ou le départ que vous voulez supprimer, jusqu’à ce qu’une flèche 
droite (>) apparaisse près de celui-ci sur l'afficheur alphanumérique 
de l'encodeur, indiquant que l'encodeur est en mode Assign.

3  Appuyez plusieurs fois sur le bouton Bypass/Mute/Pre de l'en-
codeur pour accéder au premier niveau du menu d'assignation. 

4  Tournez le bouton encodeur dans le sens contraire des aiguilles 
d'une montre jusqu'à ce que l'insert ou le départ disparaisse. 

5  Effectuez l'une des opérations suivantes :

• Pour confirmer la suppression, appuyez sur le bouton 
clignotant Select de l'encodeur. 

– ou –

• Pour annuler la suppression et restaurer l'affectation, 
appuyez sur le bouton Esc clignotant.



Affichage des affectations

Affichage des affectations d'E/S

Vous pouvez afficher les affectations d'E/S pour des canaux 
individuels dans une vue I/O temporaire. Les affectations d'E/S 
apparaissent en bas des encodeurs du canal, selon le type de piste. 
Les affectations s'affichent de haut en bas comme suit : 

• Pistes d'entrées audio et auxiliaires

• Entrée

• Sortie

• Pistes d'instrument

• Entrée MIDI

• Sortie MIDI

• Entrée auxiliaire

• Sortie auxiliaire

• Pistes MIDI

• Entrée MIDI

• Sortie MIDI

• Pistes Master Fader

• Sortie

• Pistes Master VCA

• Affectation de groupe

Pour afficher les affectations d'E/S sur une piste :

 Maintenez enfoncé le bouton Sends de la piste. Le bouton 
Sends s'allume pour signaler la vue I/O. 

Affichage des assignations de sorties multiples

Pistes audio et MIDI

Pour les pistes audio et MIDI ayant des affectations de sorties 
multiples, un signe plus (+) précède le nom de la sortie.

Pour afficher les noms des affectations de sorties multiples :

1  Maintenez enfoncé le bouton Sends d'une piste avec affecta-
tions de sorties multiples. Le bouton Sends s'allume pour signaler 
la vue I/O.

2  Appuyez sur le bouton B/M/P sous le nom d'une sortie précédé 
d'un signe plus (+). Les noms des chemins de sortie s'affichent 
dans les affichages de l'encodeur de la piste. 

3  Pour quitter cet affichage, appuyez sur l'un des boutons B/M/P 
allumés des chemins de sortie. 
Pour renommer un chemin d'E/S d'une piste audio :

1  Maintenez enfoncé le bouton Sends de la piste. Le bouton Sends 
s'allume pour indiquer l'affichage des affectations d'E/S.

2  Si vous avez plusieurs affectations d'E/S sur la piste, appuyez 
sur le bouton B/M/P sous le nom d'une sortie précédé d'un signe 
plus (+). Les noms des chemins de sortie s'affichent dans les 
affichages de l'encodeur de la piste. 

3  Maintenez la touche Démarrer (Windows) ou Ctrl (Mac) en-
foncée et appuyez sur le bouton B/M/P sous le chemin d'E/S que 
vous souhaitez renommer.

4  Entrez le nouveau nom de la piste.

5  Cliquez sur OK. 

Affichage des affectations de départs multiples

Pour les départs ayant des affectations multiples, un signe plus (+) 
précède le nom du départ.

Pour afficher les noms des affectations de départs multiples :

1  Appuyez sur le bouton Sends d'une piste avec des affectations 
de départs multiples.

2  Maintenez la touche Démarrer (Windows) ou Ctrl (Mac) en-
foncée et appuyez sur le bouton B/M/P sous le nom du départ 
précédé d'un signe plus (+). Les noms des chemins de départ 
s'affichent sur les affichages de l'encodeur de la piste.

3  Pour quitter cet affichage, appuyez sur l'un des boutons B/M/P 
allumés des chemins de départ. 

Pour renommer un chemin de départ :

1  Appuyez sur le bouton Sends de la piste du départ que vous 
souhaitez renommer.

2  Si vous avez plusieurs départs sur la piste, maintenez la touche 
Ctrl (Windows) ou Commande (Mac) enfoncée et appuyez sur le 
bouton B/M/P sous le nom du départ précédé d'un signe plus (+). 
Les noms des chemins de départ s'affichent sur les affichages de 
l'encodeur de la piste.

3  Maintenez la touche Démarrer (Windows) ou Ctrl (Mac) en-
foncée et appuyez sur le bouton B/M/P sous le nom du chemin 
de départ.

4  Entrez le nouveau nom de la piste.

5  Cliquez sur OK. 
Chapitre 11 : Fonctionnement et commandes du mode Normal 129



1

Interrogation des affectations de bus et d'E/S

Opération temporaire et de verrouillage

Lorsque vous interrogez des affectations de bus ou d'E/S, vous 
pouvez les afficher temporairement ou les verrouiller. Le ver-
rouillage des affectations est utile lorsque les banques de faders 
recherchent des indications hors banque.

Pour afficher temporairement des affectations de bus et d'E/S : 

 Bougez l'encodeur indiquant l'affectation.

Pour verrouiller l'affichage des affectations de bus et d'E/S :

 Appuyez deux fois sur l'encodeur indiquant l'affectation. 

Pour quitter l'affichage verrouillé des affectations de bus et d'E/S :

 Appuyez sur le bouton Esc clignotant. 

Indications hors banque

Lorsque vous interrogez des affectations de bus (que ce soit en 
affichage temporaire ou verrouillé), toutes les affectations hors 
banque sont indiquées par des boutons Bank/Nudge clignotants. 
Un clignotement lent indique qu'une affectation se trouve à un 
clic tandis qu'un clignotement rapide indique qu'une affectation 
se trouve à plusieurs clics. L'affichage de la section Soft Key in-
dique Nudge 1, Nudge 8 et Bank. Les touches programmables 
gauche et droite clignotent pour indiquer la présence d'affecta-
tions hors banque. 

Interrogation des affectations de bus

D-Control permet des interrogations en avant des sorties vers les 
chemins de bus et des interrogations inversées des entrées depuis 
les chemins de bus sur les pistes audio ou les pistes d'entrée 
auxiliaire. 

Pour interroger une sortie de piste vers un bus (interrogation de 
bus en avant) :

1  Maintenez enfoncé le bouton Sends d'une piste ayant le bus 
comme affectation de sortie. Le canal passe en vue I/O, indiquant 
l'entrée et la sortie de la piste dans ses encodeurs de tranche.

2  Bougez (ou appuyez deux fois) sur l'encodeur indiquant l'af-
fectation de bus sur la sortie. Le bouton de sélection de canal 
clignote sur les pistes avec ce bus affecté en tant qu'entrée.

Pour interroger un départ vers un bus (interrogation de bus en avant) :

1  Appuyez sur le bouton Sends d'une piste ayant le bus comme 
affectation de départ. 

2  Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur le bouton B/M/P sous le départ. Tous 
les départs de la piste s'affichent sur les encodeurs de la piste.

3  Bougez (ou appuyez deux fois) sur l'encodeur indiquant l'af-
fectation de bus sur le départ. Le bouton de sélection de canal 
clignote sur les pistes avec ce bus affecté en tant qu'entrée.
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Pour interroger une entrée de piste à partir d'un bus (interrogation 
de bus inversée) : 

1  Maintenez enfoncé le bouton Sends d'une piste ayant le bus 
comme affectation d'entrée. Le canal passe en vue I/O, indiquant 
l'entrée et la sortie de la piste dans ses encodeurs de tranche.

2  Bougez (ou appuyez deux fois) sur l'encodeur indiquant l'af-
fectation de bus sur l'entrée. Le bouton de sélection de canal cli-
gnote sur les pistes avec ce bus affecté en tant que sortie. Le bouton 
Select et le bouton Send du canal clignotent sur les pistes avec ce 
bus en tant qu'affectation de départ. 

Interrogation des affectations d'E/S

D-Control permet l'interrogation des affectations d'entrée ou 
de sortie correspondantes (y compris l'interface, le bus ou les 
chemins MIDI) sur des pistes audio, d'entrée auxiliaire, MIDI, 
d'instrument ou Master Fader.

Pour interroger une entrée ou une sortie de piste : 

1  Maintenez enfoncé le bouton Sends d'une piste ayant une af-
fectation d'entrée ou de sortie. Le canal passe en vue I/O, indi-
quant l'entrée et la sortie de la piste dans ses encodeurs de tranche.

2  Maintenez la touche Maj enfoncée et bougez (ou appuyez deux 
fois) sur l'encodeur indiquant l'affectation d'entrée ou de sortie. 
Le bouton de sélection de canal clignote sur les pistes ayant la 
même entrée ou sortie. 

Activation et désactivation d'éléments

Vous pouvez activer ou désactiver des entrées, des sorties, des 
inserts, des départs ou des pistes entières directement depuis 
D-Control en sélectionnant un mode Make Inactive temporaire. 

Pour activer ou désactiver une entrée, une sortie, un départ ou un 
plug-in :

1  Vérifiez que le canal indique l'affichage de niveau supérieur 
pour l'élément que vous souhaitez activer ou désactiver.

2  Appuyez sur le bouton Make Inactive pour activer le mode 
Make Inactive approprié. 

3  Appuyez sur le bouton Bypass/Mute/Pre des encodeurs pour 
désactiver ou réactiver les éléments correspondants sur la piste.

4  Appuyez sur le bouton Make Inactive qui clignote pour quitter 
le mode Inactive.

Pour activer ou désactiver une piste :

1  Appuyez sur l'un des boutons Make Inactive.

2  Appuyez sur les boutons Select des tranches pour désactiver 
ou réactiver les pistes correspondantes. 

3  Appuyez sur le bouton Make Inactive qui clignote pour quitter 
le mode Inactive.



Utilisation des pistes

Sélection d'une piste

Vous pouvez sélectionner des pistes dans Pro Tools directement 
depuis D-Control. En mode Select, vous pouvez régler le com-
portement des boutons Select sur continu ou non. Pour plus de 
détails sur l'activation du mode Latch pour le bouton Select, 
reportez-vous à la section « Mode Select Switch Latch » à la 
page 42. 

Pour sélectionner une piste depuis D-Control :

1  Vérifiez que le mode du bouton Select/Focus est Select.

2  Appuyez sur le bouton Select du canal pour la piste que vous 
souhaitez sélectionner.

Pour sélectionner un ensemble de pistes :

1  Appuyez sur le bouton Select du canal au début de la plage à 
sélectionner.

2  Maintenez la touche Maj enfoncée et appuyez sur le bouton 
Select du canal à la fin de la plage à sélectionner.

Toutes les pistes situées entre le premier et le dernier canal (inclus) 
sont sélectionnées.

Pour sélectionner ou désélectionner plusieurs pistes non contiguës, 
effectuez l'une des opérations suivantes :

 Si le mode Select Switch Latch est défini sur Latch, appuyez 
sur les autres boutons Select.

– ou –

 Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur le bouton Select de plusieurs canaux.

Mettre le focus sur une piste

Vous pouvez mettre le focus sur une piste d'une session pour la 
passer sur la tranche Focus de D-Control. Cela permet de refléter 
les commandes de piste de la tranche de l'unité principale de 
D-Control, en les plaçant sur la position centrale de mixage. La 
sélection d'une piste permet également de mettre le focus sur les 
premiers plug-ins Dynamics et EQ en les passant sur la section 
centrale EQ et Dynamics, rendant disponible le mode Custom 
Fader Plug-in.Voir « Mettre le focus sur un plug-in » à la page 132.

Pour passer une piste sur la tranche Focus depuis D-Control :

1  Vérifiez que le mode du bouton Select/Focus est Focus.

2  Appuyez sur le bouton Select du canal de la piste sur laquelle 
vous souhaitez mettre le focus.
Pour passer une piste sur la tranche Focus depuis D-Control tout 
en restant en mode Select :

 Maintenez les touches Démarrer+Maj (Windows) ou Ctrl+
Maj (Mac) enfoncées et appuyez sur le bouton Select du canal de 
la piste à laquelle vous souhaitez donner la priorité.

Pour passer une piste sur la tranche Focus depuis Pro Tools :

1  Vérifiez que l'option Target Track from Application est définie 
sur Yes. Pour plus de détails sur cette option, reportez-vous à la 
section « Target Track from Application » à la page 44. 

2  Dans l'écran de Pro Tools, cliquez sur la fenêtre des plug-ins, 
des départs, de panoramique ou le panneau du préampli micro 
pour la piste sur laquelle vous souhaitez mettre le focus. 

Pour mettre le focus sur un numéro de piste spécifique :

1  Effectuez l'une des opérations suivantes :

• Appuyez sur le bouton Go To de D-Control.

– ou –

• Choisissez Operations > Scroll To Track Number dans 
Pro Tools.

2  Saisissez le numéro de position de la piste et appuyez sur la 
touche Entrée.

Pour déplacer le focus de la piste vers la gauche ou vers la droite 
par incréments de 1 canal :

 Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur le bouton Nudge 1 vers la gauche ou 
vers la droite dans la section Bank/Nudge.

Pour déplacer le focus de la piste vers la gauche ou vers la droite 
par incréments de 8 canaux :

 Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur le bouton Nudge 8 vers la gauche ou 
vers la droite dans la section Bank/Nudge.

Pour déplacer le focus de la piste avec la molette Scrub/Shuttle :

1  Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur le bouton Nudge 1 vers la gauche ou 
vers la droite. 

2  Tout en maintenant le bouton Nudge 1 enfoncé, tournez la 
molette Scrub/Shuttle.

Mettre le focus sur des pistes lors de leur mise en 
solo

Pour configurer D-Control de façon à placer automatiquement le 
focus sur une piste lorsqu'elle est mise en solo :

1  Appuyez sur le bouton Operation plusieurs fois afin d'afficher 
la page contenant Focused Track Follows Solo (SoloFc).

2  Appuyez sur la touche programmable correspondant à SoloFc 
pour afficher le paramètre Yes.
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Affectation de playlists de pistes

Vous pouvez faire défiler les playlists disponibles de la piste mise 
en focus depuis D-Control. 

Pour parcourir les playlists d'une piste :

1  Mettez le focus sur la piste.

2  Dans la section Management, appuyez sur le bouton Playlist.

3  Dans la section Soft Keys, effectuez l'une des opérations 
suivantes :

• Appuyez sur la touche programmable correspondant à 
Prevs Plylst pour sélectionner la playlist précédente dans 
le menu Playlist de cette piste.

• Appuyez sur la touche programmable Next Plylst pour 
sélectionner la playlist suivante dans le menu Playlist de 
cette piste.

Utilisation de l'option HEAT

Vous pouvez activer et contrôler l'option HEAT depuis D-Control.

Pour activer et contrôler HEAT pour une session :

 Maintenez les touches Démarrer+Maj (Windows) ou Ctrl+
Maj (Mac) enfoncées et appuyez sur le bouton Plug-Ins dans la 
section Custom Faders. Les commandes HEAT Master suivantes 
apparaissent sur un canal des Custom Faders :

On/Off : pour activer HEAT, appuyez sur le bouton B/M/P corres-
pondant à HEAT dans l'affichage de l'encodeur du canal Custom 
Fader. 

Master Bypass : pour activer Master Bypass, appuyez sur le bouton 
B/M/P correspondant à MstByp dans l'affichage de l'encodeur 
du canal Custom Fader.

Drive : pour régler le paramètre Drive, utilisez l'encodeur corres-
pondant à Drive dans l'affichage de l'encodeur du canal Custom 
Fader.

Tone : pour régler le paramètre Tone, utilisez l'encodeur corres-
pondant à Tone dans l'affichage de l'encodeur du canal Custom 
Fader.

Pour afficher les commandes HEAT d'un canal :

1  Vérifiez que HEAT est activé dans la session. 

2  Maintenez les touches Démarrer+Maj (Windows) ou Ctrl+
Maj (Mac) enfoncées et appuyez sur le bouton Inserts du canal.

Pour désactiver HEAT sur un canal :

1  Maintenez les touches Démarrer+Maj (Windows) ou Ctrl+
Maj (Mac) enfoncées et appuyez sur le bouton Inserts du canal 
pour afficher ses commandes HEAT. 

2  Appuyez sur le bouton B/M/P correspondant à Bypass.
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Pour alterner entre l'opération HEAT pré-fader et post-fader sur 
un canal :

1  Maintenez les touches Démarrer+Maj (Windows) ou Ctrl+
Maj (Mac) enfoncées et appuyez sur le bouton Inserts du canal 
pour afficher ses commandes HEAT. 

2  Appuyez sur le bouton B/M/P correspondant à Pre ou Post.

Utilisation des plug-ins et des départs

Mettre le focus sur un plug-in

Lorsque vous mettez le focus sur un plug-in dans D-Control, ses 
commandes sont placées sur les encodeurs et les faders de tran-
ches pour faciliter les opérations d'édition. Vous pouvez mettre 
le focus sur un plug-in de différentes façons : sur les encodeurs 
de ses canaux, sur les encodeurs de la tranche Focus et dans la 
section Custom Faders. 

Avec les plug-ins Dynamics et EQ, vous pouvez également mettre 
le focus sur des paramètres de plug-ins puis les contrôler à partir 
des sections Dynamics et EQ spécifiques de D-Control.

Pour mettre le focus sur un plug-in sur une tranche :

1  Appuyez sur le bouton Inserts du canal. Les noms des plug-ins 
s'affichent sur les encodeurs du canal.

2  Appuyez sur le bouton Select situé sous le nom du plug-in sur 
lequel vous souhaitez mettre le focus. Les paramètres du plug-in 
s'affichent sur les encodeurs du canal. 

3  S'il existe plusieurs pages de paramètres pour le plug-in, les 
boutons Page Up ou Page Down s'allument. Pour faire défiler les 
pages de paramètres, appuyez sur le bouton approprié.

Pour passer un plug-in sur la tranche Focus :

1  Passez la piste du plug-in sur la tranche Focus.

2  Appuyez sur le bouton Inserts du canal. Les noms des plug-ins 
s'affichent sur les encodeurs du canal.

3  Appuyez sur le bouton Select situé sous le nom du plug-in sur 
lequel vous souhaitez mettre le focus. Les paramètres du plug-in 
s'affichent sur les encodeurs de la tranche Focus. 

4  S'il existe plusieurs pages de paramètres pour le plug-in, les 
boutons Page Up ou Page Down s'allument. Pour faire défiler les 
pages de paramètres, appuyez sur le bouton approprié.

HEAT prend en charge le mode Flip pour les commandes 
Master et Channel. 



Pour contrôler un plug-in à partir de la section Dynamics ou EQ :

1  Passez la piste du plug-in sur la tranche Focus en appuyant sur 
le bouton Select correspondant à la piste. Les premiers plug-ins 
Dynamics et EQ de cette piste passent automatiquement dans la 
section correspondante de l'unité D-Control. 

2  Appuyez sur le bouton Cycle de la section Dynamics ou EQ 
pour mettre le focus sur d'autres plug-ins Dynamics ou EQ du 
canal. L'option No Insert est toujours disponible.

Pour mettre le focus sur un plug-in et le contrôler depuis la section 
Custom Faders :

1  Passez la piste du plug-in sur la tranche Focus en appuyant sur le 
bouton Select correspondant à la piste. Le focus est automati-
quement mis sur le premier plug-in qui ne soit pas un plug-in 
Dynamics ou EQ, et son nom s'affiche dans l'affichage Custom 
Faders. 

2  Dans la section Custom Faders, appuyez sur le bouton Bank/
Cycle pour afficher successivement les plug-ins du canal mis en 
focus. L'option No Insert est toujours disponible.

Le plug-in dont le nom s'affiche dans la zone Custom Faders 
devient alors disponible en mode Custom Fader Plug-In. (Voir 
« Mode Plug-In de Custom Faders » à la page 154.)

Mode Automation Safe

Le bouton Automation Safe appelle un mode dans lequel le 
bouton Bypass/Mute/Pre de chaque encodeur et le bouton Select 
des canaux se transforment en boutons Automation Safe. Lorsque 
ce mode est activé, le fait d'appuyer sur le bouton Bypass/Mute/
Pre d'un plug-in ou d'un départ évite l'écrasement d'une auto-
mation sur ce plug-in ou départ. Le fait d'appuyer sur un bouton 
Select de canal empêche l'écrasement des paramètres automatisés 
de cette piste. 

En mode Automation Safe, le bouton Automation Safe est allumé. 
Lorsque ce mode est activé, le bouton Bypass/Mute/Pre des inserts 
ou départs protégés est allumé et le bouton de sélection des ca-
naux protégés est allumé.

Pour activer et désactiver le mode Automation Safe :

1  Appuyez sur le bouton Automation Safe.

2  Appuyez sur le bouton Select des pistes dont vous souhaitez 
activer ou désactiver le statut Automation Safe.

3  Appuyez sur le bouton Bypass/Mute/Pre des plug-ins ou départs 
dont vous souhaitez activer ou désactiver le statut Automation 
Safe.

4  Pour quitter ce mode, appuyez de nouveau sur le bouton 
Automation Safe.
Bypass (contournement) de plug-in

Lorsque le nom d'un plug-in s'affiche sur un encodeur (dans 
l'affichage Inserts supérieur), le bouton B/M/P de l'encodeur 
permet de contourner ce plug-in. Le bouton B/M/P s'allume 
lorsque l'insert ou le plug-in est en bypass.

Pour contourner un plug-in :

1  Appuyez sur le bouton Inserts du canal du plug-in pour afficher 
le nom des inserts sur les encodeurs du canal. 

2  Appuyez sur le bouton B/M/P correspondant au plug-in que 
vous souhaitez contourner. Le bouton B/M/P s'allume lorsque 
le plug-in est en bypass.

Activation et désactivation des plug-ins

Lorsque le nom d'un plug-in s'affiche sur un encodeur (dans 
l'affichage Inserts supérieur), il peut être désactivé sans passer 
par le mode Make Inactive.

Pour activer ou désactiver un plug-in :

1  Appuyez sur le bouton Inserts d'une tranche pour afficher le 
nom des plug-ins sur les encodeurs du canal.

2  Si l'emplacement de l'insert pour le plug-in que vous souhaitez 
activer ou désactiver n'apparaît pas, appuyez sur les boutons 
Page Up ou Page Down du canal faisant l'objet de l’affectation 
jusqu'à ce que l'emplacement approprié s'affiche.

3  Maintenez les touches Ctrl+Démarrer (Windows) ou Ctrl+
Commande (Mac) enfoncées et appuyez sur le bouton Select de 
l'encodeur pour le plug-in.

Coupure du son des départs

Vous pouvez mettre en mute des départs depuis D-Control en 
activant le mode approprié pour le bouton Bypass/Mute/Pre.

Pour couper le son des départs :

1  Appuyez sur le bouton Sends de la piste pour afficher le nom 
des départs sur les encodeurs du canal.

2  Appuyez sur le bouton Switch Mode pour définir le mode Mute.

3  Appuyez sur le bouton B/M/P pour le départ dont vous souhaitez 
couper le son. Le témoin Mute rouge s'allume pour indiquer que le 
son est coupé. 
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Définition d'opérations pré-fader ou 
post-fader pour les départs

Vous pouvez définir une opération pré ou post-fader pour des 
départs directement depuis D-Control en activant le mode ap-
proprié pour le bouton Bypass/Mute/Pre.

Pour alterner entre les opérations pré-fader et post-fader pour les 
départs :

1  Appuyez sur le bouton Sends de la piste pour afficher le nom 
des départs sur les encodeurs du canal.

2  Appuyez sur le bouton Switch Mode pour définir le mode Pre.

3  Appuyez sur le bouton B/M/P pour définir le départ que vous 
souhaitez configurer. Le témoin Pre vert s'allume pour indiquer 
que le départ est prêt pour une opération pré-fader. 

Mode Flip et mode Flop

Mode Flip

En mode Normal, les canaux peuvent utiliser le mode Flip, ce qui 
permet de transférer des commandes depuis une rangée d'enco-
deurs vers les faders de canal. 

En mode Flip, les fonctions du fader de canal sont transférées 
vers l'encodeur rotatif, celles du bouton Select de l'encodeur 
sont attribuées au bouton Select du canal, le bouton Bypass/Mute/
Pre de l'encodeur et le bouton Mute du canal permutent, tout 
comme l'affichage de l'encodeur et l'affichage du canal. 

En mode Flip, le bouton Flip de la rangée d'encodeurs concernée 
s'allume, et les affichages des encodeurs permutés s'affichent 
en jaune.

Pour transférer des commandes d'une rangée d'encodeurs rotatifs 
vers des faders de canal :

 Appuyez sur le bouton Flip correspondant à la rangée d'enco-
deurs à transférer.

Pour quitter le mode Flip :

 Appuyez sur un bouton Flip allumé.

Mode Flop

En mode Normal, les canaux peuvent utiliser le mode Flop, ce qui 
permet de transférer les commandes entre deux rangées d'enco-
deurs rotatifs, et facilite l'accès aux commandes d'encodeur de-
puis la position de mixage. 
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Pour transférer des commandes entre deux rangées d'encodeurs 
rotatifs :

 Maintenez la touche Démarrer (Windows) ou Ctrl (Mac) en-
foncée et appuyez plusieurs fois sur le bouton Flip de la rangée 
d'encodeurs où les commandes doivent être transférées. Sur 
chaque rangée, les boutons Flip s'allument pour indiquer les 
commandes en cours de transfert.

Les commandes transférées sont indiquées par un texte jaune 
dans les affichages des encodeurs.

Pour rétablir la position d'origine des commandes transférées :

 Appuyez sur l'une des boutons Flip allumés.

Affectation d’inserts et de départs en mode 
Flip

Vous pouvez affecter des inserts et des départs à un encodeur 
même lorsque ses commandes sont affectées au fader de canal 
(mode Flip). 

Lorsque les commandes de l'encodeur sont affectées au fader de 
canal, le bouton Select du canal remplace le bouton Select de 
l'encodeur, le bouton Mute du canal remplace le bouton Bypass/
Mute/Pre et le fader du canal remplace le bouton encodeur. 

Pour affecter un insert ou un départ à un encodeur en mode Flip :

1  Sur le canal auquel vous voulez affecter un insert ou un départ, 
appuyez sur le bouton Inserts ou Sends pour afficher les éléments 
correspondants sur le canal. Les commandes de l'encodeur en 
mode Flip s'affichent sur le fader de canal. 

2  Maintenez enfoncé le bouton Select du canal auquel vous 
voulez affecter l’insert ou le départ. L’afficheur alphanumérique 
du canal affiche une flèche droite (>– –) pour indiquer que le canal 
est en mode Assign. 

3  Utilisez le fader du canal pour sélectionner le premier niveau 
de choix du menu.

4  Appuyez sur le bouton Select du canal pour accéder aux niveaux 
inférieurs du menu et sur le bouton Mute du canal pour revenir 
aux niveaux supérieurs du menu. 

5  Effectuez l'une des opérations suivantes :

• Pour confirmer l’affectation, appuyez sur le bouton Select 
de canal clignotant. 

– ou –

• Pour annuler l'affectation, appuyez sur le bouton Esc 
clignotant.



Pour modifier un insert ou un départ déjà affecté à un encodeur en 
mode Flip :

1  Sur le canal auquel est affecté l'insert ou le départ que vous 
voulez modifier, appuyez sur le bouton Inserts ou Sends pour 
afficher les éléments correspondants sur le canal. 

2  Maintenez enfoncé le bouton Select du canal pour l’insert ou le 
départ en mode Flip que vous voulez modifier, jusqu’à ce qu’une 
flèche droite (>) apparaisse près de celui-ci sur l'afficheur alphanu-
mérique du canal, pour indiquer que le canal est en mode Assign.

3  Effectuez l'une des opérations suivantes pour sélectionner un 
nouvel insert ou un nouveau départ :

• Utilisez le fader du canal pour sélectionner le niveau actif 
de choix du menu.

– ou –

• Appuyez sur le bouton Select du canal pour accéder aux 
niveaux inférieurs du menu et sur le bouton Mute du canal 
pour revenir aux niveaux supérieurs du menu.

4  Lorsque le nouvel insert ou le nouveau départ apparaît sur 
l'afficheur alphanumérique du canal, effectuez l'une des opé-
rations suivantes :

• Pour confirmer l’affectation, appuyez sur le bouton Select 
de canal clignotant. 

– ou –

• Pour annuler l'affectation, appuyez sur le bouton Esc 
clignotant.

Pour supprimer un insert ou un départ affecté à un encodeur en 
mode Flip :

1  Sur le canal auquel est affecté l'insert ou le départ que vous 
voulez supprimer, appuyez sur le bouton Inserts ou Sends pour 
afficher les éléments correspondants sur le canal. 

2  Maintenez enfoncé le bouton Select du canal pour l’insert ou le 
départ en mode Flip que vous voulez supprimer, jusqu’à ce qu’une 
flèche droite (>) apparaisse près de celui-ci sur l'afficheur alphanu-
mérique du canal, pour indiquer que le canal est en mode Assign.

3  Appuyez plusieurs fois sur le bouton Bypass/Mute/Pre de l'en-
codeur pour accéder au premier niveau du menu d'assignation. 

4  Utilisez le fader du canal jusqu’à ce qu’aucun insert ou départ 
n’apparaisse. 

5  Effectuez l'une des opérations suivantes :

• Pour confirmer la suppression, appuyez sur le bouton 
Select de canal qui clignote. 

– ou –

• Pour annuler la suppression et restaurer l'affectation, 
appuyez sur le bouton Esc clignotant.
Mode Inline Console
En mode Inline, vous pouvez contrôler un canal d'entrée et son 
canal de monitoring correspondant à partir d'une tranche uni-
que sur D-Control.

Un signal (d'un préampli Digidesign PRE, par exemple) arrivant 
sur une piste d'entrée auxiliaire est acheminé sur une piste audio 
pour enregistrement et écoute. Le mode Inline sur D-Control 
permet alors de contrôler chacun des éléments ci-dessous sur 
une tranche unique : les encodeurs et le fader de tranche per-
mettent de contrôler respectivement les niveaux d'entrée du 
préampli et de la piste auxiliaire, et les niveaux de la piste d'en-
registrement.

Pour contrôler une piste d'entrée auxiliaire et une piste audio sur 
une seule tranche avec D-Control :

1  Affectez la sortie d'un préampli Digidesign PRE (facultatif) ou 
de toute autre source audio à une piste d'entrée auxiliaire.

2  Affectez la sortie de la piste auxiliaire à une piste audio.

3  Sur D-Control, appuyez sur le bouton Input des commandes 
Channel Strip Mode du canal audio.

4  Sur le canal audio, appuyez sur le bouton Select de l'encodeur de 
la rangée inférieure et utilisez le bouton encodeur pour sélectionner 
la piste d'entrée auxiliaire.

5  Confirmez votre choix en appuyant sur Select. 

Les commandes du préampli et de l'entrée auxiliaire s'affichent 
sur les encodeurs rotatifs du canal audio comme suit, de haut 
en bas :

• Bouton/bouton encodeur 1 : alimentation fantôme du 
préampli 

• Bouton/bouton encodeur 2 : polarité du préampli

• Bouton/bouton encodeur 3 : impédance et pad du 
préampli

• Bouton/bouton encodeur 4 : source/insert du préampli

• Bouton/bouton encodeur 5 : gain/HPF du préampli 

• Bouton/bouton encodeur 6 : gain auxiliaire/mute auxiliaire

6  (Facultatif) Masquez les canaux d'entrée auxiliaire à l'aide des 
touches programmables Show/Hide.

7  Réglez le gain du préampli avec l'encodeur 5.

8  Affinez le gain d'entrée en réglant le niveau d'entrée auxiliaire 
à l'aide de l'encodeur 6 (encodeur du bas). 

9  Appuyez sur le bouton Sends des commandes Channel Strip 
Mode pour configurer les mixages de retour ou les départs d'effets 
du canal.

10  Réglez le niveau d'écoute à l'aide du fader du canal audio.

Pour afficher un canal d'entrée auxiliaire masqué en mode Inline :

 Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur le bouton Select de l'encodeur 6.

Le canal d'entrée auxiliaire passe sur la tranche Focus.
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Utilisation du mode Automation

Définition du mode d'automation des canaux

Pour naviguer d'un canal vers l'avant dans les modes d'automation :

 Appuyez sur le bouton Automation Mode du canal.

Pour naviguer d'un canal vers l'arrière dans les modes d'automation : 

 Maintenez la touche de modification Maj (Add) enfoncée et 
appuyez sur le bouton Automation Mode du canal.

Pour activer ou désactiver le mode Trim d'un canal :

 Appuyez sur le bouton Trim du canal. 

Pour configurer le mode d'automation sur un ou plusieurs canaux :

1  Maintenez enfoncé un bouton Automation Mode (Write, 
Touch, Latch, Trim, Read ou Off). 

2  Appuyez sur les boutons Select ou Auto des canaux dont vous 
souhaitez définir le mode d'automation.

Pour configurer le mode d'automation sur tous les canaux ou tous 
les canaux sélectionnés :

1  Appuyez sur le bouton Do To All ou Do To Selected.

2  Appuyez sur un bouton Automation Mode (Write, Touch, 
Latch, Trim, Read ou Off). 

Pour changer le mode activé pour l'écriture d'un type d'automation 
sur tous les canaux :

 Appuyez sur le bouton correspondant au type d'automation 
(volume, panoramique, mute, niveau de départ, panoramique de 
départ, mute de départ ou plug-in) dans la section Automation 
Enable.

Pour interrompre l'automation sur toutes les pistes :

 Appuyez sur le bouton Auto Suspend dans les commandes 
Channel Strip Master Function. 

Affichage de la playlist d'automation d'une 
commande

Pour afficher la playlist d'automation d'un fader :

 Maintenez les touches Ctrl+Démarrer (Windows) ou 
Commande+Ctrl (Mac) enfoncées et sélectionnez le fader.

Pour afficher la playlist d'automation d'un encodeur :

 Maintenez les touches Ctrl+Démarrer (Windows) ou 
Commande+Ctrl (Mac) enfoncées et sélectionnez l'encodeur.
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Aperçu de l'automation

Pour prévisualiser une nouvelle valeur d'automation d'une 
commande :

1  Activez l'automation d'une piste en appuyant sur le bouton 
Automation Mode pour passer en mode Touch, Latch ou 
Touch/Latch.

2  Activez le type d'automation en appuyant sur le bouton dans 
la section Automation Enable.

3  Effectuez l'une des opérations suivantes :

• Appuyez sur la touche programmable Preview dans la 
page Actions. 

– ou –

• Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur le bouton Off dans les commandes 
Automation Mode. Le bouton Off clignote pour signaler le 
mode Preview.

4  Isolez une commande en la déplaçant.

5  Démarrez la lecture et réglez la commande isolée afin d'écouter 
le résultat de la nouvelle valeur d'automation.

Pour interrompre le mode Preview :

 Effectuez l'une des opérations suivantes :

• Appuyez sur la touche programmable Suspend Preview 
dans la page Actions. 

– ou –

• Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur le bouton Read dans les commandes 
Automation Mode.

Pour insérer une valeur d'aperçu dans la playlist d'automation :

 Effectuez l'une des opérations suivantes :

• Appuyez sur la touche programmable Punch Preview dans 
la page Actions. 

– ou –

• Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur le bouton Off clignotant dans les 
commandes Automation Mode.



Capture et rappel des données d'automation

Vous pouvez capturer les valeurs d'automation actuelles des com-
mandes en cours d'écriture et les stocker en tant que snapshots. 
Sur D-Control, vous pouvez stocker et rappeler jusqu'à 48 snaps-
hots. Ces snapshots stockés sont enregistrés avec la session 
Pro Tools.

Capture de valeurs d'automation

Avant de pouvoir stocker des valeurs d'automation en tant que 
preset de snapshot, vous devez les charger dans le buffer Capture.

Pour capturer des valeurs d'automation :

1  Dans les commandes Channel Strip Function, appuyez sur le 
bouton Auto de tous les canaux dont vous souhaitez capturer 
les valeurs d'automation afin qu'ils soient dans un mode activé 
pour l'écriture (Write, Touch, Latch, Touch/Latch ou Latch).

2  Dans les commandes Automation Enable, appuyez sur le bou-
ton correspondant pour activer chaque type d'automation que 
vous souhaitez capturer (volume, panoramique, mute, niveau 
de départ, panoramique de départ, mute de départ ou plug-in).

3  Dans la section Management, appuyez sur la touche Snap pour 
afficher les commandes Capture dans la section Soft Keys. 

4  Lancez la lecture, et si nécessaire, sélectionnez une commande 
activée pour l'écriture afin de lancer l'écriture des données d'auto-
mation. Le bouton Capture dans la section Soft Keys s'allume 
pour indiquer qu'une capture est possible.

5  Lorsque les commandes d'écriture en cours d'exécution attei-
gnent une valeur à capturer, appuyez sur le bouton Capture dans 
la section Soft Keys.

Le bouton Punch Capture s'allume dans la section Soft Keys 
pour indiquer que des valeurs capturées peuvent être insérées.

Stockage et rappel de valeurs d'automation capturées

Une fois les valeurs d'automation capturées, l'état capturé peut 
être stocké dans l'un des 48 presets de snapshots disponibles. Ces 
valeurs peuvent alors être rappelées vers le buffer Capture où elles 
sont prêtes à être insérées.

Pour stocker un snapshot :

1  Capturez les valeurs d'automation que vous souhaitez stocker. 
Reportez-vous à la section « Capture de valeurs d'automation » 
à la page 137.

2  Dans la section Management, appuyez sur le bouton Snap 
plusieurs fois jusqu'à ce que le numéro du preset de snapshot de 
votre choix apparaisse. Les quatre boutons programmables du bas 
indiquent quatre presets de snapshots à la fois (1 à 4, 5 à 8, etc.). 

3  Maintenez enfoncé le bouton correspondant à la présélection 
que vous souhaitez enregistrer pendant plus d'une seconde. 

Les valeurs d'automation actuellement dans le buffer Capture 
sont stockées dans le preset. Toutes les presets précédemment 
enregistrés sont écrasés. 
Pour attribuer un nom à un snapshot :

1  Dans la section Management, appuyez sur le bouton Snap 
plusieurs fois jusqu'à ce que le numéro du preset de snapshot de 
votre choix apparaisse. 

2  Appuyez deux fois sur la touche programmable correspondant 
au snapshot auquel vous souhaitez attribuer un nom. 

3  Tapez le nom du snapshot et appuyez sur la touche program-
mable correspondant à Enter. 

Pour rappeler un snapshot :

1  Dans la section Management, appuyez sur le bouton Snap 
plusieurs fois jusqu'à ce que le numéro du preset de snapshot de 
votre choix apparaisse. Les quatre boutons programmables du bas 
indiquent quatre presets de snapshots à la fois (1 à 4, 5 à 8, etc.). 

2  Appuyez sur le bouton correspondant au preset de snapshot 
que vous souhaitez rappeler. Le bouton clignote pour indiquer 
que le preset est chargé dans le buffer Capture et disponible pour 
être inséré.

Pour supprimer un snapshot stocké :

 Maintenez les touches Ctrl+Alt+Démarrer (Windows) ou 
Commande+Option +Ctrl (Mac) enfoncées et appuyez sur le 
bouton correspondant au snapshot que vous souhaitez supprimer. 

Insertion de valeurs d'automation rappelées

Pour insérer un snapshot rappelé :

1  Placez-vous à l'endroit où vous souhaitez appliquer les états 
d'automation capturés. Cette opération peut être effectuée pen-
dant la lecture ou pendant l'arrêt du transport.

2  Appuyez sur le bouton Punch Capture dans la section Soft Keys 
pour appliquer les états d'automation capturés. Les états capturés 
sont appliqués à tous les types d'automation actuellement activés 
dans la fenêtre Automation.

Association de valeurs d'automation 

Pour associer des valeurs d'automation :

1  Vérifiez que les commandes que vous souhaitez associer sont 
dans un mode activé pour l'écriture.

2  Arrêtez la lecture pendant une passe d'automation.

3  Démarrez la lecture.

4  Si vous souhaitez reprendre l'écriture des données d'automation 
aux valeurs précédentes, appuyez sur le bouton Join dans la zone 
Automation de la section Soft Keys. 
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Application de la fonction AutoMatch sur des 
valeurs d'automation

Pour appliquer la fonction AutoMatch à toutes les commandes 
d'écriture actuelles :

1  Assurez-vous que l'écriture est autorisée pour les types d'automa-
tion auxquels vous souhaitez appliquer la fonction AutoMatch.

2  Démarrez la lecture.

3  Lorsque vous atteignez un point de la session sur lequel vous 
souhaitez rétablir les valeurs d'écriture de commandes précéden-
tes, appuyez sur le bouton AutoMatch dans la zone Automation de 
la section Soft Keys.

Application de la fonction AutoMatch sur des 
commandes individuelles

Sur D-Control, vous pouvez appeler la fonction AutoMatch sur 
des commandes ou types de commandes de canaux uniques.

Pour appliquer la fonction AutoMatch à toutes les commandes 
d'un type donné sur un seul canal :

 Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée tout en appuyant sur l'une des commandes Channel 
Strip Mode suivantes de la piste dont les commandes doivent se 
voir appliquer la fonction AutoMatch :

• Inserts

• Sends

• Pan

• Dyn

• EQ
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Pour appliquer la fonction AutoMatch au fader de volume d'un 
canal :

 Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur le bouton Auto dans les commandes 
Channel Strip Function du canal.

Pour appliquer la fonction AutoMatch à une commande de 
panoramique ou aux commandes d'un insert ou d'un départ 
individuel d'un canal :

1  Dans les commandes Channel Strip Mode, appuyez sur le 
bouton permettant d'afficher les commandes de panoramique 
ou le premier niveau d'inserts ou de départs du canal. 

2  Tout en maintenant la touche Ctrl (Windows) ou Commande 
(Mac) enfoncée, appuyez sur le bouton Select de l'encodeur ro-
tatif correspondant à la commande à laquelle appliquer la fonction 
AutoMatch :

• Pour Sends, la fonction AutoMatch est appliquée aux 
paramètres niveau, panoramique et mute des départs. 

• Pour Inserts, la fonction AutoMatch est appliquée à toutes 
les commandes automatisées. 

• Pour Pan, la fonction AutoMatch est appliquée à tous les 
curseurs de panoramique du canal. 

Pour appliquer la fonction AutoMatch à toutes les commandes 
d'un plug-in affiché dans la section Dynamics ou EQ :

 Tout en maintenant la touche Ctrl (Windows) ou Commande 
(Mac) enfoncée, appuyez sur le bouton Auto de la section Dyn 
ou EQ de la console. 



Chapitre 12 : Assignation d'inserts, de départs et 
d'E/S à l'aide de la matrice d'assignation
D-Control permet d'assigner rapidement des inserts, des départs 
et des routages d'E/S aux pistes dans une session. Au lieu d'effectuer 
les assignations en explorant les différents niveaux d'un encodeur, 
la matrice d'assignation utilise provisoirement une section 6 x 8 
d'encodeurs pour afficher plusieurs couches de navigation en 
même temps.

Activation de la matrice d'assignation

La préférence de console Assign Matrix Enable (AsnMtx) détermine 
si le mode utilisé pour assigner des inserts, des départs, ou des 
routages d'entrées/sorties sur la surface de contrôle est le mode 
Assign standard (utilisant un seul encodeur pour les assignations) 
ou la matrice d'assignation.

 Lorsque cette préférence est activée, la matrice d'assignation 
est utilisée pour effectuer les assignations.

 Lorsqu'elle est désactivée, les assignations sont réalisées à l'aide 
des modes Global standard et Assign local. 

Pour activer ou désactiver la matrice d'assignation :

1  Dans la section Soft Keys, appuyez sur le bouton Operation 
plusieurs fois afin d'afficher la page contenant la préférence 
Assign Matrix (AsnMtx). 

2  Appuyez sur la Soft Key correspondant à AsnMtx pour activer 
ou désactiver le paramètre.

3  Tout en maintenant la touche Ctrl (Windows) ou Commande 
(Mac) enfoncée, appuyez sur le bouton Operation pour quitter.
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Préférences Assign Matrix

Les préférences et paramètres suivants affectent l'aspect et le 
fonctionnement de la matrice d'assignation de D-Control.

Assign Matrix Select Area Justification

La préférence Assign Matrix Select Area Justification (justification 
de la zone de sélection dans la matrice d'assignation) détermine 
si les éléments dans la zone de sélection de la matrice d'assigna-
tion doivent être affichés dans l'ordre de haut en bas ou de bas 
en haut sur les encodeurs rotatifs de D-Control. 

Cette préférence n'affecte pas l'ordre d'affichage des éléments 
dans la zone de menu. (L'affichage des inserts et des départs dans 
la zone de menu respecte la préférence Encoder Order.)

Pour définir la justification de la zone de sélection dans la matrice 
d'assignation :

1  Dans la section Soft Keys, appuyez sur le bouton Operations 
plusieurs fois afin d'afficher la page contenant la préférence 
Matrix Select Area Justification (MtxJst).

2  Appuyez sur la Soft Key correspondant à MtxJst pour sélectionner 
le paramètre Bot-Tp (de bas en haut) ou Tp-Bot (de haut en bas). 

3  Tout en maintenant la touche Ctrl (Windows) ou Commande 
(Mac) enfoncée, appuyez sur le bouton Operations pour quitter.
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Assign Matrix Column Width

La préférence Assign Matrix Column Width (largeur des colonnes 
de la matrice d'assignation) permet de définir le nombre d'élé-
ments apparaissant dans chaque ligne de la zone de sélection de 
la matrice d'assignation. 

La largeur des colonnes est définie de manière distincte pour les 
assignations d'entrées/sorties (chemins d'E/S et départs) et de 
plug-ins. 

Les options incluses sont les suivantes : 6 éléments (un affichage 
Encoder pour chaque élément), 3 éléments (deux affichages par 
éléments), 2 éléments (trois affichages par élément), ou 1 élément 
(six affichages par élément) par ligne. Plus le nombre d'éléments 
sélectionnés est grand, plus les abréviations affichées sont courtes, 
et inversement. 

Pour définir les préférences Assign Matrix Column Width :

1  Dans la section Soft Keys, appuyez plusieurs fois sur le bouton 
Operations pour afficher la page contenant la largeur de la colonne 
E/S (IOClms) et la largeur de la colonne Plug-In (PIClms).

2  Effectuez l'une des opérations suivantes :

• Appuyez sur la Soft Key correspondant à IOClms pour bais-
ser le nombre d'assignations E/S ou de points de départ à 
afficher par ligne. Maintenez la touche Maj enfoncée pour 
augmenter le nombre.

– ou –

• Appuyez sur la Soft Key correspondant à PIClms pour baisser 
le nombre de points d'insertion à afficher par ligne. Main-
tenez la touche Maj enfoncée pour augmenter le nombre.

3  Tout en maintenant la touche Ctrl (Windows) ou Commande 
(Mac) enfoncée, appuyez sur le bouton Operations pour quitter.
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Assign Matrix Rows

La préférence Assign Matrix Rows (lignes de la matrice d'assigna-
tion) vous permet de définir le nombre de lignes d'encodeurs 
utilisées dans la zone de sélection de la matrice d'assignation. 

Pour définir la préférence Assign Matrix Rows :

1  Dans la section Soft Keys, appuyez sur le bouton Operations 
plusieurs fois afin d'afficher la page contenant la préférence 
Matrix Rows (MtxRws).

2  Appuyez sur la Soft Key correspondant à MtxRws pour baisser 
le nombre de lignes à afficher. Maintenez la touche Maj enfoncée 
pour augmenter le nombre.

3  Tout en maintenant la touche Ctrl (Windows) ou Commande 
(Mac) enfoncée, appuyez sur le bouton Operations pour quitter.

Verrouillage de la matrice d'assignation

La préférence Assign Matrix Lock Enable (verrouillage activé de 
la matrice d'assignation) vous permet d'activer automatiquement 
le mode Lock (Verrouillage) lorsque la matrice est ouverte. 

 Lorsque cette préférence est définie sur On, la matrice d'assigna-
tion s'ouvre toujours en mode de verrouillage et reste ouverte 
une fois les assignations effectuées. La matrice reste en mode de 
verrouillage jusqu'à ce que vous désactiviez ce mode.

 Lorsque cette préférence est définie sur Off, la matrice doit 
être mise en mode de verrouillage manuellement. 

Pour définir la préférence Assign Matrix Lock Enable :

1  Dans la section Soft Keys, appuyez sur le bouton Operations 
plusieurs fois afin d'afficher la page contenant Matrix Lock 
Enable (MtxLck).

2  Appuyez sur le bouton correspond à MtxLck pour activer ou 
désactiver le paramètre. 

3  Tout en maintenant la touche Ctrl (Windows) ou Commande 
(Mac) enfoncée, appuyez sur le bouton Operations pour quitter.



Aperçu de la matrice d'assignation
La matrice d'assignation est divisée en trois zones : la zone de menu, la zone de sélection et la zone de navigation. 
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Organisation des commandes dans la matrice d'assignation

Zone de 
navigation

Verrouillage/
déverrouillage

Défilement 
vers la 
gauche/
droite

Retour/
Quitter

Zone de sélection

Zone de menu

Nom de 
piste

Assignations 
d'inserts, de 
départs ou 
d'E/S
Zone de menu

La zone de menu se compose d'une colonne d'encodeurs indi-
quant les assignations d'inserts, de départs et d'E/S sur la piste 
lorsque vous effectuez l'assignation. Ces encodeurs vous permet-
tent de sélectionner le point d'insertion, le point de départ et le 
chemin d'E/S que vous souhaitez assigner, ainsi que les différentes 
pistes pour l'assignation. 

Zone de sélection

La zone de sélection est constituée de six colonnes d'encodeurs 
indiquant les noms des inserts, des départs et des chemins d'E/S 
disponibles. Ces encodeurs vous permettent de naviguer rapi-
dement entre les sous-menus et les différents inserts, départs et 
chemins d'E/S. 

Zone de navigation

La zone de navigation se compose d'une colonne d'encodeurs 
indiquant l'emplacement de menu actuel dans la matrice d'as-
signation et fournit des commandes pour naviguer dans la zone 
de sélection. Ces encodeurs vous permettent de parcourir les 
pages d'éléments disponibles, de revenir aux niveaux de menu 
précédents, de verrouiller l'affichage de la zone de sélection et 
quitter le mode Assign (Assignation). 
Mode de verrouillage de la matrice d'assignation

En mode de fonctionnement normal, la matrice d'assignation 
se ferme après que vous avez effectué ou supprimé une assigna-
tion. Vous pouvez régler la matrice pour qu'elle reste ouverte 
après l'ajout ou la suppression d'une assignation de sorte à pou-
voir en effectuer d'autres.

Pour que la matrice reste ouverte après une assignation (mode 
Lock), procédez comme suit :

1  Affichez une assignation d'insert, de départ ou d'E/S dans la 
matrice.

2  Dans la zone de navigation, appuyez sur le bouton Select de 
l'encodeur intitulé Lock.

Le bouton Lock s'allume et l'affichage de cet encodeur devient 
rouge, indiquant le statut verrouillé.

Pour désactiver le verrouillage de la matrice :

 Dans la zone de navigation, appuyez sur le bouton Lock. 
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Mode Multi-Assign de la matrice d'assignation

(départs et sorties uniquement)

En mode de fonctionnement normal, la matrice d'assignation 
vous permet d'effectuer une assignation à la fois, ce qui a pour 
effet de désactiver l'assignation précédente. Vous avez également 
la possibilité de régler la matrice pour effectuer plusieurs assigna-
tions de sortie. 

Pour ce faire, procédez comme suit :

1  Affichez une assignation d'insert, de départ ou d'E/S dans la 
matrice.

2  Dans la zone de navigation, appuyez sur le bouton B/M/P + 
(au-dessous de l'encodeur Lock) pour bloquer des assignations 
de sortie.

Matrice d'assignation d'insertions

La matrice d'assignation d'insertions permet d'afficher, d'assigner, 
de modifier, et de supprimer des insertions dans une session. Elle 
affiche les points d'insertion (A-J), le type d'insertion (TDM, RTAS, 
ou HW), les catégories de plug-in (EQ ou DYN), le fabricant de 
plug-in, et les noms d'insertion et de plug-in dans la zone de sé-
lection.

Affichage des inserts

Pour afficher un insert dans la matrice d'assignation :

1  Appuyez sur le bouton Inserts correspondant au canal portant 
l'insert à afficher. Les points d'insertion sont affichés sur les 
encodeurs de canal. 

2  Effectuez l'une des opérations suivantes au point d'insertion 
que vous souhaitez afficher : 

• Si le point d'insertion ne comporte pas d'insert, appuyez sur 
le bouton Select de l'encodeur.

– ou –

• Si un insert existe déjà au point d'insertion, maintenez 
enfoncé le bouton Select de l'encodeur. 

La matrice d'assignation s'ouvre, affichant les points d'insertion 
dans les 5 encodeurs supérieurs (en jaune) et le nom de piste 
dans l'encodeur inférieur (en vert) dans la zone de menu. Le bouton 
Select de l'encodeur s'allume au point d'insertion actuellement 
affiché dans la zone de sélection. 

 Si le point d'insertion ne comporte pas d'insertion, la zone de 
sélection indique les éléments du menu d'insertion de niveau 
supérieur (insertions de types TDM, RTAS, et HW) ainsi que les 
plug-ins par défaut ou favoris au niveau supérieur.

 Si un insert existe déjà au point d'insertion, la zone de sélection 
affiche les éléments du menu d'insertion de niveau inférieur. 
L'insert actuel est indiqué par un texte en jaune et un bouton 
Select allumé.
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Pour parcourir les pages d'options dans la zone de sélection de la 
matrice d'assignation : 

 Appuyez sur le bouton Select (<) ou le bouton BMP (>) sur 
l'encodeur intitulé PG dans la zone de navigation. Pour parcourir 
les pages en continu, maintenez les boutons enfoncés. 

Pour faire défiler les options dans la zone de sélection : 

 Tournez le bouton encodeur PG dans la zone de navigation.

Pour descendre dans les niveaux du menu Insert :

 Appuyez sur le bouton Select de l'encodeur correspondant à 
un élément de menu dans la zone de sélection. 

Pour monter dans les niveaux du menu d'insertion, effectuez l'une 
des opérations suivantes :

 Dans la zone de navigation, appuyez sur le bouton Select de 
l'encodeur inférieur (intitulé Back). 

– ou –

 Dans la zone de navigation, appuyez sur le bouton Select de 
l'encodeur correspondant à un niveau de menu (inserts TDM, 
RTAS, ou HW) sur les encodeurs supérieurs pour revenir au niveau 
en question.

Pour afficher provisoirement le nom complet d'un élément de 
menu ou d'un insert dans les affichages d'encodeur :

 Touchez le bouton encodeur de l'élément.

Pour ouvrir ou fermer la fenêtre d'un insert :

 Maintenez la touche Démarrer (Windows) ou Ctrl (Mac) enfon-
cée et appuyez sur le bouton Select de l'encodeur correspondant 
au point d'insertion dans la zone de menu. 

Modification de l'affichage des inserts pour une 
piste dans la matrice d'assignation

Pour afficher un autre insert dans la matrice en parcourant les 
inserts :

1  Dans la zone de menu, effectuez l'une des opérations suivantes 
pour basculer entre les affichages Inserts A-E et Inserts F-J :

• Appuyez sur le bouton allumé Page Up ou Page Down dans 
la zone de menu. 

– ou –

• Tournez un encodeur dans la zone de menu. 

2  Appuyez sur le bouton Select de l'encodeur correspondant au 
point d'insertion que vous voulez afficher. 



Pour afficher une autre insertion dans la matrice d'assignation à 
l'aide des noms d'insertions :

1  Dans la zone de menu, appuyez sur le bouton B/M/P correspon-
dant à un insert. Les points d'insertion s'affichent dans la zone 
de sélection.

2  Appuyez sur le bouton Select de l'encodeur correspondant au 
point d'insertion à afficher. 

Modification de l'affichage des pistes dans la 
matrice d'assignation

Pour afficher les inserts d'une autre piste dans la matrice 
d'assignation en faisant défiler les noms de piste :

1  Dans la zone de menu, appuyez sur le bouton Select (nom de 
piste) de l'encodeur inférieur. 

2  Tournez l'encodeur inférieur pour faire défiler les pistes dans 
la session. 

3  Appuyez sur le bouton Select clignotant afin d'afficher les in-
serts pour cette piste dans la matrice d'assignation. 

Pour afficher les inserts d'une autre piste en affichant les noms de 
piste :

1  Dans la zone de menu, appuyez sur le bouton B/M/P (nom de 
piste) de l'encodeur inférieur. Les noms de piste s'affichent dans la 
zone de sélection. 

2  Si nécessaire, utilisez l'encodeur PG ou les boutons dans la zone 
de navigation pour repérer la piste à afficher.

3  Appuyez sur le bouton Select de l'encodeur correspondant à 
la piste à afficher. 

Fermeture de la matrice d'assignation

Pour fermer la matrice, effectuez l'une des actions suivantes :

 Appuyez sur le bouton Select de l'encodeur inférieur (intitulé 
Exit) dans la zone de sélection. Ceci permet de quitter la matrice 
lorsque celle-ci est verrouillée.

 Tout en maintenant la touche Ctrl (Windows) ou la touche 
Commande (Mac) enfoncée, appuyez sur le bouton Select de 
l'encodeur inférieur (appelé Back) dans la zone de navigation. 
Ceci permet de quitter la matrice lorsque celle-ci est verrouillée.

 Appuyez sur le bouton Escape qui clignote. Ceci fonctionne 
uniquement lorsque la matrice n'est pas verrouillée.
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Assignation d'inserts

Pour assigner un insert (lorsque aucune insertion n'est présente) :

1  Appuyez sur le bouton Inserts sur le canal auquel vous voulez 
assigner l'insert. Les points d'insertion sont affichés sur les en-
codeurs de canal.

2  Appuyez sur le bouton Select de l'encodeur au point d'insertion 
où vous voulez effectuer une assignation. La matrice d'assignation 
s'ouvre et les éléments du menu d'insertion de niveau supérieur 
(types d'insertion tels que TDM, RTAS et HW) s'affichent dans 
la zone de sélection.

3  Appuyez sur le bouton Select de l'encodeur correspondant au 
type d'insert que vous voulez assigner. 

4  Appuyez sur le bouton Select de l'encodeur correspondant au 
choix du menu de niveau supérieur (par exemple, la catégorie 
ou le fabricant de plug-in). 

5  Appuyez sur le bouton Select de l'encodeur correspondant à 
l'insert que vous voulez assigner.

Pour assigner un autre insert (lorsqu'un insert est déjà présent) :

1  Appuyez sur le bouton Inserts sur le canal auquel vous voulez 
assigner l'insertion. Les points d'insertion sont affichés sur les 
encodeurs de canal.

2  Maintenez enfoncé le bouton Select de l'encodeur au point 
d'insertion dont vous voulez modifier l'assignation. La matrice 
d'assignation s'ouvre et l'insertion actuelle s'affiche dans la zone 
de sélection. Elle est indiquée par un texte en jaune et un bouton 
Select allumé. 

3  Si nécessaire, utilisez les boutons dans la zone de navigation 
pour repérer l'insert à assigner.

4  Appuyez sur le bouton Select de l'encodeur correspondant à 
l'insert que vous voulez assigner.

Pour supprimer un insert :

1  Appuyez sur le bouton Inserts sur le canal dont vous voulez 
supprimer l'insert. Les points d'insertion sont affichés sur les 
encodeurs de canal.

2  Maintenez enfoncé le bouton Select de l'encodeur au point 
d'insertion dont vous voulez supprimer l'assignation. La matrice 
d'assignation s'ouvre et l'insert s'affiche dans la zone de sélection. 
Elle est indiquée par un texte en jaune et un bouton Select allumé. 

3  Effectuez l'une des opérations suivantes :

• Maintenez le bouton Set to Default enfoncé et appuyez sur 
le bouton Select de l'encodeur correspondant à un insert 
dans la zone de sélection. 

– ou –

• Dans la zone de navigation, appuyez sur le bouton Select 
de l'encodeur inférieur appelé Back jusqu'à atteindre le 
niveau supérieur des éléments du menu, puis appuyez sur 
le bouton Select de l'encodeur correspondant à -- (Pas 
d'insert) dans la zone de sélection.
tion d'inserts, de départs et d'E/S à l'aide de la matrice d'assignation 143



1

Matrice d'assignation de départs

La matrice d'assignation de départs permet d'afficher, d'assigner, 
de modifier, et de supprimer des départs dans une session. Elle 
affiche les points de départ (A-J), les types de départ (Interface 
ou Bus), et les noms de départ dans la zone de sélection.

Affichage des départs

Pour afficher un départ dans la matrice d'assignation :

1  Appuyez sur le bouton Sends correspondant au canal portant 
le départ à afficher. Les points de départ sont affichés sur les en-
codeurs de canal.

2  Effectuez l'une des opérations suivantes au point de départ que 
vous souhaitez afficher : 

• Si le point de départ ne comporte pas de départ, appuyez sur 
le bouton Select de l'encodeur.

– ou –

• Si un départ existe déjà au point de départ, maintenez en-
foncé le bouton Select de l'encodeur. 

La matrice d'assignation s'ouvre, affichant les points de départ 
sur les 5 encodeurs supérieurs (en jaune) et le nom de la piste sur 
l'encodeur inférieur (en vert) dans la zone de menu. Le bouton 
Select de l'encodeur s'allume au point de départ actuellement 
affiché dans la zone de sélection. 

 Si aucun départ n'est présent au point de départ, la zone 
de sélection affiche les types de départ de niveau supérieur 
(Interface et Bus).

 Si un départ existe déjà au point de départ, la zone de sélec-
tion affiche les chemins de départ. Le chemin de départ actuel 
est indiqué par un texte en jaune et un bouton Select allumé.

Pour parcourir les pages d'options dans la zone de sélection de la 
matrice d'assignation : 

 Appuyez sur le bouton Select (<) ou le bouton BMP (>) sur 
l'encodeur intitulé PG dans la zone de navigation. Pour parcourir 
les pages en continu, maintenez les boutons enfoncés. 

Pour faire défiler les options dans la zone de sélection : 

 Tournez le bouton encodeur PG dans la zone de navigation.

Pour descendre dans les niveaux du menu de départs :

 Appuyez sur le bouton Select de l'encodeur correspondant à 
Interface (intrfc) ou Bus (bus) dans la zone de sélection. 
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Pour monter jusqu'au niveau supérieur du menu de départ, effectuez 
l'une des opérations suivantes :

 Dans la zone de navigation, appuyez sur le bouton Select de 
l'encodeur inférieur (appelé Back). 

– ou –

 Dans la zone de navigation, appuyez sur le bouton Select de 
l'encodeur correspondant au type Interface (intrfc) ou Bus (bus) 
sur l'encodeur supérieur.

Pour afficher provisoirement le nom complet d'un élément de menu 
ou d'un départ dans les affichages d'encodeur :

 Touchez le bouton encodeur de l'élément.

Pour ouvrir ou fermer la fenêtre d'un départ :

 Maintenez la touche Démarrer (Windows) ou Ctrl (Mac) en-
foncée et appuyez sur le bouton Select de l'encodeur correspon-
dant au point de départ dans la zone de menu. 

Modification de l'affichage des départs pour une 
piste dans la matrice d'assignation

Pour afficher un autre départ dans la matrice en parcourant les 
départs :

1  Dans la zone de menu, effectuez l'une des opérations suivantes 
pour basculer entre les affichages Sends A-E et Sends F-J :

• Appuyez sur le bouton allumé Page Up ou Page Down dans 
la zone de menu. 

– ou –

• Tournez un encodeur dans la zone de menu. 

2  Appuyez sur le bouton Select de l'encodeur correspondant au 
point de départ à afficher. 

Pour afficher un autre départ dans la matrice d'assignation à l'aide 
des noms de départs :

1  Dans la zone de menu, appuyez sur le bouton B/M/P corres-
pondant à un départ. Les points de départ s'affichent dans la zone 
de sélection.

2  Appuyez sur le bouton Select de l'encodeur correspondant au 
point de départ à afficher. 

Modification de l'affichage des pistes dans la 
matrice d'assignation

Pour afficher les départs d'une autre piste dans la matrice 
d'assignation en faisant défiler les noms de piste :

1  Dans la zone de menu, appuyez sur le bouton Select (nom de 
piste) de l'encodeur inférieur. 

2  Tournez l'encodeur inférieur pour faire défiler les pistes dans 
la session. 

3  Appuyez sur le bouton Select clignotant afin d'afficher les 
départs pour cette piste dans la matrice d'assignation. 



Pour afficher les départs d'une autre piste en affichant les noms 
de piste :

1  Dans la zone de menu, appuyez sur le bouton B/M/P (nom de 
piste) de l'encodeur inférieur. Les noms de piste s'affichent dans 
la zone de sélection. 

2  Si nécessaire, utilisez l'encodeur PG ou les boutons dans la zone 
de navigation pour repérer la piste à afficher.

3  Appuyez sur le bouton Select de l'encodeur correspondant à 
la piste à afficher. 

Fermeture de la matrice d'assignation

Pour fermer la matrice, effectuez l'une des actions suivantes :

 Appuyez sur le bouton Select de l'encodeur inférieur (intitulé 
Exit) dans la zone de sélection. Ceci permet de quitter la matrice 
lorsque celle-ci est verrouillée.

 Tout en maintenant la touche Ctrl (Windows) ou la touche 
Commande (Mac) enfoncée, appuyez sur le bouton Select de 
l'encodeur inférieur (appelé Back) dans la zone de navigation. 
Ceci permet de quitter la matrice lorsque celle-ci est verrouillée.

 Appuyez sur le bouton Escape qui clignote. Ceci fonctionne 
uniquement lorsque la matrice n'est pas verrouillée.

Assignations de départs

Pour assigner un départ (lorsqu'aucune assignation de chemin de 
départ n'existe) :

1  Appuyez sur le bouton Sends sur le canal auquel vous voulez 
assigner le départ. Les points de départ sont affichés sur les en-
codeurs de canal.

2  Appuyez sur le bouton Select de l'encodeur au point de départ 
où vous voulez effectuer une assignation. La matrice d'assigna-
tion s'ouvre et les types de départ de niveau supérieur (Interface 
et Bus) s'affichent dans la zone de sélection.

3  Appuyez sur le bouton Select de l'encodeur correspondant au 
type de départ que vous voulez assigner. 

4  Appuyez sur le bouton Select de l'encodeur correspondant au 
chemin de départ que vous voulez assigner.

Pour assigner un autre départ (lorsqu'une assignation de chemin 
de départ existe déjà) :

1  Appuyez sur le bouton Sends sur le canal auquel vous voulez 
assigner le départ. Les points de départ sont affichés sur les en-
codeurs de canal.

2  Maintenez enfoncé le bouton Select de l'encodeur au point de 
départ dont vous voulez modifier l'assignation. La matrice d'as-
signation s'ouvre et le chemin de départ actuel s'affiche dans la 
zone de sélection. Il est indiqué par un texte en jaune et un bouton 
Select allumé. 

3  Si nécessaire, utilisez les boutons dans la zone de navigation 
pour repérer le départ à assigner.
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4  Appuyez sur le bouton Select de l'encodeur correspondant au 
chemin de départ que vous voulez assigner.

Pour assigner un départ à plusieurs chemins de sortie :

1  Suivez les procédures ci-dessus afin d'utiliser la matrice d'as-
signation pour assigner ou modifier une assignation de chemin 
de départ.

2  Si vous voulez effectuer plusieurs assignations, activez le mode 
Assign Lock en appuyant sur le bouton Select de l'encodeur appelé 
Lock dans la zone de navigation. 

3  Dans la zone de navigation, appuyez sur le bouton B/M/P + 
(au-dessous de l'encodeur Lock) pour bloquer des assignations 
de sortie.

4  Si nécessaire, utilisez les boutons dans la zone de navigation 
pour repérer le départ à assigner.

5  Appuyez sur le bouton Select de l'encodeur correspondant aux 
chemins de sortie supplémentaires que vous voulez assigner.

Pour supprimer un départ :

1  Appuyez sur le bouton Sends sur le canal dont vous voulez 
supprimer le départ. Les points de départ sont affichés sur les 
encodeurs de canal.

2  Maintenez enfoncé le bouton Select de l'encodeur au point de 
départ dont vous voulez supprimer l'assignation. La matrice 
d'assignation s'ouvre et le départ s'affiche dans la zone de sé-
lection. Il est indiqué par un texte en jaune et un bouton Select 
allumé. 

3  Dans la zone de navigation, appuyez sur le bouton Select de 
l'encodeur inférieur appelé Back jusqu'à atteindre le niveau su-
périeur des départs, puis appuyez sur le bouton Select de l'encodeur 
correspondant à -- (Pas de départ) dans la zone de sélection.
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Matrice d'assignation d'E/S

La matrice d'assignation d'E/S permet d'afficher, d'assigner, de 
modifier, et de supprimer des assignations d'E/S sur différentes 
pistes de la manière suivante :

• Pistes audio et pistes d'entrée auxiliaire : chemins d'entrées et 
de sorties audio

• Pistes MIDI : canaux d'entrées et de sorties MIDI

• Pistes Instrument : canaux d'entrées et de sorties MIDI, 
chemin d'entrées et de sorties audio

• Pistes Master VCA : assignations de groupe

• Master Faders et chemins de sortie

Affichage des chemins d'E/S

Pour afficher un chemin d'E/S dans la matrice d'assignation :

1  Appuyez sur le bouton Sends correspondant au canal dont vous 
souhaitez supprimer le routage d'E/S.

2  Appuyez sur le bouton Select de l'encodeur correspondant à 
l'entrée ou la sortie à afficher.

La matrice d'assignation s'ouvre, affichant les noms des chemins 
d'entrées et de sorties dans les encodeurs supérieurs (en jaune) 
et le nom de la piste dans les encodeurs inférieurs (en vert) dans 
la zone de menu. Le bouton Select de l'encodeur s'allume pour 
le chemin actuellement affiché dans la zone de sélection. 

Pour parcourir les pages d'options dans la zone de sélection de la 
matrice d'assignation : 

 Appuyez sur le bouton Select (<) ou le bouton BMP (>) sur l'en-
codeur intitulé PG dans la zone de navigation. Pour parcourir les 
pages en continu, maintenez les boutons enfoncés. 

Pour faire défiler les options dans la zone de sélection : 

 Tournez le bouton encodeur PG dans la zone de navigation.

Pour descendre dans les niveaux du menu d'E/S (pour les chemins 
audio) :

 Appuyez sur le bouton Select de l'encodeur correspondant à 
Interface (intrfc) ou Bus (bus) dans la zone de sélection. 

Pour monter jusqu'au niveau supérieur du menu d'E/S, effectuez 
l'une des opérations suivantes :

 Dans la zone de navigation, appuyez sur le bouton Select de 
l'encodeur inférieur (appelé Back). 

– ou –

 Dans la zone de navigation, appuyez sur le bouton Select de 
l'encodeur correspondant au type Interface (intrfc) ou Bus (bus) 
sur l'encodeur supérieur.
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Pour afficher provisoirement le nom complet d'un élément de menu 
ou d'un chemin d'E/S dans les affichages d'encodeur :

 Touchez le bouton encodeur de l'élément.

Pour ouvrir ou fermer la fenêtre Output d'une piste (pour les chemins 
audio) :

 Maintenez la touche Démarrer (Windows) ou Ctrl (Mac) en-
foncée et appuyez sur le bouton Select de l'encodeur correspondant 
à Output dans la zone de menu. 

Modification de l'affichage des E/S pour une piste 
dans la matrice d'assignation

Pour afficher un autre chemin d'E/S dans la matrice 
d'assignation :

1  Dans la zone de menu, appuyez sur le bouton B/M/P correspon-
dant à un chemin. Les chemins d'E/S s'affichent dans la zone de 
sélection.

2  Appuyez sur le bouton Select de l'encodeur correspondant au 
chemin d'E/S à afficher. 

Modification de l'affichage des pistes dans la matrice 
d'assignation

Pour afficher les chemins d'E/S d'une autre piste dans la matrice 
d'assignation en faisant défiler les noms de piste :

1  Dans la zone de menu, appuyez sur le bouton Select (nom de 
piste) de l'encodeur inférieur. 

2  Tournez l'encodeur inférieur pour faire défiler les pistes dans 
la session. 

3  Appuyez sur le bouton Select clignotant afin d'afficher les 
chemins d'E/S pour cette piste dans la matrice d'assignation. 

Pour afficher les chemins d'E/S d'une autre piste en affichant les 
noms de piste :

1  Dans la zone de menu, appuyez sur le bouton B/M/P (nom de 
piste) de l'encodeur inférieur. Les noms de piste s'affichent 
dans la zone de sélection. 

2  Si nécessaire, utilisez l'encodeur PG ou les boutons dans la zone 
de navigation pour repérer la piste à afficher.

3  Appuyez sur le bouton Select de l'encodeur correspondant à 
la piste à afficher. 



Fermeture de la matrice d'assignation

Pour fermer la matrice, effectuez l'une des actions suivantes :

 Appuyez sur le bouton Select de l'encodeur inférieur (intitulé 
Exit) dans la zone de sélection. Ceci permet de quitter la matrice 
lorsque celle-ci est verrouillée.

 Tout en maintenant la touche Ctrl (Windows) ou la touche 
Commande (Mac) enfoncée, appuyez sur le bouton Select de 
l'encodeur inférieur (appelé Back) dans la zone de navigation. 
Ceci permet de quitter la matrice lorsque celle-ci est verrouillée.

 Appuyez sur le bouton Escape qui clignote. Ceci fonctionne 
uniquement lorsque la matrice n'est pas verrouillée.

Assignation des chemins d'E/S

Pour assigner un chemin d'E/S :

1  Maintenez enfoncé le bouton Sends sur le canal auquel vous 
voulez assigner le chemin. Les chemins d'E/S sont affichés sur 
les encodeurs de canal.

2  Appuyez sur le bouton Select de l'encodeur correspondant au 
chemin d'E/S que vous voulez assigner. La matrice 
d'assignation s'ouvre, le chemin actuel est indiqué par un texte 
en jaune et un bouton Select allumé. 

3  Si nécessaire, utilisez les boutons dans la zone de navigation 
pour repérer le chemin d'E/S à assigner.

4  Appuyez sur le bouton Select de l'encodeur correspondant au 
chemin d'E/S que vous voulez assigner.
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Pour assigner plusieurs chemins de sortie (audio or MIDI) :

1  Suivez les procédures ci-dessus afin d'utiliser la matrice d'as-
signation pour assigner ou modifier une assignation de chemin 
de sortie.

2  Si vous voulez effectuer plusieurs assignations, activez le mode 
Assign Lock en appuyant sur le bouton Select de l'encodeur appelé 
Lock dans la zone de navigation. 

3  Dans la zone de navigation, appuyez sur le bouton B/M/P + 
(au-dessous de l'encodeur Lock) pour verrouiller des assignations 
de sortie.

4  Si nécessaire, utilisez les boutons dans la zone de navigation 
pour repérer le chemin de sortie à assigner.

5  Appuyez sur le bouton Select de l'encodeur correspondant aux 
chemins de sortie supplémentaires que vous voulez assigner.

Pour supprimer un chemin d'E/S :

1  Maintenez enfoncé le bouton Sends sur le canal dont vous vou-
lez supprimer le chemin. Les chemins d'E/S sont affichés sur les 
encodeurs de canal.

2  Appuyez sur le bouton Select de l'encodeur correspondant au 
chemin d'E/S à supprimer. La matrice d'assignation s'ouvre, le 
chemin actuel est indiqué par un texte en jaune et un bouton 
Select allumé. 

3  Dans la zone de navigation, appuyez sur le bouton Select de 
l'encodeur inférieur appelé Back jusqu'à atteindre le niveau su-
périeur des chemins d'E/S, puis appuyez sur le bouton Select de 
l'encodeur correspondant à -- (Pas d'E/S) dans la zone de sélection.
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Chapitre 13 : Modes Custom Fader
Grâce à la fonction Custom Faders, vous pouvez temporairement 
mettre les tranches de côté sur D-Control et les transférer sur vos 
propres groupes personnalisés de pistes, sur les groupes de mixage 
et d'édition de Pro Tools, sur des types de pistes particuliers ou 
sur les commandes de plug-ins. Les modes Custom Fader sont 
accessibles uniquement sur D-Control et ne s'affichent pas dans 
Pro Tools.

Dans D-Control, les canaux Custom Faders sont distincts des autres 
canaux de la surface de contrôle. Toutes les pistes sont regroupées 
autour des canaux Custom Faders et ont un comportent classique 
dans Pro Tools et sur D-Control.

Tous les modes Custom Fader permettent principalement de 
dupliquer les commandes de pistes en mode Normal, et permettent 
de les réorganiser pour les adapter à votre workflow. Tous les 
mouvements de commandes réalisés sur un canal Custom Fader 
sont reflétés dans le canal en mode Normal s'il est présent sur 
D-Control.

Lorsque les canaux sont utilisés dans l'un des modes Custom 
Fader, le témoin bleu CF situé à gauche du fader de canal s'allume.

Le statut des modes Custom Fader est enregistré avec la session 
Pro Tools. Si un mode Custom Fader est actif dans la session que 
vous enregistrez et fermez, il est activé à la réouverture de cette 
session.

Disposition des banques Custom Faders sur 
D-Control

D-Control dispose de deux banques Custom Faders indépendantes 
(Custom Faders de gauche et Custom Faders de droite) contrôlées 
par les sections Custom Fader Control situées à gauche et à droite 
de l'unité principale.

Les deux banques peuvent être contrôlées à partir de la matrice 
Bank Select, avec les informations de groupe, de piste ou de 
plug-in correspondantes qui s'affichent dans la section Soft Keys. 
La banque cible active dans la matrice Bank Select apparaît en 
texte jaune dans l'affichage Custom Faders.
Présentation des modes Custom Fader

Les quatre modes Custom Fader font l'objet d'une description 
détaillée plus loin dans cette section : 

Mode Custom Groups : permet de créer et de rappeler 48 disposi-
tions de pistes sur D-Control, qui sont indépendantes des groupes 
de mixage/édition Pro Tools.

Mode Mix/Edit Groups : permet de rappeler des groupes de mixage 
ou des groupes de mixage/édition Pro Tools et de les afficher sur 
les tranches Custom Faders. Vous pouvez également activer et 
supprimer des groupes de mixage ou de mixage/édition depuis 
ce mode.

Mode Tracks : permet de placer toutes les pistes d'un type parti-
culier sur les tranches Custom Faders. Les types de pistes incluent 
les pistes audio, les pistes d'entrée auxiliaire, les pistes MIDI, les 
pistes d'instrument, les pistes Master Fader, les pistes Master VCA 
et les pistes masquées.

Mode Plug-in : permet de transférer les commandes de deux 
plug-ins distincts sur les deux banques de canaux disponibles 
Custom Faders. Un mode Plug-In étendu spécial permet trans-
férer les commandes d'en-tête de plug-in (Bypass, Compare et 
Safe par exemple) sur les boutons Mute de la tranche. 

Deux modes supplémentaires fonctionnent de pair avec ces modes 
Custom Fader :

Mode Custom Fader Flip : permet de permuter les rangées de 
commandes des encodeurs avec les faders des tranches Custom 
Faders.

Mode Custom Fader Map : permet de mapper des commandes 
d'encodeur individuel sur les tranches Custom Faders (piste par 
piste).
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Options des Custom Faders

Paramétrage de la taille maximale de banque 
Custom Faders :

Vous pouvez définir indépendamment la taille de chacune des 
deux banques Custom Faders disponibles pour chaque mode 
Custom Fader. Voir « Maximum Custom Fader Bank Size » à la 
page 42.

Positionnement des Custom Faders

Vous pouvez définir l'emplacement des deux banques Custom 
Faders disponibles sur la surface de contrôle. Voir « Alignement 
des banques Custom Faders » à la page 42.

Affichage des pistes masquées sur les Custom 
Faders

Vous pouvez configurer D-Control de sorte à afficher les pistes 
masquées sur les affichages Custom Faders. Voir « Affichage de 
pistes masquées sur les Custom Faders » à la page 43. 

Commandes Custom Faders

Les boutons Custom, Groups, Master et Plug-In de la section 
Custom Faders s'allument lorsque le mode Custom Faders cor-
respondant est activé. 

Les boutons Map et Flip fonctionnent de pair avec les modes 
Custom Fader (sauf le mode Master Faders) et n'ont aucun effet 
lorsqu'ils sont utilisés seuls.

Les boutons Lock et Window peuvent fonctionner conjointement 
avec les modes Custom Fader ou de façon indépendante. 
Reportez-vous à la section « Bouton Lock » à la page 68. 

Commandes Custom Faders

Bouton Map

Bouton Flip

Bouton Lock

Bouton Window

Bouton Bank/Cycle

Bouton Plug-In

Bouton Tracks

Bouton Custom (Groups)

Bouton (Mix/Edit) Groups

Affichage Custom
Faders
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Mode Custom Groups
Le mode Custom Groups permet de créer un ensemble personnalisé 
de pistes et de les organiser dans les deux banques disponibles 
de canaux Custom Faders. Vous pouvez créer 48 Custom Groups 
indépendants dans une session. 

Les Custom Groups permettent d'associer temporairement des 
pistes qui ne font pas partie d'un groupe de mixage/édition de 
Pro Tools. Étant donné que vous pouvez ajouter plusieurs 
instances d'une même piste à un Custom Group, vous pouvez 
utiliser ce mode conjointement avec le mode Flip ou Map pour 
mapper plusieurs paramètres d'une seule piste sur les faders de 
canaux adjacents.

Les Custom Groups sont créés et rappelés en intégralité sur 
D-Control et ils sont indépendants des groupes de mixage/édition 
de Pro Tools. Les Custom Groups de D-Control ne sont par reflétés 
à l'écran dans Pro Tools. Les Custom Groups sont enregistrés 
dans le fichier de la session Pro Tools et peuvent être déplacés 
avec la session vers un autre système prenant en charge D-Control. 

Affichage des Custom Groups

Les Custom Groups sont accessibles dans la matrice Bank Select 
dans quatre pages de 12 (1 à 12, 13 à 24, 25 à 36 et 37 à 48). 

Vous pouvez également afficher et rappeler des Custom Groups 
dans la section Soft Keys (par pages de six) en appuyant plusieurs 
fois sur le bouton Bank Select dans la section Soft Keys.

Pour créer un nouveau Custom Group :

1  Appuyez sur le bouton Custom de la section Custom Faders 
de gauche ou de droite. Le bouton s'allume pour indiquer que le 
mode est actif pour la banque Custom Faders correspondante.

2  Maintenez la touche Maj enfoncée et appuyez sur le bouton 
Bank/Cycle dans la section Custom Faders pour accéder à la page 
(1 à 12, 13 à 24, 25 à 36, ou 37 à 48) de la matrice Bank Select à 
laquelle vous souhaitez affecter le nouveau Custom Group.

3  Dans la matrice Bank Select, appuyez sur le bouton Bank Select 
(1 à 12) pour la banque à laquelle vous souhaitez affecter le nouveau 
Custom Group. Le bouton s'allume pour indiquer la sélection.

4  Dans la section Bank Select, appuyez sur le bouton Edit : il se 
met à clignoter pour indiquer le mode Edit.

5  Effectuez l'une des opérations suivantes :

• Appuyez sur le bouton Select de chaque canal à ajouter au 
Custom Group. 

• Maintenez la touche Maj enfoncée pendant que vous appuyez 
sur un bouton Select allumé pour placer une même piste sur 
plusieurs faders.

• Pour supprimer une piste du Custom Group, appuyez sur le 
bouton Select correspondant, sur les canaux Custom Faders.

Les pistes sont ajoutées au Custom Group selon l'ordre dans 
lequel vous les avez sélectionnées et sont alignées à droite dans 
les canaux Custom Faders.

6  Pour terminer, appuyez sur le bouton Edit clignotant dans la 
section Bank Select.



Pour rappeler un Custom Group depuis la matrice Bank Select :

1  Appuyez sur le bouton Custom de la section Custom Faders 
de gauche ou de droite. Le bouton s'allume pour indiquer que le 
mode est actif pour la banque Custom Faders correspondante.

2  Maintenez la touche Maj enfoncée et appuyez sur le bouton 
Bank/Cycle dans la section Custom Faders pour accéder à la page 
(1 à 12, 13 à 24, 25 à 36, ou 37 à 48) de la matrice Bank Select 
contenant le Custom Group que vous souhaitez rappeler.

3  Appuyez sur le bouton Bank Select (1 à 12) correspondant au 
Custom Group que vous souhaitez rappeler.

Pour rappeler un Custom Group depuis les encodeurs rotatifs des 
Custom Faders : 

1  Maintenez le bouton Custom enfoncé dans l'une des sections 
Custom Faders jusqu'à ce que les groupes disponibles apparais-
sent dans l'affichage des encodeurs rotatifs des Custom Faders. 

2  Appuyez sur le bouton Select de l'encodeur pour sélectionner 
le groupe que vous souhaitez afficher sur les Custom Faders.

Pour attribuer un nom à un Custom Group :

1  Rappelez le Custom Group que vous souhaitez nommer.

2  Dans la section Bank Select, appuyez deux fois sur le bouton 
Edit.

3  Donnez un nom au Custom Group, puis cliquez sur OK. 

Pour ajouter des canaux à un Custom Group :

1  Rappelez le Custom Group que vous souhaitez modifier.

2  Dans la section Bank Select, appuyez sur le bouton Edit : Il se 
met à clignoter pour indiquer le mode Custom Groups Edit. 

3  Appuyez sur le bouton Select du canal de la tranche Custom 
Faders à droite de l'emplacement où vous souhaitez insérer de 
nouveaux canaux.

4  Appuyez sur le bouton Select de chaque canal à ajouter au 
Custom Group.

5  Pour quitter, appuyez sur le bouton Edit clignotant dans la 
section Bank Select.

Les nouveaux canaux s'ajoutent au Custom Group à gauche de 
la tranche Custom Fader sélectionnée.

Les boutons Bank Select mémorisent leur mode de fonction-
nement précédent (Custom Groups ou Mix/Edit Groups). Si 
la dernière fois que vous avez utilisé le bouton Bank Select vous 
étiez en mode Custom Groups, vous pouvez rappeler un Custom 
Group directement depuis les boutons Bank Select, vous n'avez 
pas à appuyer d'abord sur le bouton Custom Groups. 
Pour supprimer les canaux d'un Custom Group :

1  Rappelez le Custom Group que vous souhaitez modifier.

2  Effectuez l'une des opérations suivantes :

• Appuyez sur le bouton Select des canaux que vous 
souhaitez supprimer du Custom Group.

• Maintenez les touches Ctrl+Démarrer (Windows) ou 
Ctrl+Commande (Mac) enfoncées et appuyez sur le 
bouton Select des canaux Custom Faders à supprimer.

• Maintenez le bouton Set to Default enfoncé et appuyez sur 
le bouton Select du canal Custom Fader à supprimer.

Pour supprimer un Custom Group :

1  Rappelez le Custom Group que vous souhaitez supprimer.

2  Maintenez les touches Démarrer+Alt+Ctrl (Windows) ou 
Ctrl+Option+Commande (Mac) enfoncées et appuyez sur le 
bouton correspondant dans la section Bank Select. 

Pour quitter le mode Custom Groups :

 Appuyez sur le bouton Custom Groups allumé. 
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Mode Mix/Edit Groups de Custom 
Faders

Le mode Mix/Edit Groups permet de créer, d'afficher et de modifier 
les groupes de mixage et de mixage/édition de Pro Tools dans 
l'une des deux banques disponibles de canaux Custom Faders. 
Ce mode permet d'appeler rapidement les membres d'un groupe 
vers un ensemble de faders pour le mixage et l'automation.

Pour afficher un groupe de mixage/édition sur les canaux Custom 
Faders :

 Appuyez sur le bouton Groups de la section Custom Faders de 
gauche ou droite. 

Les boutons s'allument, la lettre et le nom du groupe apparais-
sent dans l'affichage Custom Faders et les membres du groupe 
s'affichent dans les canaux Custom Faders.

Vous pouvez également afficher et rappeler les groupes de mixage/
édition depuis la section Soft Keys (par pages de six) en appuyant 
plusieurs fois sur le bouton Bank Select de la section Soft Keys.

Pour rappeler plusieurs groupes, appuyez sur les boutons corres-
pondants dans la matrice Bank Select. Les groupes sont rappelés 
par séquences selon leur lettre :

• Bank Select 1 correspond au groupe All. 

• Bank Select 2–12 correspond aux groupes allant de la lettre 
« a » à la lettre « k ».

• Maintenez la touche Maj enfoncée et appuyez sur Bank/
Cycle pour modifier les boutons Bank Select 1–12 pour 
qu'ils correspondent aux groupes allant de la lettre « l » à 
la lettre « w ».

• Maintenez la touche Maj enfoncée et appuyez de nouveau 
sur Bank/Cycle pour modifier les boutons Bank Select 1-3 
pour qu'ils correspondent aux groupes allant de la lettre 
« x » à la lettre « z ». 

Pour activer ou désactiver un groupe de mixage/édition :

 En mode Mix/Edit Groups, effectuez l'une des opérations 
suivantes :

• Maintenez les touches Démarrer+Ctrl (Windows) ou Ctrl+
Commande (Mac) enfoncées et appuyez sur le bouton cor-
respondant au groupe dans la section Bank Select. 

Les boutons Bank Select mémorisent leur mode de fonction-
nement précédent (Custom Groups ou Mix/Edit Groups). Si 
vous avez utilisé le bouton Bank Select pour la dernière fois en 
mode Mix/Edit Groups, vous pouvez rappeler un groupe de 
mixage/édition directement depuis les boutons Bank Select, 
vous n'avez pas à appuyer d'abord sur le bouton Mix/Edit 
Group. 
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• Maintenez le bouton Custom Fader Groups enfoncé jusqu'à 
ce qu'il clignote, puis appuyez sur les boutons de la section 
Bank Select pour les groupes que vous souhaitez activer ou 
désactiver. Lorsque vous avez terminé, appuyez sur le bouton 
Groups clignotant. 

Un groupe désactivé apparaît en texte inversé dans l'affichage 
Custom Faders. 

Pour afficher et activer un groupe de mixage/édition depuis les 
encodeurs rotatifs des Custom Faders : 

1  Maintenez le bouton Groups enfoncé dans l'une des sections 
Custom Fader jusqu'à ce que les groupes disponibles apparaissent 
dans les affichage des encodeurs rotatifs des Custom Faders. 

2  Appuyez sur le bouton Select de l'encodeur pour sélectionner 
le groupe que vous souhaitez afficher sur les Custom Faders.

3  Appuyez sur le bouton B/M/P de l'encodeur pour activer ou 
désactiver le groupe correspondant. 

Pour créer un groupe de mixage/édition :

1  Assurez-vous d'être en mode Select.

2  Sélectionnez les pistes que vous souhaitez grouper en appuyant 
sur les boutons Select correspondants.

3  Appuyez sur le bouton Groups pour passer en mode Mix/Edit 
Groups.

4  Dans la matrice Bank Select, appuyez sur le bouton Bank Select 
auquel vous souhaitez affecter le nouveau groupe de mixage/
édition. 

5  Dans la section Bank Select, appuyez deux fois sur le bouton 
Edit. 

6  Choisissez le type de groupe à créer : Edit Group, Mix Group 
ou Edit/Mix Group.

7  Attribuez un nom au groupe, puis appuyez sur Entrée. 

Pour modifier un groupe de mixage/édition :

1  Assurez-vous d'être en mode Select.

2  Appuyez sur le bouton Groups pour passer en mode Mix/Edit 
Groups.

3  Dans la matrice Bank Select, appuyez sur le bouton Bank Select 
pour rappeler le groupe de mixage/édition que vous souhaitez 
modifier.

4  Dans la section Bank Select, appuyez sur le bouton Edit : 

5  Effectuez l'une des opérations suivantes :

• Appuyez sur le bouton Select des canaux que vous souhaitez 
ajouter ou supprimer du groupe.

• Appuyez sur le bouton Select allumé des canaux Custom 
Faders que vous souhaitez supprimer du groupe.

6  Appuyez sur le bouton Edit clignotant pour confirmer le groupe.



Pour supprimer un groupe de mixage/édition :

 En mode Mix/Edit Groups, maintenez les touches Démarrer+
Alt+Ctrl (Windows) ou Ctrl+Option+Commande (Mac) enfoncées 
et appuyez sur le bouton dans la section Bank Select correspon-
dant au groupe que vous souhaitez supprimer.

Pour quitter le mode Mix/Edit Groups :

 Appuyez sur le bouton Groups allumé.

Affichage des pistes d'un groupe de mixage/édition

Sur le premier niveau du mode Mix/Edit Groups, vous pouvez 
afficher les pistes d'un groupe de mixage/édition et masquer 
toutes les autres pistes de D-Control. 

Pour afficher les pistes d'un groupe de mixage/édition :

 Maintenez la touche Démarrer (Windows) ou Ctrl (Mac) en-
foncée et appuyez sur le bouton Select du groupe de mixage/
édition pour effectuer la commande Show Only Tracks In Group. 

Affichage ou basculement des pistes esclaves VCA 
sur les Custom Faders

Vous pouvez afficher toutes les pistes esclaves d'une piste Master 
VCA dans les Custom Faders. Cette fonction utilise le mode Mix/
Edit Groups pour remplacer une commande basculement VCA.

Dès qu'une piste Master VCA est affectée au groupe, le bouton 
Bypass/Mute correspondant s'allume. 

Pour basculer des pistes esclaves VCA dans les Custom Faders :

 Appuyez sur le bouton Bypass/Mute allumé d'une piste Master 
VCA. Le bouton Bypass/Mute clignote pour indiquer que le groupe 
VCA s'affiche.

Pour quitter l'affichage des pistes esclaves VCA dans les Custom 
Faders, effectuez l'une des opérations suivantes :

 Appuyez sur le bouton Bypass/Mute clignotant de la piste 
Master VCA. 

– ou –

 Appuyez sur le bouton Groups des commandes Custom Faders.

Mettre le focus sur des pistes Master VCA lorsque 
les pistes esclaves correspondantes ont été 
basculées

Vous pouvez configurer D-Control de sorte à passer automati-
quement une piste Master VCA sur la tranche Focus lorsque les 
pistes esclaves correspondantes ont été basculées.
Pour mettre automatiquement le focus sur une piste Master VCA 
lorsque ses pistes ont été basculées :

1  Dans la section Soft Keys, appuyez sur le bouton Operation 
plusieurs fois afin d'afficher la page contenant Focus VCA Master 
When Spilled (SplFcs).

2  Appuyez sur la touche programmable correspondant à SplFcs 
pour activer le paramètre.

3  Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur le bouton Operation pour quitter.

Mode Tracks de Custom Faders

Le mode Tracks permet de placer toutes les pistes d'un type par-
ticulier dans l'une des deux banques disponibles des canaux 
Custom Faders. Le type de piste de chaque banque Custom Faders 
peut être sélectionné depuis la matrice Bank Select :

• Bank Select 1= faders Master

• Bank Select 2 = pistes audio

• Bank Select 3 = entrées auxiliaires

• Bank Select 4 = pistes MIDI

• Bank Select 5 = pistes d'instrument

• Bank Select 6 = pistes Master VCA

• Bank Select 7 = pistes masquées

Si le nombre de pistes dépasse celui des tranches Custom Faders, 
les pistes peuvent être assignées à l'aide du bouton Bank/Cycle 
de la section Custom Faders.

Pour afficher et sélectionner les types de pistes dans la section 
Soft Keys, appuyez sur le bouton Bank Select.

Pour placer un type de piste particulier sur les canaux Custom 
Faders :

1  Appuyez sur le bouton Tracks de la section Custom Faders de 
gauche ou droite. 

2  Appuyez sur le bouton Bank Select pour afficher les types de 
pistes dans la section Soft Keys.

3  Appuyez sur la touche programmable correspondant au type 
de piste que vous souhaitez afficher dans les canaux Custom 
Faders.

Le nom du type de piste apparaît dans l'affichage Custom Faders 
correspondant. Les pistes du type sélectionné apparaissent dans 
les canaux Custom Faders.

Pour quitter le mode Tracks :

 Appuyez sur le bouton Tracks allumé.
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Mode Plug-In de Custom Faders

Le mode Plug-In met le focus sur les plug-ins disponibles du canal 
ciblé dans les canaux Custom Faders de gauche et de droite. Cela 
permet de placer tous les paramètres de plug-ins sur les encodeurs 
des canaux Custom Faders et tous les VU-mètres des plug-ins sur 
les VU-mètres des canaux Custom Faders.

Si les plug-ins contiennent plusieurs pages de paramètres, vous 
pouvez sélectionner les pages depuis la matrice Bank Select. Si 
un plug-in dispose de plus de 12 pages, vous pouvez parcourir 
les banques de pages en appuyant sur le bouton Bank/Cycle dans 
la section Custom Faders tout en maintenant la touche Maj 
enfoncée.

Vous pouvez également accéder aux pages des plug-ins dans la 
section Soft Keys en appuyant sur le bouton Bank Select dans la 
section Soft Keys. 

Ce mode est utile pour contrôler les plug-ins possédant une grande 
quantité de commandes, tels que des instruments virtuels. 

Pour mettre le focus sur un plug-in sur les canaux Custom Faders : 

1  Passez la piste du plug-in sur la tranche Focus, en appuyant sur 
le bouton Select correspondant à la piste. Les noms des plug-ins 
présents apparaissent dans les affichages Custom Faders de gauche 
et droite.

2  Appuyez sur le bouton Plug-In dans l'une des sections Custom 
Faders. Il s'allume pour indiquer que le mode est actif. Les paramèt-
res du plug-in apparaissent dans les encodeurs de canal Custom 
Faders.

3  Dans l'une des sections Custom Faders, appuyez sur le bouton 
Bank/Cycle pour afficher successivement les plug-ins du canal 
ciblé. L'option No Insert est toujours disponible.

Pour mettre le focus sur un plug-in en mode Custom Fader 
directement depuis le premier niveau de la vue Inserts :

 Maintenez les touches Ctrl+Alt (Windows) ou Commande+
Option (Mac) enfoncées et appuyez sur le bouton Select de 
l'encodeur du plug-in sur lequel vous souhaitez mettre le focus.

Custom Faders et affichage des paramètres de plug-ins

Trois options d'affichage sont disponibles pour les paramètres 
de plug-ins dans les affichages des canaux Custom Faders. Ces 
options, ou définitions d'affichage, sont accessibles dans les préfé-
rences de fonctionnement de D-Control. Pour plus d'informations, 
reportez-vous à la section « Définitions d'affichage en mode 
Custom Fader Plug-In » à la page 43. 
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Affichage des types de paramètres dans les encodeurs rotatifs

En général, les paramètres de plug-ins continus sont mappés 
sur les boutons encodeurs des Custom Faders et les fonctions 
des paramètres commutés sont mappées sur les boutons B/M/P 
(Bypass/Mute/Pre) des encodeurs. La présence d'un paramètre 
commuté est signalée par l'activation du témoin Pre au-dessus 
du bouton B/M/P correspondant. 

Pour afficher le paramètre contrôlé par les boutons B/M/P :

 Appuyez sur le bouton Switch Info.

Les VU-mètres de plug-ins sont mappés sur les VU-mètres des 
canaux Custom Faders. Les VU-mètres des plug-ins d'entrée et 
de sortie s'affichent sous forme de VU-mètres de niveaux stan-
dard avec des segments de couleur verte, jaune et rouge. Tous 
les VU-mètres de réduction de gain de dynamique (un plug-in 
de limiteur ou de compresseur par exemple) s'affichent de haut 
en bas avec des segments de couleur jaune. 

Affichage Expanded Plug-In

En mode Custom Fader Plug-In, l'affichage Expanded Plug-In 
permet d'accéder à des commandes de plug-ins supplémentaires 
et de gérer des canaux individuels (également appelés flux) des 
plug-ins multi-mono. Ce mode place les commandes d'en-tête 
standard suivantes dans les affichages de canaux :

• Plug-In Bypass

• Plug-In Compare

• Plug-In Automation Safe

• Plug-In Automation Enable

Pour activer l'affichage Expanded Plug-In :

 Maintenez le bouton Plug-In de la section Custom Faders 
enfoncé jusqu'à ce qu'il se mette à clignoter. 

Les commandes d'en-tête de plug-ins sont mappées comme suit :

Plug-In Bypass : pour contourner le plug-in actuellement affiché, 
appuyez sur le bouton Mute correspondant à Bypass dans les 
affichages du canal. Cela active le bouton Effect Bypass de la 
fenêtre Plug-In. 

Plug-In Compare : pour basculer entre les paramètres d'origine du 
plug-in enregistré et leurs valeurs après modification, appuyez 
sur le bouton Mute correspondant à Comp dans les affichages 
du canal. Cela active le bouton Compare de la fenêtre Plug-In.

Il est possible qu'une même commande soit mappée à la fois 
sur un bouton encodeur et sur le bouton correspondant, ce 
qui permet d'utiliser l'une des deux commandes pour régler 
le paramètre.

Si l'affichage du mode Custom Fader Plug-In est en affichage 
étendu, vous êtes automatiquement en affichage Expanded 
Plug-In lorsque vous passez en mode Plug-In.



Plug-In Automation Safe : pour empêcher l'écrasement des don-
nées d'automation d'un plug-in, appuyez sur le bouton Mute 
correspondant à Safe dans les affichages du canal. Cela active le 
bouton Safe de la fenêtre Plug-In.

Plug-In Automation Enable : pour activer l'automation des com-
mandes de plug-in individuelles, appuyez sur le bouton Mute 
correspondant à AutoEn dans les affichages du canal. Cela ré-
pertorie les commandes du plug-in pouvant être automatisées 
sur les encodeurs des Custom Faders. Choisissez les commandes 
à automatiser en appuyant sur les boutons Select des encodeurs 
correspondants. Cela active le bouton Auto de la fenêtre Plug-In.

Plug-in multi-mono et mode Expanded Plug-In

Avec les plug-ins multi-mono, les commandes de canaux de plug-in 
suivantes sont également mappées sur les affichages des canaux 
Custom Faders :

Link : pour coupler les canaux d'un plug-in multi-mono, appuyez 
sur le bouton Mute correspondant à Link dans les affichages du 
canal. Cela active le bouton Master Link de la fenêtre Plug-In.

Target Stream : pour cibler le canal d'un plug-in multi-mono 
spécifique en vue de sa modification, appuyez sur le bouton 
Mute correspondant à TargtS dans les affichages du canal. Cela 
répertorie les canaux du plug-in sur les encodeurs des Custom 
Faders. Vous pouvez ensuite choisir un canal en appuyant sur le 
bouton Select de l'encodeur correspondant. Le bouton s'allume 
pour indiquer le canal ciblé. 

Group Stream : pour grouper des canaux individuels d'un plug-in 
multi-mono en vue de leur modification, appuyez sur le bouton 
Mute correspondant à GroupS dans les affichages du canal. Cela 
répertorie les canaux du plug-in sur les encodeurs des Custom 
Faders. Vous pouvez ensuite grouper les flux de votre choix en 
appuyant sur les boutons Select des encodeurs correspondants. 
Les boutons Select s'allument pour indiquer les canaux groupés.

Bypass Stream : pour mettre en bypass des flux individuels d'un 
plug-in multi-mono, appuyez sur le bouton Mute correspondant 
à BypS dans les affichages du canal. Cela répertorie les canaux 
du plug-in sur les encodeurs des Custom Faders. Vous pouvez 
mettre un flux en bypass en appuyant sur le bouton B/M/P de 
l'encodeur correspondant. Le bouton B/M/P s'allume pour in-
diquer le flux mis en bypass.

Pour quitter le mode Expanded Plug-In :

 Appuyez sur le bouton Plug-In clignotant.
Mode Custom Fader Flip

Dans les modes Custom Fader, vous pouvez permuter les rangées 
des encodeurs des Custom Faders avec les faders en mode Custom 
Fader Flip. Le bouton unique Custom Fader Flip permet d'affecter 
successivement chaque rangée d'encodeurs aux faders. Le bouton 
Custom Fader Flip affecte uniquement les canaux Custom Faders 
et n'a aucun effet sur les canaux en mode Normal.

En mode Custom Fader Flip, le bouton portant le même nom 
s'allume et les affichages des encodeurs affectés apparaissent en 
jaune.

Pour activer le mode Custom Fader Flip :

1  À partir d'un mode Custom Fader, appuyez sur le bouton Custom 
Fader Flip. La rangée supérieure d'encodeurs est transférée sur 
les faders.

2  Pour permuter les rangées suivantes, appuyez plusieurs fois sur 
le bouton Custom Fader.

Pour quitter le mode Custom Fader Flip :

 Appuyez plusieurs fois sur le bouton Custom Fader Flip pour 
quitter le mode Flip. 

– ou –

 Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur le bouton Custom Fader Flip.

Modes Custom Fader Map

En mode Custom Groups, Mix/Edit Groups ou Plug-In, vous 
pouvez mapper des commandes d'encodeur individuel sur des 
faders (piste par piste) grâce aux modes Custom Fader Map.

Cette fonction de mappage fonctionne différemment selon le 
mode Custom Fader principal activé. Elle n'est pas disponible 
en mode Master Faders.

Modes de mappage Custom Groups et Mix/Edit 
Groups

En mode Custom Groups ou Mix/Edit Groups, vous pouvez map-
per des paramètres d'encodeur sur le fader du même canal Custom 
Fader. Dans ces modes de mappage, la commande d'encodeur 
rotatif est permutée avec le fader de canal et le bouton Bypass/
Mute/Pre d'encodeur est permutée avec le bouton Mute du canal.

Le mappage est ainsi restreint verticalement aux encodeurs et 
faders de la même tranche.

Stockage des mappages Custom Group et Mix/Edit Group

Les mappages Custom Group et Mix/Edit Group sont enregistrés 
dans le fichier de la session Pro Tools et peuvent être déplacés 
avec la session vers un autre système prenant en charge D-Control. 
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Pour mapper un encodeur sur un fader (mode Custom Groups ou 
Mix/Edit Groups) :

1  En mode Custom Groups ou Mix/Edit Groups, maintenez le 
bouton Map de la section Custom Faders enfoncé jusqu'à ce qu'il 
clignote.

2  Dans les canaux Custom Faders, touchez les encodeurs rotatifs 
que vous souhaitez mapper sur le fader de canal leur correspondant. 

3  Effectuez l'une des opérations suivantes : 

• Appuyez sur le bouton Map clignotant pour confirmer le 
mappage.

– ou –

• Appuyez sur le bouton Esc pour annuler le mappage et quitter 
le mode d'édition Map. 

Le bouton Map reste allumé tant que le mappage est actif.

Pour désactiver le mappage (en mode Custom Groups ou Mix/Edit 
Groups) :

 Appuyez sur le bouton Map allumé. Même s'il n'est pas affiché, 
le mappage est rappelé pour chaque Custom Group ou groupe 
de mixage/édition.

Pour rappeler le mappage (en mode Custom Groups ou Mix/Edit 
Groups) : 

1  Rappelez le Custom Group ou le groupe de mixage/édition en 
appuyant sur le bouton correspondant dans la section Custom 
Faders. 

2  Appuyez sur le bouton Map. 

Mode de mappage Custom Fader Plug-In

Le mode de mappage Custom Fader Plug-In permet de mapper des 
commandes des encodeurs sur les faders de la surface D-Control. 
Ce mode est différent de la fonction Plug-In Mapping de Pro Tools 
qui permet de mapper des commandes de plug-ins à l'écran sur 
les encodeurs de la surface. Pour plus d'informations sur les fonc-
tions Plug-In Mapping, reportez-vous à la section « Assignation 
de plug-ins » à la page 75. 

En mode Custom Fader Plug-In, vous pouvez mapper les para-
mètres de plug-in d'un encodeur sur tous les faders des canaux 
Custom Faders, y compris aux faders se trouvant sur d'autres ca-
naux. En mode de mappage Plug-In, un encodeur rotatif mappé 
est dupliqué sur le fader et un bouton mappé est dupliqué sur le 
bouton Mute du canal. Étant donné que le mode Plug-In n'utilise 
pas les faders, aucune permutation ne se produit.

Dans ce mode, le mappage ne contient aucune restriction sur les 
relations verticales entre les encodeurs et les faders.
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 Lorsque vous mappez un plug-in, toutes les autres instances 
de ce plug-in dans la session utilisent le même mappage. 

 Le mappage de plug-in est enregistré en tant que fichier de 
préférences avec une extension .pim. 

 Le mappage de plug-in de la dernière session est rappelé par le 
système Pro Tools (enregistré dans le fichier de préférences de 
l'application Pro Tools). Ainsi, lorsque vous créez une session 
sur le système, toutes les instances d'un même plug-in utilisent 
le mappage stocké. 

 Les fichiers de mappage de plug-in (.pim) peuvent être importés 
et exportés afin d'être utilisés avec d'autres consoles D-Control 
et D-Command. 

Pour mapper un encodeur sur un fader (mode Plug-In) :

1  En mode Plug-In, appuyez sur le bouton Map de la section 
Custom Faders.

2  Sur les canaux Custom Faders, appuyez sur le bouton Select du 
canal sur lequel vous souhaitez mapper l'encodeur. Le bouton 
Select clignote pour indiquer le mode Map. 

3  Effectuez l'une des opérations suivantes :

• Dans les canaux Custom Faders, appuyez sur tous les enco-
deurs rotatifs que vous souhaitez mapper sur les faders des 
canaux sélectionnés.

– ou –

• Dans les canaux Custom Faders, appuyez sur tous les boutons 
que vous souhaitez mapper sur les boutons Mute des canaux 
sélectionnés. 

La commande mappée s'affiche sur le fader du canal sélectionné. 
Le mappage des paramètres de plug-in est rappelé pour ce plug-in 
et peut être utilisé sur tous les canaux sur lequel il est présent. 

Pour mettre un mappage en bypass (mode Custom Fader Plug-In) :

 Appuyez sur le bouton Map allumé. Même s'il n'est pas affiché, 
le mappage est rappelé pour chaque plug-in. 

Pour rappeler un mappage (mode Custom Fader Plug-In) : 

1  Passez le plug-in sur la tranche Focus.

2  Rappelez le plug-in en appuyant sur le bouton Plug-In de la 
section Custom Faders. 

3  Appuyez sur le bouton Map.

Pour supprimer un mappage (mode Custom Fader Plug-In) : 

1  En mode de mappage Custom Faders Plug-In, affichez le plug-in 
pour lequel vous voulez supprimer le mappage. 

2  Appuyez sur le bouton Set to Default. 

3  Appuyez sur le bouton Do To All.

4  Appuyez sur le bouton Select de n'importe quelle tranche 
Custom Faders. 



Exportation et importation de fichiers .pim

Pour exporter un mappage de plug-in :

1  Appuyez sur le bouton Operation plusieurs fois afin d'afficher 
la page contenant Export Plug-In Maps (Export PIMaps).

2  Appuyez sur la touche programmable correspondant à Export 
PIMaps.

3  Saisissez le nom du fichier de carte d'assignation de plug-in 
(.pim), choisissez un emplacement et cliquez sur Save.

4  Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur le bouton Operation pour quitter.

Pour importer un mappage de plug-in :

1  Appuyez sur le bouton Operation plusieurs fois afin d'afficher 
la page contenant Import Plug-In Maps (Import PIMaps).

2  Appuyez sur la touche programmable correspondant à Import 
PIMaps.

3  Localisez le fichier de carte d'assignation de plug-in (.pim) que 
vous souhaitez utiliser et cliquez sur Import.

4  Maintenez la touche Ctrl (Windows) ou Commande (Mac) 
enfoncée et appuyez sur le bouton Operation pour quitter.
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Annexe A : Mode Utility
Le mode Utility de D-Control permet d'afficher des informations 
sur le système, d'exécuter des tests de diagnostic, de définir des 
préférences matérielles et de restaurer les paramètres du système.

Activation du mode Utility

Vous pouvez activer le mode Utility à tout moment pour modifier 
les paramètres de D-Control. Ce mode est accessible depuis 
l'unité principale de D-Control et depuis les modules de faders 
individuels de D-Control. 

Activation du mode Utility depuis une unité principale

Lorsque le mode Utility est activé pour une unité principale de 
D-Control, le comportement des modules de faders connectés 
diffère selon que les unités sont online ou non. 

Une unité D-Control est online si Pro Tools est en cours d'exécution 
et que l'unité est déclarée dans la page Peripherals de la boîte de 
dialogue Setup. Une unité est offline si Pro Tools n'est pas en cours 
d'exécution ou si cette unité n'est pas déclarée sur un système 
qui exécute Pro Tools. 

Pour activer le mode Utility depuis une unité principale :

 Appuyez sur le bouton Utility de la section Session Management. 
Le bouton Utility et les Soft Keys clignotent pour signaler que le 
mode Utility est actif.

• Si l'unité principale est online, tous les modules de faders 
déclarés sur un même système Pro Tools passent également 
en mode Utility. 

• Si l'unité principale est offline, tous les modules de faders 
offline sur un même réseau Ethernet passent en mode Utility.

Activation du mode Utility sur un module de faders

Vous pouvez activer le mode Utility pour chacun des modules 
de faders à tester indépendamment des autres unités D-Control. 

Pour activer le mode Utility pour un module de faders :

1  Si Pro Tools est en cours d'exécution, effectuez l'une des 
opérations suivantes :

• Quittez Pro Tools.

– ou –

• Sélectionnez Setup > Peripherals, cliquez sur Ethernet 
Controllers et vérifiez que le module de faders n'est pas 
déclaré.
2  Dans la partie inférieure gauche du module de faders, maintenez 
les touches de modification enfoncées en respectant l'ordre suivant : 
Maj + Alt/Commande + Win/Option. Les boutons Select de 
l'encodeur de la rangée inférieure clignotent pour indiquer que 
le mode Utility est actif. 

Navigation dans le mode Utility

Lorsque l'unité est en mode Utility, la page Utility Setup apparaît 
dans les affichages de la section Soft Keys (unité principale) ou 
dans la rangée inférieure des encodeurs (module de faders). 

La page Utility Setup comporte cinq options de niveau supérieur :

• System : page d'informations du système

• Name : page d'attribution de nom

• Test : page de configuration de test

• Reset : restauration des paramètres par défaut de D-Control

• Pref : page de configuration des préférences

Pour accéder à une option de la page Utility Setup :

 Appuyez sur la Soft Key (unité principale) ou sur le bouton 
Select de l'encodeur (module de faders) correspondant à l'option.

Pour retourner à la page Utility Setup :

 Appuyez sur la Soft Key (unité principale) ou sur le bouton Select 
de l'encodeur (module de faders) correspondant à la commande 
d'échappement.

Séquence de touches de modification du module de faders pour activer 
le mode Utility

1

3

2
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Désactivation du mode Utility

Pour quitter le mode Utility, effectuez l'une des opérations suivantes :

 Appuyez sur le bouton clignotant Utility (unité principale).

– ou –

 Appuyez sur la Soft Key (unité principale) ou sur le bouton Select 
de l'encodeur (module de faders) correspondant à la commande 
d'échappement. 

Page System Info de D-Control

La page System Info permet d'accéder à la version du firmware 
du système et aux informations Ethernet. 

Pour accéder à la page System Info :

 Dans la page Utility Setup, appuyez sur la Soft Key (unité 
principale) ou sur le bouton Select de l'encodeur (module de 
faders) correspondant à System.

Pour fermer la page System Info :

 Appuyez sur la Soft Key (unité principale) ou sur le bouton Select 
de l'encodeur (module de faders) correspondant à la commande 
d'échappement. 

Version du firmware

Dans la page System Info, appuyez sur la Soft Key (unité princi-
pale) ou sur le bouton Select de l'encodeur (module de faders) 
correspondant à FW ver. Les versions du firmware des cartes Comm 
et Motor Control s'affichent. 

Informations Ethernet

Dans la page System Info, appuyez sur la Soft Key (unité princi-
pale) ou sur le bouton Select de l'encodeur (module de faders) 
correspondant à Ethrnt pour afficher les informations suivantes :

 Unit Name : nom de l'unité (tel qu'il apparaît dans la page Name)

 ID : adresse Ethernet (Machine Address Code) de l'unité

 Num : numéro de série de l'unité

 Type : type de paquet Ethernet utilisé pour communiquer avec 
la surface de contrôle
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La page Name permet d'afficher et de modifier le nom des unités 
D-Control. Ces noms s'affichent dans la boîte de dialogue Peripherals 
de Pro Tools et doivent être uniques pour identifier chaque unité 
D-Control de façon spécifique. Cette règle est importante, notam-
ment si votre système se trouve sur un réseau Ethernet et que 
plusieurs contrôleurs y sont connectés. 

Pour afficher la page Name d'une unité D-Control :

1  Activez le mode Utility pour l'unité que vous souhaitez nommer. 
Le mode Utility doit être activé indépendamment pour chaque 
module de faders. (Voir « Activation du mode Utility sur un 
module de faders » à la page 159.)

2  Dans la page Utility Setup, appuyez sur la Soft Key (unité 
principale) ou sur le bouton Select de l'encodeur (module de 
faders) correspondant à Name.

Le nom de l'unité principale s'affiche dans la section Soft Keys. 
Le nom du module de faders apparaît dans les affichages des 
encodeurs. Le premier caractère du nom clignote pour signaler 
une saisie de texte.

Pour modifier le nom de l'unité : 

1  Utilisez la molette Scrub/Shuttle (unité principale) ou un bouton 
encodeur (module de faders) pour modifier le texte sélectionné. 

2  Pour avancer ou reculer dans le champ du nom, appuyez sur les 
Soft Keys clignotantes (unité principale) ou sur les boutons Select de 
l'encodeur (module de faders) correspondant aux symboles < et >. 

3  Une fois votre texte saisi, effectuez l'une des opérations suivantes :

• Pour confirmer le nouveau nom, appuyez sur la Soft Key 
(unité principale) ou sur le bouton Select de l'encodeur 
(module de faders) correspondant à OK.

• Pour effacer le nom du champ, appuyez sur la Soft Key 
(unité principale) ou sur le bouton Select de l'encodeur 
(module de faders) correspondant à Clear.

• Pour annuler le nouveau nom, appuyez sur la Soft Key 
(unité principale) ou sur le bouton Select de l'encodeur 
(module de faders) correspondant à Cancel.



Pages Test de D-Control
Les pages Test permettent de tester plusieurs composants 
mécaniques et électroniques de l'unité. 

Pour afficher la page Test Setup :

 Dans la page Utility Setup, appuyez sur la Soft Key (unité 
principale) ou sur le bouton Select de l'encodeur (module de 
faders) correspondant à Test. 

La page Test Setup comporte cinq modes de test de niveau supérieur :

• Ethernet : page de test de la communication Ethernet

• LED : page de test des boutons et témoins

• Display : page de test des affichages

• Fader : page de test des faders

• Rotary : page de test des encodeurs rotatifs

Pour activer un mode de test sur la page Test Setup :

 Appuyez sur la Soft Key (unité principale) ou sur le bouton 
Select de l'encodeur (module de faders) correspondant au nom 
du mode de test.

Pour fermer la page Test Setup :

 Appuyez sur la Soft Key (unité principale) ou sur le bouton 
Select de l'encodeur (module de faders) correspondant à la 
commande d'échappement. 

Page Ethernet Test
La communication Ethernet sur D-Control fait l'objet de trois 
niveaux de test : Internal, Mendec et External. Ces tests peuvent 
être une aide précieuse pour le personnel de support technique, si 
la communication Ethernet entre D-Control et Pro Tools pose 
problème. 

Chaque test envoie des paquets de données via le système Ethernet 
de l'unité. Les valeurs Transmit (Xmit) et Receive (Recv) de chaque 
test affichent la quantité de paquets envoyée et reçue au cours du 
test et les champs Error et Retry affichent le pourcentage d'erreur 
dans le processus de transmission et de réception. Un pourcentage 
d'erreur inférieur ou égal à 1 indique généralement que le niveau 
de performances est satisfaisant. En mode de fonctionnement 
normal, les erreurs font l'objet de nouvelles tentatives et aucun 
donnée n'est perdue.

Pour afficher la page Ethernet Test :

1  Activez le mode Utility pour l'unité que vous souhaitez tester. 
Le mode Utility doit être activé indépendamment pour chaque 
module de faders. (Voir « Activation du mode Utility sur un 
module de faders » à la page 159.)

2  Dans la page Test Setup, appuyez sur la Soft Key (unité princi-
pale) ou sur le bouton Select de l'encodeur (module de faders) 
correspondant à Ethrnt.

Pour fermer la page Ethernet Test :

 Appuyez sur la Soft Key (unité principale) ou sur le bouton 
Select de l'encodeur (module de faders) correspondant à la 
commande d'échappement. 
Internal
Le test Internal vérifie la première étape de la communication 
Ethernet en envoyant des paquets de données via la carte 
Ethernet Link.

Pour exécuter le test Ethernet Internal :

1  Dans la page Ethernet Test, appuyez sur la Soft Key (unité 
principale) ou sur le bouton Select de l'encodeur (module de 
faders) correspondant à Clear pour effacer toutes les valeurs de 
la page de données du test de l'unité. 

2  Appuyez sur la Soft Key (unité principale) ou sur le bouton 
Select de l'encodeur (module de faders) correspondant à Intrnl.

Pour quitter le test Ethernet Internal :

 Appuyez sur la Soft Key clignotante (unité principale) ou sur 
le bouton Select de l'encodeur (module de faders). 

Mendec
Le test Mendec (Manchester Encoder/Decoder) vérifie la seconde 
étape de la communication Ethernet en envoyant des paquets 
via l'encodeur et le décodeur Ethernet de l'unité. 

Pour exécuter le test Ethernet Mendec :

1  Dans la page Ethernet Test, appuyez sur la Soft Key (unité 
principale) ou sur le bouton Select de l'encodeur (module de 
faders) correspondant à Clear pour effacer toutes les valeurs 
de la page de données du test de l'unité. 

2  Appuyez sur la Soft Key (unité principale) ou sur le bouton 
Select de l'encodeur (module de faders) correspondant à Mendec.

Pour quitter le test Ethernet Mendec :

 Appuyez sur la Soft Key clignotante (unité principale) ou sur 
le bouton Select de l'encodeur (module de faders). 

External
Le test External vérifie la troisième étape de la communication 
Ethernet en envoyant des paquets de données hors du port 
Ethernet externe de l'unité, puis en les renvoyant vers l'unité via 
le connecteur de bouclage Ethernet (fourni avec l'unité principale 
de D-Control).

Pour exécuter le test Ethernet External :

1  Si Pro Tools est en cours d'exécution, quittez l'application. 

2  Débranchez l'unité du réseau Ethernet.

3  Branchez le connecteur de bouclage Ethernet au port Ethernet 
de l'unité. 

4  Dans la page Ethernet Test, appuyez sur la Soft Key (unité 
principale) ou sur le bouton Select de l'encodeur (module de 
faders) correspondant à Clear pour effacer toutes les valeurs 
de la page de données du test de l'unité. 

5  Appuyez sur la Soft Key (unité principale) ou sur le bouton 
Select de l'encodeur (module de faders) correspondant à Extrnl.

Pour quitter le test Ethernet External :

 Appuyez sur la Soft Key clignotante (unité principale) ou sur 
le bouton Select de l'encodeur (module de faders). 
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Page Switch and LED Test

La page Switch and LED Test comporte cinq modes :

• Switch : mode de test des boutons

• Red : mode de test des témoins rouges

• Yellow : mode de test des témoins jaunes

• Green : mode de test des témoins verts

• Vegas : mode Vegas

Pour afficher la page de test des boutons et témoins :

 Dans la page Test Setup, appuyez sur la Soft Key (unité princi-
pale) ou sur le bouton Select de l'encodeur (module de faders) 
correspondant à LED.

Pour fermer la page Switch and LED Test :

 Appuyez sur la Soft Key (unité principale) ou sur le bouton 
Select de l'encodeur (module de faders) correspondant à la 
commande d'échappement. 

Pour activer l'un des modes de test des boutons et témoins :

 Appuyez sur la Soft Key (unité principale) ou sur le bouton 
Select de l'encodeur (module de faders) correspondant au nom 
du mode. 

Mode Switch Test

Le mode Switch Test permet de tester chaque bouton de l'unité 
séparément.

Pour tester les boutons :

 Appuyez sur le bouton que vous souhaitez tester.

Le témoin du bouton s'allume dès que celui-ci est enfoncé et 
les affichages de la section Soft Keys (unité principale) ou les 
affichages des encodeurs (module de faders) consignent des 
informations sur l'emplacement du bouton.

Pour désactiver le mode Switch Test :

 Appuyez sur la Soft Key (unité principale) ou sur le bouton 
Select de l'encodeur (module de faders) correspondant à la 
commande d'échappement. 

Modes LED Test (Red, Yellow, Green)

Les modes LED Test permettent de tester séparément les témoins 
rouges, jaunes et verts de l'unité. 

Pour tester les témoins :

 Appuyez sur la Soft Key correspondant à Red, Yellow ou Green 
pour tester tous les témoins de la couleur spécifiée.

Pour désactiver le mode LED Test :

 Appuyez sur la Soft Key (unité principale) ou sur le bouton 
Select de l'encodeur (module de faders) correspondant à la 
commande d'échappement. 
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Le mode Vegas allume librement les boutons, VU-mètres et 
affichages de l'unité et exécute les faders sous forme d'onde 
sinusoïdale.

Pour activer le mode Vegas :

 Appuyez sur la Soft Key correspondant à Vegas.

Pour désactiver le mode Vegas :

 Appuyez sur un bouton de l'unité. 

Page Display Test

La page Display Test comporte trois modes :

• Text : test des affichages texte

• Time Code : test des affichages du timecode

• Meter : test Meter Bridge LED

Pour afficher la page Display Test :

 Dans la page Test Setup, appuyez sur la Soft Key (unité princi-
pale) ou sur le bouton Select de l'encodeur (module de faders) 
correspondant à Disply.

Pour fermer la page Display Test :

 Appuyez sur la Soft Key (unité principale) ou sur le bouton 
Select de l'encodeur (module de faders) correspondant à la 
commande d'échappement. 

Pour activer l'un des modes Display Test :

 Appuyez sur la Soft Key (unité principale) ou sur le bouton 
Select de l'encodeur (module de faders) correspondant au nom 
du mode. 

Test Text

Le mode Text Test exécute successivement une série de tests des 
affichages texte qui vérifient tous les affichages texte de la surface 
de contrôle.

Pour désactiver le mode Text Test :

 Appuyez sur une Soft Key clignotante (unité principale) ou 
un bouton Select de l'encodeur (module de faders).

Test Meter Bridge LED

Le test Meter Bridge LED exécute successivement une série de tests 
automatisés qui vérifient tous les témoins de chaque VU-mètre.

Pour quitter le test Meter Bridge LED :

 Appuyez sur la Soft Key (unité principale) ou sur le bouton Select 
de l'encodeur (module de faders) correspondant à la commande 
d'échappement. 



Test Time Code Display

(unité principale uniquement)

Le test Time Code Display exécute une série de tests automatisés 
qui vérifient tous les segments des témoins de l'affichage du 
timecode de l'unité principale.

Pour quitter le test Time Code Display :

 Appuyez sur la Soft Key correspondant à la commande 
d'échappement. 

Page Fader Test

La page Fader Test fournit quatre modes de test et un mode 
d'étalonnage :

• Step : mode de test des faders par palier

• Cycle : mode de test des faders par cycle

• Group : mode de test des faders par groupe

• Touch : mode de test des faders par touche

• Recal : réétalonnage des faders

Pour afficher la page Fader Test :

 Dans la page Test Setup, appuyez sur la Soft Key (unité princi-
pale) ou sur le bouton Select de l'encodeur (module de faders) 
correspondant à Fader.

Pour fermer la page Fader Test :

 Appuyez sur la Soft Key (unité principale) ou sur le bouton 
Select de l'encodeur (module de faders) correspondant à la 
commande d'échappement. 

Pour activer l'un des modes Fader Test :

 Appuyez sur la Soft Key (unité principale) ou sur le bouton Select 
de l'encodeur (module de faders) correspondant au nom du test.

Mode Step Test

En mode Step Test, les faders passent simultanément, par palier, 
sur des positions réglables avec la molette Scrub/Shuttle (unité 
principale) ou avec un bouton encodeur (module de faders). 

Pour désactiver le mode Step Test :

 Appuyez sur la Soft Key (unité principale) ou sur le bouton 
Select de l'encodeur (module de faders) correspondant à la 
commande d'échappement. 

Mode Cycle Test

En mode Cycle Test, les faders se déplacent simultanément, de 
bas en haut, de façon continue et à une vitesse réglable avec le 
molette Scrub/Shuttle (unité principale) ou avec un bouton 
encodeur (module de faders). 

Les valeurs de position des faders apparaissent dans les affichages 
des canaux et sont mises à jour en temps réel au fur et à mesure 
que les faders sont déplacés. 
Pour désactiver le mode Cycle Test :

 Appuyez sur la Soft Key (unité principale) ou sur le bouton 
Select de l'encodeur (module de faders) correspondant à la 
commande d'échappement. 

Mode Group Test

En mode Group Test, les faders peuvent être déplacés de manière 
à tester la réactivité du groupe.

Ce mode signale les faders qui sont déplacés par une lettre T 
indiquée dans l'affichage du canal associé.

Pour désactiver le mode Group Test :

 Appuyez sur la Soft Key (unité principale) ou sur le bouton 
Select de l'encodeur (module de faders) correspondant à la 
commande d'échappement. 

Mode Touch Test

La page Touch Test permet de tester la réactivité de chaque fader. 
Les affichages des canaux indiquent lorsqu'un fader est sollicité et 
affiche la fréquence reconnue. La valeur de fréquence des faders 
est mise à jour en temps réel. 

Ce mode signale les faders qui sont déplacés par une lettre T 
indiquée dans l'affichage du canal associé.

Pour désactiver le mode Touch Test :

 Appuyez sur la Soft Key (unité principale) ou sur le bouton 
Select de l'encodeur (module de faders) correspondant à la 
commande d'échappement. 

Recal

La commande Recal réétalonne la réactivité des faders de D-Control 
et rétablit les spécifications d'origine des faders. 

Par ailleurs, en cas d'utilisation intense du système, la fonction de 
protection du moteur des faders de D-Control peut désactiver les 
faders pour prévenir tout risque de surchauffe. La commande 
Recal réactive tous les faders désactivés. 

Pour réétalonner les faders :

 Dans la page Fader Test, appuyez sur la Soft Key (unité princi-
pale) ou sur le bouton Select de l'encodeur (module de faders) 
correspondant à Recal.

Page Rotary Test

La page Rotary Test permet de tester le bouton encodeur tactile 
et la couronne de témoins de chaque encodeur rotatif ainsi que 
la molette Scrub/Shuttle de l'unité principale. 

Pour activer le mode Rotary Test :

 Dans la page Test Setup, appuyez sur la Soft Key (unité princi-
pale) ou sur le bouton Select de l'encodeur (module de faders) 
correspondant à Rotary.
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Pour désactiver le mode Rotary Test :

 Appuyez sur la Soft Key située près de la commande d'échap-
pement (unité principale) ou sur le bouton Select clignotant de 
l'encodeur. 

Pour tester les encodeurs rotatifs :

 Touchez un bouton encodeur. Dès que vous touchez le bouton 
encodeur, l'affichage de cet encodeur devient rouge et le témoin 
Auto situé sous le bouton s'affiche. 

 Tournez un bouton encodeur. Dès que vous tournez le bouton, 
les témoins de la couronne s'allument les uns après les autres.

Pour tester la molette Scrub/Shuttle :

 Tournez la molette Scrub/Shuttle. La valeur numérique dans 
l'affichage inférieur gauche de la section Soft Keys change en 
fonction du sens dans lequel vous tournez la molette. 

Restauration des paramètres par 
défaut de D-Control

La page Reset permet de restaurer les paramètres d'usine de l'unité 
principale et des modules de faders de D-Control.

Pour réinitialiser D-Control :

1  Dans la page Utility Setup, appuyez sur la Soft Key (unité 
principale) ou sur le bouton Select de l'encodeur (module de 
faders) correspondant à Reset.

2  Appuyez sur la Soft Key (unité principale) ou sur le bouton 
Select de l'encodeur (module de faders) correspondant à OK.

3  Effectuez l'une des opérations suivantes :

• Confirmez votre choix en appuyant de nouveau sur OK. 

– ou –

• Pour annuler l'opération de réinitialisation, appuyez sur 
la Soft Key (unité principale) ou sur le bouton Select de 
l'encodeur (module de faders) correspondant à Cancel.
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Dans les préférences de D-Control, vous pouvez définir plusieurs 
préférences d'affichage et de fonctionnement de l'unité. 

Pour afficher la page Preferences :

 Dans la page Utility Setup, appuyez sur la Soft Key (unité 
principale) ou sur le bouton Select de l'encodeur (module de 
faders) correspondant à Prefs.

La page Preferences de D-Control comporte cinq préférences :

• Bright : luminosité de l'affichage

• Contrast : contraste de l'affichage

• Foot 1 : paramètres de la pédale 1

• Foot 2 : paramètres de la pédale 2

• Sleep : paramètres du mode Sleep

Pour accéder à une préférence de la page Preferences :

 Appuyez sur la Soft Key (unité principale) ou sur le bouton 
Select de l'encodeur (module de faders) correspondant au nom 
de la préférence.

Page Display Brightness

La page Display Brightness permet de régler la luminosité des 
témoins des affichages.

Pour définir la luminosité de l'affichage :

1  Dans la page Preferences, appuyez sur la Soft Key (unité prin-
cipale) ou sur le bouton Select de l'encodeur (module de faders) 
correspondant à Bright.

2  Utilisez la molette Scrub/Shuttle (unité principale) ou un bouton 
encodeur (module de faders) pour modifier la valeur de luminosité. 
La plage de valeurs de la luminosité varie de 0 à 127. 

3  Effectuez l'une des opérations suivantes :

• Pour confirmer la nouvelle valeur de luminosité, appuyez 
sur la Soft Key (unité principale) ou sur le bouton Select de 
l'encodeur (module de faders) correspondant à OK.

– ou –

• Pour annuler la nouvelle valeur de luminosité, appuyez 
sur la Soft Key (unité principale) ou sur le bouton Select de 
l'encodeur (module de faders) correspondant à Cancel.



Page Display Contrast

La page Display Contrast permet de régler le niveau de rétroé-
clairage des témoins.

Pour définir le contraste de l'affichage :

1  Dans la page Preferences, appuyez sur la Soft Key (unité prin-
cipale) ou sur le bouton Select de l'encodeur (module de faders) 
correspondant à Contrast.

2  Pour ajuster le contraste général pour tous les affichages, appuyez 
sur la Soft Key (unité principale) ou sur le bouton Select de l'encod-
eur (module de faders) qui correspond à >> ou << pour augmenter 
ou réduire la valeur de contraste. Les valeurs de contraste varient 
entre 0 à 9. 

3  Pour ajuster le contraste relatif pour des rangées spécifiques 
d'affichages, tournez les boutons encodeur Flip (unité principale) 
ou un bouton encodeur pour une rangée donnée (module de 
faders). Les valeurs de contraste individuelles se présentent sous 
la forme de numéros de palier compris entre 0 et 62. 

4  Pour afficher successivement les affichages de texte inversé, 
appuyez plusieurs fois sur la Soft Key (unité principale) ou le 
bouton Select de l'encodeur (module de faders) correspondant 
à Invert.

5  Effectuez l'une des opérations suivantes :

• Pour confirmer les nouvelles valeurs de contraste, appuyez 
sur la Soft Key (unité principale) ou sur le bouton Select de 
l'encodeur (module de faders) correspondant à OK.

• Pour restaurer les valeurs de contraste par défaut, appuyez 
sur la Soft Key (unité principale) ou sur le bouton Select de 
l'encodeur (module de faders) correspondant à Reset.

• Pour annuler les nouvelles valeurs de contraste, appuyez 
sur la Soft Key (unité principale) ou sur le bouton Select de 
l'encodeur (module de faders) correspondant à Cancel.
Pages de paramètres de pédales 1 et 2
(unité principale uniquement)

Dans les paramètres des pédales 1 et 2, vous pouvez définir la 
fonction de chaque pédale. Pour chaque paramètre, appuyer 
sur la pédale revient à appuyer sur le bouton correspondant sur 
l'unité principale de D-Control.

Chaque page Footswitch Settings comporte quatre options :

• Flip + / Flip – : rend la polarité de la connexion de la pédale 
positive (+) ou négative (–). 

• Play : simule une pression sur le bouton Play des commandes 
de transport.

• Record : simule une pression sur le bouton Record des 
commandes de transport.

• Talkback : simule une pression sur le bouton Talkback 
de l'unité principale de D-Control.

Pour définir la fonction des pédales :

1  Dans la page Preferences, appuyez sur la Soft Key correspondant 
à Foot 1 ou Foot 2.

2  Appuyez sur la Soft Key correspondant à la fonction que vous 
souhaitez assigner à la pédale. La Soft Key correspondant à la 
fonction sélectionnée s'allume de façon continue. 

 Appuyez sur la Soft Key correspondant à la commande 
d'échappement. 

Page Sleep Mode Settings

Le mode Sleep permet de réaliser des économies d'énergie par 
estompage de l'éclairage des témoins de l'unité D-Control. La 
page Sleep Mode Settings permet de définir la durée d'inactivité 
avant que les témoins de l'unité ne s'estompent automatiquement. 

Pour définir cette durée avant la mise en veille de l'unité D-Control :

1  Dans la page Preferences, appuyez sur la Soft Key (unité prin-
cipale) ou sur le bouton Select de l'encodeur (module de faders) 
correspondant à Sleep.

2  Utilisez la molette Scrub/Shuttle (unité principale) ou un bouton 
encodeur (module de faders) pour modifier l'intervalle de temps 
qui doit s'être écoulé avant que l'unité ne passe en mode Sleep. 
Cette durée peut être modifiée par incrément d'une minute 
(jusqu'à 59 minutes) pour des valeurs exprimant des minutes, 
puis par incrément d'une heure pour les valeurs exprimant des 
heures, ou encore définie sur Off (pas de mise en veille de l'unité). 
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Annexe B : Brochages et connexions audio

Toutes les connexions audio de D-Control s'effectuent depuis le panneau arrière de l'interface XMON, illustré ci-après. L'ensemble 
des connexions audio est assuré par des connecteurs femelles standard DB-25. Le connecteur de communication avec D-Control est 
un connecteur femelle à 15 broches. 
Connecteurs du panneau arrière de XMON

Entrées StereoEntrées SurroundEntrées MainEntrées Cue

Sorties Cue Sorties Main Sorties Alt Connecteur D-ControlTalkback/Listenback/Utility
Brochages des connecteurs femelles à 
25 broches

Tous les brochages des connecteurs DB-25 XMON sont conformes 
aux principes de numérotation de broches illustrés ci-dessous. 

Entrées Cue

Connecteur DB-25 (vue utilisateur)

Entrées Cue

Nom du signal
Point 
chaud (+)

Point 
froid (–)

Terre (blindage)

Entrée Cue 1 (gauche) 24 12 25

Entrée Cue 1 (droite) 10 23 11

Entrée Cue 2 (gauche) 21 9 22

Entrée Cue 2 (droite) 7 20 8

Entrée Cue 3 (gauche) 18 6 19

Entrée Cue 3 (droite) 4 17 5

Non connecté 15 3 16

Non connecté 1 14 2

GND 13

SHIELD GND Logement du 
connecteur

113

1425
Entrées Main

Problème connu avec XMON REV A, B, C et D : avec XMON REV 
A à D, si vous avez besoin de mixer des signaux des sorties 
Cue 1, 2 ou 3 avec d'autres signaux de Pro Tools ou de l'interface 
XMON, permutez les points chaud (+) et froid (–) soit des entrées 
Cue soit des sorties Cue. 

Problème connu avec XMON REV E : avec XMON REV E, si vous 
avez besoin de mixer des signaux des sorties Cue 1, 2 ou 3 avec 
d'autres signaux de Pro Tools ou de l'interface XMON, permutez 
les points chaud (+) et froid (–) soit des entrées Cue soit des sorties 
Cue. 

Entrées Main

Nom du signal
Point 
chaud (+)

Point 
froid (–)

Terre (blindage)

Entrée Main 1 (L) 24 12 25

Entrée Main 2 (Lc) 10 23 11

Entrée Main 3 (C) 21 9 22

Entrée Main 4 (Rc) 7 20 8

Entrée Main 5 (R) 18 6 19

Entrée Main 6 (Ls) 4 17 5

Entrée Main 7 (Rs) 15 3 16

Entrée Main 8 (LFE) 1 14 2

GND 13

SHIELD GND Logement du 
connecteur
Ann
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Entrées Surround

Entrées Stereo

Entrées Surround

Nom du signal
Point 
chaud (+)

Point 
froid (–)

Terre (blindage)

Entrée Surround 1 (L) 24 12 25

Entrée Surround 2 (Lc) 10 23 11

Entrée Surround 3 (C) 21 9 22

Entrée surround 4 (Rc) 7 20 8

Entrée surround 5 (R) 18 6 19

Entrée Surround 6 (Ls) 4 17 5

Entrée Surround 7 (Rs) 15 3 16

Entrée Surround 8 (LFE) 1 14 2

GND 13

SHIELD GND Logement du 
connecteur

Entrées Stereo

Nom du signal
Point 
chaud (+)

Point 
froid (–)

Terre (blindage)

Entrée Stereo 1 
(gauche)

24 12 25

Entrée Stereo 1 
(droite)

10 23 11

Entrée Stereo 2 
(gauche)

21 9 22

Entrée Stereo 2 
(droite)

7 20 8

Entrée Stereo 3 
(gauche)

18 6 19

Entrée Stereo 3 
(droite)

4 17 5

Entrée Stereo 4 
(gauche)

15 3 16

Entrée Stereo 4 
(droite)

1 14 2

GND 13

SHIELD GND Logement du 
connecteur
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Sorties Cue

Sorties Main Speaker

Sorties Cue

Nom du signal
Point 
chaud (+)

Point 
froid (–)

Terre (blindage)

Sortie SLS (gauche) 24 12 25

Sortie SLS (droite) 10 23 11

Sortie Cue 1 (gauche) 21 9 22

Sortie Cue 1 (droite) 7 20 8

Sortie Cue 2 (gauche) 18 6 19

Sortie Cue 2 (droite) 4 17 5

Sortie Cue 3 (gauche) 15 3 16

Sortie Cue 3 (droite) 1 14 2

GND 13

SHIELD GND Logement du 
connecteur

Sorties Main Speaker

Nom du signal
Point 
chaud (+)

Point 
froid (–)

Terre (blindage)

Main 1 (L) 24 12 25

Main 2 (Lc) 10 23 11

Main 3 (C) 21 9 22

Main 4 (Rc) 7 20 8

Main 5 (R) 18 6 19

Main 6 (Ls) 4 17 5

Main 7 (Rs) 15 3 16

Main 8 (LFE) 1 14 2

GND 13

SHIELD GND Logement du 
connecteur



Sorties Alt Speaker

Brochages Talkback/Listenback

Sorties Alt Speaker

Nom du signal
Point 
chaud (+)

Point 
froid (–)

Terre (blindage)

Alt 1 (L) 24 12 25

Alt 2 (Lc) 10 23 11

Alt 3 (C) 21 9 22

Alt 4 (Rc) 7 20 8

Alt 5 (R) 18 6 19

Alt 6 (Ls) 4 17 5

Alt 7 (Rs) 15 3 16

Alt 8 (LFE) 1 14 2

GND 13

SHIELD GND Logement du 
connecteur

Talkback/Listenback

Nom du signal
Point 
chaud (+)

Point 
froid (–)

Terre (blindage)

Entrée Ext Talkback Mic 24 12 25

Entrée Listen Mic 1 10 23 11

Entrée Listen Mic 2 21 9 22

Entrée AFL 1 20 7 8

Entrée AFL 2 6 18 19

Sortie Mini Speaker (L) 4 17 5

Sortie Mini Speaker (R) 15 3 16

Sortie Talkback/Slate 1 14 2

GND 13

SHIELD GND Logement du 
connecteur
Brochages des connecteurs à 
15 broches

Les brochages des connecteurs XMON à 15 broches sont conformes 
aux principes de numérotation de broches illustrés ci-dessous. 

Brochages des connecteurs XMON vers D-Control

Connecteur à 15 broches (vue utilisateur)

Brochages XMON vers D-Control

Nom du signal
Point 
chaud (+)

Point 
froid (–)

Terre (blindage)

Entrée RS422 1 9

Sortie RS422 2 10

NC 12 4

NC 11 3

Headphones L 5 13

Headphones R 6 14

Internal Talkback Mic 15 8

GND 7

SHIELD GND Logement du 
connecteur

18

915
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Annexe C : Informations de conformité
Conformité avec les normes 
environnementales

Élimination des équipements usagés par les 
utilisateurs de l'Union européenne

Ce symbole figurant sur le produit et son conditionnement indique que des conditions 
d'élimination spécifiques s'appliquent à ce produit. En effet, il vous incombe d'apporter 
vos équipements usagés à un dépôt de recyclage de matériel électrique et électronique. 
La collecte sélective et le recyclage spécifique de vos équipements usagés permettront 
de préserver les ressources naturelles et de protéger l'environnement et la santé 
des populations. Pour plus d'informations sur les lieux de collecte et de recyclage 
de vos équipements usagés, veuillez contacter votre service de recyclage municipal 
ou le revendeur local auprès de qui vous avez effectué votre achat.

Avertissement : Proposition 65

Avis sur le perchlorate

Ce produit peut contenir une batterie lithium-ion. L'État de Californie impose la 
mention de l'avis suivant : « Présence de perchlorate - un mode de manipulation 
spécifique peut être requis. Rendez-vous sur 
www.dtsc.ca.gov/hazardouswaste/perchlorate. »

Avis de recyclage

Certains des composants chimiques tels que le plomb 
présents dans ce produit sont considérés cancérigènes 
par l'État de Californie et risquent d'entraîner pendant 
la grossesse des effets nfastes sur l'enfant. Lavez-vous 
les mains après manipulation.
Conformité aux normes 
électromagnétiques
Avid déclare que ce produit est conforme aux normes suivantes relatives aux 
interférences et à la compatibilité électromagnétique :
• FCC Part 15 Classe A
• EN55103-1 E4
• EN55103-2 E4
• AS/NZS 3548 Classe A
• CISPR 22 Classe A

Conformité FCC pour les États-Unis

Interférence radio et télévision

Cet équipement a été testé et s'est révélé conforme aux limites d'un périphérique 
numérique de classe A, conformément aux règlements Part 15 de la FCC. 

Conformité australienne

Conformité canadienne

This Class A digital apparatus complies with Canadian ICES-003

Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada.

Conformité européenne

(normes électromagnétiques et sécurité)

Avid est autorisé à apposer la mention CE (Conformité Européenne) sur les 
équipements conformes, déclarant ainsi la conformité à la directive EMC 
89/336/EEC et à la directive 73/23/EEC sur les basses tensions.

Déclaration de communication
Cet équipement a été testé et s'est révélé conforme aux limites 
des périphériques numériques de classe A. Les changements 
ou modifications apportés à ce produit, et non autorisés par 
Avid Technology, Inc., peuvent annuler la certification et vous 
priver du droit de faire fonctionner ledit produit. Ce produit a été 
soumis à des tests de conformité CISPR, dans un environnement 
utilisant des périphériques et des câbles et connecteurs blindés 
entre les composants du système. Avid recommande l'utilisation 
de câbles et de connecteurs blindés entre les composants du 
système pour réduire la possibilité d'interférences sur les radios, 
téléviseurs et autres appareils électroniques.

Avid
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Conformité avec les normes de sécurité

Déclaration de sécurité

Cet équipement a été testé pour être en conformité avec la certification de sécurité 
des Etats-Unis et du Canada, conformément aux spécifications des normes UL (UL6500) 
et des normes canadiennes CSA (CSA C22.2 n°1 – M90). Avid Technology Inc. a reçu 
l'autorisation d'appliquer la marque UL et CUL appropriée sur ses équipements 
conformes.

Attention

Consignes de sécurité importantes

1) Lisez ces instructions.

2) Conservez-les.

3) Soyez attentif aux avertissements.

4) Suivez toutes les instructions.

5) N'utilisez pas cet équipement à proximité d'une source d'eau.

6) Pour le nettoyage, utilisez uniquement un chiffon sec.

7) N'obstruez pas les conduits de ventilation. Lors de l'installation, respectez les 
instructions du fabricant.

8) N'installez pas l'unité à proximité de sources de chaleur, telles que des radiateurs, 
poêles ou autres équipements (amplificateurs compris) produisant de la chaleur.

9) Ne retirez pas la sécurité de la prise polarisée ou de mise à la terre. Une prise 
polarisée possède deux lames, dont l'une est plus large que l'autre. Une prise mise 
à la terre comporte deux lames et une broche de masse. La lame plus large et la 
troisième broche sont fournies pour votre sécurité. Si la prise fournie n'est pas 
adaptée à votre fiche, consultez un électricien, afin qu'il remplace la prise obsolète.

10) Veillez à ne pas marcher sur le cordon d'alimentation, ni à le pincer, en particulier 
au niveau des prises, des fiches femelles et de leur point de connexion à l'équipement.

11) Utilisez uniquement des attaches et des accessoires recommandés par le fabricant.
Guide D-Control72
12) Pour les produits non montables sur rack : utilisez uniquement un chariot, un socle, 
un trépied ou une table recommandés par le fabricant ou vendus avec l'équipement. 
Lorsque vous utilisez un chariot, déplacez l'ensemble chariot/équipement avec 
précaution afin d'éviter tout accident en cas de renversement de l'équipement.

13) Débranchez l'équipement en cas d'orage ou s'il n'est pas utilisé pendant une 
longue période. 

14) Pour tout entretien et réparation, adressez-vous à un personnel qualifié. Des 
réparations sont requises lorsque l'équipement est endommagé, notamment lorsque 
la prise d'alimentation ou le cordon d'alimentation est abîmé, en cas de mauvais 
fonctionnement, d'exposition à la pluie ou à la moisissure, de renversement de 
l'équipement, de déversement accidentel de liquide ou de chute d'objets sur l'unité.

15) Pour les produits auto-alimentés : 
l'équipement doit être protégé des éclaboussures et des ruissellements de liquide. 
Évitez de placer des récipients contenant du liquide (un vase, par exemple) sur 
l'équipement. 

Avertissement ! Afin de réduire les risques d'incendie ou de choc électrique, 
n'exposez pas cet équipement à la pluie ou à l'humidité. 

16) Pour les produits contenant une batterie au lithium : 
ATTENTION ! Si la batterie n'est pas correctement remplacée, elle risque d'exploser. 
Utilisez le même modèle ou un modèle équivalent. 

17) Pour les produits dotés d'un interrupteur d'alimentation : 
L'interrupteur principal se situe sur le panneau arrière de D-Control. Il doit rester 
accessible une fois l'installation effectuée. 

18) La température ambiante d'utilisation de cet équipement ne doit pas dépasser 40° C.

N'essayez pas de réparer l'équipement vous-même. Aucun composant ne 
peut être réparé par l'utilisateur. Contactez le personnel qualifié d'Avid 
pour toute maintenance du produit.

AVERTISSEMENT

Afin de réduire les risques de choc électrique, n'exposez pas cet 
équipement à la pluie ou à l'humidité.

Toute tentative de réparation de l'équipement vous expose à un risque 
de décharge électrique et annule la garantie du fabricant.

AVERTISSEMENT SPECIAL RELATIF A LA VENTILATION :

N'installez pas D-Control dans un endroit où la circulation de l'air 
autour du panneau arrière de l'unité est obstruée.

AVERTISSEMENT SPECIAL RELATIF A LA TEMPERATURE AMBIANTE :

Avant de mettre en marche l'unité D-Control, assurez-vous qu'elle a 
atteint la température ambiante. Certains composants de l'unité étant 
sensibles aux températures froides, il est recommand de déballer 
l'unité et de la laisser s'adapter à la température ambiante avant de 
l'allumer pour la première fois.
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Nombres
9-Pin Remote (bouton) 94

A
Action (bouton de la section Automation) 109
affichage de l’échelle temporelle 8, 124
affichage de l’emplacement 124
affichage des VU-mètres (module de faders) 125
affichage des VU-mètres (unité principale) 124
affichage vidéo 8, 28
After Fader Listen (section Monitor) 120
All (bouton d'automation) 62
All Notes Off (bouton) 102
Assign Talkback (bouton) 122
assignation

assignation de plug-in 75
modes Custom Fader Map 156

assignation de plug-ins 75
Attack (commande du plug-in Dynamics) 79
Audio Files (bouton) 111
Audition (boutons) 95
Auto Insert/Punch (bouton) 96
Auto Off (bouton) 109
Auto Talkback (bouton) 123
AutoMatch (bouton) 109
AutoMatching (automation) 138
automation

activation pour plug-ins 74, 155
AutoMatching 138
capture 137
indication du mode de l'encodeur 50
insertion 137
plug-in 59, 83, 89
snapshots 137

Automation (bouton de plug-in) 83, 89
Automation Mode (bouton) 56, 95
Automation Safe (bouton de plug-in) 83
Automation Safe (mode) 59, 133, 155
Automation Suspend (bouton) 67
Automation Trim (bouton) 56
Automation Write To (bouton) 62

B
B/M/P (voir Bypass/Mute/Pre)
Back (bouton) 95
Back & Play (bouton) 96
Bank Justification (préférence) 40
Bank Select (bouton) 106
Bank Select (boutons) 8
Bank/Cycle (bouton)

mode Custom Fader 68
Bank/Nudge (boutons) 8, 98
boutons de modification 57
boutons fléchés 97
boutons Master Record Mode 94
boutons passe-bande du plug-in EQ 87
Broadcast (mode de la section Monitor) 120
Bypass (bouton de plug-in) 83, 90
Bypass/Mute/Pre (bouton d'encodeur rotatif) 51, 133

Show Values 62
Switch Info 62
Switch Mode 61

Bypass/Spill (bouton de tranche de console) 54
C
Calibration Mode (bouton) 118
canal

mise en focus 55, 93, 131
sélection 55

canaux
commandes PRE 135
mode Inline Console 135

capture de données d'automation 137
caractéristiques techniques

mécanique 5
changement de zoom 113
Channel Strip Master (section) 8
chemins d'E/S

affichage 129, 130
assignation 147

clavier
reconfiguration pour Windows 30

Clear Clip (bouton) 102
combinaison de touches 57
commande Gain/Hold (plug-ins Dynamics) 80
commande Knee/Hysteresis (plug-ins Dynamics) 79
commande Ratio/Range (plug-ins Dynamics) 79
commande Threshold (plug-ins Dynamics) 80
commandes Audition

Audition Mode 95
Mark In 95
Mark Out 95
Post-Roll 95
Pre-Roll 95

commandes Automation Enable 62
Inserts 62
Mute 62
Pan 62
Send Mute 62
Send Pan 62
Send Volume 62
Volume 62

commandes Automation Mode 9, 68
Latch 69
Off 69
Read 69
Touch 69
Trim 69
Write 69

commandes Automation Write To
All 62
End 63
Next 63
Punch 63
Start 63
Write to All 62
Write to End 63
Write to Next 63
Write to Punch 63
Write to Start 63

commandes Channel Strip Function 55
Automation Mode 56
Automation Trim 56
Input Monitor Mode 55
mode Record Safe 55
modes d'affichage 55
Mute 55
Record Enable 55
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sélection des canaux 55
Solo 55

commandes Channel Strip Master Function 66
Automation Suspend 67
Display Mode 67
Escape 66
Mute Clear 67
Select/Focus 66
Solo Clear 67

commandes Channel Strip Mode 52, 54
Bypass/Spill 54
Dynamics 52
EQ 52
Global Input 66
Input 53
Inserts 53
Mic Pre 53
Pan 53
Sends 54

commandes d'assignation 60, 127, 128
Inputs 60
Inserts 60
Outputs 60
plug-in 61
Sends 60

commandes d'automation 109
Action 109
Auto Off 109
AutoMatch 109
Join 109
Modes 110
Prefs 110

commandes d'édition 105
fonctions d'édition 105
modes d'édition 105
outils d'édition 105

commandes d'entrée (section Monitor) 116
commandes de gain (plug-ins) 84, 90
commandes de navigation 8, 97
commandes de plug-in

Dynamics 8, 71, 78
EQ 8, 71, 85
gain 84, 90

commandes de plug-in Dynamics
Attack 79
External Key 82
Filter Frequency 80
Filter In 80
Filter Q/Slope 80
Gain 80
Hold 80
Hysteresis 79
Key Listen 82
Knee 79
Notch/Shelf 80
Range 79
Ratio 79
Release 79
Threshold 80

commandes de plug-in EQ
High Shelf/Peak 86
High-Pass Filter 86
Low Shelf/Peak 86
Low-Pass Filter 86
passe-bande 87

commandes de sélection des canaux
plug-ins 81, 88
section Monitor 119

commandes de sélection des canaux de sortie (section Monitor) 119
Mute 119
Solo 119

commandes de somme des sources en entrée (section Monitor) 116
commandes de sortie (section Monitor) 117
commandes de transport 8, 91
commandes de trim de niveau en entrée (section Monitor) 116
commandes diverses 8, 112
commandes Edit Mode 112
commandes External Machines 96

Auto Insert/Punch 96
Machine Insert 96
Track Arm from Channel Strips 96

commandes Filter Frequency (plug-ins Dynamics) 80
commandes Global 64

Do To All 64
Do to Selected 64
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Set to Default 65
Suspend Groups 65

commandes Global Channel Strip Mode 65
Dynamics 66
EQ 66
Inserts 66
Mic Pre 66
Page 65
Pan 66
Sends 66

commandes Locate 95
Back 95
Back & Play 96
Forward and Play 96
Go To End 95
Go To Start 95
Instant Playback 96

commandes Make Inactive 58, 130
Inputs 59
Inserts 59
Outputs 59
Sends 59

commandes Management 103
commandes Master Record Mode

bouton Master Input Monitor Mode 94
bouton Master Record Enable 94

commandes MIDI 52
commandes Monitor Output Mode 118

bouton Calibration 118
bouton Dim 118
bouton Mono 118
bouton Mute 118

commandes Plug-in Automation 59
commandes PRE 135

pistes 135
commandes Q/Slope (plug-ins Dynamics) 80
commandes Scrub/Shuttle 92

bouton Scrub 93
bouton Shuttle 93
bouton Trim 93
molette Scrub/Shuttle 92

commandes Select/MIDI 106
Bank Select 106
Memory Location 106
MIDI 106

commandes Session Management
All Notes Off 102
Clear Clip 102
Publish 102
QWERTY Disable 102
Redo 102
Save 102
Undo 102
Utility 102

commandes Solo Mode (section Monitor)
After Fader Listen 120
Broadcast 120
Pre Fader Listen 120
Solo in Place 120

commandes Talkback
bouton Auto Talkback 123

commandes Track Size 113
commandes Transport Modes 94

9-Pin Remote 94
Loop Playback 94
Pro Tools Online 94
QuickPunch 94
TrackPunch 95

commandes Zoom Preset 97
Compare (bouton de plug-in) 83, 89
configuration des fenêtres 114
configuration requise

connexions 4, 33, 35, 167
fonctionnement 4

connexion
alimentation 33
audio 35, 167

alt 169
casque 37
entrées stéréo 168
entrées surround 168
principale 167, 168
salle de régie 36
sortie solo 169
système de retour 37, 167, 168



talkback/listenback 169
Ethernet 9, 10, 33, 39
pédale 9, 34
USB 9, 34
XMON 9, 12, 35, 169

contraste de l'affichage 165
Custom Fader Bank Justification (préférence) 42
Custom Fader Flip (mode) 68, 155
Custom Fader Hidden Tracks (préférence) 43
Custom Fader Map (mode) 68, 155
Custom Groups (mode Custom Fader) 67, 150
Cycle (bouton de plug-in) 83, 90

D
défilement (molette Scrub/Shuttle) 92
définition de vue 43, 154
départ

Automation Safe 59
indication d'écrêtage 54

départs
affichage 129
assignation 127, 128, 134, 145
définition du pré-fader ou post-fader 134
désactivation 130
mise en mute 133

déplacement par incrément (pistes) 8
Dim Level (commande) 117
Display Mode (bouton) 67
Do to All (bouton) 64
Do to Selected (bouton) 64
Drive (paramètre HEAT) 132
Dual Transport (mode) 99
Dynamics (bouton de tranche de console) 52
Dynamics (plug-in) 8, 71, 78

affichage de la réduction de gain 77, 84

E
Edit (fenêtre)

navigation 8, 97
Edit Function (bouton) 105, 113
Edit/Timeline (bouton) 112
édition (commandes)

boutons Edit Function 105
emplacement mémoire 113
Enable Parameters (bouton) 59
Encoder Order (préférence) 41
encodeur rotatif 50, 51

basculement entre Bypass/Mute/Pre 61
couleur de l'affichage 50
indication du mode d'automation 50

End (bouton d'automation) 63
End (bouton de la section Start/End/Length) 112
enregistrement des paramètres 82, 89
entrées

assignation 127, 128
désactivation 130

entrées (section Monitor)
Main 116
sélection 116
somme 116
Stereo 116
Surround 116
trim 116

entrées principales (section Monitor) 116
entrées stéréo (section Monitor) 116
entrées Surround (section Monitor) 116
EQ (bouton de tranche de console) 52
EQ (plug-in) 8, 71, 85
Escape (bouton) 66
étalonnage

faders 45
indication du niveau de sortie 45
VU-mètres 45

état online
machine externe 94
Pro Tools 94

Ethernet 9, 10, 33, 39
Explode (bouton) 113
External Key (bouton de plug-in Dynamics) 82

F
fader 56
fader personnalisé 8
affichage 67
affichage de plug-in 68
banques 149
définition de vue du plug-in 43, 154
préférences 42
taille des banques 150
verrouillage de plug-in 68

faders
étalonnage 45

faders activés/désactivés (préférence) 40
fenêtre

déplacement 93
ouverture 101, 104

Filter In (bouton de plug-in Dynamics) 80
Flip (bouton du mode Custom Fader) 68
Flip (bouton) 57
Flip (mode) 57, 134
Flop (mode) 58, 134
fonction Dim 121, 123
fonction HEAT 132
Forward and Play 96

G
Global Input (bouton) 66
Go To (bouton) 113
Go To End (bouton) 95
Go To Start (bouton) 95
Group (bouton) 104
groupe

activation 152
création 152
édition 152
suppression 153

H
High Shelf/Peak (boutons du plug-in EQ) 86
High-Pass Filter (boutons du plug-in EQ) 86

I
indicateur de format de l'affichage d'échelle temporelle 124
indication d’écrêtage 54, 102, 124, 125
Inline Console (mode) 135
Input (bouton) 53
Input Monitor Mode (bouton) 55
Insert/Assemble (bouton) 96
insertion de données d'automation 137
Inserts 132
inserts

assignation 127, 128, 134, 143
désactivation 130

Inserts (bouton d'automation) 62
Inserts (bouton) 53
Instant Playback (bouton) 96

J
Join (bouton) 109

K
Key Listen (bouton de plug-in Dynamics) 82

L
Latch (bouton d'automation) 69
Latch (mode pour bouton Select) 42
Learn Touch (préférence) 75
Length (bouton de la section Start/End/Length) 112
Link Edit/Timeline (bouton) 112
listenback

connexion 169
Lock (bouton de plug-in) 83, 89
Lock (bouton du mode Custom Fader Plug-In) 68
Lock Enable (préférence de la matrice d'assignation) 140
Loop Playback (bouton) 94
Low Shelf/Peak (boutons du plug-in EQ) 86
Low-Pass Filter (boutons du plug-in EQ) 86
luminosité de l'affichage 164

M
Machine Insert (bouton) 96
Machine Online (bouton) 96, 100
MachineControl
Index 175
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commandes de transport 91
Main Counter et Sub Counter (boutons) 112
Map (bouton du mode Custom Fader) 68
Mark In (bouton) 95
Mark Out (bouton) 95
Master Input Monitor Mode (bouton) 94
Master Link (bouton de plug-in) 81, 88
Master Record Enable (bouton) 94
matrice Bank Select 98
matrice d'assignation 139

départs 144
E/S 146
inserts 142
Lock Enable (préférence) 140
préférences 139

matrice d'assignation d'E/S 146
matrice d'assignation d'inserts 142
matrice d'assignation de départs 144
Maximum Custom Fader Bank Size (préférence) 42, 75
Memory Location (bouton) 106
Meter (bouton) 107
Mic Pre (bouton) 53
MIDI (bouton) 106
mise en focus

canal 55, 93, 113, 131
plug-in 72, 132, 133

Mix/Edit Groups (mode Custom Fader) 67, 152, 153
mode Focus (bouton de sélection du canal) 55
mode Select (bouton de sélection du canal) 55
Mode Zoom (bouton) 97
Modes (bouton de la section Automation) 110
modes Custom Fader 67, 149

Custom Groups 67, 150
et mode Custom Fader Plug-In 156
et mode Custom Groups 155
et mode Mix/Edit Groups 155
Mix/Edit Groups 67, 152
Plug-In 68
Plug-in 154
Tracks 68, 153
vue Expanded Plug-In 154

modes d'affichage des canaux 55
module de faders

composants 3
mode Utility 159
présentation du panneau arrière 10
présentation du panneau supérieur 10

molette Scrub/Shuttle 92
défilement 92
déplacement des fenêtres 93
déplacement des pistes par incrément 93
scrubbing 93
sélection 92
zoom 92

Monitor (section) 115
commandes de monitoring de la régie 116

monitoring 8, 115, 116
Mono (bouton) 118
Mute (bouton d'automation) 62
Mute (bouton de tranche de console) 55
Mute (mode de la section Monitor) 118
Mute Clear (bouton) 67

N
Navigate Mode (bouton) 97
Next (bouton d'automation) 63
niveaux

canaux de sortie (section Monitor) 119
entrées (section Monitor) 116
modes Solo (section Monitor) 120
sorties (section Monitor) 117

nom de l'unité (mode Utility) 160
Notch/Shelf (bouton de plug-in Dynamics) 80

O
Off (bouton d'automation) 69
Operation (bouton) 107
options d'extension 4
options Solo Latch (section Monitor) 120
ouverture d'une session 111

P
Page (bouton de plug-in) 82
Guide D-Control76
Page (bouton de tranche de console) 52
pages Test (mode Utility) 161
Pan (bouton d'automation) 62
Pan (bouton) 53
Pan on Lower Encoder (préférence) 41
paramètres des pédales 165
paramètres du mode Sleep 165
pédale 9, 34
piste

Automation Safe 59
déplacement par incrément 93
mise en focus 55, 93, 131
sélection 55, 131

piste d’entrée auxiliaire 135
piste esclave 52
piste Instrument 50, 51, 52, 57, 61
piste Master VCA 50, 51, 52, 54, 153
pistes

désactivation 130
mode Inline Console 135

Playlist (bouton) 104
playlists

assignation 132
plug-in

activation de l'automation 59, 74, 155
assignation 71
Automation Safe 59, 155
bouton Automation 83, 89
bouton Automation Safe 83
bouton Bypass 83, 90
bouton Compare 83, 89, 154
bouton Cycle 83, 90
bouton de basculement entre les modes Select/Link/Bypass 81, 88
bouton Lock 83, 89
bouton Master Link 81, 88
bouton Page 82
bouton Safe 90
bouton Save As 82, 89
bouton Window 83, 90
commandes de sélection des canaux 81, 88
contournement 83, 90, 133, 154
copie de paramètres 74
désactivation 74, 133
Dynamics 78, 133
EQ 85, 133
mise en focus 43, 72, 132, 133, 154
mode Custom Fader 154
modification de paramètres 74
multicanal 71, 81, 88
multi-mono 71, 81, 88, 155
ouverture de plusieurs fenêtres Plug-in 72, 83, 90
plusieurs fenêtres Plug-in 73
réduction du gain Dynamics 77
sélection 73
VU-mètre 84

Plug-In (mode Custom Fader) 68, 154
plug-ins 8, 71, 78, 85
Post-Roll (bouton) 95
pré- et post-insert (HEAT) 132
Pre Fader Listen (section Monitor) 120
préférence du niveau de référence (VU-mètres) 125
Preferences (D-Control) 40, 164

Bank Justification 40
Custom Fader Bank Justification 42
Custom Fader Hidden Tracks 43
Display 44
Display Brightness 164
Display Contrast 165
Encoder Order 41
fader personnalisé 42
faders activés/désactivés 40
Footswitch, paramètres 165
Latch (mode pour bouton Select) 42
Learn Touch 75
matrice d'assignation 139
Maximum Custom Fader Bank Size 42, 75
Meters 44
Pan on Lower Encoder 41
Sleep Mode settings 165
Touch Value 40
Velocity (mode pour encodeur rotatif) 41

préférences d'affichage 44
Préférences de la console

Meter 107
Operation 107



User 106
préférences des VU-mètres 44
Prefs (bouton de la section Automation) 110
Pre-Roll (bouton) 95
Pro Tools Online (bouton) 94
Publish (bouton) 102
Punch (bouton d'automation) 63
Punch Capture (commande) 137

Q
QuickPunch (bouton) 94
QWERTY Disable (bouton) 102

R
Read (bouton d'automation) 69
recherche dans les banques (pistes) 8
Record Enable (bouton) 55
Record Safe (mode) 55
Redo (bouton) 102
réinitialisation des unités D-Control (mode Utility) 164
Release (commande du plug-in Dynamics) 79

S
Safe (bouton de plug-in) 90
Save (bouton dans sessions) 102
Save As (bouton des paramètres du plug-in) 82, 89
schéma de brochage 167
Scrub (bouton) 93
scrubbing (molette Scrub/Shuttle) 93
section Monitor

affichages 119
commandes Headphone/Cue 121
commandes Talkback/Listen 122

Select (bouton d'encodeur) 51
Select/Focus (bouton) 66
Select/Link/Bypass Mode (bouton de plug-in) 81, 88
selection

définition des valeurs Start/End/Length 112
sélection

molette Scrub/Shuttle 92
sélection de plug-ins 73
sélection des canaux (boutons)

tranche de console 55
Send Mute (bouton d'automation) 62
Send Pan (bouton d'automation) 62
Send Pan (mode) 54
Send Volume (bouton d'automation) 62
Sends (bouton) 54
session

enregistrement 102
ouverture 111

Session Management (boutons) 8, 102
Set to Default (bouton) 65
Show Values (bouton) 62
Show/Hide (bouton) 111
Shuttle (bouton) 93
Single Transport (mode) 99
Snap (bouton) 103
snapshot 137
stand

assemblage 19, 20, 22
calage 18
composants 3, 16
finition 25, 26
installation d'unités D-Control 22, 23, 24
matériel 17

Soft Keys 8, 103
commandes d'automation 109
commandes d'édition 105
commandes Management 103
commandes Select/MIDI 106

solo
connexion de sortie 169
mise en focus de pistes 131
verrouillage 55

Solo (bouton) 55
Solo Clear (bouton) 67
Solo In Place (section Monitor) 120
Solo Safe (mode) 55
Solo/Mute (bouton de la section Monitor) 119
sorties

assignation 127
désactivation 130
sorties (Monitor section)
Alt 117
canaux 119

sorties (section Monitor)
étalonnage 118
Main 117
Mini (stéréo) 117
sélection 117
trim 117, 119

sorties alternatives (section Monitor) 117
sorties Mini (stéréo) (section Monitor) 117
sorties principales (section Monitor) 117
Start (bouton d'automation) 63
Start (bouton de la section Start/End/Length) 112
Sum (mode de la section Monitor) 116
Suspend Groups (bouton) 65
Switch Info (bouton) 62
System Info (mode Utility) 160
système de monitoring de la régie 116

commande Dim Level 117
commandes d'entrée 116
commandes de somme des sources en entrée 116
commandes de sortie 117
commandes de trim de niveau en entrée 116
commandes de trim de niveau en sortie 117
commandes Monitor Output Mode 118
sélection des canaux de sortie 119

système Headphone/Cue 121
commandes d'entrée 122
commandes de sortie 121

système Listen 123
boutons Mic Select 123
commande Mic Level 123

système Talkback/Listen 122

T
taille de banque (faders personnalisés) 150
talkback

bouton d'assignation 122
connexion 169
contrôle intégré du niveau 122
External (contrôle du niveau) 122
fonction Dim 121, 123
micro (intégré) 124

Talkback (boutons) 9, 69, 123
témoins AutoMatch 56
témoins Automation Mode 56
témoins Custom Fader Mode 56
témoins Group Status 56
Tone (paramètre HEAT) 132
Touch (bouton d'automation) 69
Touch Value (préférence) 40
Track (bouton) 104
Track Arm from Channel Strips (bouton) 96
trackball

déplacement ou remplacement 31
TrackPunch (bouton) 95
Tracks (mode Custom Fader) 68, 153
tranche de console 49

bouton de sélection du canal 55
Focus Channel Strip 8, 49
section fader 56
section master 57

tranche Focus 8, 49
Transport (mode) 99
Transport Master 100
Trim (bouton d'automation) 69
Trim (bouton de commande Scrub/Shuttle) 93
Trim (mode de la section Monitor) 119
trim de niveau en sortie (section Monitor) 117

U
Undo (bouton) 102
unité principale

composants 3
mode Utility 159
présentation du panneau arrière 9
présentation du panneau supérieur 7

unités D-Control
attribution de nom 40
déclaration 39

User (bouton) 106
Utility (bouton du mode Utility) 102
Utility (mode) 102, 159
Index 177
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pages Test 161
réinitialisation de l'unité 164
System Info 160
Unit Name 160

V
Velocity (mode pour encodeur rotatif) 41
verrouillage

solo 55
Volume (bouton d'automation) 62
VU-mètre 8

étalonnage 45
niveaux de référence 125
plug-in 84

W
Window (bouton de plug-in) 83, 90
Window (bouton du mode Custom Fader Plug-In) 68
Window Management (boutons) 8, 101
Write (bouton d'automation) 69
Write to All (bouton d'automation) 62
Write to End (bouton d'automation) 63
Write to Next (bouton d'automation) 63
Write to Punch (bouton d'automation) 63
Write to Start (bouton d'automation) 63

X
XMON 167

composants 3
connexion 9, 12, 35, 169
présentation du panneau arrière 12
présentation du panneau avant 11

Z
zoom

molette Scrub/Shuttle 92
Zoom/Navigate (section) 97

bouton Navigate Mode 97
bouton Zoom Mode 97
boutons fléchés 97
commandes Zoom Preset 97
Guide D-Control78
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